Security Management Server v10.2.6
AdminHelp







Table of Contents

L= ol ] o 1= PP PP PRP PRSPPI 1
Fa o Jo 10 O] ] [T e[ =] [ o PP PP TPPPPPPR 1
DN A AT o UL A To] g/ 0] o) g [o] ) £ PP PPP PP TPPRT 1

(CT= ] = L (=0 FO RSP RT 23
Get Started With Dell DAtA SECUITTY .......uiiiiiiiiiiiiiie e e et e e e e s s bbb e e e e e e e s s nnbbbeeeas 23
LOG TN et 23
o T T O U SR 23
DT g oo F= 1 o SRR 24
STAIT SBIVICES ... ettt ettt e a et e o h et oo b e e ookt e e ok bttt e e e b et e ek E et e e nb et e e e be e e e e e nnne e e nnreeeeas 26
5] o] o IS T=] Y/ ol =R STPSRSRRRR 27
Change SUPEradmin PASSWOIT .........coiueiieiiieie et et e ettt e ettt e e ettt e e e sttt e e e e ettt e e e amseeeaanseeeeaseeeeaeannseeeaanseeeaanneeaans 27

(070] ] o o] dT=] o1 £ O PP PP PP PPPPPPPPPPPPP 29
ATCNTTECTUIE DIAWINGS ..vtiieiiiiiiiiiiie s s sttt et e e e e e sttt e e e e s sttt ee et e e e e e e s s bbb et e eee e s e st bae et aaeseeaassbbbaeeaeesaansbbbneaaaesnnannns 29

ArChItECTUIE WIth MBNAGEN ... . eeiee ettt ettt e e ettt e e e ettt e e e teeee s enteeeesnbeeeesenaeeeeanneeeeanneaeaans 29
Architecture with Encryption Enterprise for WindowWS/Manager ..........ccuuuiiieiiiiiiiiieniiee s esiiineeae e sivineens 29
DETAUIT POIT VBIUES ...ttt ekt e et e s bbbt e e as et e e st e et e s s e e e e sanneeeesnnees 29
PIOXY SBIVEIS ..ottt 30
TYPES OF PIOXY SEIVEIS. ... .eeieiitiiee ittt ettt e e ettt e e e ettt e e ettt e e e teeee e e aateeeeaateeeeaaateeeeameeee e e nsseeesamteeeeanneeeeannneeeanes 30
L0 [TV = {04V SO PPPT P 32
LI =TS (0 o 1T RSP UTRRSTRR 32
2] | 7o o OSSPSR 32
Lo | I I T o [T PO PPP PP 32

e L=To Il oo LN 1 =10 ] o] £ PP PPPPPS 32
LCTcTaT=T = 1IN T 0] 2 0 U o To o ISR 32

NAVIGALE ThE DEII SEIVEL ...ttt e ettt e e ettt e e s bt e e e eanbe e e e anbee e e abbe e e e anbeeaesnbeeans 33

N Y To T U [0 o DO PO PPPPRP 33
DT 4] oo =1 (o S OO SR TT 33
[0 o181 F- X o o] PRSP PRRPRY 33
(2] o1 ] o 1 oo PP PPRRPN 33
MBNAGEIMENT. ... e 33

YTy g 1= Vo N oo oL SRS 33

DISCONNECTEA MOUE......ci ittt skt e e st e e e st e e ettt e e sa bt e e e abb e e e e nb e e e e anbneeeennnnees 33



Table of Contents

(O 1= o1 Yot €A Ui o] o PP PP OT PR PPPRR 34
MANAGEMENT CONSOIE ... . uiiiiiiii ettt e e s e e e e e e s e e st e et e e e s saa e bae et eaeessaastesaeeeeeesannsbaanaeaeessannnes 34
[ T aT o o F= 1 1 2P PRRPRE 34
DASHDOAIT ...ttt e et e et e 34
(D= T o] oo = 1 o [E O PP TP PP P PP PP PP 35
N [0 1) = U o gL T USSP 37
N[0 o Tor= 1 o] N Y] = PP PPPPPP 37
PrIOFTEY LEVEIS ...ttt e e e st e e e e e s st b e bbbt e e e e e e s aabb b bt eeeeesanstbbeeaeeeaeenan 38
ENAPOINT PrOTECTION STALUS ....cooiiiiiiiiiiie ettt ettt ettt e ettt e e et e e e e st e e e amteeeeeeamteeaeanneeeeannneeas 38
o ) (=10t R0 ] =X LSRR 38
TREATL PrOtECTION STATUS ....coiiiiiiiiii ettt ettt sttt e e e e e s bt e e as bt e e e e sn e e e esr e e e e anbeeeesnnees 39
Threat Protection Status fOr SEVEIITY LEVEL.......c.uuviiiiii ittt 39
Advanced Threat Prevention EVENTS. ... .. ... ittt e e ettt e e e eate e e s smtee e e s nneeeeeeanneeeens 39
Advanced TRreats DY PrIOTITY .......uueiiiii it e e e s s st e e e e e s s sbb bbb e e e eaessannsbrnees 40
Advanced Threat Prevention ClassSifiCatioNS .............coiiieiiiiiiiioii et 42
BT LI LI 1 (=T ST STI 42
ST ] 44
LTSI Y/ o1 TP PSP PP PPRP 44
L0 ) Y =T OSSPSR 45
FAYo AV = Vg Tot=To B I o T (= N ks o o T 1= o SRR 45
[SlgTefoTe] ok o fo] (=Tox A To] g I o 113 (o] o PR OPUPPPR 45
ENAPOINT INVENTONY HISTOMY ...vviiiiiiiiiiiiiiiie ettt e e sttt e e e e e s sttt e e e e e s s bbb et e eeeaeeessnsnaeeaeeeennnes 45
SUMMIATY STATISTICS. ...t eee ettt ettt e e ettt e e e e e e bbb et e e e e e e aa kbbb et e e e e e e e e annbbb e e e e e e e annnbbneeeaeeeeanan 45
[T TofoTo] T ol A N2 {=] o] o SO PPRPPRt 46
(o = U (o] 0 (=] o o] o APPSR PPPPPR 46
0T 01U =Y o o OSSO PERRR 46
200 01U U [ o PP PRRPR 46
[0 (=] 0 o TP POPPPPRRPPN a7
View or Modify ENTEIrPriSE POIICIES. . ...iiii ittt ettt s st e e e e s st e e e e e s s st baeeeeaaeesannnes a7
VIBW TRFEAT EVENTS ...ttt ettt ettt e e e bt e e e st e e e ekt e e e e aat b et e e smbee e e e aabe e e e snneeeeeaneees 47
Manage Enterprise AQVANCEA TRIEATS.........coiiiuiiiiiiee ettt e e e st e e e e e s b eeeeaaee s 48
AAVANCEA TRFEALS TAD......itiiiii ittt et e e n e 48
Advanced Threat EVENTS TaD..........oo e e e e 48
o] 4= 1P 49



Security Management Server v10.2.6 AdminHelp

0] 1o [ PO O P PP PUPRPTPPPRPP 49
FAYe (o =T D o] o = [ PRSP PRPTOP 49
LT PSP P PP PP R POPPPPPPP 49
PaYo (o = WU =T g o)A B o] 4 o= 1] o T PP UPPRT 49
USEIE GIOUS .. s 50
P Vo [0 I O LYY g 0T o SRS 50
A NON-DOMAIN USEIS ...ttt ettt ettt e e e et s bt e e s et e e e e b et e e e st et e e snr e e e s anr e e e e anneeas 51
View or Modify Domain Policies and INFOrmation ..........ccccccoiiiiiiiiiii e 51
DOMAIN DETAIIS & ACTIONS ... .eeiii ittt ettt et e et e e s ettt e e s s m b e e e sttt e e e neeee e nnbeeeeanbeeesanneeaeanes 51
DOMAIN MEBIMIDETS ...ttt ettt oottt e e ettt e e e ettt e e e ea bt e e e amteeeeanseeeeanseeeeeeambeeeeanseeeeanseeeeanneenaeann 52
Do apF= 1T g I 1= 1 T 1P PP OO PPPTPRPP 52
DOMEAIN KBY SEIVET .eiiiiiiiiiiiiiit ettt ettt e e e e e ettt e e e e e e e s ettt e e e e e e s st bbbt e e e e e e e s s asbbbeeeeeeeansabaeeaaeeaannan 53
(UL g T 010 oL S PO PP PP PO PPPPPPPPNt 53
USEIE GIOUDS ...ttt 5555555555555 555555555 5555555555555 e 55 ennnnnnnen 53
FAo [0 I W U T g € o TU ] o TP PP PU P PRT PR 53
REIMOVE USEE GIOUDS .....eeeeeteeeeeeeeeeeseeeeeeeeeseeeeeseee s s s e e s s s e s s e s e s e e sssnnenseneenneesnnnnnnnnnnnnnes 54
1T U= T o T o PR SSTPRRR 54
View or Modify User Group Policies and INformation .............cccuveiiieiiiiiiiiiiiiie i 54
RV O LT gl o] T[T OSSR 55
Policy and Configuration Requirements fOr VDI USEIS ..........cueiiuiiaiiiieieiiiee et e e e 55
USEr Group Details & ACTIONS ......ccii ittt e e e e s s et e e e e e e s s bbb e e e e e e e s aannbrneeeaeeeas 56
(UL g T o0 o JN 1Y T=T0 ] o1 TP T PP 56
A USEIS TO TNE GIOUP ....eeeeiiiiieeeei ettt e ettt e e e e e bbb e et e e e s s bbb e e e e e e e e nnb bbb e e e e e e e e sannnreeeeas 57
REMOVE USEIS TrOM The GIrOUP ..eiieiiiiiiiiiieie ettt ettt e e et e e e e e e e s s bbb e e e e e e s s bbb e eee e e e e s s ansbbeeeas 57
(0L CT g el o107 o Ao [0 o I PP PPPRRR 57
To [T €T (o]0 o I = 4 [o] ¢ 1 A OO PP O UOUPPPPPPPI 58
[fo [T =T o o To] Lol €T oT0] I = g To] | YA PP PEPPR 58
o [ LT g T doT 0 o I o g T ¢ 1 YT PPRPPRTTP 58
Assign or Modify AdmINISErator ROIES...........uuuiiiieii e e e e e e e e e s st brae e e e e e e e aaanes 59
VieW RECONCIITATION DALE ......cooueeiieitiit ettt ettt et et e et e e e s es et e e sbb e e e s smbe e e e e ambeeaeanbeeaeanneas 60
VIEW POLICY PIOXY STATE ...eeiiiiiiiiiiiiiiii ettt ettt e e e s s ettt e e e e e s s sabb b b e e et eaeesanbbbaeeeaeesnannnes 60
L85 OO PUPTPPRTTTOt 60
(6= £ TSP PT T OPPPPPPPN 60
PA¥o [0 - WO 1YY gl o)V o 3 T Ul TS 60



Table of Contents

REMOVE USEIS ...ttt ettt e e e s s e et e e e e s s b et e e e e e s aa b n et e e e e s s annrbneeeeee e s 61
T a1 I U= PP OUPSUPRPRP 61
DEACTIVALE/SUSPENA USETS ...eviiieeiiiiiiiiiet e e e e ettt e e e e s s ettt e e e e e s s s bt eaeeeaeessastbaaeeaaeessansbbaeeaeaaeesannsrraneaaannas 61
REINSTALE SUSPENUEA USEIS ...ueeiiiiiiiiiitiiiit ettt e sttt e e e sttt et e e e s s sab bt e e e e e s s sbb b b eeeeaessaansbbneeaaeenas 62
View or Modify User Policies and INfOrmation ..............eeviieiiiiiiiiiin e 62
USEE DETAIIS & ACTIONS ... eiiiee ittt ettt e ettt e e ettt e e ettt e e e emtee e e anneeeeenseeeeeamteeeeaneeeeeanneeaeanes 63
(6L =T g = 0o ] o To | 1 £ PP OTPPPPPPP 63
USEI GIOUS ...t 8 e 64
L LT o [ T 1o PRSPPI 65
VieW RECONCIHTATION DATE ........eeiieiiiiie ettt ettt e e e et e e e e e nt e e e enaeeeeanseeeeeeamneeeeanneeaeaneeeas 65
VIEW POIICY PIOXY SEATE ..eeiiiiiiiiiiiiiiee ettt ettt e e e e e e sttt e e e e e e e bbb et e e e e e e e s anbbareeeeeeannnnenees 65
Issue @ USer DECIYPLION POIICY .......uviiiiiiiiiiiiiiiiee ettt e e st e e e s s st bbb eeeeeeenes 65
=T [oToT [ 1 AT 01U o 1SS 66
= g le[oTo] Ta] AT {0 0] o 1 PO P PPP PRI 66
TYPES OF ENAPOINT GIOUPS. ..eeiiieiiiitiiiiiee et isitttit et e e e s sttt e e e s s st bt eee s s aaaebbe e et e e e s s asbbbeeeeaeeesaansbbnneaaeenas 66
FiYe (o - Ta I =l aTo o o] 1) N €1go U] o TSP 66
REMOVE aN ENAPOINT GFOUP -....eiiiiiiiieitiie ettt ettt ettt ettt e e e ettt e e e emt e e e e ante e e e smbeeeeaneneeeeaneeeaeennes 67
MOdify an ENAPOINT GIOUD ....vvviiiiiieeiiiiiieie e s sttt e e s st e e e e e s sttt et e e e e s ssabbbb e e e e e e s s nnbbbsbeeeaaeesannsbbeees 67
RVl =t o [ oo T L1 Ao 1U] o L SR 67
Policy and Configuration Requirements for VDI ENAPOINt GrOUPS .......coeviuerieiiiieieniiiee e aiieeeaiieee e 67
Persistent VS. NON-PersSiSTENT VDI .......c.uiiiiiiiii ittt e e e e b e 68
ENdpoint Groups SPECITICATION ... e e e e e e e eb e e e e e e eeas 69
ENdpoint Group SPECITICATION .......coiiiiieiie e e e e e e e e s as 69
OPErators ANU EXPIESSIONS. . .ieiiiiiiiriieeeeeeiiitttte ittt e e st sibbreee e e e e s tbreataaeaeessaabbreeeeesassssbreeaaeeasessnnssrseeeeeasnns 70
ez 1o 1] 0] L= PP PPRR 71
(o 11 €T (oI oI = ¢ [o] 41 TSP P PP O PP PPPPPPP 71
[fo [T =T o o To] Lol €T oT0] I = g To] | YA PP PEPPR 72
o [ LT g T doT 0 o I o g T ¢ 1 YT PPRPPRTTP 72
View Endpoints in an ENAPOINT GrOUP.......ccuuuiiiiieei ittt e e e e s sttt e e e e e e s st e e e e e e e e s ssttaa e s aaeesanasbraeeaaeessannnes 73
View or Modify Endpoint Group Policies and INformation ...........ccccccviiiiiiiiiie e 73
ENdpoint Group Details & ACTIONS........uuiiiiiiiiiiiiiie ittt et a e e s s bbb e e e e e e s s bbb beeeaaaeeas 74
ENAPOINT GrOUDP MEMIDEIS ...ttt ittt e sttt e e e s s st b et e e e e e e s sbb b e beeeeaessansbbeeeeaeenas 74
Add Endpoints to an Admin-Defined ENdpoint GroUP ........cuevieeiiiiciiiiiee e e e 74
Remove Endpoints from an Admin-Defined ENdpPoint GroUP.........cccvveirieeeiiiiiiiieiie et e e e 75



Security Management Server v10.2.6 AdminHelp

= g0 [T [ 0| K- PP PUPPPPRRPP 75
g To oo} 1o £ SPUPUR PR 75
PAo [ I =TT oTo ] 1)t (0 T €1 01U ] o I USSP 76
REMOVE ENAPOINTS ...eeiiiiieiiiiiiieii ettt e e ettt e e e s s e bbbt e e e e e s s ab b b e e et eee e e s anbbeeeeaeesssnbbaeeeas 76
[T To I = 0o ] o To | 1 £ PP UOPPPPPPP 76
View or Modify Endpoint Policies and INformation ............cccoccuviiiiie i 77
VIEW EFFECTIVE POLICY ....viiiiiiiiiiiiiieiie ettt e st e e e e e sttt e e e e e e s s sabbbe e e e e e e s nnnnnees 77
ENAPOINT DETAIIS & ACTIONS. ...uuiiiiiiiiiiiiiiie ettt e e e e st e e e e e s s bt e e e e e s s bbbt eeeeaeessasbbaeeeeeeenas 78
=gl [oToT [ a1 A0 =] - 1] R STSR 78

K] AT L] (o [ =] = V1 PSSP 79
Manager Detail (WINAOWS ONIY) ....oooiieiiiiiie ettt e e e e e e e e e s s e b baeeeas 82

R3] K= L= ST PR PR PP PPPPPPRTN 82
Threat Protection Detail (WINAOWS ONIY) .....oouiiiiiiiieieie et e e e e e e nneeee e 84
Advanced Threat Prevention Detalil .............cooiiiiiiiiiiie e 84
ClOUA DEVICE COMTION ...ttt ettt et e e ekt e e s b b et e s aab et e e e e bne e e e asbeeeeanbeeeenan 84
FDE Device Control (WINAOWS ONIY) ......eeiieiiiiie ittt e e ettt e e et e e e e e e e e enaee e e e enees 84
PBA Device Control (WIindOWS ONIY) ........oiiiiiiiiii ettt e e eae e e 85
PrOTECTEA STALUS. .....eeiiiiiei ittt ettt e e e e ettt e s ah et e e et e e e e s s be e e e aa b et e e s s be e e e aanreeennnneneeean 85
=TT o T T o1 AU LYY SR SRTRR 86
] 01T Lo SO SS 86
(610 TH o F RSP RTRN 87
ENAPOINT TRFEAT EVENTS......eiiiiiiiieii ittt e e e e et e e e e e s e bbb e e e e e e e s e sbn b b beeeaeeesanbbaeeeeeeenas 87
ENAPOINT ADVANCEA THEEATS ....eeiiiiiiiiiiiiiie ettt ettt e e e e e e e e e bbbt eeeae e e s annbeeeeeeeeaas 87
[T} o) Y= 0| £ T TP UPSPRRPP 88
Configure the TRIEA LISt .......c.vviiiiii i e e e e e e e e s e b b e e e e e e e s ennenees 88
X DO L. 88
QUATANTING oo 89
VWV ..ottt ekt e et o R et e e Rt e e e et e n R e e e e e anre e e e 89
o] (0T Y 1 =0 ] o] £ PR 89
Endpoint Advanced THreat EVENTS .........cciiiiiiiiiiiiieie ettt e e e e e e e e e e s s e e e e e e s snnasrrneeaaeeas 89
Server ENCIYPLION CHIENTS ...t e s e e e e e e s b b be e e e e e e s s nnnbbeeeeas 90
SUSPENA AN ENCIYPTEA SEIVET ...ttt e e e e bt e e e e e s e bbbt e e e e e s b baeeeaeeenan 90
ReINState an ENCIYPLEA SEIVEN .....cci ittt e et e e e e e e s et e e e e e e e s saaaeaeeeeaeeeannraeeeas 90
Commands for SeIf-ENCryPLing DIIVES........coiieiiiiiiiiee e e e et ee e e st e e e e e e s e e e e e e e saaraeaeeeeennssennaeees 91



Table of Contents

Priority of Commands for Self-ENCrypting DIIVES .........cooiiiiiiiiiiiiiiiiiiiiee et 91
ATIOW PBA LOGIN BYPASS ...ttvvvrieeeiiiuitiittteeesiiisitiuseseaessassssassssaesssansssssssssaessaasssssseseesssanssssssssseessannssmnmeeeesns 91
UNIOCK @ SEIT-ENCIYPTING DIV ...iiii ittt ettt e e s e e e e e e e et e e e e e e s s nnb b e e e e e e e e e ennsaenees 92
Remove Users from Endpoint with Self-EnCrypting DIiVe ............ooiiiiiiiiiiiniiiiiiiiiee i 92
LOCK @ SEIf-ENCIYPLING DIIVE.....eiiiiiiiiiiiiiieiie sttt ettt e e e s s st e e e e e s s s bbb e e eeee e s s snnbbeeeas 93
Send Wipe Command to Self-ENCrypting DIiVE...........uuuiiiiiiiiiiiiieie et eseee e e e e eiaran e e e e e aanes 93

Set the Dell Server Connection Retry INterval ..ot 93

Lo [ 1LY €= 1 (o] £ F PP PP PR PP P PPPPPPPPPPPN 93
Assign or Modify AdMINISTrAtOr ROIES.........coiiiiiiii et e e e e e e e e enees 94

F Ao [ LTIy A= U o o] = TR 94
Delegate AdMINISErator RIGNTS ........icuiiiiiiieii et e e e e e e s e e e e e e s snbbbeeeeaeenas 98
(2] 010 ] o 1] o TP PR PPPTPPPPP 98
Y= T =TT =T 0T TP PPN 99
MBINAGE REPIOITS ...ttt 885558t 99
View or Modify an EXIiSTING REPOIT........uiiiiiiiiiiiiie ettt e e e e s s e e e e e s s bt bnebeeeee s 99
Create @ NEW REPOIT .......ooiiieeeeeeee e 99

RV LTV =T o Lo o SRS 99
Query using Search and More... TO FIlTEr.........oiii i 101
(o To o A 1 1= SRS 101

Yo [0 o] T=To 11| [ SRR 101

(070 ] 0] o] I - Ta ot I (=T o To] (=] O PP PRR P 102
Data GUAardian AUGIT EVENTS.......c.uiiiiiiiii ittt e e e et e e b e s s 102
MBP VISUBIZATION ...ttt ettt e e e st e e e e e b et e et e e e e e s aanb b e e e e e e e e s snnnnreeeeas 102
Audit EVEnt OPtioNs @nd FIITEIS ....uuuiiiiiiiiiiiiie ettt e e e e e e e e e s snbbreeeeeaeeenannes 103
OpLions iN the COIUMNS MEMU .....uuiiiiiiiiiiiiiiie e et e e e e e s e e e e e e e s sbbbaeeeeeesasssbebbareeeaeenas 104
Protected Office Document or Basic File Protection audit @VentsS...........cccceeviiiiiiieiiee e 105
Examples of Map Visualization and Column FIlEerS..........cccciiiiiieii it ea e 109
Example of drilling in at the map leVEl ............oooiiiii e 109

Get Started with Data Guardian AUdIT EVENTS..........c.uiie it e et e e nneee e saneas 109
Audit Protected OffiCe DOCUMENTS ......coiitiiiii ittt ettt et e et e e e eabe e e e s b be e e s anbeeeeanneeeeaans 110
Audit Cloud Encryption (Mac OF MODIIE) .......ueiiiiiiiiiiiiiiee e e e 111
Default MONIKers and COIUMINS .........ciiiiiiiiiiie ittt e e e eesnree s 111
EU General Data Protection Regulation (GDPR) .........coiiiiviiiieeeiiiiiiiieee e e e e e e e e e ae e e e e e s nnnreeeeas 111
View Audit EVENTS (GEOIOCATION) ...uiiiiiiiiiiiiiiee e e e ettt e st e e e e e e e e e e e e s et e e e e e e e e snnaaeaeaeeeeessnnsrenens 112

vi



Security Management Server v10.2.6 AdminHelp

EVENT DATA ...t e e e e e e e a e e s 112
EXPOrt EVENtS t0 @ SIEM/SYSIOQ SEIVET ....coiieiiiiiiiiieee ettt e e e st aa e e s e st e e e e e e e s snabaneeeaaeeas 113
Export Audit Events With TLS/SSL OVEN TCP ........uuiiiiie ittt e ettt e e s e e e e e e st e e e e e s s snnraeee s 113
Advanced Threat Prevention SySIog EVENT TYPES ......uuiiiiiiiiiiiieiiie ettt 115
Advanced Threat Prevention SySIOg IP AQAIESSES .......cuiieiiiiiiiiiiieeeiiiiiiee e snbeee e e e e s sanbbeeeas 118
Y F= T = To =0 0= o X USSR 118
COMIMIT POIICIES ...tttk e e e ra e e e et e e e b et e e sab e e e e s b e e e s esneeeeannbneeenan 118
(oL [ 0 T= 1)Y= PP UPPPP 119
LRS00 YT PSPPI 119
Recover Data - Encryption External Media Authentication Failure .............cccccooiiiiiiiiii e 120
Encryption External Media Recovery for User "Removed" from Database...........cccccoovvrrivineiiiniiiiinnnnnn. 122
Enable Federated KEY RECOVETY ........uuiiiiiiiiiiiiiiie ettt ettt e e a bbbt e e e e e s bbb e e e e e s s e nbbaeeeeeas 123
Recover Data - BitLOCKEr MABNAGET ........cooi e iiieie ettt et e et e et e e e e ettt e e eneeeeaneeeeaanteeae e nneeeean 123

R CEToT0)V 7T gl = o o o To] [ | AP PUPR TP 123
WINOOWS RECOVEIY ..ottt ettt e e e e e e ettt e e e e s e s bbb ettt e e e e s e e s bbb e e e eeessnnnbbbeeeaaeens 124

SED RECOVETY ...ttt a e e e e e e e e e e e e e 124
Encryption EXternal Media RECOVEIY ........cci ittt ettt e e e et e e eenee e e e aneeeeeaan 124

Y = (ol L= Tol0 VT o T PPN 124
Lot oY g Y =Yg = o= g 1= o SRR 124
Lot e R Y =Yg F= o= g 1= o SR SROTPR 124
UPIOAd CHIENT ACCESS LICEBNSES . .uiiiieiiiiitiiiite e e ettt e e e s s st e e e e e e s st e et e e e e s s aasbbbeeeeeeessnsabbeeeeaaeeesannnes 124
View or Add License NOTITICALIONS . ......cciiuiiiiiiiie it 124
Client Access License (CAL) INTOIMATION .....c..oiiiiiiiiiiieieeiie ettt e e 125

[ To =T ] o T [PPSR PPPPP 125
UPIOAd ClIENT ACCESS LICEBNSES .ovieeiiiiiiiiiiee e e eeiiitii ettt e e e s sttt e e e e e sttt et e et e e e s st e e e e e e s e sbbreaaaaeseessnnnsbeeeeas 126
SEIVICES MABNAGEIMENT ..eiiiiiiitiieee ettt e ettt e e e e ettt e et e e e e e e bbb e e e e e e e e st bbb et e e e e e e s s anbbbeeeeeeeannsanneeaaeeas 126
SEIVICES MANAGEIMENT ... eeiiie ettt e e e e s s ettt e e e e e e e et e e e ea e e s st b e aaaeeaaeeaaasstaaeeaaeessassbansaeaeeesaanssenneeaanesannnes 126
Provision or Recover Advanced Threat Prevention SEIrVICE ...........ccoceiiiiiiiiieie e 127

o 0V o] YT oV o ORI 127
o)< T =Y VTt SO UPSPTPRRN 127
Enroll for Advanced Threat Prevention Agent AULO UPdates ........cccuuveevieiiiiiiiiiieniiee e 127
ReCEIVE A0ENT AULO UPUALES .....eeiiiiiiiiiiiiiei ettt e e et e e e e e s s s b b e e e e e e s sbbbeeteeaaeeesannres 127
Stop receiving agent AULO UPOAtES........occuivieiee e ciiiiiee e e e e st e e e e e e st e e e e e e e s s st e e e e e e e s snnaaaeaaeaaeeas 128
Events Management - Export Audit EVents 10 @ SIEM SEIVET ........cccuvviiiieeeiciiiiiie e aaveaa s 128

Vii



Table of Contents

ProduCt NOTITICATIONS ......coouiiiii ittt e s e s b e e s sar e e e e st e e e e san e e e e sareeeenans 128
Receive Product NOTITICATIONS .........cciiiiiiiii ittt e e e e e e s e s e e e e e s s erabbaeeeaaaeesaanne 128

Stop receiving product NOTITICAtIONS ..........uviiiiie e e e 128
Enable Data GUArdian ACCESS GIOUPS. ... uuutiiatiiiutirtetteessiititeretaessaaautteeeetesssanssteseeeaeessanssbseeeeeesssnnssssseees 129
NOTIFICATION MANAGEIMENT. .....iiiiiiiiitiiie ettt et e e e s e et e e e s s aasb b et e e e e e s sanbbbeeeetaeessaasbbbeeeaaeesnnnnne 129
N[ Tor= L To T Y F= T a = o 1T o 0= o USSR 129
Enable SMTP Server for Email NOTITiCatioNS. .........cooiiiiiiiiiie et 130
ProdUCT NOTITICATIONS .....eiiitiie ettt e b e et e et e e e s b e e s b n e e snn e eans 130
Receive product NOLITICATIONS .........oiiiiiiieii ettt e e et e e e et e e e e e enaeeeeanes 130

Stop receiving product NOLITICATIONS .........oii it eaeee s 130

Data GUArdian MANAGEIMENT .........oiuuiiiiee e ettt ee e e e et e e e e e e s st tbe et eeteeeessnbb b e eeaeesaasbaaeeaaeseeessnssbbeeeeeesannes 130
REGISTIATION ACCESS .eeitiiiiiiitiiiee e e e ettt ettt e e e s sttt e e e e s st bt aeaeae e s s ab bt et e e e e e asssbbeetaaeeaessanabbbeeeeeeesnnsabneeaaeens 130

KBY REQUEST ...ttt e R R e e e e e e e e e rnnrn s nnnnnnnnnn 131

GV R (oA o 1o L o] o [P TUPPRP PP 131

KBY IMBINAGEIMIENT ...ttt 5555555555555 5555555555555t e e e e e e e nnnnee 132

LA = o T oo - | SO SUUSRROTRPR 132
Change SUPeradmin PASSWOIT .........ccouiiiiiiiii ettt e ettt ettt e et e e s et e e e e atee e e e amteeaeanbeeeeenneeeeeanneeeeannees 132
Change ACCOUNT LOCKOUT SEEEINGS.......uuiiiiiiiiiiiiiiiiit ettt e e s e e e e s s st e e e e e e e s s nbbneeeaae s 133
30111/ 1 o= Vo LSRR 133

T To o T Tk Ao i Y7 U= T USRI 133

Y =g To [T oo [T oa =PTSRS 135
MANAGE SECUIITY POIICIES ...eiiiiiiiiiiiiii et e e e s s r e e e e s st eeeeae e s s bbb e eeeeeesannnbbneeeeas 135
Localize Policies Displayed on the ENdpoint COMPUTET ........oouiiiiiiieiiiieee et 136
[WoTor= 14z 1] [N oo ] [Tod = OO P P PP PPPPRTPPPPRROPPPPRTN 137
Ao [o VY = g T Y7 o) £ o] o PP PPPSPPR 140
AT e (oY L = g Tod Y o] X o] o TP P PP PUPT T PPPPPPP 140
A= LT o] 1= PP RSUURTUOTPPRT 149

O SIDLIMAIMEY .....eeeetee ettt ettt e e s e e s s e e e et e e e s s e e e s s 149
LSOO T o F= o OO PSSR 150
LN Y =T o= g L OO ERRR 150

POENV ZENVNAIME. ...eeieeiiiittiiit ettt e e s s e et e e e s b e e e e e e e s s ab b e e e e e e s s eee s 151
T PO PP PPN 151
Windows Policies that Require REDOOT ..........coiiiiiiiiiiiiiee e e e e e e e e eannes 151
Windows Policies that Require LOGOTT ..........oooii i e e e e e e e nnnes 151

viii



Security Management Server v10.2.6 AdminHelp

Advanced WIiNAOWS ENCIYPTION ......uuiiiiiiiiiiiiit ittt e e e e s s e et e e e e s s bbb e e eeeeeeesnbbrees 151
RV LT o] 1= PP RSUURUUOTPPP 181

D S IDLIMAIMIEY0 ...ttt e ettt ettt e e e e ettt e e oottt e e e e e b e et e e e e e e R b e e et e e e e e e e R b br e e e e e e e s annrneeeas 181
LA o o F= o PP PRSP PRRT R 183
NI R =T o= g L PO PRSPPI 183

UOENV ZENVINAIMIEY. ... .etee ettt e ettt e ettt e e e ekttt et e e s o e e bbb e et e e e e s s ab b b e e e e e e e e s s ann bbb e e e e e e e e annnrneeeas 183
T TPV P PPN 183
Windows Policies that Require REDOOT ..........cuuiiiiiiiiiiiiii e e e e nnane 183
Windows Policies that Require LOGOTT ... ...t e e 183
ENCIYPLION RUIES ...ttt ettt ettt e ettt e e e at e e e e se e e e ante e e e e e anbe e e e smteeeeannseaeenneeaeaeannes 183
o (0] (=101 (=T DT f=Tox (o] L= SO PP PP P PP PPPPTPPPPP 183
Modifiers - What they are and wWhat they dO ... 184
USINg the OVErTide MOGITIE ........eiiiieie ettt e et e e et e e e e e naneeeanneeeeans 184
Encrypting/Not ENCrypting EXTENSIONS. ......ciiiiiiiiiiiee e ieiiiiie ittt e e e sttt e e e e st e e e e e e s e s nbba e eeeesesnbbneeaaeeas 184
Examples of Extension INCIUSIONS/EXCIUSION ......c..uuviiiiieiiiiiiiiiiie et a e e 184
Encrypting/Not ENCrypting Dir€CTOIIES ... ...eiiiiiiiieiiiei ettt ettt e e e et e e e et e e e sneee e e anneeeeaan 185
Examples of folder inCIUSION/EXCIUSION ..........oiiiiiiiiie e e e e 185
Sub-directories and Precedence Of DIFrECTIVES..........coiiiiii it 185
EXampPle Of SUD-OIFECTOIIES. ......oi ittt e et e e et e e e enb e e e sneeeaeaneeeeaans 185
Example 1 of comMpPeting dir@CTIVES: ... ....oiiiiiiei ettt e e e e e s sneee e e an 185
Example 2 of COMPEtING AIirECTIVES: .......uviiiiii ittt e e e s s s er e e e e s nnane 186
Example 3 of COMPEtiNG AirECTIVES: .......uviiiiie it e e e e e s sb b e e e e e e e snnne 186
Environment Variables, KNOWNFOLDERID constants, and CSIDL .........cooeviiuiiiiiiiieieeee e 186
Application Data ENCryPLioN (ADE) ........oicuiiiiiieeiiiiiiiieettee e s ssitiees e e s s s stareeeaeaeesssssbbaeesaessssssseeeeseasssannnes 188
Example Policies for Common/uUser Key ENCryPLioN ........ccuvviiiieiiiiiiiiiee et e e 188
System Data ENCrYPLION (SDE).......cuiiiiiiiiiiiiii ettt ettt e e et e e e e e s st e e e e e e s snnbbnebeeeeeeesaannnes 188
Encryption RUles fOr SDE ENCIYPLION .......uuiiiii ittt a e e s e e e e e s e snntraneaaeeesnnnnes 189
Protection Of SYSTEMROOT .........uuiiiiiiiiiiiiiee et e e e s st e e e e e s s bbaeeeaeeeas 189
Encryption Rules for Encryption EXternal Media ...........c.occuuiiiiieeiiiiiiiieiiee et e e n e e e e 189
What Happens WHEN POLICIES T ....uuuiiieiiiiiiiiieiee sttt e e e s et e e e e s s a e e e s s et ae e e e e e s s snnbaeeeaeaeeas 189
Encryption Rules for Generic Drive StAteMENTS ..........oouiiiiiiiiiiie it a e eanes 189
Remove System Data ENCryption (SDE).........iiiuiiiiiiiiiiiiiiiieeee sttt eeeae s 190
F AN 1 =T o o= o Lo o SRR 190
DU a LT o Aot (o] o SRS 190



Table of Contents

AdVANCE AUTNENTICATION......ciiiiii ittt e et e st e e sn e e s nsre e e s s ne e e s nnreeens 191
e L S E=A T ) €] o TP PRR 197
TRIFEAT PrEVENTION .....eiiiiii ittt ettt oottt ettt e e sttt e e e ea bt e e e anbe e e e e s bbe e e s anbeeeesnneeeesanbeeeaanns 197
Advanced TRFEAL PrEVENTION .........ocuiii ittt ettt e et e e s e e e nnreee s 201
Client Firewall SEttings and RUIES ..........uuviiiiiiiiiiii e e e e e e s snbbreeeas 231
(O 1= o) A S LAY 1 IO o} [ o SRR 231
CHENt FIreWAIl RUIES. ........iii ittt e e e s b e e e s nneeeans 233
Policies Set by ApPliCation CONTIOL ........oiiiiiiiiiiiiiie e e et e e e e s s bbb e e reeeeaeenas 236
Advanced Threat Events tab fields and filters ........ ..o 237
Manage Enterprise Advanced Threats - PrOteCION .........cceiiiiiiiiiiii e 237
TRFBAES ..ttt e oo ettt e e et h e oo h e e e e ea bt e e b et e e e e e e nnne e e e e 237
] L D= v U] L P PO PP PP P PP PPPPRPPPPPP 239
Yol T o) o] g« o I =T o = USSR 239
Manage Enterprise Advanced Threats - AGENTS ........occiiiiiiieriiiiiiiiie e e e e e s s sibreeeae e s s anane 240
Manage Enterprise Advanced Threats - CertifiCate.........cccccoiiiiiiiiiii e 240
Manage Enterprise Advanced Threats - Cylance Score and Threat Model Updates..............ccccvvvveeeninnns 241
L C=E= LY ToTo [T B 0T« F= =PRSS 241
Manage Enterprise Advanced Threats - Global LiSt...........c.ueeiiiiiiiiiiiiiii e 242
(€] o] o T= VIO U T= U= ] = RS 242
=L {3 PP PUP PP UOUPUPRPTRTPOt 243

L g F= 1] o T o T PUPUPT RO 244
Manage Enterprise Advanced Threats - OPTiONS..........iiuiiiiiiee ittt e e e e e eeeeeeaenes 245
TREEATL DATA REPOIT ...ttt e e e s et e e e e e e s bt e e et et e e e e s annb b e e e e e e eannnnneeeeeas 245
EXPIOIT DATA ...ttt ettt 246
Advanced Threat Prevention ClassifiCatioNs ............coiiiioiiiiie it 246
Enable Compatibility Mode for MeEMOry ProteCtioN...........uiiii ittt e e e et eaa e e ananes 246
Disconnected Mode POlICY EXAMIPIES ......cciiiiiiiiiiie sttt e s e e e e e e e et e e e e e e s annabbaeeaaeeeeaanne 247
Global AHOW POLICY EXAMIPIE......iiii ittt e e e s bbb e e e e e s s annbbbeees 247
Quarantine List and Safe List poliCy @XampPlesS..........uuuiiiiiiiiiiiiiiie e e e 250
Threat ProteCtion POLICY OVEIVIEW..........uuiiiiieii ittt e e ettt e e s e e e e e e e s et e e e e e e s s snb e aeeaeeessannsreeees 251
Configurable Actions - After Threat is DeteCted ..........c.uueviiiiiiiiiiiiiiee e 252
Reputation Service SENSItIVItY POLICIES........uuuiiiiiiiiiiiiiie e e 252

ClEent FIr@Wall POLICIES .......ooi ittt ettt e et e et e e e et e e e et e e e s enteeeeanneeens 253

(O 11T ) Al S =TV U 1] ) o To g T PR 253



Security Management Server v10.2.6 AdminHelp

CHENT FIrEWAIT FUIES ...ttt e e st e s e e snees 253

WED ProteCtion POLICIES. ... ...oiiiiiie ittt ettt et e e e et ee e e e anneeens 253
Designate a Threat Protection Signature Update SEIVEN .........ccvuiiiie it e e e e 254
DY e W U T o [T o OO PP PP PR PP PP PUPPPTUPRPTN 255
DY WU U o [T o T OO TSP PP PP PPPPPP 255
F o AV =Yg Tot=To BB -\ v W €U - o | = o TSRS 260
SETL COVEI PAGE POIICIES ..ciiiiiiitiiiiet ettt e e e s e e e e e e st e e e e e e s s nabbbeeeeeeesnnennees 269
(01 [0 o I i fo) {1 [T 0 oo F= 1 £ PP PPRTOPPP 269
Set Policies to Protect DOcUMENtS iN WINGOWS ........oouueiiiiiiie et et e et e e e eeeeeeenees 270
Set Policies for Protected OffiCe DOCUMENTS. .........iiiiiiiieiiiee ettt e e e e e e e ne e e e eneeeas 270
Determine Impact on Windows Users for Opt-in or Force Protected MOdesS...........coovvvvvveeeiiiiiinninennn. 271
RETUIN O JIST ...ttt e e bt et e sk b et e e s bt e e et e e e sabne e e e e nanneeens 272
File menu options for Data Guardian v2.7 and arlier .............cccooiiiiiiie e 272
RETUIN O TIST ...ttt e et e e e b et e e e e bt e e et e e e eabb e e e e anbn e e e s anneeeens 273
Enable Both Cloud Encryption and Protected Office Documents (Windows 2.3 and earlier) ............... 273
Set Policies to Protect Office DOCUMENTS IN MAC .......ueiiiiiiiie ettt e e e e e 274
Set Protected Office DOCUMENT POIICIES........oiiiiiiieeiiiiee ittt e e e e e e e e eneeeeas 274
Determine Impact on Mac Users for Opt-in or Force Protected MOES..........cccccevviviiiiiiiienneiiiiiiiiieen, 274
Set Policies to Protect Documents in Mobile DEVICES ........c..ooiiiiiiiiiiiiie e 275
Set Protected Office DOCUMENT POLICIES.........uiiiiiiiee ettt et e e e 275
Set Policies to Protect Documents on the Web POrtal ............coccviiiiiiioiiiiicci e 275
Set Protected Office DOCUMENT POLICIES. ........uiiiiiiiiiiiie e 276
Configure BasiC File ProteCtion POIICIES .........cuiiiiiiiiiiee ettt 276
Supported applications and File TYPES ......uuuiiiiiii i 276
Additional applications and file TYPES .....c..uviiiiii i e 277
Configure policy for BasiC File ProteCTiON ...........ccuuuiiiiiiiiiiiiiiiie ettt 277
Configure policy to exclude folders for Basic File Protection (Windows and Mac)................cceeeeeeennn. 278
Unsupported applications and file TYPES .........uviiiiiiiiii e 279
REMOVE @ FIl8 TP coeiii ittt e e e e e e et e e e e e s ettt e e e e e e e e e asttaeeeaeeesannnbaaeeeaeenas 279
USE the RECOVETY TOOI .. .ueiiiiiiie ettt s ettt e e e s s ettt e e e e s e bbb e e e e e e s s annbebaaeeaaeesannntaneeaaeenan 279
Plan for factors in CONFIQUIATION ..........uuuiiiiii e e e nnbeeeeas 280
To add a Universal Windows Platform (UWP) application ..........ccccceiviiiiiiiiiieie e 280

Set TITUS classification (OPt=-iN MOOE).......uuiiiiiiiiiiiiieie et e e s e e s r e e e e s s st ra e e e e e e s snnnsseneees 280
Configure TITUS 10 €NCIYPT fIlES.....iii it e e e s e e e e e s e b e e e e eaeesenanes 281

Xi



Table of Contents

Configure TITUS to encrypt macro-enabled dOCUMENTS...........cooiiiiiiiiiiiie e 281
Configure Data Classification for Data Guardian's Opt-in MOAE ..........cceeeiiiiiiiiiiiee e 282
VoL L VA= @ Fo TSt 1 o= o o] o RO PRRR 282
Classification Name and PrIOTITY .........oiiiiiiiiiiiieii ittt e e e st e e e e e e s sabbaeeeeaeeeas 283
Yo 1 o] PP P PO T PSP PPRPPTPPPN 283

] 1= RSP SPOTRR 284

= [=T 00T ) £ TP PP PP PPPPPPPPPRPIN 284

Add an Enterprise-Specific Classification or Tag Element..........ccccccoviiiiiiiiin e 285

(O =T LI WO - T o= o] o P SRR 285
Create an EIEMENT. ... ..o ettt et e ettt e s sttt e e s te e e e e neeee e nebaeeeanbeeesanseeeeannneeaans 285

VIEW AUGIT EVENT REPOITS. ..iiiiiiiiiiiiiiie ettt ettt e sttt e e e e e e e s st e e e e e e s bbb e et aeeaeeessnnabbeeaeeeennne 286
Configure ACCesS GrouPS (ON=PreM) .......uueeeieeiiiiiriiriee e s s s ssitrrree e e s s s brrrraeessasabbrereeeessasbbeeeaeessannstnnrraeeeas 286
SET U ACCESS GFOUDS ..eeeeeeeiiiiiieieee e e ettt e e et e e e e e attbe e et e e e e e aasbbe e et e et e e e e aabb e et e e e e e e e nbbbeeeeeeeeeaeannnnseeeeeesannnnnnes 286
Enterprise does not yet have Data GUAITIAN .........coooiiiiiiiiiiee e ee e e e e iarneeeeeeas 287
Enterprise has Data Guardian INSTAEd .............uviiiiiiiiiii e 288
CONTIGUIE ACCESS GIOUS ..eeuteieeeuteeeeautteeeaatteeeae e ateeeaaseeaeaamteeaeamteeeaeaamseeeaansseaeasaeeeeanseeaeeennseeeannneeeeannneens 288
Disable Auto access for swept files (Windows and MaC) ........ccueeiiiieieiiiiiee e 289
Removable Media ENCIYPTION ........uiiiiiie ittt e et a e e s et e e e e e s s s bbb e e aee e s e nnnbbeees 290
Removable Media ENCIYPLION. ... ....ooi ettt et e e ettt e e e st e e e s enee e e e anneeeeennees 290
Removable Media Policies that Require LOGOTT ...........oooiiiiiiiii e 293
Advanced Removable Media ENCIYPLION .........iiiiiiiiiiiiei e e e e e e e e e s s snnbaeaees 293
Removable Media Policies that Require LOgOFT ..........oooiiiiiiiiiio e 301

Y F= o =l o Tod Y] ) 1 {0 o W TP O TP PPUPPP PP 302
Y = Tol =g ol Y/ o £ To o PSR SPOTUPPPP 302
FANo AV T od=To IV F= Tolt =t el Y/ o | £ ] o TR 304
[0 A O00] o1 i {0 | PO PPTPT TP 305
o] A ©o] o1 i (o ISP UPPRR 305
AAVANCE POFT CONTIOL........eiiiiiiiee ettt e e e st e e b e e e s e e e e snneee s 306
(€] To] o T LT =Y o [ To RO PPRRRR 308
PAVe V7 TaTot=Te €] [o] o - LIST=Y A 1o PSPPSR 310

Xii



Welcome

About Online Help

Version: 10.2.6

Attributions & Copyrights

Dell, EMC, and other trademarks are trademarks of Dell Inc. or its subsidiaries. Other trademarks may
be trademarks of their respective owners.

Protected by one or more U.S. Patents, including: Number 7665125; Number 7437752; and Number
7665118.

The software described is furnished under a license agreement and may be used only in accordance
with the terms of the agreement.

Third Party Software
I.  OpenSSL License - Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses
are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact
openssl-core@openssl.org.

OpenSSL License

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

A. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

B. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

C. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)".

D. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please contact
openssl-core@openssl.org.

E. Products derived from this software may not be called "OpenSSL" * nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

F. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)" THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE
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FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. This package is an SSL
implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to
conform with Netscapes SSL. This library is free for commercial and non-commercial use as long as the
following conditions are adhered to. The following conditions apply to all code found in this distribution,
be it the RC4, RSA, Ihash, DES, etc., code; not just the SSL code. The SSL documentation included
with this distribution is covered by the same copyright terms except that the holder is Tim Hudson
(tih@cryptsoft.com). Copyright remains Eric Young's, and as such any Copyright notices in the code are
not to be removed. If this package is used in a product, Eric Young should be given attribution as the
author of the parts of the library used. This can be in the form of a textual message at program startup
or in documentation (online or textual) provided with the package. Redistribution and use in source and
binary forms, with or without modification, are permitted provided that the following conditions are met:

a. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

b. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

c. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

"This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The
word ‘cryptographic' can be left out if the routines from the library being used are not
cryptographic related.

d. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

"This product includes software written by Tim Hudson (tjh@cryptsoft.com)" THIS SOFTWARE
IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. The licence and
distribution terms for any publicly available version or derivative of this code cannot be changed.
i.e. this code cannot simply be copied and put under another distribution licence [including the
GNU Public Licence.].

II.  Portions of this product use Commons 10, Commons DBCP, and Commons LANG. You may obtain
a copy of the licenses at http://www.apache.org/licenses/LICENSE-2.0.
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Ill. Portions of this product use OrientDB. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

IV. Portions of this product use Apache Wink. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

V. Portions of this product use Jackson JSON. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

VI. Portions of this product use Jetty. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

VII. Portions of this product use ActiveMQ. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

VIII. Portions of this product use jasypt. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

IX. Portions of this product make use of zlib. You may obtain a copy of the license at
http://www.zlib.net/zlib_license.html.

/* zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.7, May 2nd, 2012
Copyright (C) 1995-2012 Jean-loup Gailly and Mark Adler This software is provided 'as-is', without any
express or implied warranty. In no event will the authors be held liable for any damages arising from the
use of this software. Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

A. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

B. Altered source versions must be plainly marked as such, and must not be misrepresented as being the
original software.

C. This notice may not be removed or altered from any source distribution. Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu.

X. Portions of this product make use of Apache Tomcat (www.apache.org). You may obtain a copy of
the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

Xl. Portions of this product make use of Apache Commons HTTPClient. You may obtain a copy of the
license at http://opensource.org/licenses/apache2.0.

XIl. Portions of this product make use of log4net. You may obtain a copy of the license at
http://logging.apache.org/log4net/license.html.

XIIl. Portions of this product make use of MVVM Light Toolkit. You may obtain a copy of the license at
http://mvvmlight.codeplex.com/license.

XIV. Portions of this product make use of Apache JDBCLog, Apache Software Foundation. You may
obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XV. Portions of this product make use of Apache Log4J, Apache Software Foundation. You may obtain
a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XVI. Portions of this product make use of Apache Struts, Apache Software Foundation. You may obtain
a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XVII. Portions of this product make use of Struts2. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XVIIl.  Portions of this product make use of Struts Beanutils, Apache Software Foundation. You may
obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.



Welcome

XIX. Portions of this product make use of Struts Digester, Apache Software Foundation. You may obtain
a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XX. Portions of this product make use of Apache xmirpc, Apache Software Foundation. You may obtain
a copy of the license at http://www.apache.org/licenses/LICENSE-2.0.txt.

XXI. Portions of this product make use of Bean Scripting Framework (http://commons.apache.org/bsf/),
Apache License, Version 2.0, January 2004 http://commons.apache.org/license.html.

XXII. Portions of this product make use of Apache Commons CLI (http://commons.apache.org/cli/),
Apache License, Version 2.0, January 2004 http://commons.apache.org/license.html.

XX, Portions of this product make use of Apache Commons EL (http://commons.apache.org/el/),
Apache License, Version 2.0, January 2004 http://commons.apache.org/license.html.

XXIV.  Portions of this product make use of Groovy. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.html.

XXV. Portions of this product make use of H2. You may obtain a copy of the license at
http://www.h2database.com/html/license.html.

XXVI.  Portions of this product make use of Spring.net Application Framework. You may obtain a copy
of the license at http://www.apache.org/licenses/LICENSE-2.0.html.

XXVII.  Portions of this product make use of Java Service Wrapper
(http://lwww.tanukisoftware.com/en/index.php). You may obtain a copy of the license at
http://wrapper.tanukisoftware.com/doc/english/licenseOverview.html.

XXVIII.  Portions of this product make use of Xalan. You may obtain a copy of the license at
http://xml.apache.org/xalan-j/.

XXIX. Portions of this product make use of FreeMarker. You may obtain a copy of the license at
http://freemarker.sourceforge.net/docs/app_license.html.

XXX. Portions of this product make use of Velocity. You may obtain a copy of the license at
http://velocity.apache.org/.

XXXI. Portions of this product make use of MSV. You may obtain a copy of the license at
http://opensource.org/licenses/apache2.0.

XXXII.  Portions of this product make use of FLIB. You may obtain a copy of the license at
http://opensource.org/licenses/artistic-license.html.

XXXIII.  Portions of this product makes use of libraries developed by Boost
(http:/lwww.boost.org/users/license.html), under the following license: Boost Software License - Version
1.0 - August 17th, 2003.

XXXIV. Portions of this product make use of ANTLR. You may obtain a copy of the license at
http://antlr.org/license.html.

XXXV. Portions of this product make use of BIRT. You may obtain a copy of the license at
http://www.eclipse.org/org/documents/epl-v10.php.

XXXVI. Portions of this product make use of the getopt function, Copyright © 1987-2002 The Regents
of the University of California. All rights reserved. Redistribution and use in source and binary forms,
with or without modification, are permitted provided that the following conditions are met:

A. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

B. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
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C. Neither the names of the copyright holders nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS™
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

XXXVII. Portions of this product make use of the SHA-2 algorithm, Copyright © 2002, Dr. Brian
Gladman (brg@gladman.me.uk), Worcester, UK. All rights reserved.

A. LICENSE TERMS

The free distribution and use of this software in both source and binary form is allowed (with or without
changes) provided that:

1. Distributions of this source code include the above copyright notice, this list of conditions and the
following disclaimer;

2. Distributions in binary form include the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other associated materials;

3. The copyright holder's name is not used to endorse products built using this software without
specific written permission.

DISCLAIMER

This software is provided "as is" with no explicit or implied warranties in respect of its properties,
including, but not limited to, correctness and/or fitness for purpose.

XXXVIII. Portions of this product make use of STLport. A copy of the license may be obtained at
http://www.stlport.org/doc/license.html.

A. License Agreement:

Boris Fomitchev grants Licensee a non-exclusive, non-transferable, royalty-free license to use STLport
and its documentation without fee.

By downloading, using, or copying STLport or any portion thereof, Licensee agrees to abide by the
intellectual property laws and all other applicable laws of the United States of America, and to all of the
terms and conditions of this Agreement.

Licensee shall maintain the following copyright and permission notices on STLport sources and its
documentation unchanged:

Copyright 1999,2000 Boris Fomitchev

This material is provided "as is", with absolutely no warranty expressed or implied. Any use is at your
own risk.

Permission to use or copy this software for any purpose is hereby granted without fee, provided the
above notices are retained on all copies. Permission to modify the code and to distribute modified code
is granted, provided the above notices are retained, and a notice that the code was modified is included
with the above copyright notice.

The Licensee may distribute binaries compiled with STLport (whether original or modified) without any
royalties or restrictions.
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The Licensee may distribute original or modified STLport sources, provided that:
0 The conditions indicated in the above permission notice are met;

0 The following copyright notices are retained when present, and conditions provided in
accompanying permission notices are met :

Copyright 1994 Hewlett-Packard Company - Permission to use, copy, modify, distribute and sell
this software and its documentation for any purpose is hereby granted without fee, provided that
the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation. Hewlett-Packard Company makes no
representations about the suitability of this software for any purpose. It is provided "as is" without
express or implied warranty.

Copyright 1996,97 Silicon Graphics Computer Systems, Inc. - Permission to use, copy, modify,
distribute and sell this software and its documentation for any purpose is hereby granted without
fee, provided that the above copyright notice appear in all copies and that both that copyright
notice and this permission notice appear in supporting documentation. Silicon Graphics makes
no representations about the suitability of this software for any purpose. It is provided "as is"
without express or implied warranty.

Copyright 1997 Moscow Center for SPARC Technology - Permission to use, copy, modify,
distribute and sell this software and its documentation for any purpose is hereby granted without
fee, provided that the above copyright notice appear in all copies and that both that copyright
notice and this permission notice appear in supporting documentation. Moscow Center for
SPARC Technology makes no representations about the suitability of this software for any
purpose. It is provided "as is" without express or implied warranty.

XXXIX. Portions of this product make use of The Legion of Bouncy Castle Software. Copyright (c)
2000 - 2016 The Legion Of The Bouncy Castle. You may obtain a copy of the license at
http://www.bouncycastle.org/licence.html.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

Note: Our license is an adaptation of the MIT X11 License and should be read as such.
License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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XL. Portions of this product make use of ResizableLib. You may obtain a copy of the license at
http://opensource.org/licenses/artistic-license-1.0.

XLI. Portions of this product make use of Spring Framework. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XLII. Portions of this product use $File:

A. LEGAL NOTICE,v 1.15 2006/05/03 18:48:33 christos Exp $. Copyright (c) lan F. Darwin 1986, 1987,
1989, 1990, 1991, 1992, 1994, 1995. Software written by lan F. Darwin and others; maintained 1994-
Christos Zoulas. This software is not subject to any export provision of the United States Department of
Commerce, and may be exported to any country or planet. Redistribution and use in source and binary
forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice immediately at the beginning
of the file, without modification, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

XLIII. Portions of this product use UFSD — Paragon NTFS for Windows Driver based on Paragon
Universal File System Driver (UFSD) Technology. Copyright (C) 2008 Paragon Technologie GmbH. All
rights reserved. This software is provided 'as-is', without any express or implied warranty.

XLIV.  Portions of this product use JDBC drivers - licensed from DataDirect Technologies.

XLV. Portions of this product make use of DIMime, available at
http://www.zeitungsjunge.de/delphi/mime/.

XLVI.  Portions of this product make use of RSA Security Inc. PKCS #11 Crypto Token Interface
(Cryptoki).

XLVII.  This software uses following 3rd party libraries:
1. urwid
Copyright (C) 2004-2012 lan Ward

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 2.1 of the License,
or (at your option) any later version.

This library is distributed in the hope that it is useful, but WITHOUT ANY WARRANTY:; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if
not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
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Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is
not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version
3 of the GNU General Public License, supplemented by the additional permissions listed below.

1. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and
the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a
Combined Work as defined below.

An "Application” is any work that makes use of an interface provided by the Library, but which is
not otherwise based on the Library. Defining a subclass of a class defined by the Library is
deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library.
The particular version of the Library with which the Combined Work was made is also called the
"Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for
the Combined Work, excluding any source code for portions of the Combined Work that,
considered in isolation, are based on the Application, and not on the Linked Version.

"Corresponding Application Code" for a Combined Work means the object code and/or source
code for the Application, including any data and utility programs needed for reproducing the
Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by
section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or
data to be supplied by an Application that uses the facility (other than as an argument passed
when the facility is invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event
an Application does not supply the function or data, the facility still operates, and performs
whatever part of its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to
that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of
the Library. You may convey such object code under terms of your choice, provided that, if the
incorporated material is not limited to numerical parameters, data structure layouts and
accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do
both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and
that the Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.

4, Combined Works.
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You may convey a Combined Work under terms of your choice that, taken together, effectively
do not restrict modification of the portions of the Library contained in the Combined Work and
reverse engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it
and that the Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

c) For a Combined Work that displays copyright notices during execution, include the
copyright notice for the Library among these notices, as well as a reference directing the user
to the copies of the GNU GPL and this license document.

d) Do one of the following:

0) Convey the Minimal Corresponding Source under the terms of this License, and the
Corresponding Application Code in a form suitable for, and under terms that permit, the
user to recombine or relink the Application with a modified version of the Linked Version
to produce a modified Combined Work, in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (a) uses at run time a copy of the Library already present on the
user's computer system, and (b) will operate properly with a modified version of the
Library that is interface-compatible with the Linked Version.

e) Provide Installation Information, but only if you would otherwise be required to provide
such information under section 6 of the GNU GPL, and only to the extent that such
information is necessary to install and execute a modified version of the Combined Work
produced by recombining or relinking the Application with a modified version of the Linked
Version. (If you use option 4d0, the Installation Information must accompany the Minimal
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must
provide the Installation Information in the manner specified by section 6 of the GNU GPL for
conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single
library together with other library facilities that are not Applications and are not covered by this
License, and convey such a combined library under terms of your choice, if you do both of the
following:

a) Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser
General Public License from time to time. Such new versions is similar in spirit to the present
version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies
that a certain numbered version of the GNU Lesser General Public License "or any later version”
applies to it, you have the option of following the terms and conditions either of that published
version or of any later version published by the Free Software Foundation. If the Library as you
received it does not specify a version number of the GNU Lesser General Public License, you
may choose any version of the GNU Lesser General Public License ever published by the Free
Software Foundation.
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If the Library as you received it specifies that a proxy can decide whether future versions of the
GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of
any version is permanent authorization for you to choose that version for the Library.

XLVIII. Portions of this product use DropNet. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XLIX. Portions of this product use Hardcodet WPF Notifylcon 1.0.8. You may obtain a copy of the
license at http://www.codeproject.com/info/cpol10.aspx.

L. Portions of this product use MahApps.Metro 1.2.4.0. You may obtain a copy of the license at
http://opensource.org/licenses/ms-pl.

LI. Portions of this product use Microsoft Practices Enterprise Library 6.0.1304.0. You may obtain a
copy of the license at http://opensource.org/licenses/ms-pl.

LIl. Portions of this product use Microsoft Practices Prism 4.1. You may obtain a copy of the license at
http://opensource.org/licenses/ms-pl.

LIIl. Portions of this product use Microsoft Practices Unity 2.1. You may obtain a copy of the license at
http://opensource.org/licenses/ms-pl.

LIV. Portions of this product use RestSharp 105.2.3. You may obtain a copy of the license at
https://github.com/restsharp/RestSharp/blob/master/LICENSE.txt.

Copyright 2009 RestSharp

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except
in compliance with the License.

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License
is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND,
either express or implied.

See the License for the specific language governing permissions and limitations under the
License.

LV. Portions of this product use System.Data.SQLite 1.0.102.0. You may obtain a copy of the copyright
statement at http://www.sglite.org/copyright.html.

LVI. Portions of this product use android-passwordsafe 0.6.0. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LVII. Portions of this product use Dropbox.NET 3.4.0. You may obtain a copy of the license at
https://github.com/dropbox/dropbox-sdk-dotnet/blob/master/LICENSE.

LVIIl.  Portions of this product use Newtonsoft JSON 9.0.1. You may obtain a copy of the license at
https://raw.githubusercontent.com/JamesNK/Newtonsoft.Json/master/LICENSE.md.

The MIT License (MIT)
Copyright (c) 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

LIX. Portions of this product use NT Security Classes for .NET. You may obtain a copy of the license at
http://www.codeproject.com/info/cpol10.aspx.

LX. Portions of this product use Prism Core 6.1. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXI. System.ldentityModel. Tokens.Jwt 4.0.2. You may obtain a copy of the license at
https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-
dotnet/blob/master/LICENSE.txt.

LXII. Portions of this product use Unity 4.0.1. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXIII. Portions of this product use the Dropbox Android SDK 1.6.3. You may obtain a copy of the
license at http://opensource.org/licenses/MIT.

LXIV.  Portions of this product use the Dropbox json_simple-1.1.jar. You may obtain a copy of the
license at http://opensource.org/licenses/MIT.

LXV. Portions of this product use the Box Android Library V2. You may obtain a copy of the license
at http://www.apache.org/licenses/LICENSE-2.0.

LXVI.  Portions of this product use the Box Java Library V2. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXVII.  Portions of this product use Apache HttpClient Cache 4.2.5. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

LXVIIl.  Portions of this product use Apache HttpClient 4.2.5. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXIX. Portions of this product use Apache HttpCore 4.2.4. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXX. Portions of this product use Apache HttpClient Mime 4.2.5. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

LXXI. Portions of this product use Apache Commons 10 2.4. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXXIl.  Portions of this product use Apache Commons Lang 2.6. You may obtain a copy of the license
at http://www.apache.org/licenses/LICENSE-2.0.

LXXIIl.  Portions of this product use JUnit 4.11. You may obtain a copy of the license at
https://www.eclipse.org/legal/epl-v10.html.

LXXIV. Portions of this product use EasyMock 3.1. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXXV. Portions of this product use Jackson Databind 2.4.4. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXXVI. Portions of this product use Jackson Core 2.4.4. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.
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LXXVII. Portions of this product use Jackson Annotations 2.4.4. You may obtain a copy of the license
at http://www.apache.org/licenses/LICENSE-2.0.

LXXVIII. Portions of this product use Apache Maven Wagon 2.2. You may obtain a copy of the license
at http://www.apache.org/licenses/LICENSE-2.0.

LXXIX. Portions of this product use Scribe OAuth Library 1.3.0. You may obtain a copy of the license
at http://opensource.org/licenses/MIT.

LXXX.  Portions of this product use JSON Web Token Support for the JVM 0.6.0. You may obtain a
copy of the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXI. Portions of this product use OneDrive SDK Android 1.2.2. You may obtain a copy of the
license at http://opensource.org/licenses/MIT.

LXXXII. Portions of this product use Microsoft Services MSA Auth 0.8.4. You may obtain a copy of the
license at http://opensource.org/licenses/MIT.

LXXXIII. Portions of this product use Adal 1.1.7. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXXXIV. Portions of this product use Google API Client Library for Java with Android Platform
Extensions and GSON Extensions 1.20.0. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

LXXXV. Portions of this product use Google Drive API V3 Rev 170 1.22.0. You may obtain a copy of
the license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXVI. Portions of this product use Backport Util Concurrent 3.1. You may obtain a copy of the license
at https://creativecommons.org/publicdomain/zero/1.0.

LXXXVII. Portions of this product use Apache Commons Logging 1.1.3. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

LXXXVIII. Portions of this product use Flurry Analytics 4.1.0. You may obtain a copy of the license at
https://developer.yahoo.com/flurry/legal-privacy/terms-service/flurry-analytics-terms-service.html.

LXXXIX. Portions of this product use kSOAP2 3.4.0. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

XC. Portions of this product use FindBugs Jsr305. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XCI. Portions of this product use Google Gson 2.3.1. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XCII. Portions of this product use Hockey SDK 3.0.2. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

XCIIl.  Portions of this product use Picasso 2.5.2. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

XCIV. Portions of this product use Circular Floating Action Menu Library 1.0.2. You may obtain a copy
of the license at http://opensource.org/licenses/MIT.

XCV. Portions of this product use Apache Commons Codec 1.8. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

XCVI. Portions of this product use Apache Commons Compress 1.1. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

XCVII. Portions of this product use One Password App Extension 1.8. You may obtain a copy of the
license at http://opensource.org/licenses/MIT.
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XCVIII. Portions of this product use Azure Active Directory Authentication Library 1.2.9. You may
obtain a copy of the license at http://opensource.org/licenses/MIT.

XCIX.  Portions of this product use AF Networking 2.6.3. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

C. Portions of this product use Box iOS SDK 1.0.11. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

Cl. Portions of this product use CT Assets Picker Controller 2.9.5. You may obtain a copy of the license
at http://opensource.org/licenses/MIT.

Cll. Portions of this product use Google API Objective C Client 1.0.422. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

Clll. Portions of this product use Google GTM HTTP Fetcher 1.0.141. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

CIv. Portions of this product use Google GTM OAuth 2 1.0.126. You may obtain a copy of the
license at http://www.apache.org/licenses/LICENSE-2.0.

CV. Portions of this product use Hockey SDK iOS 3.8.6. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CVI. Portions of this product use libextobjc 0.4.1. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CVIl. Portions of this product use libPhoneNumber iOS 0.8.11. You may obtain a copy of the license
at http://www.apache.org/licenses/LICENSE-2.0.

CVIIl.  Portions of this product use MBProgressHUD 0.9.2. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CIX. Portions of this product use NSData Base64 1.0.0. You may obtain a copy of the license at
http://opensource.org/licenses/Zlib.

CX. Portions of this product use OneDrive SDK iOS 1.1.2. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXI. Portions of this product use RNCryptor 3.0.1. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXiIl. Portions of this product use SSZipArchive 1.1. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXIIl.  Portions of this product use SVProgressHUD 2.0.2. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXIV. Portions of this product use WEPopover 1.0.0. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXV. Portions of this product use XMLDictionary. You may obtain a copy of the license at
http://opensource.org/licenses/Zlib.

CXVI. Portions of this product use NHNetworkTime 1.7. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.

CXVII. Portions of this product use the Dropbox iOS SDK. You may obtain a copy of the license at
http://opensource.org/licenses/MIT.

CXVIII. Portions of this product use Flurry iOS SDK 5.3.0. You may obtain a copy of the license at
http://www.apache.org/licenses/LICENSE-2.0.
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CXIX. Portions of this product make use of the Mono and the Mono runtime, under MIT, BSD, and
Apache licenses. You may obtain a copy of the licenses at http://www.mono-
project.com/docs/fag/licensing/.

Copyright 2018 Microsoft

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be
used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2018 Microsoft

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file
except in compliance with the License

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

14
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CXX.

Unless required by applicable law or agreed to in writing, software distributed under the
License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR
CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the
License.

Portions of this product make use of the Mono .NET assemblies under MIT and BSD licenses.

You may obtain a copy of the licenses at https://mit-license.org/ and
https://opensource.org/licenses/BSD-3-Clause.
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The MIT License (MIT)
Copyright © 2018 Microsoft

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify, merge,
publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED *AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

The BSD License
Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
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NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CXXI.  Portions of this product make use of mkbundle in Mono under GNU LESSER GENERAL
PUBLIC LICENSE v3. You may obtain a copy of the license at https://www.gnu.org/licenses/Igpl.txt.

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and
conditions of version 3 of the GNU General Public License, supplemented by the
additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public
License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application
or a Combined Work as defined below.

An "Application” is any work that makes use of an interface provided by the Library, but
which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode of using an
interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the
Library. The particular version of the Library with which the Combined Work was made is
also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding
Source for the Combined Work, excluding any source code for portions of the Combined
Work that, considered in isolation, are based on the Application, and not on the Linked
Version.

The "Corresponding Application Code" for a Combined Work means the object code
and/or source code for the Application, including any data and utility programs needed for
reproducing the Combined Work from the Application, but excluding the System Libraries
of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being
bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function
or data to be supplied by an Application that uses the facility (other than as an argument
passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event
an Application does not supply the function or data, the facility still operates, and performs
whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to
that copy.
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Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is
part of the Library. You may convey such object code under terms of your choice,
provided that, if the incorporated material is not limited to numerical parameters, data
structure layouts and accessors, or small macros, inline functions and templates (ten or
fewer lines in length), you do both of the following:

Give prominent notice with each copy of the object code that the Library is used in it and
that the Library and its use are covered by this License.

Accompany the object code with a copy of the GNU GPL and this license document.
Combined Works.

You may convey a Combined Work under terms of your choice that, taken together,
effectively do not restrict modification of the portions of the Library contained in the
Combined Work and reverse engineering for debugging such modifications, if you also do
each of the following:

Give prominent notice with each copy of the Combined Work that the Library is used in it
and that the Library and its use are covered by this License.

Accompany the Combined Work with a copy of the GNU GPL and this license document.

For a Combined Work that displays copyright notices during execution, include the
copyright notice for the Library among these notices, as well as a reference directing the
user to the copies of the GNU GPL and this license document.

Do one of the following:

Convey the Minimal Corresponding Source under the terms of this License, and the
Corresponding Application Code in a form suitable for, and under terms that permit, the
user to recombine or relink the Application with a modified version of the Linked Version
to produce a modified Combined Work, in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.

Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (a) uses at run time a copy of the Library already present on the
user's computer system, and (b) will operate properly with a modified version of the
Library that is interface-compatible with the Linked Version.

Provide Installation Information, but only if you would otherwise be required to provide
such information under section 6 of the GNU GPL, and only to the extent that such
information is necessary to install and execute a modified version of the Combined Work
produced by recombining or relinking the Application with a modified version of the Linked
Version. (If you use option 4d0, the Installation Information must accompany the Minimal
Corresponding Source and Corresponding Application Code. If you use option 4d1, you
must provide the Installation Information in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.)

Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a
single library together with other library facilities that are not Applications and are not
covered by this License, and convey such a combined library under terms of your choice,
if you do both of the following:

Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities, conveyed under the terms of this License.
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b. Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same
work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License "or
any later version" applies to it, you have the option of following the terms and conditions
either of that published version or of any later version published by the Free Software
Foundation. If the Library as you received it does not specify a version number of the
GNU Lesser General Public License, you may choose any version of the GNU Lesser
General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions
of the GNU Lesser General Public License shall apply, that proxy's public statement of
acceptance of any version is permanent authorization for you to choose that version for
the Library.

CXXII.  Portions of this product make use of minizip, memcheck.h, freebsd-dwarf.h, freebsd-
elf_common.h, freebsd-elf64.h, freebsd-elf32.h, bsearch.c, w32file-unix-glob.c, and w32file-unix-glob.h
in Mono under BSD license. You may obtain a copy of the license at
https://opensource.org/licenses/BSD-3-Clause.

The BSD License
Copyright 2018 Microsoft

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CXXIIl.  Portions of this product make use of RabbitMQ.Client in Mono under dual license in Apache v2
and Mozilla Public License 1.1. You may obtain a copy of the licenses at
http://www.apache.org/licenses/LICENSE-2.0 and https://www.mozilla.org/MPL/.
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License Information:
Copyright (c) 1999 - 2017 Dell Inc. All rights reserved.

This software and associated documentation (if any) is furnished under a license and may
only be used or copied in accordance with the terms of the license.

Dell elects to use only the Apache license for any software where a choice of Apache v2,
and Mozilla Public License 1.1 license versions are made available with the language
indicating that Apache v2, and Mozilla Public License 1.1 “or any later version may be
used, or where a choice of which version of the Apache v2, and Mozilla Public License
1.1" is applied is unspecified.

CXXIV. Portions of this product make use of Compat.ICSharpCode.SharpZipLib and
ICSharpCode.SharpZipLib in Mono under GNU LESSER GENERAL PUBLIC LICENSE v3. You may
obtain a copy of the license at https://www.gnu.org/licenses/Igpl.txt, although the full text is available
below.

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and
conditions of version 3 of the GNU General Public License, supplemented by the
additional permissions listed below.

1. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public
License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application
or a Combined Work as defined below.

An "Application” is any work that makes use of an interface provided by the Library, but
which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode of using an
interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the
Library. The particular version of the Library with which the Combined Work was made is
also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding
Source for the Combined Work, excluding any source code for portions of the Combined
Work that, considered in isolation, are based on the Application, and not on the Linked
Version.

The "Corresponding Application Code" for a Combined Work means the object code
and/or source code for the Application, including any data and utility programs needed for
reproducing the Combined Work from the Application, but excluding the System Libraries
of the Combined Work.

2. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being
bound by section 3 of the GNU GPL.
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Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function
or data to be supplied by an Application that uses the facility (other than as an argument
passed when the facility is invoked), then you may convey a copy of the modified version:

under this License, provided that you make a good faith effort to ensure that, in the event
an Application does not supply the function or data, the facility still operates, and performs
whatever part of its purpose remains meaningful, or

under the GNU GPL, with none of the additional permissions of this License applicable to
that copy.

Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is
part of the Library. You may convey such object code under terms of your choice,
provided that, if the incorporated material is not limited to numerical parameters, data
structure layouts and accessors, or small macros, inline functions and templates (ten or
fewer lines in length), you do both of the following:

Give prominent notice with each copy of the object code that the Library is used in it and
that the Library and its use are covered by this License.

Accompany the object code with a copy of the GNU GPL and this license document.
Combined Works.

You may convey a Combined Work under terms of your choice that, taken together,
effectively do not restrict modification of the portions of the Library contained in the
Combined Work and reverse engineering for debugging such modifications, if you also do
each of the following:

Give prominent notice with each copy of the Combined Work that the Library is used in it
and that the Library and its use are covered by this License.

Accompany the Combined Work with a copy of the GNU GPL and this license document.

For a Combined Work that displays copyright notices during execution, include the
copyright notice for the Library among these notices, as well as a reference directing the
user to the copies of the GNU GPL and this license document.

Do one of the following:

Convey the Minimal Corresponding Source under the terms of this License, and the
Corresponding Application Code in a form suitable for, and under terms that permit, the
user to recombine or relink the Application with a modified version of the Linked Version
to produce a modified Combined Work, in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.

Use a suitable shared library mechanism for linking with the Library. A suitable
mechanism is one that (a) uses at run time a copy of the Library already present on the
user's computer system, and (b) will operate properly with a modified version of the
Library that is interface-compatible with the Linked Version.

Provide Installation Information, but only if you would otherwise be required to provide
such information under section 6 of the GNU GPL, and only to the extent that such
information is necessary to install and execute a modified version of the Combined Work
produced by recombining or relinking the Application with a modified version of the Linked
Version. (If you use option 4d0, the Installation Information must accompany the Minimal
Corresponding Source and Corresponding Application Code. If you use option 4d1, you
must provide the Installation Information in the manner specified by section 6 of the GNU
GPL for conveying Corresponding Source.)
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6. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a
single library together with other library facilities that are not Applications and are not
covered by this License, and convey such a combined library under terms of your choice,
if you do both of the following:

a. Accompany the combined library with a copy of the same work based on the Library,
uncombined with any other library facilities, conveyed under the terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same
work.

7. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License "or
any later version" applies to it, you have the option of following the terms and conditions
either of that published version or of any later version published by the Free Software
Foundation. If the Library as you received it does not specify a version number of the
GNU Lesser General Public License, you may choose any version of the GNU Lesser
General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions
of the GNU Lesser General Public License shall apply, that proxy's public statement of
acceptance of any version is permanent authorization for you to choose that version for
the Library.

Classpath is distributed under the terms of the GNU General Public License with the
following clarification and special exception.

Linking this library statically or dynamically with other modules is making a combined
work based on this library. Thus, the terms and conditions of the GNU General Public
License cover the whole combination.

As a special exception, the copyright holders of this library give you permission to link this
library with independent modules to produce an executable, regardless of the license
terms of these independent modules, and to copy and distribute the resulting executable
under terms of your choice, provided that you also meet, for each linked independent
module, the terms and conditions of the license of that module. An independent module is
a module which is not derived from or based on this library. If you modify this library, you
may extend this exception to your version of the library, but you are not obligated to do
so. If you do not wish to do so, delete this exception statement from your version.

As such, it can be used to run, create and distribute a large class of applications and
applets. When GNU Classpath is used unmodified as the core class library for a virtual
machine, compiler for the java languge, or for a program written in the java programming
language it does not affect the licensing for distributing those programs directly.

Source code for this component can be found at http://opensource.dell.com.

CXXV. Portions of this product make use of TimeZonelnfo.Android.cs in Mono under Apache License,
Version 2.0. You may obtain a copy of the license at http://www.apache.org/licenses/LICENSE-2.0

Copyright 2018 Microsoft
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Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file
except in compliance with the License.
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the
License is distributed on an "AS IS" BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the
License.

CXXVI. Portions of Advanced Threat Prevention are licensed under GNU LESSER GENERAL PUBLIC
LICENSE v3. You may obtain a copy of the license at https://www.gnu.org/licenses/Igpl.txt or request
information at www.cylance.com.
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Get Started with Dell Data Security

e Once your environment has been configured in the Server Configuration Tool, ensure

that Dell services are started.
e Loginto the Management Console.

e Add Client Access Licenses, as needed.

e Add domains from your directory server.

e If you require that users receive non-default policies upon activation, modify policies at

the appropriate level.

e Add groups and users, as necessary.

e Assign administrators, as necessary.

e Deploy clients.

Log In

To perform a given administrative procedure, an administrator must first log in to the Management
Console using an appropriate Dell administrator account.

The Dell Server installs with a default super administrator user name (superadmin) and password
(changeit) that you can use to add additional Dell administrator accounts.

1. Open a supported browser and type http://<server.domain.com>:8443/webui/login.

2. If you are logging in for the first time, in the Username, enter superadmin. In the Password,
enter changeit.

If you are not logging in for the first time, enter your user name in one of the formats listed
below. In Password, enter <your_case-sensitive_password>.

user@domain.com (preferred format)
sAMAccountName, such as jsmith

<DOMAIN>\<Username> - You must specify your domain name as an alias to use this format.
For more information, refer to Add Domains.

3. Click Sign in.

To log out, see Log Out.

Log Out

If you are an account administrator and make changes to your own account, you must log out and log
back in to see the results.

e Click the gear icon in the top right corner of the Management Console and select Log out from

the menu.
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Dashboard

The dashboard displays an overview of status information for your enterprise. Access more detailed

information directly from the dashboard by clicking its statistics, graphs, and chart legends.

In the top right, select the Widgets menu to add or remove the following widgets:

Notifications
Protection Status
Threat

Protection History
Inventory History
Summary Statistics

The images below reflect what may be seen in the dashboard, depending on widgets enabled.

Click an area below to view a description of the detail accessible by clicking the same area in the

dashboard.
Notif
Dismiss Type: All v Priority- All v Search
Type Priority Date Summary

Knowledge Base Low

Endpoints (by platform) Protected Mot Protected
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Advanced Threats by Events by Classification Advanced Threats Top Ten
Priarity

Total 13 PUP

Hacking Toaol

Threats found on the most

f HIGH 13 devices
100% of total files 1. Upgrade AppS.exe
2. Pluginexe
* MEDIUM 0 3. PluginContainer.exe
0% of total files 4. Pugnese
5. Plugin.exe
6. Pluginexe
‘r Low 0
7. ProPCCleanerSetup.exe
0% of total files
8. cdcSb2b6-5796-4d44-boTa- ..
9. Pluginexe

An Advanced Threat Prevention event is not necessarily a threat. An event is generated when a
recognized file or program is quarantined, safe listed, or waived. Threats are a category of events that
are newly detected as potentially unsafe files or programs and require guided remediation.

Advanced Threat Protection Events
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Start Services

Start the following Services:
e Dell Compatibility Server
e Dell Compliance Reporter
e Dell Console Web Services
e Dell Core Server
e Dell Device Server
e Dell Key Server
e Dell Message Broker
e Dell Policy Proxy

e Dell Security Server

From the Service Panel:
1. Click Start > Run. Type services.msc and click OK.

2. Inthe Services (Local) window, highlight Dell Compatibility Server. Right-click the entry and
select Start.
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3. Continue in the manner above until all Dell Services are started.

4. Close the Services window.

To stop Services, see Stop Services.

Stop Services

You may find it necessary to shut down the Services to run backups or perform other system
maintenance. While the Server is down, the Policy Proxy cannot poll the Server, which means that it
cannot pick up updated security policies, or activate/reactivate endpoints.

Stop the following Services:
e Dell Compatibility Server
e Dell Compliance Reporter
e Dell Console Web Services
e Dell Core Server
e Dell Device Server
e Dell Key Server
e Dell Message Broker
e Dell Policy Proxy

e Dell Security Server

From the Service Panel:
1. Click Start > Run. Type services.msc and click OK.

2. Inthe Services (Local) window, highlight Dell Compatibility Server. Right-click the entry and
select Stop.

3. Continue in the manner above until all Dell Services are stopped.

4. Close the Services window.

To start Services, see Start Services.

Change Superadmin Password

1. Inthe masthead at the top of the screen, click the gear icon and select Change superadmin
password.

2. Enter the current password.

3. Enter the new password.

The new password must be at least 6 characters, contain at least one capital letter and one of
these characters: ~@#$%"*()|?!{}[].
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4. Confirm the new password.
5. Click Update.

After three failed login attempts, the superadmin account is locked for five minutes. To change these
settings, see Set or Change Account Lockout Settings.
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Internal:

Active Directory communication: TCP/389

Email communication (optional): 25

To Front End (if needed):

Communication from external Policy Proxy to Message Broker: TCP/61616 and STOMP/61613
Communication to Back End Security Server: HTTPS/8443

Communication to Back End Core Server: HTTPS/8888 and 9000

Communication to RMI ports - 1099

Communication to Back End Device Server: HTTP(S)/8443 - If your Dell Server is v7.7 or later. If your
Dell Server is pre-v7.7, HTTP(S)/8081.

Message Broker: TCP/61616 and STOMP/61613 (closed or, if configured for DMZ, 61613 is open)
External (if needed):

SQL Database: TCP/1433

LDAP: TCP/389/636 (local domain controller), TCP/3268/3269 (global catalog), TCP/135/49125+ (RPC)
Compatibility Server: TCP/1099

Compliance Reporter: HTTP(S)/8084 (automatically configured at installation)

Core Server: HTTPS/8888 and 9000 (8888 is automatically configured at installation)

Device Server: HTTP(S)/8081 - If your Dell Server is pre-v7.7/8443 - If your Dell Server is v7.7 or later
Key Server: TCP/8050

Policy Proxy: TCP/8000

Security Server: HTTPS/8443

Client authentication: HTTPS/8449 (If using Dell Encryption on a server operating system)
Management Console: HTTPS/8443

Client communication if using Advanced Threat Prevention: HTTPS/TCP/443

Beacon server if using Data Guardian: HTTP/8446

Proxy Servers

The proxy server installation, implementation, and deployment are fast and easy. The proxy server is a
simplified web server with a single web application.

Types of Proxy Servers
e  Security Server (defaults to 8443)
e Core Server (defaults to 8888)

e Device Server (defaults to 8081) see Note
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Dell Security Management Server
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Internal Clients

Note: The purpose of Device Server proxy is to support legacy Encryption clients (pre-v8.0) that

communicate with port 8081. Newer Encryption clients (v8.0 and later) are configured by the client
installer to communicate with the Security Server (or Security Server proxy) on port 8443. The full
Device Server is not installed in v8.1. The Device Server proxy forwards all communications to the

Security Server behind the firewall.
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Policy Proxy

Policy Proxy serves as intermediary between Dell Server and Encryption client, delivering information
from each to the other.

Time Slotting

To prevent Dell Server traffic jams, Policy Proxies use a time slotting mechanism that allows them to
independently choose well-distributed time slots for communicating with the Dell Server.

Polling

On every poll, the endpoint authenticates, checks for policy updates, and uploads inventory. A
successful authentication is required for the process to begin.

Poll Triggers

A user must be logged in to poll. On the next user login, another poll occurs. The poll information
needed is only available per user, and when that user is logged in.

Other times a poll occurs:
e Immediately upon login, after encryption keys are unlocked.

e When a network status update is signaled by the operating system (cable plugged in, wireless
network connected, VPN becomes active).

e When the polling period elapses, as specified by policy.
Failed Poll Attempts

Policy Proxy poll attempts are based on a timer. When a poll attempt fails, the timer is reset. The length
of time set for the next attempt is based on when the attempt failed. If the device misses a poll when
powered off, the timer is triggered when the device is next powered on.

If the poll attempt failed while making the attempt, the time is set to one tenth the policy value for the
polling interval. For example, if the polling interval is 100 minutes, then the next interval after a failed
attempt is 10 minutes. If it fails again, the next interval is still 10 minutes. The interval remains 10
minutes until a successful poll, after which it returns to 100 minute intervals.

General Information
e Policy Proxy is generally installed on only a few computers.
e Creates inventory information for the Dell Server.

e Passes on to the Dell Server device inventory it receives when the Encryption client
successfully retrieves policies.

e Securely distributes security policies and encryption keys to devices via the network when
contacted.

e May be in your DMZ.

e Always belongs to a group. By default, all Policy Proxies belong to the same group.
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Navigation

The Management Console is a central control center that the administrator can use to deploy and
monitor security for the organization. It consists of security and configuration settings that are applied
through policy to groups called Populations.

The menu pane allows access to the following:
Dashboard

The Management Console opens to the dashboard. The dashboard provides graphs and statistics on
endpoints and threat protection as well as summary statistics on populations and operating systems.

Populations

A population is a grouping for which security policies, settings, and actions can be configured. For
example, security policies can be applied at the Enterprise, Domain, User Group, User, Endpoint Group,
and Endpoint levels. See Populations. See Manage Security Policies.

Reporting

Reporting menu items provide reports on the protection state of the environment and endpoints,
deployment issues that require action, and devices within the network. Create and manage reports with
the Manage Reports tool or by launching Compliance Reporter. This menu allows you to collect, view,
and export audit events to a SIEM server.

Management

Commit policies, manage licenses, services, alerts, and Data Guardian external users.

Masthead Icons

The following icons display on the masthead:

superadmin = ﬂ'

(1) Logged in user - The user icon and name of the user that is currently logged on.

(2) Gear icon - From the gear icon, you can Change the Superadmin Password, view information about
the Dell Server, get Dell ProSupport contact information, and log out.

(3) Question mark icon - Open a help topic that explains the current screen in the Management
Console.

Disconnected Mode

Disconnected mode allows a Dell Server to manage Advanced Threat Prevention endpoints without
client connection to the Internet or external network. Disconnected mode also allows the Dell Server to
manage clients without Internet connection or a provisioned and hosted Advanced Threat Prevention
service. The Dell Server captures all event and threat data in Disconnected mode.
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To determine if a Dell Server is running in Disconnected mode, click the gear icon at the top right of the
Management Console and select About. The About screen indicates that a Dell Server is in
Disconnected mode, below the Dell Server version.

Disconnected mode is different than a standard connected installation of Dell Server in the following
ways.

Client Activation

An install token is generated when the administrator uploads an Advanced Threat Prevention license,
which allows the Advanced Threat Prevention client to activate.

Management Console

The following items are not available in the Management Console when Dell Server is running in
Disconnected mode:

The following areas specific to Advanced Threat Prevention: Advanced Threats by Priority,
(Advanced Threat) Events by Classification, Advanced Threats Top Ten, and Advanced Threat
Prevention Events.

Enterprise > Advanced Threats tab, which provides a dynamic display of detailed events
information for the entire enterprise, including a list of the devices on which events occurred and
any actions taken on those devices for those events.

(Left navigation pane) Services Management, which allows enabling of the Advanced Threat
Prevention service and product notifications enrollment.

The following item is_available to the Management Console when Dell Server is running in
Disconnected mode:

Enterprise > Advanced Threat Events tab, which list events information for the entire enterprise
based on information available in the Dell Server, even when running in Disconnected mode.

Functionality

The following functionality is not available in the Management Console when Dell Server is running in
Disconnected mode:

Security Management Server upgrade, update, and migration
Security Management Server Virtual auto update - an update must be done manually
Cloud profile update
Advanced Threat Prevention auto update
Upload of Unsafe or Abnormal Executable files for Advanced Threat Prevention analysis
Advanced Threat Prevention file upload and log file upload
The following functionality differs:
The Dell Server sends the Global Safe List, Quarantine List, and Safe List to client computers.

The Global Safe List is imported to the Dell Server through the Global Allow policy. For more
information, see the Global Allow policy.

The Quarantine List is imported through Quarantine List policy. For more information, see the
Quarantine List policy.

The Safe List is imported through Safe List policy. For more information, see the Safe List policy.

Dashboard
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Dashboard

The dashboard displays an overview of status information for your enterprise. Access more detailed
information directly from the dashboard by clicking its statistics, graphs, and chart legends.

In the top right, select the Widgets menu to add or remove the following widgets:

Notifications
Protection Status
Threat

Protection History
Inventory History
Summary Statistics

The images below reflect what may be seen in the dashboard, depending on widgets enabled.

Click an area below to view a description of the detail accessible by clicking the same area in the
dashboard.
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An Advanced Threat Prevention event is not necessarily a threat. An event is generated when a
recognized file or program is quarantined, safe listed, or waived. Threats are a category of events that
are newly detected as potentially unsafe files or programs and require guided remediation.

Advanced Threat Protection Events
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Notifications List

The notifications list provides a configurable summary of news, alerts, and events to display on the

dashboard or to be sent as email notifications. For more information, see Dashboard Field Descriptions
and Notification Management.

Notification Types
Select the notification types to include in the list. Notifications of the remaining types are hidden.
Types include:
Update - News of upcoming product updates. To view and receive product updates, you must
enroll to receive them. Select Services Management > Product Notifications, click On, then click
Save Preferences.

Config - News about configuration changes.

Knowledge Base - Summaries and links to knowledge base articles with in-depth technical
information such as work arounds and configuration methods.

icense - Alerts when your volume license is low, or when your client access license count has been
exceeded.

Announcement - News of upcoming releases and new products.
Threat Protection - A threat alert from Advanced Threat Prevention.
Advanced Threat Event - An event detected by Advanced Threat Prevention. The summary

contains a listing of Critical, Major, Minor, Caution, and Information events, with links to more detailed
information.
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Threat Event - An event detected by Threat Protection.
Certificate - Certificate expiration notification.

Server Exceptions - A Dell Server communication issue is impacting deliveries of the following
notifications: Threat Protection, Update, Config, Knowledge Base, and Announcement.

After selecting one or more types, click in the neutral space above the list to apply the
selections.

Select Clear selected items to reset the selections in this list.
Priority Levels

Notification priority levels are not related to priority levels displayed on the dashboard other than in
the notifications area.

Priorities are Critical, High, Medium, and Low. These priority levels are only relative to one another
within a type of notification.

Select the priority levels of notifications to include in the dashboard notifications area or email
notifications lists. Notifications of the remaining priority levels are not included in the dashboard or
email notifications lists.

In the dashboard, after selecting one or more priority levels, click in the neutral space above the list
to apply selections.

Select Clear selected items to reset the selections in this drop down list. All notifications will display
(unless filtered elsewhere).

Endpoint Protection Status

In the Endpoint Protection Status section of the dashboard, view endpoint status by platform: Windows,
Mac, Mobile Devices, and All Platforms with a numeric value and bar chart that shows the numbers of
protected and unprotected endpoints. A pie chart representing total protected and unprotected
endpoints displays on the left.

Click a value to display a list of the endpoints represented in the value.

Protection Status

To access this page, click a link in the dashboard's Endpoint Protection Status graph. Click a specific
platform type or All. The page provides protection details on the endpoints within that platform.

Platform - Windows, Mac, Mobile Devices, All, Protected, or Not Protected
Endpoint ID - Value that uniquely identifies the endpoint.

Protected - A green check mark indicates the endpoint is protected. The protection status of a Windows
workstation is derived from the current encryption policies and encryption states of the Encryption client
users, as well as the current device encryption policy and state of the endpoint. On the dashboard's
Endpoint Protection Status graph, select endpoints by platform, protected endpoints, non-protected
endpoints, or all endpoints. See Protected.

Shield Inventory Received - The date and time that the inventory was received and placed in the queue.

Shield Inventory Processed - The date and time that the inventory was picked up from the queue and
processed. (Note: If the server is under load, the Processed and Received times may be different, but
usually they are the same.)
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Agent Inventory Received - The date and time that the inventory was received and placed in the queue.

Agent Inventory Processed - The date and time that the inventory was picked up from the queue and
processed (Note: If the Dell Server is under load, the Processed and Received times may be different,
but usually they are the same.)

Shield - If encryption is installed on the endpoint, an icon displays.

Manager (Windows only) - If installed on the endpoint, an icon displays. This includes endpoints with
activated PBA, SED, or BitLocker Manager.

Threat Protection Status

Threat Protection monitors the network for viruses, spyware, unwanted programs, suspicious
communications through the firewall, and unsafe websites and downloads.

The Threat Protection Status pane shows threats by category: Critical, Major, Minor, and Caution. Each
category is listed in a colored bar chart with a numerical value for the corresponding number of threats
found during the time frame.

The time frame is selectable, in days: 1, 7, 14, 30, 60, and 90 days.

Click a Threat Category value to display a detailed list of threats included in the category.

Threat Protection Status for Severity Level
To access this page, click a value on the dashboard's Threat Protection Status graph.

This page provides a detailed view of threats based on individual severity levels and devices that have a
threat within that severity level. The columns list the specific counts for each type of threat event on a
device.

List of severity levels - Select a another option from the list (Critical, Major, Minor, Caution, Information).
Critical is the most dangerous threat to the endpoint, and Information is a notification of an event that
is unlikely to harm the endpoint.

List of days - Select a time frame option: 1, 7, 14, 30, 60, and 90 days.
Platform - The platform type

Device ID - Value that uniquely identifies the target device. Click a link to view information about that
endpoint.

Event Count columns - For each device, lists the number for each of the following threat events:

Malware/Exploit - Includes counts for viruses, spyware, and unwanted programs. This could be
exploited buffer overflows that seek to execute arbitrary code on a device or attempts to exploit browser
vulnerabilities. Counts may include malware that executes from within memory space.

Web Filter - Includes threats related to web browsing and downloads.
Web Protection - Includes threats related to web browsing and downloads.
Firewall - Includes suspicious communications related to incoming or outgoing traffic and any attacks.

Uncategorized - Lists the number of threats that do not belong in other event counts.

Advanced Threat Prevention Events

39



Navigate the Dell Server
The Advanced Threat Prevention Events pane displays a time line of Advanced Threat events over the
course of a month, by file type as assigned by Advanced Threat Prevention.
Click a file type for details of the events of that type.
File types include:
Unsafe - A suspicious file with a high score (-60 to —100) likely to be malware
Abnormal - A suspicious file with a lower score (-1 to —59) less likely to be malware

Quarantined - A file that is moved from its original location, stored in the Quarantine folder, and
prevented from executing on a specific device.

Waived - A file allowed to execute on a specific device.

Cleared - A file that has been cleared within the organization. Cleared files include files that are Waived,
added to the Safe list, and deleted from the Quarantine folder on a device.

For more detail about events, see Advanced Threat Prevention Classifications and Advanced Threats
Top Ten

Advanced Threats by Priority

Advanced Threats by Priority classifies suspicious files by priority levels of High, Medium, and Low. This
prioritization helps administrators determine which threats and devices to address first. To view a list of
threats with the corresponding priority level, click a value in Advanced Threats by Priority on the
dashboard.

Files are analyzed for the following attributes:

The file has a Cylance score greater than 80.

A score is assigned to each file that is deemed Abnormal or Unsafe. The score represents the
confidence level that the file is malware. The higher the number, the greater the confidence.

The file is currently running.
The file has been run previously.
The file is set to auto run.

The file is detected by Execution Control.

Files are prioritized based on the number of the above attributes it has:

Low = 0-1 attributes
Medium = 2-3 attributes

High = 4-5 attributes

As an example, following is the analysis of three threats:

Threat 1

Cylance score 90 +1
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Currently running on any

device True +1
Ever run on any device True +1
Set to auto run on any True +1
device

Detected by Execution

Control False +0

Total score 5: High Priority
Threat 2

Cylance score 20 +0
Currently running on any True +1
device

Ever run on any device False +0
Set to auto run on any True +1
device

Detected by Execution

Control False +0

Total score 2: Medium Priority
Threat 3

Cylance score 20 +0
Currently running on any False +0
device

Ever run on any device False +0
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Set to auto run on any

. False +0
device
Detected by Execution True +5
Control
Total score 5: High Priority

Advanced Threat Prevention Classifications

Advanced Threat Prevention can provide details on the static and dynamic characteristics of files. This
allows administrators to not only block threats, but also to understand threat behavior to further mitigate
or respond to threats.

Type of Threat

Threats are classified by the type of threat - Malware, Dual Use, and Potentially Unwanted Program.

Malware

If the file is identified as a piece of malware, the file should be removed or quarantined as soon as
possible. Verified malware can be further subclassified as one of the following:

Subclass Definition Examples

Malware that provides unauthorized access to a system, Back Oirifice,
Backdoor . .

bypassing security measures. Eleanor

Malware that connects to a central Command and Control
Bot (C&C) botnet server. QBot, Koobface

Staged-
Downloader Malware that downloads data to the host system.
Downloader

Dropper Malware that installs other malware on a system.
Exploit Malware that attacks a specific vulnerability on the system.

Mal\_/vare that me_lsque_rgdes as Iegmmate security software Fake AV White
FakeAlert to trick the user into fixing fake security problems at a Paper

price. P
Generic Any malware that does not fit into an existing category.

Malware that records login credentials and/or other .
InfoStealer o . Snifula

sensitive information.

Malware that restricts access to system or files and

- CryptoLocker,
Ransom demands payment for removal of restriction, thereby
. Cryptowall

holding the system for ransom.

Remnant Any file that has malware remnants post removal attempts.
. Malware that enables access to a computer while TDL, Zero

Rootkit

protecting itself or other files to avoid detection and/or

Access Rootkit
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Trojan

Virus

Worm

Dual Use

removal by administrators or security technologies.

Malware that disguises itself as a legitimate program or
file.

Malware that propagates by inserting or appending itself to
other files.

Malware that propagates by copying itself to another
device.

Zeus

Sality, Virut

Code Red,
Stuxnet

Dual Use indicates the file can be used for malicious and non-malicious purposes. Caution should be
used when allowing the use of these files in your organization. For example, while PsExec can be a
useful tool for executing processes on another system, that same benefit can be used to execute
malicious files on another system.

Subclass

Crack

Generic

KeyGen

MonitoringTool

Pass Crack

RemoteAccess

Tool

Definition

Technologies that can alter (or crack) another
application to bypass licensing limitations or Digital
Rights Management protection (DRM).

Any Dual Use tool that does not fit into an existing
category.

Technologies which can generate or recover/reveal
product keys that can be used to bypass Digital Rights
Management (DRM) or licensing protection of software
and other digital media.

Technologies that track a user's online activities without
awareness of the user by logging and possibly
transmitting logs of one or more of the following:

user keystrokes

email messages

chat and instant messaging
web browsing activity
screenshot captures
application usage

Technologies that can reveal a password or other
sensitive user credentials either by cryptographically
reversing passwords or by revealing stored passwords.
Technologies that can access another system remotely
and administer commands on the remote system, or
monitor user activities without user notification or
consent.

Programs that offer administrative features but can be
used to facilitate attacks or intrusions.

Potentially Unwanted Programs
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Veriato 360,
Refog
Keylogger

I0Ophtcrack, Cain
& Abel

Putty, PsExec,
TeamViewer

Nmap, Nessus,
Pof
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The file has been identified as a Potentially Unwanted Program. This indicates that the program may be
unwanted, despite the possibility that users consented to download it. Some PUPs may be permitted to
run on a limited set of systems in your organization (EX. A VNC application allowed to run on domain
administrator devices). A Dell Server administrator can choose to waive or block PUPs on a per device
basis or globally quarantine or safelist based on company policies. Depending on how much analysis
can be performed against a PUP, further subclassification may be possible. Those subclasses are
shown below and will aid an administrator in determining whether a particular PUP should be blocked or
allowed to run:

Subclass Definition Examples

Technologies that provide annoying advertisements
(example: pop-ups) or provide bundled third-party add-ons

Adware when installing an application. This usually occurs without Gator,
adequate notification to the user about the nature or Adware Info
presence of the add-on, control over installation, control over
use, or the ability to fully uninstall the add-on.

Corrupt Any executable that is malformed and unable to run.

Steam
Technologies that create an interactive environment with Games,

Game :

which a player can play. League of
Legends

Generic Any PUP that does not fit into an existing category.

. . . . . Cobalt Strike,
HackingTool Technologies that are designed to assist hacking attempts. MetaSpoit
Portable Program designed to run on a computer independently,

S . T . Turbo
Application without needing installation.

Scripting Any script that can run as if it were an executable. AutolT,

Tool py2exe

Nasdaq
Technologies that place additional buttons or input fields on- Toolbar,

Toolbar !

screen. Bring Me
Sports

A Score is assigned to each file. Negative scores, from -1 to -100 denote files that are deemed
Abnormal or Unsafe. The score represents the confidence level that the file is malware. The higher the
negative number, the greater the confidence.

File Type

The file is assigned a type, based on the score.

File Types:

Unsafe: A file with a score ranging from -60 to -100. An Unsafe file is one in which the Advanced
Threat Prevention agent finds attributes that greatly resemble malware.

Abnormal: A file with a score ranging from -1 to -59. An Abnormal file has a few malware attributes
but fewer than an unsafe file, thus is less likely to be malware.
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Note: Occasionally, a file may be classified as Unsafe or Abnormal even though the score displayed doesn’t
match the range for the classification. This could result from updated findings or additional file analysis after the
initial detection. For the most up-to-date analysis, enable Auto Upload in the Device Policy.

Priority Level

The file is given a priority level. The priority level helps administrators determine which threats and
devices to address first. For more information, see Advanced Threats by Priority.

Advanced Threats Top Ten
Click Threats to view the threats found on the largest number of devices.
e Click a threat to display additional information about the threat. Details display on a new page.
Click Devices to view a list of devices that have the largest number of threats.

e Click a device to display additional information about the device. Details display on a new page.

Endpoint Protection History

This graph gives a time line snapshot of the past 90 days of the total number of endpoints that are
protected and total number that are not protected. This graph is especially useful during initial
deployment, when moving toward complete protection.

The green bars represent the total number of protected endpoints. The red bars represent the total
number of endpoints that are not protected.

Endpoint Inventory History

This graph gives a time line snapshot of the past 90 days of the total number of endpoints that have
communicated with and sent inventory to the Dell Server and the total number that have not sent
inventory.

Summary Statistics
Summary Statistics provides a breakdown of the following:
= Domains
= User groups
=  Endpoint groups
= AD users
= Local users
=  Endpoints
= Protected
= Not protected
=  Shields

= Managers

45



Navigate the Dell Server

= Modified policies

Summary Statistics provides a breakdown of endpoints by platform, with a link to a detailed report for
the selected platform:

= Windows

=  Mac

Mobile device

= Al

Endpoint OS Report

To access this page, click a platform link on the dashboard's Summary Statistics. If you click All and the
Platform Report page opens, click view in the OS Report column.

OS/Version - Operating system name and version as reported in the endpoint's inventory
Count - Number of endpoints or devices

Shielded - Number of encrypted endpoints for that OS and version

Unshielded - Number of endpoints for that OS and version that are not encrypted
Platform Report - Click view for a report on all the platforms

Endpoint List - Click the icon to navigate to the Endpoints page and the list of endpoints for that OS and
version

Platform Report

To access this page, click All on the dashboard's Summary Statistics. If you click a specific platform link
and access the Endpoint OS Report page, click view in the Platform Report column.

Platform - Windows or Mac

Count - Number of endpoints or devices Platform Report for that platform

Shielded - Number of encrypted endpoints for that platform

Unshielded - Number of endpoints for that platform that are not encrypted

OS Report - Click view for a report based on each operating system/version for that platform

Endpoint List - Click the icon to navigate to the Endpoints page and the list of endpoints for that platform

Populations

Populations

A population is a grouping for which policies, settings, and actions can be configured.

To access a Populations page, click Populations in the left pane and select a Population. For example,
Populations > Enterprise.

Tabs available on each Populations page provide information, allow you to edit details of the Population,
and provide configuration options for that Population. The table lists the tabs available for each
Population.
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Enterprise U

Domains [ . . ) °

User Groups U . .

Users . . )
Grotps g : )

Endpoints ] J ]

Administrators L

To access the tabs for each Population:
= Enterprise - Click Populations > Enterprise.

=  Populations other than Enterprise - Click a Population link, then search for or click a Domain, User
Group, User, Endpoint Group, Endpoint, or Administrator link.

The tabs available for an administrator may vary, depending on the role.

Enterprise

View or Modify Enterprise Policies
To view or modify Enterprise policies, follow these steps:
1. Inthe left pane, click Populations > Enterprise.
2. Click the Security Policies tab.

3. Select the technology group, such as Windows Encryption, or policy group, such as Policy-
Based Encryption, to view or modify.

View Threat Events

Threats are categorized as Malware/Exploit, Web Filter, Firewall, or Uncategorized events. The list of
threat events can be sorted by any of the column headers. You can view threat events for the entire
enterprise or for a specific endpoint. To view threat events of a specific endpoint, from the Enterprise
Threat Events tab, select the endpoint's device in the Device ID column.

To view threat events in the enterprise, follow these steps:
1. Inthe left pane, click Populations > Enterprise.

2. Click the Threat Events tab.
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3. Select the desired severity level and time period to display events.
To view threat events on a specific endpoint, follow these steps:
1. Inthe left pane, click Populations > Endpoints.

2. Search or select a hostname, then the Threat Events tab.

Manage Enterprise Advanced Threats

Advanced Threats tab

If the Advanced Threat Prevention service is provisioned and licenses are available, the Advanced
Threats tab provides a dynamic display of detailed events information for the entire enterprise, including
a list of the devices on which events occurred and any actions taken on those devices for those events.
For information about provisioning the service, see Provision Advanced Threat Prevention Service.

To access the Enterprise Advanced Threats tab, follow these steps:
1. Inthe left pane, click Populations > Enterprise.
2. Select the Advanced Threats tab.
Information about events, devices, and actions are organized on the following tabs:

Protection - Lists potentially harmful files and scripts and details about them, including the devices on
which the files and scripts are found.

Agents - Provides information about devices running the Advanced Threat Prevention client as well as the
option to export the information or remove devices from the list.

Global List - Lists files in the Global Quarantine and Safe list and provides the option to move files to
these lists.

Options - Provides a way to integrate with Security Information Event Management (SIEM) software using
the Syslog feature as well as export Advanced Threat data.

Certificate - Allows certificate upload. After upload, certificates display on the Global List tab and can be
Safe listed.

Tables on the tabs can be organized in these ways:

Add or remove columns from the table - Click the arrow next to any column header, select Columns, then
select the columns you want to display. Clear the check box of columns to hide.

Sort the data - Click a column header.
Group by a column - Drag the column header up, until it turns green.

Filter based on data of one column - click the down-arrow on any column to display the context menu, and
select Filter.

Advanced Threat Events tab

The Advanced Threat Events tab displays information about events for the entire enterprise based on
information available in the Dell Server.

The tab displays if the Advanced Threat Prevention service is provisioned and licenses are available.
To export data from the Advanced Threat Events tab, click Export and select Excel or CSV file format.
Note: Excel files are limited to 65,000 rows. CSV files have no size limit.

For a list of fields and filters on the tab, see Advanced Threat Events tab fields and filters.
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Domains

Domains

On the Domains page, you can add a domain or search and select a domain to View or Modify Domain

Information.

Add a Domain

To add a Domain, follow these steps:

Users

1.
2.

In the left pane, click Populations > Domains.
On the Domains page, click Add.

Complete the fields on the Add Domains page.

Domain DNS Suffix - Enter the fully qualified host name or the computer name and
domain portion of the hostname (for example,
<computer_name>.<domainname>.com) for the enterprise directory server.

Port - Enter a port for the directory server. If you do not specify a port, the default port
of 389 is used. The secure port, 636, uses an SSL connection instead of clear text.
Global catalog ports are 3268 (clear-text) and 3269 (secure).

Distinguished Name - Populated when you tab from the completed Host Name field or
refresh the URL. If necessary, correct the entry to reflect the domain (for example,
DC=domainname, DC=com).

User Name - Enter a user name with rights for the domain to read and run queries on
the enterprise directory server. The format must be UPN, such as user@domain.com.

Password - Enter a password with rights for the domain to read and run queries on the
enterprise directory server.

In the Domain Alias area, enter the domain name or other alias and click Add. It is
recommended that you add a pre-Windows 2000 domain hame as an alias. You may
enter any UPN suffixes that are allowed for the domain and are configured in the
enterprise directory server.

A Domain Alias is a mapping the Dell Server uses to select which domains to search to
locate users that might match the suffix in the UPN.

Click Add Domain.

Users are added through reconciliation. Reconciliation is the automated process the Dell Serveruses to
compare user data in the Dell Server database with user data in the enterprise directory server and
update the Dell Server database when necessary.

In the left pane, click Populations > Users and then click a user name, to view details about the user.
Click the arrow next to a User Name to view the Common Name, sAM Account Name, and User

Principal Name.

Add a User by Domain
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On the Users page, click Add Users by Domain.
In the Add Users by Domain dialog, select a domain from the pull-down list.

In Full name, enter the exact text for the user name or use the wildcard character (*).

a M 0N

Select Common Name, Universal Principal Name, or sAMAccountName from the list.

A Common Name, Universal Principal Name, and sAMAccountName must be defined
in the enterprise directory server for every user. If a user is a member of a domain or
group but does not display in the domain or group members list in the Management
Console, ensure that all three names are properly defined for the user in the enterprise
directory server.

6. Click Search. Depending on the size, this may take a few minutes to populate.
If the query is too large, a dialog prompts you to revise the query.

7. Select users from the directory user list to add to the Domain. The user names are
added to the field below the list.

8. Click X to remove the user name or click Add.

User Groups

Add a user group, edit User Group priority, or search and select a user group to View or Modify User
Group Policies and Information.

Add a User Group
1. Inthe left pane, click Populations > User Groups.
2.  On the User Groups page, click Add.

3. Select the type of User Group from the list: Active Directory User Group or ADMIN-DEFINED
User Group

Note: If adding user groups for Access Groups, see Set_up Access_Groups.
4. Select a domain from the list.

5. For Active Directory User Groups, follow these steps:

a. Enter the exact text for the group name or use the wildcard character (*).

b. Click Search. Depending on the size, this may take a few minutes to
populate.

C. Select a group from the list to add to the domain. The group name is added

to the field below the list.
Click the X in the group name to remove the group name.
d. Click Add.
6. For ADMIN-DEFINED User Groups, follow these steps:
a. Enter the exact text for the group name or use the wildcard character (*).
b. Enter a description for the group.
c. Click Add Group.

Notes:
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Universal security groups are only supported for domains that connect through the Global
Catalog port.

Nested groups are not supported.

Add Non-Domain Users

To add non-domain users, the non-domain activation feature can be enabled by contacting Dell
ProSupport and requesting instructions.

View or Modify Domain Policies and Information
1. Inthe left pane, click Populations > Domains.
2. Search or select the appropriate Domain Name to display Domain Detail.
When you click a Domain, the Domain Detail page displays.
3. Click the tab that corresponds with the action to perform:
Security Policies - To view or modify policies of the Domain, click Security Policies.

Details & Actions - To view properties of the Domain, click Details & Actions

Members - To view, add, or modify information for groups and users within the domain. For
instructions on how to perform these tasks, refer to the appropriate topic:

Add Users to Domain

Add User Groups

View or Modify User Information

View or Modify User Group Information

Settings - To configure LDAP settings for the domain, click Settings. Refer to Add Domains for
instructions.

Key Server - To configure components for use with Kerberos Authentication/Authorization, click Key
Server. See Domain Key Server for instructions.

Domain Details & Actions
The Domain Details & Actions tab lists the properties of a domain.
To access the Domain Details & Actions tab, follow these steps:
1. Inthe left pane, click Populations > Domains.
2. Search or select a Domain Name, then the Details & Actions tab.
Details displayed on the Domain Details & Actions tab:

Domain Name - Name of the domain server. This should match the domain name in the title of the
page.

Location - The location (path) of the domain within the enterprise structure. This information is derived
from the fully qualified hostname or the computer name and domain portion of the hostname entered
when the domain was added. Example: /com/enterpriseserver
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LDAP Url - URL to the active directory. This field is populated after adding the domain. The information
is derived from the completed hostname.
Example - LDAP://domainname.com:porthnumber/DC=domainname,DC=com
To configure LDAP settings for the domain, click the Settings tab.

Status - Describes the health of the domain server (Good, Fair, Poor).

Domain Members
This page allows you to view, add, or modify information for groups and users within the domain.
To access the Domain Members tab, follow these steps:
1. Inthe left pane, click Populations > Domains.
2. Search or select a Domain Name, then the Members tab.
From this tab, you can perform these actions:

Add Users to Domain - Allows you to add users by domain

Add Group - Allows you to add a user group by domain
Select to view the following information about groups & users, users only, or groups only:
User/Group - Each user or user group in the domain. Click an entry to view details.
Distinguished Name
CN is the common name, either a user or group name.
OU is the organizational unit name, for example, Dallas.
DC are domain components, for example, DC=0Organization, DC=com
Common Name - For a user, the user name; for a group, the group name
User - Column displays a green checkmark

Group - Column displays a green checkmark

Domain Settings
This page allows you to configure or modify LDAP settings for the Domain.
To access the Domain Settings tab, follow these steps:
1. Inthe left pane, click Populations > Domains.
2. Search or select a Domain Name, then the Settings tab.
On the Domain Settings tab, you can view this information:

Directory URL - Lists the current URL for the enterprise directory server. If you modify the settings, click
Refresh URL.

Host Name - The fully qualified hostname or the computer name and domain portion of the hostname
(for example, <computer_name>.<domainname>.com) for the enterprise directory server.

Port - The port for the directory server. If you do not specify a port, the default port of 389 is used. The
secure port, 636, uses an SSL connection instead of clear text. Global catalog ports are 3268 (clear-
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text) and 3269 (secure).

Distinguished Name - This field is populated when you tab from the completed hostname or refresh the
URL. If necessary, correct the entry to reflect the domain (for example, DC=domainname, DC=com).

Secure LDAP - Select this check box for LDAPS.

User Name - The user name with rights to read and run queries on the enterprise directory server. The
format must be UPN, such as user@domain.com.

Password - Enter a password with rights to read and run queries on the enterprise directory server.

Alias - A mapping that the Dell Server uses to select which domains to search to locate users that might
match the suffix in the UPN. The domain name or other alias. It is recommended that you add a pre-
Windows 2000 domain name as an alias. You may enter any UPN suffixes that are allowed for the
domain and are configured in the enterprise directory server.

Click Add, and the entry populates the field below.
Select an alias in the list, and click Remove Selected.

Update Domain - Click to update changes.

Domain Key Server

This page allows you to view or modify components for use with Kerberos Authentication/Authorization.
Account - Enter an account name.
Click Add Account, and the entry populates the field below.
Select an account in the list, and click Remove Selected.
To access the Domain Key Server tab, follow these steps:

1. Inthe left pane, click Populations > Domains.

2. Search or select a Domain Name, then the Key Server tab.

User Groups

User Groups

Add a user group, edit User Group priority, or search and select a user group to View or Modify User
Group Policies and Information.

Add a User Group
1. Inthe left pane, click Populations > User Groups.
2. On the User Groups page, click Add.

3. Select the type of User Group from the list: Active Directory User Group or ADMIN-DEFINED
User Group

Note: If adding user groups for Access Groups, see Set_up_Access_Groups.

4. Select a domain from the list.
5. For Active Directory User Groups, follow these steps:

a. Enter the exact text for the group name or use the wildcard character (*).
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b. Click Search. Depending on the size, this may take a few minutes to
populate.
C. Select a group from the list to add to the domain. The group name is added

to the field below the list.
Click the X in the group name to remove the group name.
d. Click Add.
6. For ADMIN-DEFINED User Groups, follow these steps:

a. Enter the exact text for the group name or use the wildcard character (*).

b. Enter a description for the group.

c. Click Add Group.

Notes:

Universal security groups are only supported for domains that connect through the Global
Catalog port.

Nested groups are not supported.

Remove User Groups
1. Inthe left pane, click Populations > User Groups.

2. Click a group name link or enter a filter to search for available groups. The wildcard character
(*) is supported.

3. Select a row to highlight it.
4. Atthe top, click Delete.
As another option, click a group name link and select the Details & Actions tab. Click Remove Group.

If you remove a user group that has administrative privileges and later re-add the group, it remains an
Administrator Group.

Find User Groups
1. Inthe left pane, click Populations > User Groups.
2. Enter a filter to search for available Groups. The wildcard character (*) is supported.

3. Click Search.

A Group or list of Groups displays, based on the search filter.

View or Modify User Group Policies and Information
1. Inthe left pane, click Populations > User Groups.

2. Search or select the appropriate group name to display the User Group Detail page. The
wildcard character (*) is supported.

Click a group name to display the User Group Detail page.
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3. Click the tab that corresponds with the action to perform:
Security Policies - To view or modify policies of the Group, click Security Policies.

Details & Actions - To view properties of the Group, click Details & Actions. Viewable
information includes:

e  Group Name: Groupl (DOMAIN\Groupl)

e Distinguished Name: CN=Groupl, OU=Dallas, DC=Organization, DC=com
Common Name: Groupl

e Last Modified in Directory - date and time stamp
e Last Reconciled - date and time stamp
e AG Enabled - Access Group is configured for a user group when selected

Members - To view or modify the information of a user in the group, click Members. The list of
users in the group displays. Click a user to view the user's Security Policies, Details & Actions,
Endpoints, User Groups, and Admin. For instructions on how to view or modify User information,
refer to View or Modify User Information.

Admin - To view, assign, or modify administrator roles assigned to the group, click Admin.
Select or deselect administrator roles to modify administrator roles assigned to the Group. For
more information about privileges available to each administrator role, refer to Administrator
Roles.

4. If modified, click Save.

VDI User Policies

To manage policy for users in a VDI environment, create a Windows domain group, associate domain
users with that group, and then import the group into Dell Server. This allows Dell Server to manage the
users and their policies.

Policy settings differ, based on whether persistent or non-persistent VDI is deployed in the environment.
For an explanation of the differences between persistent and non-persistent VDI, see Persistent vs.
Non-Persistent VDI.

Policy and Configuration Requirements for VDI Users

The policy requirements below are for VDI users running Advanced Threat Prevention. The list includes
only policies that are significant for VDI users. VDI endpoint group policy settings must also meet certain
requirements. See Policy and Configuration Requirements for VDI Endpoint Groups.

Note: Ensure that you turn off Advanced Threat Prevention Agent Auto Update. In the left pane of the
Management Console, select Management > Services Management > Advanced Threats - Agent
Auto Update, then select Off.

Note: With Persistent VDI groups, ensure that roaming user profiles are configured.

These policy and configuration settings for VDI users must be configured before VDI client activation:

Windows Encryption Policy-Based Encryption Policy-Based Encryption
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Encrypt Outlook Personal

Windows Encryption Policy-Based Encryption Fold Not Selected Not Selected
olders
Windows Encryption Policy-Based Encryption Encrypt Temporary Files Not Selected Not Selected
Encrypt Temporary Internet
Windows Encryption Policy-Based Encryption il P porary Not Selected Not Selected
iles
. . . . Encrypt User Profile
Windows Encryption Policy-Based Encryption Not Selected Not Selected
Documents
. X . i Secure Post-Encryption . . . .
Windows Encryption Policy-Based Encryption c Single-pass Overwrite Single-pass Overwrite
eanup
] . . . Force Logoff/Reboot on
Windows Encryption Policy-Based Encryption . Selected Not Selected
Policy Updates
Removable Media Encryption Windows Media Encryption Windows Media Encryption On On
Removable Media Encryption Windows Media Encryption  EMS Scan External Media Not Selected Not Selected

User Group Details & Actions

1.
2.

The User Group Details & Actions tab lists the properties of a selected user group.
In the left pane, click Populations > User Groups.
Search or select a group name, then the Details & Actions tab.
Remove Group
The Remove Group command permanently removes this user group from the Dell Server.
Details:

Group Name - Name of the user group <user group>(<domain name>\<user group>). This should
match the user group name in the title of the page.

Distinguished Name - CN=Groupl, OU=Dallas, DC=0rganization, DC=com
CN is the common name
OU is the organizational unit name
DC are domain components
Common Name - non-technical name of the user group
Last Modified - Date/time stamp of the last time this information changed.
Last Reconciled - Date/time stamp of the last time this information was reconciled.

Access Groups Enabled - Access Group is configured for a user group when selected.

User Group Members

This page displays information about each user within the user group.

1.
2.

In the left pane, click Populations > User Groups.

Search or select a Group Name, then click the numeral in the Members column.
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User - Each user in that user group
Distinguished Name - CN=Groupl, OU=Dallas, DC=0rganization, DC=com
CN is the common name
OU is the organizational unit name
DC are domain components
Common Name - non-technical name of the user group
Add Users to the Group
1. Onthe Members tab, click Add Users to Group.
2. Search or select a user, then select the check box to the left of the user name.
3. Click Add Selected Users to Group.
OR

Select Upload Multiple User from File, then click Browse to select a CSV file and click
Upload.

Valid CSV requirements:
e The file must be in valid CSV format and contain a maximum of 999 endpoints.

e The first column must contain valid fully qualified host names. All columns
except the first column are ignored.

e Only activated endpoints are added to the group.
Remove Users from the Group
1. In User Group Detail, search or select a user, then select the check box to the left of the user name.
2. Click Remove Users from Group.
3. Click OK.
Users can also be removed from the ADMIN DEFINED Groups.

User Group Admin
Assign, modify, or view Administrator roles for a group.
1. Inthe left pane, click Populations > User Groups.
2. Search or select a Group Name, then the Admin tab.
Administrator Roles - Assign or modify roles for a group membership and click Save.

Delegated Roles - Delegate Administrator rights for the Group to a User.

Related topics:

Administrator Roles

Assign or Modify Administrator Roles

Delegate Administrator Roles
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Edit Group Priority

The Group priority feature is used to determine policy precedence for effective policies that affect
multiple groups. Group priority creates a weight associated with the specific group it is assigned to, and
that weight is used to determine which policy setting is applied to an endpoint that is a member of more
than one Endpoint Group when policy settings differ between those groups. Policy overrides are used
from the group with higher priority when two (or more) separate groups have different priority levels.

Edit Endpoint Group Priority

Endpoint Group Priority can be changed only for Rule-Defined, Admin-Defined, and Active Directory
Groups. System-Defined Group priority cannot be modified. In general, the Endpoint Group at the top of
the list of Endpoint Groups has highest priority. The Endpoint Group at the bottom of the list has lowest
priority.

Q@ ~aa #4 Edit Pricrity Group Type: All

Precedence Ranking

The System Defined Non-Persistent VDI Endpoint Group has the highest priority level, followed by the
Persistent VDI Endpoint Group.

Order of priority:
1. Non-Persistent VDI Endpoint Group
2. Persistent VDI Endpoint Group
3. Highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Group
4

Second and subsequent highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint
Groups

5. Opt-in Endpoint Group
6. Default Endpoint Group
To change Active Directory/Rule-Defined/Admin-Defined Endpoint Group priority:
1. Inthe left pane, click Populations > Endpoint Groups.
2. Click Edit Priority.

3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups
that reflects its new priority level.

4. Click Save.

Edit User Group Priority
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The user group at the top of the list has highest priority. The user group at the bottom of the list has
lowest priority.
User Groups

0 Add 44 Edit Priority Group Type: All v

1| » » 25 v

To edit User Group priority:
1. Inthe left pane, click Populations > User Groups.
2. Click Edit Priority.

3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups
that reflects its new priority level.

4. Click Save.

Assign or Modify Administrator Roles
View or modify existing administrator privileges.
1. Inthe left pane, click Populations > Administrators.

2. Search or select the row that displays the user name of the appropriate administrator to display
User Detalil.

3. View or modify administrator roles in the pane at the right.
4. Click Save.
Dell recommends assigning administrator roles at the Group level rather than at the User level.
1. Inthe left pane, click Populations > User Groups.
2. Search or select a group name, then the Admin tab.
3. Select or deselect administrator roles assigned to the group.
4. Click Save.

If you remove a group that has administrative privileges and later re-add the group, it remains an
administrator group.

To view, assign, or modify administrator roles at the User level, see User Admin.
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Related topics:

Administrator Roles

User Admin

Delegate Administrator Roles

View Reconciliation Date

To view the date and time a user group's or user's information was last reconciled with Active Directory,
click the Details & Actions tab for the group or user, and refer to last reconciled. For instructions, refer to
View or Modify User Group Policies and Information and View or Modify User Policies and Information.

View Policy Proxy State

Users

Users

The Management Console tracks the Policy Proxy's policy updating state.
1. Inthe left pane, click Populations > Endpoints.

2. Select an endpoint type, for example, Workstation or Mobile Device.

3. If you know the full endpoint hostname, enter it into Search and click

For Windows and Mac, enter the full endpoint hostname if you know it. Leave the field blank to display
all Windows and Mac endpoints.

For Mobile devices, optionally enter the user's email address.

If you do not know the full hostname or user email address, scroll through the list of available endpoints
to locate the endpoint.

4. Click an endpoint in the list to display the endpoint detail.

5. Click the Details & Actions tab of the endpoint to view information.

Users are added through reconciliation. Reconciliation is the automated process the Dell Serveruses to
compare user data in the Dell Server database with user data in the enterprise directory server and
update the Dell Server database when necessary.

In the left pane, click Populations > Users and then click a user name, to view details about the user.
Click the arrow next to a User Name to view the Common Name, sAM Account Name, and User
Principal Name.

Add a User by Domain

1. Inthe left pane, click Populations > Users.

2. On the Users page, click Add Users by Domain.

3. Inthe Add Users by Domain dialog, select a domain from the pull-down list.

4. In Full name, enter the exact text for the user name or use the wildcard character (*).
5

Select Common Name, Universal Principal Name, or sAMAccountName from the list.
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A Common Name, Universal Principal Name, and sAMAccountName must be defined
in the enterprise directory server for every user. If a user is a member of a domain or
group but does not display in the domain or group members list in the Management
Console, ensure that all three names are properly defined for the user in the enterprise
directory server.

6. Click Search. Depending on the size, this may take a few minutes to populate.
If the query is too large, a dialog prompts you to revise the query.

7. Select users from the directory user list to add to the Domain. The user names are
added to the field below the list.

8. Click X to remove the user name or click Add.

Remove Users

In general, a user cannot be removed in the Management Console. Instead, you must remove the user
from Active Directory.

Find Users
1. Inthe left pane, click Populations > Users.

2. Do one of these:
e Enter the user name or a filter in Search and click

e Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard
character is supported.

e Scroll through the user name list.

3. Click alink in the user name column.

The User Detail page opens, displaying the Security Policies tab.

Deactivate/Suspend Users

If the user to deactivate is no longer associated with your organization, be sure the Current Shield State
policy is set to a value other than Activate, and ensure that the policy commit is complete and
successful prior to your enterprise directory server. The user does not need to be in your enterprise
directory server, but the policy does need to delivered to be their device for it to take effect.

Best Practice - Deleting users from the enterprise directory server is not recommended. If a user
leaves the organization, the account should be moved to a disabled group. With that said, if a deletion
occurs, the user is simply marked “removed”, rather than deleted. The user does not display in the
Management Console, but their encryption keys and other information are still available in the Dell
Serverdatabase.

1. Inthe left pane, click Populations > Users.
2. Click a user name link or enter a filter to search for available users.

Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character
(*) is supported. On the User Detail > Security Policies tab in the Windows Encryption technology
group, click the Policy-Based Encryption policy group.

3. Click Show advanced settings.
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Change the Current Shield State policy to Suspend.
Click Save.

Commit Policies.

To reactivate a deactivated Windows user, follow the instructions in Reinstate Suspended Users.

Reinstate Suspended Users

To reinstate a suspended user, follow these steps:

1.
2.

N g A

In the left pane, click Populations > Users.
Click a user name link or enter a filter to search for available users.

To Search, enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard
character (*) is supported.

On the User Detail > Security Policies tab in the Windows Encryption technology group, click
the Policy-Based Encryption policy group.

Click Show advanced settings.

Change the Current Shield State policy to Activate.

Click Save.

Commit Policies.

Repeat these steps for each type of device the user was suspended from.

To reinstate a suspended Dell Encryption user, perform the preceding steps and then run
WSDeactivate on the computer that was suspended for that particular user. WSDeactivate and
its instructions are located in the Dell installation media. When using WSDeactivate, existing
local encryption keys, credentials, and policy material are no longer accessible to Dell
Encryption, and all managed users are forced to reactivate upon their next log on.

View or Modify User Policies and Information

1.
2.

In the left pane, click Populations > Users.

Click a user name or enter a filter to search for available users. The wildcard character (*) is
supported.

Click a user name to display the User Detail page.

Click the tab that corresponds with the action to perform:
Security Policies - Click to view or modify policies of the user.

Details & Actions - Click to view properties of the user. Viewable information includes:
User Name: (username@organization.com)
Distinguished Name: CN=User Name, OU=Dallas, DC=Organization, DC=com
Common Name: User Name
User Principal Name: username@organization.com

sAM Account Name: username
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User Type - possible values are AD or local
Last Modified - Date/time stamp

Last Reconciled - Date/time stamp

Endpoints - Click to view or modify information for the User's endpoints. For instructions on how
to modify endpoint information, refer to View or Modify Endpoint Information.

User Groups - Click Groups to view information for groups for which the user belongs. Click a
user group to view the group's Security Policies, Details & Actions, Members, and Admin.

Admin - Click to view, assign, or modify administrator roles assigned to the user. Select or
deselect administrator types to modify administrator roles assigned to the user.

4. If modified, click Save.

User Details & Actions

1.
2.

The user Details & Actions tab lists the properties of the selected user.
In the left pane, click Populations > Users.
Search or select a user name, then the Details & Actions tab.
Details:
User Name - (username@organization.com)
Distinguished Name - CN=User Name, OU=Dallas, DC=0rganization, DC=com
Common Name - User Name
Universal Principal Name - username@organization.com
sAMAccountName - username
Email - User email address
User Type - possible values are AD or local
Last Modified - Date/time stamp

Last Reconciled - Date/time stamp

User Endpoints

This page displays information about a user's endpoints, listed by platform type. Endpoint categories include
Shield, Mobile Device, and Cloud.

1. Inthe left pane, click Populations > Users.
2. Search or select a user name, then the Endpoints tab.
Shield
Platform - The platform type
Device ID - Value that uniquely identifies the target device

Last Successful Login - Date/time stamp, per endpoint
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Last Unsuccessful Login - Date/time stamp, per endpoint

Last Gatekeeper Sync - Date/time stamp, per endpoint

Effective Policies - Click view for a simple layout view of the effective endpoint policies
Actions - Click Recover to proceed to the Recover Data page

Last Encryption Sweep Start - Date/time stamp, per user

Sweep End - Date/timestamp, per user

Encryption Failure - Click view for a simple list of files that could not be encrypted, per
user

States (Date/time stamp, per endpoint):
Policy Updating
User Encryption Profile Updating
EMS Encryption Profile Updating
User Data Encryption On
Deactivation Pending
Suspension Pending
Suspended
Mobile Device
Platform - The platform type
Device ID - Value that uniquely identifies the target device
Effective Policies - Click view for a simple layout view of the effective endpoint policies
Cloud
Platform - The platform type

Device ID - Value that uniquely identifies the target device

User Groups

If the user belongs to a user group, this page displays information about the group and provides a link to the
group.

1. Inthe left pane, click Populations > Users.
2. Search or select a user name, then the Users Groups tab.
User Group - Group to which the user belongs
Distinguished Name - CN=Groupl, OU=Dallas, DC=0Organization, DC=com
CN is the common name
OU is the organizational unit name

DC are domain components
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Common Name - non-technical name of the user group

User Admin
This page allows you to assign, modify, or view administrator roles for the user.
1. Inthe left pane, click Populations > Users.
2. Search or select a user name, then the Admin tab.
Administrator Roles - Assign or modify roles for the user and click Save.

Inherited Group Roles - A read-only list of roles that the user inherited from a group. To modify the roles,
click the User Groups tab for that user and select the group name.

Delegated Roles - Delegate administrator rights to a user.

Related topics:

Administrator Roles

Assign or Modify Administrator Roles

Delegate Administrator Roles

View Reconciliation Date

To view the date and time a user group's or user's information was last reconciled with Active Directory,
click the Details & Actions tab for the group or user, and refer to last reconciled. For instructions, refer to
View or Modify User Group Policies and Information and View or Modify User Policies and Information.

View Policy Proxy State
The Management Console tracks the Policy Proxy's policy updating state.
1. Inthe left pane, click Populations > Endpoints.

2. Select an endpoint type, for example, Workstation or Mobile Device.

3. If you know the full endpoint hostname, enter it into Search and click

For Windows and Mac, enter the full endpoint hostname if you know it. Leave the field blank to display
all Windows and Mac endpoints.

For Mobile devices, optionally enter the user's email address.

If you do not know the full hostname or user email address, scroll through the list of available endpoints
to locate the endpoint.

4. Click an endpoint in the list to display the endpoint detail.

5. Click the Details & Actions tab of the endpoint to view information.

Issue a User Decryption Policy

1. Inthe left pane, click Populations > Users.
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2. Click a user name link or search for a user and then click a link to display the user detail.

Enter Common Name, Universal Principal Name, or sAMAccountName. The wildcard character
(*) is supported.

3. Onthe Security Palicies tab, click Policy-Based Encryption.
4. Set the value of Policy-Based Encryption to Off.
5. Click Save.
6. Commit Policies.
Once this policy reaches the specified Encryption client, decryption begins.

Endpoint Groups

Endpoint Groups

On the Endpoint Groups page, you can add or remove an Endpoint Group, edit Endpoint Group priority,
or search and select an Endpoint Group to view or modify Endpoint Group information.

Types of Endpoint Groups

System - Endpoint Group maintained by Dell Server. System groups include Default Endpoint Group,
Opt-In Endpoint Group, Persistent VDI Endpoint Group, and Non-Persistent VDI Endpoint Group. For
more information about VDI Endpoint Groups, see VDI Endpoint Groups.

Rule-Defined - Dynamic Endpoint Group based on a specification, or rule set, defined by the
administrator.

Admin-Defined - Static endpoint group for which the administrator can select specific endpoints for
inclusion. The group remains unchanged unless the administrator adds or removes an endpoint. For
more information, see Add Endpoints to an Admin-Defined Endpoint Group or Remove Endpoints from
an Admin-Defined Endpoint Group.

Active Directory Group - Endpoint group for which the administrator can select a group from Active
Directory for inclusion. The Active Directory group scope must be Global, and type must be Security. At
least one endpoint in the Active Directory group must be running a Dell Data Security product and be
managed by Dell Server. For more information about adding Active Directory endpoint groups to the
Dell Server, see KB article SLN306875.

Add an Endpoint Group

Before you add the first Endpoint Group see Endpoint Groups Specification, which explains fields and
expressions used in Group Specifications.

1. Inthe left pane, click Populations > Endpoint Groups.
2. Click Add.

3. In Select the type of Endpoint Group, select RULE-DEFINED Group, ADMIN-DEFINED
Group, or Active Directory Group.

4. In Group Name, enter a name for the new Endpoint Group.
5. In Description, enter a description for the new Endpoint Group.

6. (For Rule-Defined Groups only) In Specification, enter the rule that describes the Endpoint
Group. Specifications can be up to 20,000 characters and are case insensitive.

(For Active Directory Groups only) In Choose AD Group, enter the beginning characters of an
Active Directory group name (Example: Accounting), and select the desired group.
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7. (For Rule-Defined and Active Directory Groups only) Click Preview to view the endpoints to be
included in the group.

8. Click Add Group to save the group definition.

9. After the group is added, modify the group priority if necessary.
Remove an Endpoint Group

1. Inthe left pane, click Populations > Endpoint Groups.

2. Select the group to remove.

3. Click Delete, then click OK.
Modify an Endpoint Group
In the left pane, click Populations > Endpoint Groups.
Select the group to modify.
Click the Details & Actions tab.
Click Modify.

Make changes as desired.

o g > w npoE

Click Update Group.

VDI Endpoint Groups

Upon activation, a VDI endpoint is added to the appropriate VDI Endpoint Group on Dell Server, and
policies are sent to the endpoint. Persistent VDI Endpoint Groups and Non-Persistent VDI Endpoint
Groups are System Endpoint Groups, which are maintained by Dell Server.

Policy settings differ, based on whether persistent or non-persistent VDI is deployed in the environment.
For an explanation of the differences between persistent and non-persistent VDI, see Persistent vs.
Non-Persistent VDI.

Policy and Configuration Requirements for VDI Endpoint Groups

The policy requirements below are for VDI endpoints running Advanced Threat Prevention. The list
includes only policies that are significant for VDI endpoints. VDI User policy settings must also meet
certain requirements. See Policy and Configuration Requirements for VDI Users.

Note: Ensure that you turn off Advanced Threat Prevention Agent Auto Update. In the left pane of the
Management Console, select Management > Services Management > Advanced Threats - Agent
Auto Update, then select Off.

Note: With Persistent VDI Groups, ensure that roaming user profiles are configured.

These policy and configuration settings for VDI Endpoint Groups must be configured before VDI client
activation:

Windows Encryption Self-Encrypting Drive (SED)  Self-Encrypting Drive (SED)
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Windows Encryption

Windows Encryption

Windows Encryption
Windows Encryption

Windows Encryption

Windows Encryption

Windows Encryption

Windows Encryption

Windows Encryption

Windows Encryption

Windows Encryption

Threat Prevention
Removable Media Encryption

Port Control

Hardware Crypto Accelerator Hardware Crypto Accelerator

(HCA)

Policy-Based Encryption

Policy-Based Encryption
Policy-Based Encryption
Policy-Based Encryption

Policy-Based Encryption

Policy-Based Encryption

Policy-Based Encryption

Policy-Based Encryption

BitLocker Encryption

Server Encryption

Advanced Threat Protection
Mac Media Encryption

Windows Port Control

Persistent vs. Non-Persistent VDI

(HCA)

SDE Encryption Enabled

Common Encrypted Folders
Encrypt Windows Paging File

Secure Windows Credentials

Block Unmanaged Access to
Domain Credentials

Secure Windows Hibernation
File

Prevent Unsecured
Hibernation

Enable Software Auto
Updates

BitLocker Encryption

Server Encryption

Advanced Threat Protection
Mac Media Encryption

Port Control System

Off

Not Selected

<retain default settings>
Not Selected
Not Selected

Not Selected

Not Selected

Not Selected

Not Selected

off

off

On
Off
Disabled

Persistent and Non-Persistent VDI endpoints differ in the following ways:

Persistent

endpoints may
exist for many days

to years.

Persistent

endpoints retain the
configurations that
are set for the VM,
until the VM clone
pool is removed

and rebuilt.

A persistent
endpoint is

dedicated to a

single user.

Non-persistent
endpoints usually

exist only for a few

days or weeks.

off.

Non-persistent
endpoints revert to
baseline settings
after a user logs

After reverting to
baseline settings,a
non-persistent
endpoint is
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Off

Not Selected

<retain default settings>
Not Selected
Not Selected

Not Selected

Not Selected

Not Selected

Not Selected

off

Off
On

Off
Disabled
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available for
another user.

Endpoint Groups Specification

To skip to instructions about how to add an endpoint, see Add Endpoint Groups.

At deployment time, all endpoints belong to a default endpoint group, which is generally sufficient for
most deployments. This feature is used to assign policy to a specific group of endpoints. For instance,
you may want to create an endpoint group based on the locale that the operating system sends up in
inventory. Once that endpoint group is established, you could then apply a specific policy set to just the
endpoints in your specified locale.

Conversely, creating an endpoint group based on a platform type would not be useful because policies
are already grouped by platform.

Endpoint groups are created using a group specification. This specification allows you to define the
endpoint characteristics used to add endpoints to a group. You cannot manually add endpoints to
endpoint groups. The system, based on the characteristics in the endpoint group specification,
automatically manages endpoints and endpoint group membership.

Endpoints can be members of many endpoint groups simultaneously, as there is no mutual exclusion
requirement for endpoints in groups. All endpoints are included in the default endpoint group in addition
to any defined endpoint groups that they may be a member of. This is similar to the way users are a
member of the domain they are a part of, in addition to any security groups. Like the user group
mapping, the endpoint group mapping creates a potential policy arbitration problem for endpoints. To
resolve this problem, the default endpoint group has the lowest possible precedence, and cannot be
altered. The endpoint groups that you create have medium precedence by default. For more information
on group precedence, see Modify Group Precedence.

Endpoint Group Specification

The endpoint group specification is a domain specific language that allows you to define groups. The
endpoint group specification consists of a set of operators and a set of data fields that these operators
can be applied to. A group specification is a Boolean expression that is evaluated per endpoint to
determine whether or not a endpoint is a member of a group.

The information obtained to assign endpoints to endpoint groups happens when inventory is received,
not at activation time. If you set up endpoint groups, all endpoints will stay only in the default endpoint
group until inventory is received.

Group specifications are created using the following fields and expressions. Multiple fields and
operators can be used in a single group specification.

CATEGORY Endpoint category: WINDOWS, MAC, SED
uiD Windows hostname
DISPLAYNAME Fully qualified hostname

Operating system version as reported in inventory. Dell recommends using other
OSVERSION available fields, as discrepancies in operating system versions may reduce the
usefulness of this field.

oS Operating system name as reported in the endpoint's inventory
PROCESSOR System processor information
SERIALNUMBER Endpoint serial number

69



LOCALE

WINCOMPUTERNAME
ASSETTAG
SHIELDVERSION
AGENTVERSION
PLUGINVERSION
MEMBEROFGROUP
MEMBEROFDOMAIN
CLOUDPRESENT
CLOUDINTERNAL
CLOUDEXTERNAL
SEDPRESENT
BITLOCKERPRESENT
TOTALMEMORY

Operators and Expressions

Navigate the Dell Server

The current locale of the endpoint. This is typically only reported by Encryption
Enterprise.

Fully qualified hostname

Asset tag of the computer manufacturer
Version of Encryption client

Agent version for Manager

Plugin version for Manager

Active Directory group name

Active Directory domain name

All Dell Data Guardian clients

Internal Data Guardian clients

External Data Guardian clients

All SED clients

TRUE/FALSE value for BitLocker Manager, indicating if BitLocker is enabled.

Total memory available on the computer

The basic operators are the binary operators that return a Boolean value.

AND

NOT

Boolean, Integer, and String equality operator
Greater than, greater than or equal, integer operator
Less than, less than or equal, integer operator

Not equal, integer string operator

Logical AND for Boolean expression

Logical OR for Boolean expression

Logical NOT for Boolean expression

The logical operators follow the standard Boolean operator precedence (NOT, AND, OR). String fields
have the following string operators that return Boolean values:

BEGINSWITH
ENDSWITH
CONTAINS

These operators can be used on the string fields:

UID BEGINSWITH '*A1850502"
ASSETTAG CONTAINS "007"

String fields also have the following string operators that return substrings of the field:

LEFT(string,int)
RIGHT (string,int)
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MID(string,int,int)

The substring operators can be used in the string operators that return Boolean values:

LEFT(DISPLAYNAME, 4 ) = "A185"

There is one additional string operator that returns an integer value that is the length of the string:
LEN(string)
This can be used in a Boolean expression:

LEN(DISPLAYNAME)<=10

e Using the FQDN of the client computer to attach it to a device group can be done by keying on
any commonality amongst the desired client computers. In the example below, a child domain
of ORGANIZATION, AMERS, represents a domain in America. Additionally, a 2nd child
domain, EMEA, represents non-American based clients.

DISPLAYNAME ENDSWITH “AMERS.ORGANIZATION.COM”

This group will contain all clients that are in the AMERS domain according to their FQDN.
DISPLAYNAME ENDSWITH “EMEA.ORGANIZATION.COM”

This group will contain all clients that are in the EMEA domain according to their FQDN

e If the hostname of the client computers contain several notations that indicate desired ways in
which to create a group, those specific portions can be captured as long as their location is
consistent.

Looking at the hostname: A12345jdoe. AMER.ORGANIZATION.COM

A denotes an asset, while the following 5 digits denotes the asset’s assigned value. The user that was
assigned the asset has their SAM account appended to the end.

You can capture the assigned number of the asset, and that it is within a certain subsection of assets.
This example shows how to look for assets that have a value less than 1000.

MID(DISPLAYNAME , 2, 5) < 1001
This example targets user's computer where their last name begins with ‘r’.
MID(DISPLAYNAME, 8, 1) = “r"
e Data Guardian:
To display Data Guardian internal clients, add the specification "cloudpresent and cloudinternal”.

To display Data Guardian external clients, add the specification "cloudpresent and cloudexternal”.

For instructions about how to add an endpoint, see Add Endpoint Groups.

Edit Group Priority
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The Group priority feature is used to determine policy precedence for effective policies that affect
multiple groups. Group priority creates a weight associated with the specific group it is assigned to, and
that weight is used to determine which policy setting is applied to an endpoint that is a member of more
than one Endpoint Group when policy settings differ between those groups. Policy overrides are used
from the group with higher priority when two (or more) separate groups have different priority levels.

Edit Endpoint Group Priority

Endpoint Group Priority can be changed only for Rule-Defined, Admin-Defined, and Active Directory
Groups. System-Defined Group priority cannot be modified. In general, the Endpoint Group at the top of
the list of Endpoint Groups has highest priority. The Endpoint Group at the bottom of the list has lowest
priority.

Precedence Ranking

The System Defined Non-Persistent VDI Endpoint Group has the highest priority level, followed by the
Persistent VDI Endpoint Group.

Order of priority:
1. Non-Persistent VDI Endpoint Group
2. Persistent VDI Endpoint Group
3. Highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint Group
4

Second and subsequent highest ranked Active Directory/Rule-Defined/Admin-Defined Endpoint
Groups

5. Opt-in Endpoint Group
6. Default Endpoint Group
To change Active Directory/Rule-Defined/Admin-Defined Endpoint Group priority:
1. Inthe left pane, click Populations > Endpoint Groups.
2. Click Edit Priority.

3. Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups
that reflects its new priority level.

4. Click Save.

Edit User Group Priority

The user group at the top of the list has highest priority. The user group at the bottom of the list has
lowest priority.
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User Groups

Pricrit
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To edit User Group priority:

1.
2.
3.

In the left pane, click Populations > User Groups.
Click Edit Priority.

Select the row of the appropriate group and drag it to the location in the list of Endpoint Groups
that reflects its new priority level.

Click Save.

View Endpoints in an Endpoint Group

This page displays the endpoints included in information for every user of the specified endpoint.

1.
2.

In the left pane, click Populations > Endpoint Groups.

Click a Group Name link or enter a filter to search for available Groups. The wildcard character
(*) is supported.

When you click a Group Name, the Endpoint Group Detail page displays.

If applicable, View or Modify Endpoint Information.

View or Modify Endpoint Group Policies and Information

1.
2.
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In the left pane, click Populations > Endpoint Groups.

Click a Group Name or enter a filter to search for available Endpoint Groups. The wildcard
character (*) is supported.

When you click a Group Name, the Endpoint Group Detail page displays.

Click the tab that corresponds with the action to perform:

Security Policies - To view or modify policies of the Group, click Security Policies.
Note: Before modifying VDI Endpoint Group policies, see Policy Requirements for VDI

Endpoint Groups.
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Details & Actions - To view properties of the Group, click Details & Actions. Viewable
information includes:
Group Name: Groupl (DOMAIN\Groupl)
Description: The description provided when the Group was added.

(For Rule-Defined groups) Specification: The endpoint group specification that defines endpoints
as members of the group.

PBA Device Control - The PBA Unlock command for this endpoint group is carried out in the
PBA Device Control area. This command unlocks the PBA screen after it has been locked —
either by sending a Lock command or by exceeding the maximum number of authentications
attempts allowed by policy.

Members - To view or modify the information of an endpoint in the group, click Members. The
list of endpoints in the group displays. Click an endpoint to view the endpoint's Security Policies,
Details & Actions, Users, Endpoint Groups, Threat Events, and Advanced Events.

4. If modified, click Save.

Endpoint Group Details & Actions

This page lists the properties of the selected Endpoint Group.

1. Inthe left pane, click Populations > Endpoint Groups.

2. Search or select a Group Name, then the Details & Actions tab.
Details:
Group Name of the endpoint group
A description of this endpoint group
The specification that was used to create this endpoint group (applies only to Rule-Defined Groups)
Active Directory Group (applies only to Active Directory Groups)
PBA Device Control

The PBA Unlock command for this endpoint group is carried out in the PBA Device Control area. This
command unlocks the PBA screen after it has been locked — either by sending a Lock command or by
exceeding the maximum number of authentications attempts allowed by policy.

Endpoint Group Members

This page lists the endpoints within an endpoint group. Information displays based on the group specification
used to create the endpoint group.

1. Inthe left pane, click Populations > Endpoint Groups.
2. Search or select a Group Name, then the Members tab.
Category - WINDOWS, MAC, SED, iOS, or Android
Hostname - Endpoint hostname
OS/Version - Endpoint operating system and version

Add Endpoints to an Admin-Defined Endpoint Group
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In the left pane, click Populations > Endpoint Groups.
Select the group to which to add endpoints.

Click the Members tab.

A 0 b P

Select Add Endpoints to Group, then search for specific endpoints or select endpoints in the
list, and click Add Selected Endpoints to Group.

OR

Select Upload Multiple Endpoints from File, then click Browse to select a CSV file and click
Upload.

Valid CSV requirements:
e The file must be in valid CSV format and contain a maximum of 999 endpoints.

e The first column must contain valid fully qualified hostnames. All columns except the first
column are ignored.

e Only activated endpoints are added to the group.
Remove Endpoints from an Admin-Defined Endpoint Group
In the left pane, click Populations > Endpoint Groups.
Select the group in which to add endpoints.

Click the Members tab.

A 0 Ddp PR

Search for specific endpoints or select endpoints in the list. To select more than one endpoint,
press Shift and select the endpoints.

5. Click the red X in the right column for each endpoint, or select the endpoints and click Remove
Endpoints from Group.

Endpoints

Endpoints

On the Endpoints page, you can add an endpoint to a group, remove an endpoint, or search and select
an endpoint to View or Modify Endpoint Information. You can also quickly view the following summary
information about each endpoint:

*Hostname - Endpoint hostname.

*OS/Version - Operating system and version running on the endpoint (Example: Microsoft Windows 10
Enterprise).

*Category - Catetory of endpoint (Example: Windows or Mac).

*Protected - A green check displays if the endpoint is protected. If the endpoint is not protected, the
column is blank.

*Serial Number - Manufacturer assigned serial number.
*Win Computer Name - Computer name Windows uses to identify the computer on the network.
PBE - Policy-Based Encryption version.

Manager - Manager/Agent version.
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Data Guardian - Data Guardian version.
Hardware ID - A unique identifier sent to the server from the client.
* Click the column header to sort by column label.

Click a hostname to view additional details about the endpoint. Click an arrow at the left of a hostname
to view the Category, Unique ID, and Processor.

Add Endpoint to Group
To add an endpoint to an Endpoint Group:
1. Inthe left pane, click Populations > Endpoints.

2. Select the check box next to a hostname in the list or enter a filter to search for available
endpoints. The wildcard character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to
display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.
3. At the top left, click Add Endpoints to Group.

An endpoint is added to inventory when a user who is in the Dell Server database activates the
endpoint.

If the user is not found in the Dell Server database, they is located in Active Directory.
Remove Endpoints
Endpoint removal is permanent. Once an endpoint is removed, the action cannot be undone.
To remove an endpoint:
1. Inthe left pane, click Populations > Endpoints.
2. Select the appropriate endpoint type, for example, Workstation or Mobile Device.

3. Click the box next to a hostname in the list or enter a filter to search for available endpoints.
The wildcard character (*) is supported.

For Windows and Mac, if you know the hostname of the endpoint, enter it in Search. Leave the field
blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.
4. Atthe top left, click Remove.
5. Click OK to confirm removal of the endpoint.

As another option, click an endpoint and select the Details & Actions tab. Under Endpoint Detalil, click
Remove.

Find Endpoints
1. Inthe left pane, click Populations > Endpoints.

2. Navigate the list of endpoints using the scroll bar or page navigation controls at the bottom of
the page or enter a filter into Search to search for available endpoints. The wildcard character
(*) is supported.
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For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to
display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.

View or Modify Endpoint Policies and Information
1. Inthe left pane, click Populations > Endpoints.
2. Select the appropriate endpoint type, for example, Workstation or Mobile Device.

3. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard
character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to
display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.
Click a hostname or endpoint serial number to display the Endpoint Detail page.

4. Click the tab that corresponds with the action to perform:
Security Policies - Click Security Policies to view or modify policies of the endpoint.

Details & Actions - Click Details & Actions to view properties of the endpoint, including
Inventory Information. Viewable information includes hardware information, effective policies,
inventory and protection status, threat protection and Advanced Threat Prevention detail, and
SED Device Control commands.

Users - Click Users to view a list of users who store and access data on the endpoint. These statistics
of users may be available on the Endpoint Detail page: login, last Gatekeeper sync, effective policies,
and states. You can also recover data from this page.

Endpoint Groups - Click Endpoint Groups to view a list of Endpoint Groups to which this endpoint
belongs. All endpoint belong to at least one endpoint group, the Default Endpoint Group.

Threat Events - Click Threat Events view information about threat events on the endpoint. The
following information is displayed for events: severity, category (malware, web filtering, web protection,
and firewall), event ID, event description, user name, and received.

Advanced Threat Events - Click Advanced Threat Events view, export, quarantine, or waive unsafe
files. Events are grouped by Status (unsafe, quarantined, or abnormal), and the following information is
displayed for events: file name, file paths, score, classification, first found time stamp, running, auto run,
and detected by.

6. If modified, click Save.

View Effective Policy

When you view Effective Policies, you are viewing the policies and settings that are enforced on an
endpoint.

1. Inthe left pane, click Populations > Endpoints.

2. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard
character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in Search. Leave the field blank to
display all Windows and Mac endpoints.
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For Mobile devices, optionally enter the model name or user's email address.
Click a hostname or endpoint serial number to display the Endpoint Detail page.
3. On the Endpoint Detail page, click the Details & Actions tab.
4. Under Manager Detail, click View Effective Policies.
Related topics:

Manage Security Policies

Endpoint Details & Actions

The Details & Actions page lists the details for the selected endpoint as well as commands, such as
Remove Endpoint. Available details and commands vary, depending on the endpoint platform.

To access Endpoint Details & Actions, follow these steps:
1. Inthe left pane, click Populations > Endpoints.
2. Search or select a hostname, then the Details & Actions tab.
Endpoint Detail
Command:
Remove - Endpoint is removed.
Endpoint removal is permanent. Once an endpoint is removed, the action cannot be undone.
Details:
Windows
Category - Windows
OS/Version - Example: Microsoft Windows 10 Enterprise
Processor
Serial Number - Manufacturer assigned serial number
Host ID - Endpoint identifier
Unique ID - Dell assigned unique identifier
Hardware ID - A unique identifier sent to the server from the client.
Protected - Date and time stamp
Mac
Category - Mac
OS/OS Version - Example: Mac OS X 10.11.0
Processor
Serial Number - Manufacturer assigned serial number
Host ID - Endpoint identifier
Unique ID - Dell assigned unique identifier

Hardware ID - A unique identifier sent to the server from the client.
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Protected - Date and time stamp

Mobile Device

Category - Mobile Device

OS/OS Version - Example: Lollipop /5.0

Model Name - Examples: Android or iPad

Serial Number - Manufacturer assigned serial number

Last Contact Time - Date and time stamp of last contact with the Security Management Server
State:

Discovered — device found

Blocked — block from Exchange access

Blocked Sub-States (on the Endpoint Detail page):

Blocked by Admin — (EAS only) blocked by administrative override using the Block Device command

Blocked by Policy — (EAS or iOS) subject to the Allow iOS Devices and Allow Non-iOS Devices
policies.

Pending — iOS policy pending
Protected — policies implemented
Cloud
Category - Windows, iOS, or Android
OS/OS Version - Examples:
Windows 10
Android / 5.0
iPhone OS /8.0
Model ID - Examples: iPhone6, or iPad3,4
Model Name (if available)
Phone ESN/IMEI (if available)
Processor (will display if the data is available)
Memory available and total (MBs) (will display if the data is available)
Battery remaining% (will display if the data is available)
Serial Number - Manufacturer assigned serial number
Unique ID - Dell assigned unique identifier
Actions - Hide or Remove Endpoint
Shield Detail
Commands:
To view the policies of the endpoint, click View Effective Policies.

Obtain the endpoint's recovery keys:
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1. Click Device Recovery Keys.
2. Enter a Recovery Password and click Download.

The recovery bundle containing this endpoint's encryption keys is downloaded. You must remember the
this recovery password to access the recovery keys.

Detail:
Windows
Policy Proxy Group (typically CMGREMOTE)
Recovery ID of the specific endpoint
Version (core/edition)
Activation Method (typically Mandatory)
HCA Enabled: True or False
TPM Present: True or False
Edition: Dell or CREDANT
States:
Policy Updating: Date and timestamp
Device Encryption Updating: Date and timestamp
Device Data Encryption On: Date and timestamp
Sweep Started: Date and timestamp
Sweep Completed: Date and timestamp
Inventory Received: Date and timestamp
Inventory Processed: Date and timestamp
Manager Inventory Received: Date and timestamp
Manager Inventory Processed: Date and timestamp
Protected:
Protection Status Tab:
Disk Name
Capacity (storage)
Protection Status (Protected, Protecting, Unknown)
Interface type
Model number of the endpoint
GPE Tab:
GPE Available (True or False)
GPE Driver Version
GPE Functional (True or False)

GPE Lifecycle Remaining (number)
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GPE Lifecycle Owner Remaining (number)
GPE Provisioned Status
TPM Tab:
TPM Present (True or False)
TPM Activated (True or False)
TPM Owned (True or False)
TPM Functional Status (True or False)
TPM Spec Version (version number)
HCA Tab:
HCA Functional Status
HCA Provision State
Preboot Present (True or False)
Preboot Set (True or False)

Actions: Effective policies on the specific endpoint and Recovery Keys for the specific endpoint

Mac
Policy Proxy Group (typically CMGREMOTE)
Recovery ID of the specific endpoint
Version (core/edition)
Activation Method (typically Mandatory)
Edition (Dell or Credant)
States:
Policy Updating: Date and timestamp
Device Encryption Updating: Date and timestamp
Device Data Encryption On: Date and timestamp
Sweep Started: Date and timestamp
Sweep Completed: Date and timestamp
Inventory Received: Date and timestamp
Inventory Processed: Date and timestamp
Protected:

Protection Status Tab:

Disk Name

Capacity (storage)
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Protection Status (Protected, Protecting, Unknown)
Interface type
Model number of the endpoint

Actions: Effective policies on the specific endpoint and Recovery Keys for the specific endpoint

Manager Detail (Windows only)
Command:
Click View Effective Policies to go to the effective policy page for this endpoint.

States

The client gathers the following information via a Windows Management Instrumentation (WMI) call to
the Operating System. It is updated with each inventory update.

Inventory Received - the date and time that the inventory was received by the Dell Server and placed in
the queue.

Inventory Processed - the date and time that the inventory was picked up from the queue and
processed. (Note: If the Dell Server is under load, the Processed and Received times may be different,
but usually they is the same.)

Agent Version - the version of Manager the endpoint is running.
Protected - the date and time that the device was protected.

Protection Status

Disk - number of the disk

Partitions - number of partitions the disk has
Capacity - capacity of the disk

Encryption Technology - encryption technology in use
Protection Status - Protected or unprotected

Interface - Disk interface (Examples: IDE, SATA)
Model - Manufacturer name and model of the disk

Click the small black arrow on the left to expand the disk details to view information for each partition of
the disk.

Logical Disk - The name of the logical disk.

ID - The identifying number of the logical disk.

Encryption % - The percentage of the partition that has been encrypted.

Capacity - The capacity of the partition.

Protection Status - Protection status for the partition: Protected, Unprotected, Locked
Providers

Agent - SED, FDE, Authentication Proxy, Preboot Authentication, Windows Authentication, BitLocker,
TPM, Threat Protection, Advanced Threat Prevention
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Plugin Functional Status (green check mark or red "x") - This indicates whether the Agent has been
enabled via policy. To get more detail on whether each plugin is working as expected, look at Plugin
State column.

Plugin State:
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e BitLocker Plugin:

Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory
update would capture this so you would probably never see this state in the Management
Console.

Disabled - Manager is disabled by policy and not enforcing any previously received policy.
Active - Manager is running normally and enforcing policies.

No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy.
This is only relevant the very first time you install the Manager client. Manager does not start a
plugin until an initial policy is received from the Dell Server, versus starting the plugin with some
default policy placed on the client during install. After an initial policy has been received from the
Dell Server, via the activation process, plugins are always started with the last policy the client is
aware of.

OpSys Not Supported - Manager does not support this operating system. Manager is not actively
enforcing policy related to this plugin, due to this plugin-specific exception.

e TPM Plugin:

Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory
update would capture this so you would probably never see this state in the Management
Console.

Disabled - Manager is disabled by policy and not enforcing any previously received policy.
Active - Manager is running normally and enforcing policies.

TPM Services Not Started — In the Enterprise Server Console this is listed as TPM Base
Services Failed. It means something is preventing the TPM service from starting as expected.
The Manager is not actively enforcing policy related to this plugin, due to this plugin-specific
exception.

No TPM Device — The TPM device is not present or is not detectable in the indicated computer.
The Manager is not actively enforcing policy related to this plugin, due to this plugin-specific
exception.

No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy.
This is only relevant the very first time you install the Manager client. Manager does not start a
plugin until an initial policy is received from the Dell Server, versus starting the plugin with some
default policy placed on the client during install. After an initial policy has been received from the
Dell Server, via the activation process, plugins are always started with the last policy the client is
aware of.

e SED Plugin:
Initialized - Manager is initialized waiting for delayed startup

Starting - Manager is starting up. Because this is a fairly quick process, it is unlikely an inventory
update would capture this so you would probably never see this state in the Management
Console.

Disabled - Manager is disabled by policy and not enforcing any previously received policy.

Active - Manager is running normally and enforcing policies.
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No Policy - Initial policy has not been received so the plugin is not actively enforcing any policy.
This is only relevant the very first time you install the Manager client. Manager does not start a
plugin until an initial policy is received from the Dell Server, versus starting the plugin with some
default policy placed on the client during install. After an initial policy has been received from the
Dell Server, via the activation process, plugins are always started with the last policy the client is
aware of.

Waiting For Escrow - Manager is waiting for keys to escrow
Waiting For Server Public Key - Manager is waiting for public key to proceed with activation
No Opal Drive Present - Manager did not detect an OPAL drive

Plugin Version - The version of the plugin, which is taken from the plugin's version information

Vendor version - The version of the underlying framework. For example, BitLocker is Microsoft's
technology, therefore Vendor Version is Microsoft's version for BitLocker.

Threat Protection Detail (Windows only)
Scan Engine Version - Lists the version of the engine that performed the last scan.
DAT File Version - Lists the version of the DAT file.
Last Scan Started - Date/time stamp that the last scan was started.
Last Scan Completed - Date/time stamp that the last scan was completed.
Advanced Threat Prevention Detail
Device ID - Lists the identifier of the device as it pertains to Advanced Threat Prevention.
Agent Version - Lists the version of the agent.
Update Date - Date/time stamp that the agent was updated.
Provisioned Date - Date/time stamp that the client was provisioned.
Cloud Device Control

Cloud device commands apply to the selected endpoint and are carried out from the Cloud Device
Control section of the device's endpoint page. Unlike policies, commands are pushed to the device to
enable an action.

Commands:
Suspend - Suspends the endpoint device. It does not suspend the user account.
Unsuspend - Unsuspends the endpoint device.
FDE Device Control (Windows only)
Current State of the Endpoint - Unlocked or Locked
Commands:

PBA commands for a specific endpoint are carried out in the PBA Device Control area. Each command
has a priority ranking. A command with a higher priority rank cancels commands of lower priorities in the
enforcement queue. For a list of command priority rankings, see Priority of Commands for Self-
Encrypting Drives.

Lock - Locks the PBA screen and prevents any user from logging into the computer.

Unlock - Unlocks the PBA screen after it has been locked on this endpoint, either by sending a Lock
command or by exceeding the maximum number of authentications attempts allowed by policy.
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Remove Users - Removes all users from the PBA.

Bypass Login - Bypasses the PBA screen one time to allow a user into the computer without
authenticating. The user will still need to login to Windows after PBA has been bypassed.

Wipe - The Wipe command functions as a “restore to factory state” for the FDE drive. The Wipe
command can be used to re-purpose a computer or, in an emergency situation, wipe the computer,
making the data permanently unrecoverable. When the wipe command is consumed by the client, all
history and details about this endpoint are removed from the Dell Server. Ensure that this is the desired
behavior before invoking this command.

The FDE Device Control Table
The table lists the commands most recently sent to the PBA Device.
To sort the table, click a column header.
PBA Device Control (Windows only)
Current State of the Endpoint - Unlocked or Locked
Commands:

PBA commands for a specific endpoint are carried out in the PBA Device Control area. Each command
has a priority ranking. A command with a higher priority rank cancels commands of lower priorities in the
enforcement queue. For a list of command priority rankings, see Priority of Commands for Self-
Encrypting Drives.

Lock - Locks the PBA screen and prevents any user from logging into the computer.

Unlock - Unlocks the PBA screen after it has been locked on this endpoint, either by sending a Lock
command or by exceeding the maximum number of authentications attempts allowed by policy.

Remove Users - Removes all users from the PBA.

Bypass Login - Bypasses the PBA screen one time to allow a user into the computer without
authenticating. The user will still need to login to Windows after PBA has been bypassed.

Wipe - The Wipe command functions as a “restore to factory state” for the SED drive. The Wipe
command can be used to re-purpose a computer or, in an emergency situation, wipe the computer,
making the data permanently unrecoverable. When the wipe command is consumed by the client, all
history and details about this endpoint are removed from the Dell Server. Ensure that this is the desired
behavior before invoking this command.

The PBA Device Control
Lists the commands most recently sent to the PBA device.

To sort, click a column header.

Protected Status
Protected status is indicated if any of the following criteria are met:
e Advanced Threat Prevention is installed and enabled.
e Data Guardian is installed and enabled.
e Self-Encrypting Drive Management is installed, enabled, and the PBA is enabled.
e BitLocker Manager is installed, enabled, and encryption has completed.

e Dell Encryption (Mac) is installed and enabled, and policy-based encryption has been enforced.
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e Dell Encryption (Windows) is installed, enabled, Policy-Based Encryption has been set for the
endpoint, and the most recent policy has been applied for the last logged on user.

To check Protected Status of an endpoint:
1. Inthe left pane, click Populations > Endpoints.

2. Click a hostname in the list or enter a filter to search for available endpoints. The wildcard
character (*) is supported.

For Windows and Mac, if you know the endpoint hostname, enter it in the Search field. Leave
the field blank to display all Windows and Mac endpoints.

For Mobile devices, optionally enter the model name or user's email address.
Click a hostname or endpoint serial number to display the Endpoint Detail page.

3. A green check mark displays in the Protected column if any of the criteria for Protected status
are met.

Endpoint Users

This page displays information for every user of the specified endpoint. The user information differs for each
technology group or policy category.

1. Inthe left pane, click Populations > Endpoints.
2. Search or select a hostname, then the Users tab.
Shield
User - Each user on the specific endpoint
Last Successful Login - Date/time stamp, per user
Last Unsuccessful Login - Date/time stamp, per user
Last Gatekeeper Sync - Date/time stamp, per user
Effective Policies - Click view for a simple layout view of the effective user policies
Actions - Click Recover to proceed to the Recover Data page
Last Encryption Sweep Start - Date/time stamp, per user
Sweep End - Date/time stamp, per user
Encryption Failure - Click view for a simple list of files that could not be encrypted, per user
States (Date/time stamp, per user):
Policy Updating
User Encryption Profile Updating
EMS Encryption Profile Updating
User Data Encryption On
EMS Data Encryption On
Deactivation Pending

Suspension Pending
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Suspended
Cloud

User - Each user on the specific endpoint

Endpoint Threat Events

This page lists information on threat events for the selected endpoint.
1. Inthe left pane, click Populations > Endpoints > Workstation.
2. Search or select a Hostname, then the Threat Events tab.

Threat Event Data

Severity - Severity of the threat, where Critical is the most dangerous threat to the endpoint, and
Information is just a notification of an event that is unlikely to harm the endpoint. (Critical, Major, Minor,
Caution, Information)

Category - Category of the threat. Upon identification, threats are sorted into these categories: Malware,
Web Filtering, Web Protection, and Firewall.

Event ID - Unique number assigned to each threat event.
Description - Description of the last preventative action taken to handle the threat.
User Name - The DOMAIN\Username associated with the endpoint where the threat was identified.
Received - Date/time stamp when the last action was taken to handle a threat.
Navigate the Threat Event Data
To sort the data, click a column header.
Use the controls at the bottom of the page to:

= Advance to the top of the data.

=  Go back one page.

=  Go forward one page.

= Advance to the end of the data.

= Increase or reduce the items per page.

= View the range of items currently displayed.

= Refresh the data.

Endpoint Advanced Threats

This page allows you to view, export, quarantine, or waive unsafe files that trigger events on the
selected endpoint.

An event is not necessarily a threat. An event is generated when a recognized file or program is
quarantined, safe listed, or waived. Threats are a category of events that are newly detected as
potentially unsafe files or programs and require guided remediation.

1. Inthe left pane, click Populations > Endpoints.
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2. Search or select a hostname, then the Advanced Events tab.
List of Events
The list presents all files that have triggered events found on this device.
Columns
= Icon - An icon displays in this column, when available.
= Name - File triggering the event.
= File Paths - The location of the file on the device.

=  Cylance Score - A score is assigned to each file that is deemed Abnormal or Unsafe. The score
represents the confidence level that the file is malware. The higher the number, the greater the
confidence.

=  Status - Indicates whether the file has been quarantined or waived.

= Classification - Classification of the threat: High, Medium, or Low. For details, see Advanced
Threat Protection Classifications.

=  First Found - Date/timestamp that the file was first found.
= Running - Indicates whether the file that triggered the event is running or not.
= Auto Run - Indicates whether the file was set to automatically run upon startup.

= Detected By - Indicates whether the file was detected by Execution Control or by Memory
Protection.

Configure the Threat List
Add or Remove Columns

Click an arrow next to any column header and select Columns to add columns to, or remove columns from, the
table.

Filter on Column Data

To filter the list based on column data, click the down-arrow on any column to display the context menu, and
select Filter.

The filter options vary, depending on the type of data in the column. For example, you may want to filter the list
so that it shows only high priority threats.

Group by a Column

Drag a column header, such as Status, to the area directly above the column headers to group the data by
Status. When you drag a column header, it turns green, indicating that the table can be grouped by that data.
You can drag additional headers over the table to group the data even further.

For each group, a number displays in parentheses to indicate the total number of threats that share that
group's attribute.

Commands:

Select the check box next to a file name to perform an action on the file. To select all files, select the
check box in the column heading row.
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Export lets you export selected data to a .CSV file so that you can view the data in Excel or a similar
application which has powerful sorting/organizing features.

After selecting the data to export, click Export to save the data in a .CSV file.

Click Quarantine to add the file to the Quarantine list.
Quarantining a file will prevent the file from being executed on this device.

Note: Quarantining a file will move the file from its original location to the Quarantine directory
(C:\ProgramData\Cylance\Desktop\q).

Click Waive to allow the file to run on this device.

Note: Occasionally, a “good” file could be quarantined or reported. This could happen if the features of
that file strongly resemble those of malicious files. Waiving or globally safe listing the file can be useful
in these instances.

Exploit Attempts

This section lists the detection of attempts to exploit running processes, or malware that executes from
within memory space.

A number displays the total number of events, followed by the number in each subcategory.

Check box - Select all events by selecting the check box in the column heading row, or select individual
events. When you select a check box, Quarantine and Waive are activated.

Added - Date and time when the exploit attempt was added.

Process Name - Name of the process identified as an exploit attempt.

Process ID - Unique number associated with the exploit attempt.

Type - Type of memory exploit: Exploitation, Process Injection, Escalation.

Action - Action taken to protect the system from the exploit attempt:
. Ignore - The agent does not take any action against identified memory violations.
= Alert - The agent will record the violation and list the incident on this page.

=  Block - If an application attempts to call a memory violation process, the agent will block the
process call. The application that made the call is allowed to continue to run.

=  Terminate - If an application attempts to call a memory violation process, the agent will block the
process call and will also terminate the application that made the call.

User Name - Name of the user who was logged in when the exploit attempt was identified.

Endpoint Advanced Threat Events

The Advanced Threat Events tab displays if the Advanced Threat Prevention service is provisioned and
Advanced Threat Prevention is enabled on the endpoint.

The tab displays information about events for the endpoint based on information available in the Dell
Server.
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To access the Enterprise Advanced Threats tab, follow these steps:
1. Inthe left pane, click Populations > Endpoints.
2. Search or select a hostname, then the Advanced Threat Events tab.
Use the following filters to select content to display on the Advanced Threat Events tab:

Type - Threat Found, Threat Blocked, Threat Terminated, Memory Violation Blocked, Memory Violation
Terminated, Memory Violation (Detected), Threat Removed, Threat Quarantined, Threat Waived, Threat
Changed, Protection Status Changed.

Severity - Severity level of the event: Critical, Major, Minor, Caution, or Informational.
Timeframe (in days) - 1, 7, 14, 30, 60, 90
Columns - Allows you to select the following additional columns to display:
Hostname - The fully qualified name of the computer
Data - Details about the event
Created - Date and time that the event was captured
Machine Name - Name of the computer on which the threat event was detected
Path - Path to the file in which the threat was detected

Sha256 - The file's 256-character Secure Hash Algorithm can be compared with an expected result to
indicate whether the file has been tampered with.

Score - The threat file's score, indicating the confidence level that the file is malware. The higher the
number, the greater the confidence.

Server Encryption Clients

Suspend an Encrypted Server

When you suspend an encrypted server, you suspend the user associated with the encryption client
rather than an individual user who logs on to the endpoint.

To suspend a Server Encryption client:

1. Inthe left pane, click Populations > Users.

In Search, enter SERVER-USER and click the
Click the user name of the appropriate user.

On the User Detail page, click the Endpoints tab.
Click the Device ID of the appropriate endpoint.

On the Endpoint Detail page, click the Details & Action tab.

N oo o A~ W DN

In Server Device Control, click Suspend.

Suspension takes effect the next time the endpoint is rebooted.

To reinstate an encrypted server, follow the instructions in Reinstate a Suspended Server Encryption
Client.

Reinstate an Encrypted Server
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To reinstate an encrypted server, follow these steps:

In the left pane, click Populations > Users.

In Search, enter SERVER-USER and click

Click the user name of the appropriate user.

On the User Detail page, click the Endpoints tab.

Click the Device ID of the appropriate endpoint.

On the Endpoint Detail page, click the Details & Action tab.
In Server Device Control, click Reinstate.

Reinstatement takes effect the next time the endpoint is rebooted.

Commands for Self-Encrypting Drives

Priority of Commands for Self-Encrypting Drives

agRrLNE

Each command for self-encrypting drives has a priority ranking. A command with a higher priority rank
cancels commands of lower priorities in the enforcement queue.

Priority rankings (1 is highest):
Wipe
Lock
Remove Users

Unlock
Bypass

For example, a Wipe command cancels a Lock command that was previously queued to send to the
endpoint.

Related topics:

Send Wipe Command to Self-Encrypting Drive

Lock a Self-Encrypting Drive

Remove Users from Endpoint with Self-Encrypting Drive

Unlock a Self-Encrypting Drive

Allow PBA Login Bypass

Allow PBA Login Bypass

You can allow users to bypass the Preboot Authentication (PBA) screen one time to allow a user into
the computer without authenticating on an endpoint equipped with a self-encrypting drive.

To send the Bypass Login command, follow these steps:
1. Inthe left pane, click Populations > Endpoints.

2. Select the Workstation Endpoint Type.
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If you know the full endpoint hostname, enter it in Search. Leave the field blank to display all
Workstation endpoints.

Click . An endpoint or list of endpoints displays, based on your search filter.
Click the endpoint hostname on which to allow PBA login bypass.

Click the Details & Actions tab.

Under SED Device Control, click Bypass Login.

Click Yes to confirm that you want to send the Bypass Login command to the endpoint.

Unlock a Self-Encrypting Drive

You can unlock the PBA screen after it has been locked on this endpoint, either by sending a Lock
command or by exceeding the maximum number of authentications attempts allowed by policy.

To send the Unlock command, follow these steps:

1.
2.
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In the left pane, click Populations > Endpoints.
Select the Workstation endpoint type.

If you know the full endpoint hostname, enter it in Search. Leave the field blank to display all
Workstation endpoints.

Click . An endpoint or list of endpoints displays, based on your search filter.
Click the endpoint hostname with the self-encrypting drive to unlock.

Click the Details & Actions tab.

Under SED Device Control, click Unlock.

Click Yes to confirm that you want to send the Unlock command to the endpoint.

Remove Users from Endpoint with Self-Encrypting Drive

To remove users from the PBA, follow these steps:

1.
2.
3.
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In the left pane, click Populations > Endpoints.
Select the Workstation endpoint type.

If you know the full Hostname of the endpoint, enter it in the Search field. However, you may
leave the field blank to display all Workstation endpoints.

Click the search icon.

An endpoint or list of endpoints displays, based on your search filter.
Click the Hostname of the endpoint from which to remove users.
Click the Details & Actions tab.

Under SED Device Control, click Remove Users.

Click Yes to confirm that you want to send the Remove Users command to the endpoint.
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Lock a Self-Encrypting Drive
To lock the PBA screen and prevent any user from logging onto the computer, follow these steps:
1. Inthe left pane, click Populations > Endpoints.
2. Select the Workstation Endpoint Type.

3. If you know the full endpoint hostname, enter it in Search. Leave the field blank to display all
Workstation endpoints.

Click . An endpoint or list of endpoints displays, based on your search filter.
Click the endpoint hostname with the self-encrypting drive to lock.

Click the Details & Actions tab.

Under SED Device Control, click Lock.
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Click Yes to confirm that you want to send the Lock command to the endpoint.

Send Wipe Command to Self-Encrypting Drive
CAUTION: The Wipe command clears all data from the disk and cannot be undone.

The Wipe command functions as a “restore to factory state” for the self-encrypting drive. In an
emergency situation, wipe the computer, making the data permanently unrecoverable. When the wipe
command is consumed, all history and details about this endpoint are removed. Ensure that this is the
desired behavior before invoking this command.

To send the Wipe command, follow these steps:
1. Inthe left pane, click Populations > Endpoints.
2. Select the Workstation Endpoint Type.

3. If you know the full endpoint hostname, enter it in Search. Leave the field blank to display all
Workstation endpoints.

Click = . An endpoint or list of endpoints displays, based on your search filter.
Click the endpoint hostname on which to wipe the self-encrypting drive.

Click the Details & Actions tab.

Under SED Device Control, click Wipe.

© N o o &

Click Yes to confirm that you want to send the Wipe command to the endpoint.

Set the Dell Server Connection Retry Interval

To set the interval that the SED client attempts to contact the Dell Server when it is unavailable to
communicate with the SED client, set the following value on the client computer:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\DellMgmtAgent\Parameters
CommeErrorSleepSecs (DWORD Value)=300

This value is the number of seconds the SED client waits to attempt to contact the Dell Server if it is
unavailable to communicate with the SED client. The default is 300 seconds (5 minutes).

Administrators

93



Navigate the Dell Server

Assign or Modify Administrator Roles
View or modify existing administrator privileges.
1. Inthe left pane, click Populations > Administrators.

2. Search or select the row that displays the user name of the appropriate administrator to display
User Detalil.

3. View or modify administrator roles in the pane at the right.
4. Click Save.
Dell recommends assigning administrator roles at the Group level rather than at the User level.
1. Inthe left pane, click Populations > User Groups.
2. Search or select a group name, then the Admin tab.
3. Select or deselect administrator roles assigned to the group.
4. Click Save.

If you remove a group that has administrative privileges and later re-add the group, it remains an
administrator group.

To view, assign, or modify administrator roles at the User level, see User Admin.

Related topics:

Administrator Roles

User Admin

Delegate Administrator Roles

Administrator Roles

Administrator login is integrated with Active Directory to simplify the process of managing administrators
and to allow you to leverage your existing user authentication infrastructure. Administrators are
assigned roles that define what level of access each administrator is allowed. For example, some
administrators may only be allowed to implement help desk assisted recovery while others have full
access to edit security policies. You can assign administrator roles to Active Directory groups so you
can easily change the level of administrator access users have with a simple change to AD group
membership. Non-domain users can be granted reporting-only access via Compliance Reporter.

There are 11 types of administrators. Distributed administration is key to the secure administration of
your environment. It allows you to divide roles appropriately among your administrators and ensures the
proper level of privileges are assigned to each administrator. A single administrator can have privileges
of more than one administrator type. However, it is recommended to have a maximum of one super
administrator (an administrator who has privileges of all administrator types).

The following table shows the tasks each administrator can perform in the Management Console or
Compliance Reporter.
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Login . ° ° ° . °

Log out ° ° ° ° ° .

View current
system state

Search for

Users, Groups, ° . . °
and Endpoints

Add Users and
Groups

Browse
Domains

Add and edit
Domains

Upload
licenses
Recover an
endpoint -
Authentication

Failure

Remove an
endpoint

Change Dell
Server Options

Suspend a User .

Reinstate
suspended .
user

Deactivate a
User

View policies .
Modify policies °

Commit
policies

Issue
commands

View audit
events

Analyze logs . .

View
Administrators

Create,

change, and

delete .
Administrator

accounts
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Administrator
privileges

Download
Endpoint .
software

Download
recovery key .
bundle

Provision or
recover the
Advanced
Threat
Prevention
service

Enroll for

Advanced

Threat .
Prevention

auto updates

Set email
notifications of
Client Access
Licenses,
Threat
Protection, and
Advanced
Threat
Prevention
alerts

Manage Data
Guardian .
external users

Manage Data
Guardian

external user
key requests

Revoke Data
Guardian keys

Install/uninstall
Compliance
Reporter

Log in to
Compliance
Reporter

Manage report
folders and
modify/save
Compliance
Reporter
report layouts

Access the
Compliance
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Reporter
reports
window

Work with
Compliance
Reporter
report views
and generate
reports

Access the
Compliance
Reporter
report
administrator
window

Create,
manage,
schedule, and
make
Compliance
Reporter
report layouts
available to
report users

Specify the
data source for
Compliance
Reporter

Manage
Compliance
Reporter user
privileges

Edit or delete a
report that is
settorunata
specified
interval in the
Compliance
Reporter
Scheduler

Schedule and
rename a
report that is
settorunata
specified
interval in the
Compliance
Reporter
Scheduler

Enter or
modify settings
in Compliance
Reporter
Settings
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Open a Report,
modify an
online Report
display, and
rename a
Report view in
Compliance
Reporter

Generate,
export, store,
print, and
email a Report
result in
Compliance
Reporter

Add, edit, and
delete a
Compliance
Reporter
Report folder

Access the
Manage
Reports Tab
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1 The forensic administrator role provides the rights to use the forensic administrator tools via XAPI.

% The policy administrator role is reserved for future use.

Delegate Administrator Rights

Administrator rights for a user group can be delegated to a user. The delegated administrator and users
must be members of the user group not only in Active Directory but in the Dell Server database.
Administrator rights are available to the delegated administrator only if the delegated administrator is a
member of the user group in the Dell Server database. Delegated administrator rights are effective only
with regard to Users who are members of the user group in the Dell Server database.

Only the superadmin and account administrator can delegate administrator rights.

To delegate Administrator rights, follow these steps:

1.

2
3
4.
5

In the left pane, click Populations > User Groups.
Search for the appropriate group.

Click the Admin tab.

Under Delegated Roles, click Add.

Search for and select the user to receive administrator rights, then click Add.

To remove delegated administrator rights, under Delegated Roles in User Group Detail, locate the user
to remove as delegated administrator and click the red X next to the user name.

Reporting
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Manage Reports

Manage Reports
In the left pane, click Reports > Manage Reports. For compliance and monitoring purposes, you can:

e Manage reports

e View or modify an existing report

. Create a new report

The Manage Reports page has:

e New Report - See Create a new report.

e Report Type - Select All (default) or specific report types to display in the Name column. Clear
selected items to undo selections. See Report Type.

Note: Policy-based reports are not an option.
e Grouping - Group by Report Type, Author, Private, or None (default).

e Columns - Select which columns to display on the Manage Reports page, such as Name,
Description, Report Type, Author. Also:

e Private - True indicates only the owner of the report can access it.
e Report Administrator - can view all public and private reports.

e Other Administrators - can view private reports they created and all public
reports.

e Created - Date the report was created.
e Modified - Date the report was modified.

e Search - Hover to view columns for performing a search, then enter specific text for those
columns. Use * for a wildcard. For additional filtering to provide a detailed search on a specific
report, see Use_Search_and_More_to_filter.

View or Modify an Existing Report

On the Manage Reports page, select a report from the Name column to view an instance of that report.
The owner can make the report private or public. See View Report.

Create a New Report

On the Manage Reports page, click New Report and select an option. An instance of that report opens
to customize the information to display. See View Report.

View Report

On the Manage Reports page, select an option in Create New Report or click an existing report in the
Name column.
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e New report - An administrator can select Save As. Save, Rename, and Delete options are
activated, and the report is saved to the Manage Reports page. The owner can make the report
private or public. You can create:

e Single reports

e Report templates - Determine frequent report content that you will generate. Select
Column and Grouping options that are common to all those reports and save it as a
template. See View_or_modify_an_existing_report.

e Existing report:

e Tofilter a report, perform a query using Search and More.

e Owner of a report - Can view their private reports and all public ones. Only the Owner
or a Report administrator can modify or rename the report.

e Report administrator - Can view all private and public reports. Can modify or rename
public and private reports.

e Public reports - Any administrator can select Save As to modify a copy of the report.

Grouping, Columns, and More differ for each report type. Some Column and Grouping options are

selected by default.

e Columns allows customized options to display. After you select options, you can drag and
resequence to avoid scrolling. The resequenced columns return to the default when you close

the report.

e Grouping allows you to sort the column options you selected.

e Hover over Search to view suggested columns for performing a search, then enter specific text.
Suggested column options differ for each report type. Use (*) as a wildcard.

For a description of each report's Column and Grouping options, click a link below.

Device Detail

Shield Detail

Notifications

Log Analyzer

Audit Event

ATP Event

EMS Event
BitLocker Manager

Windows Encryption Failures

Windows Shield User Encryption Status

Provides reports based on Windows, Mac, iOS, and Android device details.
See Endpoint Details & Actions.

Customize a report of an endpoint's policies, recovery keys, or details.

See Shield Detail.

Customize a report of news, alerts, and events or email notifications.

See Notifications.

Customize a report of policy modifications or logs based on message priority level, date and time
periods, and occurrences of usernames and hosts.

See Log Analyzer.

Provides reports on the audit trail of file activity for Windows, Mac, mobile devices, and the web
client.

Data Guardian and Audit Events

Get Started with Data Guardian Audit Events

Provides reports of events for the entire enterprise based on information available in the Dell Server.
See Advanced Threat Events tab filters.

Provides data about events that occur when removable media is used.

Customize a report to see if BitLocker is enabled and to view details.
See Manager Detail (Windows only).

Provides a report on files that were not encrypted on a Windows Encryption client.
See Endpoints and Endpoint Details & Actions.

For Windows, provides a report more focused on the user and a device, for example if one device has
multiple users. See Protected Status.
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Query using Search and More... to filter
Search performs a text-only quick search across multiple fields and may return numerous results.
e Hover to view columns that apply to this search, then enter specific text for those columns.
e Use * for a wildcard.
To filter and narrow the search with More... :

e Select More... and select a check box. Check boxes differ for each report type. Select one or
multiple check boxes to narrow the search.

e An additional field displays for that check box option where you can either enter text to search
on that column or select from a list of enumerators or a data type for that column.

Query example for Log Analyzer report

1. In Columns, select options. From menu options such as, Priority and Category select
enumerators. Created allows you to filter by date.

2. Enter text in Search to perform a quick search on Username and Message.

3. For additional filtering, select More.... and then select Username, Message, or both. Additional
text fields allow you to limit the text search specifically to that column.

Query example for Data Guardian and Audit Events report

With Data Guardian, you can set specify policies and the Protected Office and Beacon Monikers to
identify protected Office files in an unexpected location or a non-Data Guardian Device that tries to
access a protected Office document. See

Protected Office Document or Basic File Protection audit events or Map_visualization.

Query example for BitLocker Manager report
1. In Columns, select options.
2. Enter text in Search to perform a quick search on Registered User.

3. For additional filtering, select More.... and then select one or more options. Additional text fields
allow you to limit the text search to that column:

o Registered User - Enter text to search specifically on that column.
e BitLocker Enabled or TPM Enabled - Boolean search specifically on those columns.

e Disk Status and Logical Disk Status - Enumerator searches specifically on those
columns.

Export File
Export to Excel or a .csv file.
Add Schedule
To add an email schedule for a report:
1. Inthe left pane of the Management Console, click Reporting > Manage Reports.
2. In Columns, click a report name then click Schedule.
3. In Schedules, click Add Schedule.

4. In Add Schedule, set the following parameters:
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e Email - add a single or multiple addresses separated by commas

e Schedule - select one of the following:
e Every Day
e Days of Week - select a specific weekday or multiple weekdays
e Day of Month - select a day of the month

e Time - select a time of day

e Locale - select a language

5. Click Save.

Compliance Reporter

Compliance Reporter has its own help system. When Compliance Reporter launches, click the Help link
on the top menu.

To launch Compliance Reporter:
1. Inthe left pane of the Management Console, click Compliance Reporter.

2. When Compliance Reporter launches, log in with superadmin credentials or reporting
credentials.

Data Guardian Audit Events

Data Guardian audit event logs maintain an audit trail of file activity for Windows, Mac, mobile devices,
and the web portal. By alternating between a map visualization and multiple filter options, you can
access audit data in various ways, from a global overview to specific geolocations or audit data on a
specific file or a specific user. This audit data offers the potential to visually identify data security
breaches or preliminary security risks.

To view audit events, select Reporting > Audit Events. The Audit Events page contains the map
visualization and columns for filtering. For tips on getting started, see Get Started with Data Guardian

Audit Events.

Map visualization

In Populations > Enterprise > Global Settings, if you enable the Data Guardian Geo Location Audit
Data policy and have the operating system's geolocation API, audit events that are sent to the Dell
Server include the geolocation data (latitude and longitude) of each device. A map visualization of audit
events can identify device locations that might indicate significant location changes or
unexpected/questionable locations for devices within an organization. The geolocation is checked
periodically, not each time an event is recorded. See

Examples of Map Visualization_and Column_Filters.

If the policy for geolocation is disabled, no geolocation data is contained in the audit events.

The map displays the following:
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e Marker cluster - A numeric value represents audit events within a similar area. Hover over the
marker cluster to view an outline of the determined area. Click a marker cluster to zoom to the
audit event markers within that cluster. Continue to click marker clusters until blue markers.

e Blue marker - Represents the location of a single audit event.
e Click a marker to list the device, file, user, and timestamp for that marker's audit event.

e The audit event can be a combination of the device and user that caused the audit
event, for example: One device or user accessed one file. Multiple devices or users
accessed one file, and the time stamp indicates the user who last accessed the file.
One user accessed numerous files.

e Mapping points of interest and points visible - Scroll to the bottom right of the columns to
display the total number of items in the column. The map displays only files that have
geolocation data (latitude and longitude). If a column lists 1000 files, but some lack geolocation
data, the map displays only the points with geolocation data.

e For performance, the map limits the display to the first 2000 audit events that have
latitude/longitude points in the table. It also varies depending on the filters you set.

e Drill into a marker cluster to list the total points of interest and visible points.

Note: Files that lack geolocation data and display only in the columns still provide some information for
auditing.

e Show only visible check box - If you click a marker cluster, the map only displays the area for
that cluster, but the columns list all audit events in the original query. Select the check box on
the lower right for the columns to only list audit events for those visible map points. As you
continue to drill down, the columns only list the events for the visible map points. Clear the
check box to return to the global view.

Audit Event Options and Filters
Use these options to determine the type and amount of audit event data to display.

e Moniker - By default, information displays for all monikers. Select one or more check boxes to
display specific monikers. Click Clear selected items to display all.

e Cloud Encryption (mobile and web portal; Data Guardian v2.3 and earlier for
Windows and Mac)

e Protected Office or Basic File Protection (Windows, Mac, mobile, and web portal)

e System - Populates the user logged into or logged out of the device that has Data
Guardian installed.

e Data Classification (Windows)

e Protected Email (Windows) - Relates to files other than protected Office
documents.

e Share (Windows) - Lists events when a user shares one or more files or attaches
an encrypted file to an email.

e Beacon - (protected Office documents) Indicates a device without Data Guardian
installed that tried to access a protected file. These audit events may have limited
data. For example, the location where the file was accessed but without the name
of the user of the device.

e Time stamp - Select the amount of past time for audit events to display - 1, 7, 14, 30, 60, or 90
days.
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e More - If you set filters and create a query, you can select the filter options in More to modify
the query. As you select an option, it displays as a menu. Some actions apply to Windows,
Mac, and mobile devices. Some are specific to one or more.

e Action - The default is All. Select one or more check boxes to display specific actions
associated with the payload file. See Action and the tables below for details and to
determine the operating system.

e Cloud Action - The default is All. Select one or more check boxes to display the
reason for an Action. See Cloud_Encryption_audit events and the tables below for
details and to determine the operating system.

e Data Guardian Action - The default is All. Select one or more check boxes to display
the reason for an Action. See
Protected Office_Document or Basic_File Protection_audit events and the tables
below for details and to determine the operating system.

e Net Action - (Windows and Data Guardian v2.7 and earlier)
e Grouping - Allows you to select one option. The default is None. For example:
e Moniker - Groups by moniker if you have more than one selected.
e Device or User - Allows you to determine the activity of specific devices or users.

o File Name, File Path or File Key ID - With device and user columns added, allows you
to see which users or devices accessed a file.

e Columns - Filter the amount of data by selecting one or multiple columns to display. If you
clear all column check boxes, audit events are listed for all endpoints and all users. Some filters
apply to all monikers and some to specific monikers. For a description of column filters, see
Options_in_the Columns_menu.

e Search - Hover to view columns for performing a search (device, user, file name, and file key
ID), then enter specific text for those columns. Use a wildcard (*) to search on .docx, .pptx,
XlIsx, .docm, .pptm, .xIsm, or .pdf.

e Export File - Export to Excel or a .csv file.

Options in the Columns Menu

Options can apply to all monikers or to a specific moniker. Policies must be enabled for audit data to
display.

Search icons in the columns - If you click “ next to an item in the device, user, file name, or key ID
columns, it copies the cell content to Search and executes a search on that content. You can then select
Action or IP address to do additional filtering.

Column options for all audit events

Moniker - Select one or more. Category of the audit event:
o Cloud Encryption (Mac and mobile)
. Protected Office
o System
o Data Classification (Windows)
o Protected Email (Windows)

o Share (Windows)
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Device
User

Logged In User

Timestamp
Created

Column options related to payload data:

File Name
File Path
File Key ID
File Size
Client Type

Action

Version
Client

o Beacon (protected Office documents)
The hostname of the device where the event occurred.
User associated with the event.
Typically, this is the email address of the activated user. See also Logged In User.
For manual activations or external users, the login name and email address used to activate may
differ. If you do not recognize the user name, open the log files to view the logged-in user name.

o In the log file for Protected Office, information displays as sl_protected_file.

o In the log file for Cloud Encryption on Mac or mobile, information displays as sl_xen_file.
Date and time when the event occurred.
Date and time when the entry was created. View this if a delay occurs.
Data for an audit event's moniker or parameters.
To search for a specific file, use the file key ID.
Note: When both .xen and protected Office files exist in Mac or mobile, parameters may differ for
each audit event but are the same within the event. For example, the data may differ for sl_xen_file
and sl_protected_file, but the data for each Cloud Encryption .xen file event is the same.
Indicates whether the client is internal or external
The action associated with the payload file. See
Protected Office Document or Basic_File Protection audit_events. For Mac or mobile, see also

Cloud Encryption audit events.

For internal Dell use only.

For internal Dell use only.

Column options for Protected Office only

Data Guardian Action

Column options related to Embargo:
From
To

If a service acts on a protected Office file, for example, modifying or deleting a file, the Data Guardian
Action column lists the reason. See
Protected Office Document or Basic File Protection_ audit events.

From - The time that an external user can start viewing a protected file.
To - The time that an external user can no longer view a protected file.

Protected Office Document or Basic File Protection audit events

This table lists audit events that apply to Office documents or other files entered in Basic File Protection:

e For Windows and Mac, audit events apply to Opt-in or Force Protected modes.

e Mobile has Opt-in mode only.

e The Cloud Provider name and Cloud Action events display for XEN audit events. Protected
Office document audit events do not contain this information since protected Office documents
can move to a cloud service provider outside of the bounds of Data Guardian.

Created New
Opt-in mode - logs an event when a user selects Save

As Protected and an Office document is protected.
Force-Protected mode - logs events when Data
Guardian performs a sweep and creates protected

Office documents.
Accessed Open
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Modified

Modified

Accessed
(Windows only

A user opened a protected Office document.

Swept

For Windows, when Force Protected is enabled,
provides data about files that were swept and
converted from unprotected to protected Office.
Updated

Summary of the number of times a file was changed
since the last audit data transmission.
Watermarked

User printed a file or exported a file with a watermark.
Block Copy

Indicates a file where a user tried to copy from a

with Data Guardian protected Office document to an unprotected file and

v2.7 and earlier)
Accessed
(Windows only

was blocked.
Blocked Print
Indicates a file where a user tried to print a protected

with Data Guardian Office document and was blocked.

v2.7 and earlier)

Accessed

Modified

Attempt Access

Modified

Deleted
(Mac only)

Accessed
(Mobile only)

Open
(Windows only)
Sent

(Windows only)
Reply
(Windows only)
Forward
(Windows only)

Column options for System (protected Office documents and Windows)

Detected tampering

Tampering was detected in the .xen file portion of a
protected Office document. This audit event alerts you
to the tampering, but the .xen file cannot be repaired.
For the web portal, tampering is detected on protected
Office documents but not .xen files.

Repaired tampering

Tampering was detected in the wrapper of the
protected Office document, which contains the cover
page that opens in the cloud or on a device that does
not have Data Guardian installed. Data Guardian
repaired the wrapper or cover page.

Request Access

An external user requested a key for a file to which
they do not have access or the access time has expired.
Audit data includes user account, time stamp,
filename, key ID, and geolocation if enabled by policy.
Unprotected:

A Mac user unprotected a protected Office file or a
Basic File Protected one-time decrypt.

Windows - Opt-in mode only, for example, a protected
Office document is open and the user selects Save As
and unprotects it.

Deleted

The user deleted a .xen file from the cloud sync folder.

Geo Blocked

A user outside the geofence tried to access a protected
document, and the attempt was blocked.

Used with Email Action.

Used with Email Action.

Used with Email Action.

Used with Email Action.

Navigate the Dell Server

The following actions relate to the computer, so they have no corresponding Data Guardian action.
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Note: The greyed out options apply to Windows and Data Guardian v2.7 and earlier.

Login

Logout

Blocked PrintScreen

(Windows only and Data Guardian v2.7 and
earlier)

Blocked Process

(Windows only and Data Guardian v2.7 and
earlier)

Process Name

(Windows only and Data Guardian v2.7 and
earlier)

Process Disposition

(Windows only and Data Guardian v2.7 and
earlier)

If a user logged in and did a fast user switch, for example, logged in and then rebooted.

User logged out of a session.
Indicates a file where a user tried to capture a screen while a protected Office document was open
and is blocked.

When policy blocks a specified process executable, indicates a file where a user tried to run that
process executable.

The name of the process that was blocked, for example, Snipping Tool.

Indicates whether the process has exited or has been terminated.

Column options for Beacon only (protected Office documents)

Column options related to geolocation:
IP Address

Routable

Geo Type

Latitude

Longitude

IP Address - When a Beacon event comes in and the Beacon server can determine the location of the
event, it lists the IP address.

Routable - True or False

o If True, geolocation data exists for that IP address and identifies the device's latitude and
longitude based on each operating system's APIs.
Note: If the Routable column lists True, but no geolocation data displays, an error occurred.

o If False, the IP address is non-routable.
Latitude and longitude - The data visualization is based on these coordinates rather than a street
address. Usually, the map visualization displays the location of the device. If a user accesses the
computer remotely and neither GPS or WiFi is available, the map visualization may display the
location based on the remote computer's VPN IP address. The column lists the coordinates as plus (+)
or minus (-), correlating to North, South, East, or West.
Geo Type - Typically, this is Point.
Geolocation for audit events is supported on Windows 8.1 and higher

Column options for Cloud Encryption only (Mac and mobile; Windows with Data Guardian v2.3

and earlier)

Provider
Cloud Name
Cloud Action

Process
Address
Application

Column options related to folder management

(Windows only with Data Guardian v2.3 and
earlier):

Folder Path

Folder Protection
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Cloud storage provider.
The .xen file name.

If a service acts on a .xen file, the Cloud Action column lists the reason. See Cloud Encryption audit

events.

Process - Migration of Cloud Encryption events. A system event from the client performs an action on
the .xen file.

Application - App indicates this is part of the Cloud Encryption application.

If the Folder Management Enabled policy in Data Guardian > Cloud Encryption is enabled for an
endpoint, a user can select the Data Guardian icon in the endpoint's notification area, select Manage
Folders, and manually protect or unprotect a sync client folder. Typically, this policy is enabled for a
manager on a temporary basis.

This audit event allows you to monitor overrides to protected folders and investigate if files that need
to be encrypted are now decrypted.
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Cloud Encryption audit events (Mac and mobile; Windows with Data Guardian v2.3 and earlier)

This table lists audit events that occur for files or folders stored in the cloud sync client folders. Events
may differ slightly for Mac and mobile devices.

Created

Unprotected

Deleted

N/A

Encrypt

In the cloud sync client folder, Data Guardian encrypted a file, creating a
.xen file.

Note: If Cloud Encryption is enabled but Protected Office is disabled and
the user uploads an Office document to the cloud, the file is encrypted as
a .xen file.

Decrypt

Data Guardian decrypted a .xen file.

Deleted

A user deleted a .xen file from the cloud sync folder.

Upload

Lists the folder path and whether the folder was protected.

Column options for Data Classification only (Windows)

Data Classification applies to Windows' Opt-in mode.

Policies: Protected Office Documents, Classification, Data Classification Rules. To include emails that
must comply with Data Classification rule, also enable Email Encryption via Outlook.

For a report, select from these column options.

Classification
Classification File
Classification Path

Classification Action

Classification Triggers

The type of data classification, such as Public, Internal Use, or Restricted.

The name of the file that was audited or encrypted based on a data classification.

The location of the file.

Based on the type of Classification selected and the rules, these actions can display:

. Audit - For data classifications with a priority of two and higher, audit events are created.

. Encrypt - If the Encrypt check box is selected for a classification in policy, the file was

encrypted based on the rules set.
Public classification has no actions.

The rules that cause the actions to occur.

Column options for Protected Email only (Windows)

Email Keyid

Email Subject
Email From

Email To

Email Cc

Email Bcc

Email Attachment
Email Action

The Key ID used to protect the email.
Subject line from the email.

The email address of the person who sent the email.

Email addresses of recipients.
Email addresses of those copied.
Email addresses of those blind-copied.

Names of attachments added to the email.

What the user did with the action. In Protected Office Document audit events, see Opened, Sent,
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Reply, and Forwarded.

Column options for Share only (Windows)

In Column options for all audit events, see User, Logged in User, Client Type, Action. You can

also select File, Email, Group, Status, e

Actions for Share are listed here.

Add

Remove

Request

A protected file or email was shared with a user or a group. This applies °
to pre-share.

Data Guardian Access to a protected file or email has been revoked from °
a user or a group.

A user had to request access to a protected file or email because they °
did not have access.

Examples of Map Visualization and Column Filters

You can alternate between drilling in at the map level and drilling in at the filter and search level. For
example:

4.

Endpoint or endpoint group - If geolocation is enabled, the map displays the location of the
events for each endpoint's .xen and protected Office files. If the map indicates protected files in
an unexpected location, you can use the audit data to identify who modified the file. If several
users modified the file, you can filter the time stamp column to determine the last person who
modified it.

User - You can audit a users' file activities. For example, in Columns, if you select Action, the
protected Office files for that column can list Created or Modified. If you also select Data
Guardian Action, the column lists the reason for a user modifying files, such as Updated or
Swept. For information on Action and Data Guardian Action, see
Options_in_the_Columns_menu, Cloud Encryption audit events, and Protected Office
Document audit events.

In the global view, drill in to a marker cluster and select a blue marker.

Select the Show only visible check box for the columns to list only the files for that audit event.

Click * next to a device, user, file name, or key ID.

For example, click =" next to a user name, then click . next to a file name to zoom to the map
location of the specified user when a specified file was accessed.

Clear Search and press Enter to return to the global map view.

Return to Data Guardian policies.

Get Started with Data Guardian Audit Events

Before you begin, navigate to Populations > Global > Settings and select the Data Guardian Audit
Data Enabled policy for these policy groups:
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Audit Control Policies (for Windows or Mac)
Web Portal Audit Policies

Mobile Audit Control Policies

In the Management Console > Reporting > Audit Events, use these examples to get started.

For detailed information about column options, see Data Guardian and Audit Events.

Audit Protected Office Documents

To audit protected Office documents only:

1.

2
3
4.
5

In Moniker, select Protected Office.

In More, select Action and Data Guardian Action.

In Columns, select Device, User, Timestamp, File Name, and File KeyID.
Optionally, in Grouping, select one item like Device or User to sort.

Select Export File > Excel or CSV to view the data for the Action and Data Guardian Action

columns. For more information, see
Protected_Office_Document_or_Basic_File_Protection_audit_events. Optionally, you can
export the audit events to a SIEM server.

To identify issues, return to the Management Console, click Data Guardian Action, and select:

e Block Copy (for Windows) - indicates a Windows user tried to copy from a protected
Office document and was blocked.

e Geo Blocked (for Mobile) - indicates a mobile user outside a geofence tried to access
a protected document and the attempt was blocked.

If these options display in the Data Guardian Action column, click next to that user or device.
In Data Guardian Action, click Clear selected items and view all the actions by that user or
device to determine a potential issue. For more information, see

Protected Office_Document_audit_events.

To identify issues, select Data Guardian Action and select the following:
e Detected tampering
e Repaired tampering
If these options display, determine any potential issues.

For Windows, in Moniker, select System. In Action, select Login and Logout to identify a
user who logged into the device that has Data Guardian installed.

Analyze the data in the Management Console or select Export File > Excel or CSV where you
can sort the data. Optionally, you can export the audit events to a SIEM server.

Audit events related to external users

In addition to the steps above:

1.

In Columns, select:
e Client Type - to indicate internal or external users.

e From and To - to audit embargo and external users.
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e Request Access - an external user requested access to encryption keys from an
internal user.

2. Analyze the data in the Management Console or select Export File > Excel or CSV where you
can sort the data. Optionally, you can export the audit events to a SIEM server.

Map visualization

You can use this to identify protected Office files in an unexpected location or a non-Data Guardian
Device that tries to access a protected Office document.

For map data to display, you must enable policy. See Global > Settings and select the Data Guardian
Geo Location Audit Data policy from one or more of these:

e Audit Control Policies
e Web Portal Audit Policies
e Mobhile Audit Control Policies

For Beacon events, see the advanced settings for Data Guardian and select the Enable Callback
Beacon policy from one or more of these policy groups:

e Protected Office

e Mobile Client

e Web Portal

1. In Moniker, select Protected Office and Beacon.

2. Inthe global map view, drill in to a marker cluster in an unexpected location and select a blue
marker.

3. Select the Show only visible check box for the columns to list only the files for that audit event.
4. Click % next to a Device, User, File Name, or File KeyID.

For example, click next to a user name, then click next to a file name to zoom to the map
location of the specified user when a specified file was accessed.

5. Analyze the data in the Management Console or click Export File > Excel or CSV where you
can sort the data. Optionally, you can export the audit events to a SIEM server.

6. Clear Search and press Enter to return to the global map view.

Audit Cloud Encryption (Mac or mobile)

To audit protected .xen files only:
1. In Moniker, select Cloud Encryption.
2. In More, select Action and Cloud Action.

3. Initially, in Columns, select Device, User, Timestamp, File KeyID, Provider, Action, and Cloud
Action.

Default Monikers and Columns

If you leave the defaults, all monikers and columns display. Select one item from Grouping to sort
monikers or column options. Select options to minimize the data that displays.

EU General Data Protection Regulation (GDPR)
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For privacy laws in Europe, you can disable audit events. See Enterprise > Global Settings > Settings
> Web Portal Audit Policies.

View Audit Events (Geolocation)

Click Audit Events in the left pane to view geographic map points of file events on computers and
devices running Data Guardian.

For a list of audit event types, see Data Guardian and Audit Events.

For information about exporting audit events to a SIEM server, see Export Events to SIEM Server.

Map points are color coded to indicate the number of audit events in a location:

Q Map point represents a single event

o Fewer than 10 events

10 More than 10 events

. More than 100 events

Use the + and - icons in the upper left corner of the map to zoom in or out. Drag the map to view
different areas of the map.

To view individual events for map points representing multiple events, use the + icon in the upper left
corner to zoom in on the map point. Click an individual map point within the group of points to view the
event.

File named: Omegaew x5 was dcoessed from this
location by wser . at 8516

Event Data
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Event data displays below the map about the events represented on the map. Narrow the amount of
data displayed by using the + icon in the upper left corner of the map to zoom in. Expand the amount of
data displayed by using the - icon in the upper left corner of the map to zoom out.

Filter the event data with the following fields, which are immediately below the map:
Event Type - Data Guardian Cloud Encryption, Protected Office, or Beacon
Timestamp - Event date and time

Device - Device type and identifier (hostname, serial number, IMEI/MEID, CDN)
User - User name in UPN format

File Key ID - GUID that identifies the key used to protect the file

File Name - File name with extension

Action - File action that triggered the event

Data Guardian Action - Action taken by Data Guardian, based on policy and the file action that
triggered the event

Select columns to display from the Columns list.

Export Events to a SIEM/Syslog Server

Integrating with a SIEM/syslog server allows administrators to run customized analytics on threat and
audit data within their environments. The Dell Server supports the export of Advanced Threat
Prevention and Data Guardian events.

To export audit events to a syslog server or to a local file:
1. Inthe left pane, click Management > Services Management.
2. Select the Events Management tab.
3. Select the appropriate option(s):

Export to Local File allows export of audit events to a file. Enter the location in which to store the file.
This option also provides a backup of the audit events database.

Export to Syslog allows specification of the syslog server to which to export the file. If TCP protocol is
not selected, select it.

4. Click Save Preferences.
Export Audit Events with TLS/SSL over TCP

To use TLS/SSL,the syslog server must be configured to listen for TLS/SSL messages. The root
certificate used for the syslog server configuration must be added to the Dell Server Java keystore.

The following example shows necessary configurations for a Splunk server with default certificates.
Configurations are specific to individual environments. Property values vary when using non-default
certificates.

1. Configure the Splunk server to use the Splunk server certificate and root certificate to listen on
TCP for TLS/SSL messages:

$SPLUNK_HOME!\etc\system\local\inputs.conf
[tcp-ssl:<port number>]

disabled =0
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[SSL]
serverCert = $SPLUNK_HOME\etc\auth\server.pem
sslPassword = <password>

requireClientCert = false

$SPLUNK_HOME\etc\system\local\server.conf

[ssIConfig]

sslRootCAPath = $SPLUNK_HOME\etc\auth\cacert.pem
sslPassword = <password>

Restart the Splunk server.

After the restart, splunkd.log will have entries similar to the following:

07-10-2017 16:27:02.646 -0500 INFO TcplnputConfig - IPv4 port 5540 is reserved for raw input
(SSL)

07-10-2017 16:27:02.646 -0500 INFO TcplnputConfig - IPv4 port 5540 will negotiate new-s2s
protocol

07-10-2017 16:27:02.653 -0500 INFO TcplnputConfig - IPv4 port 5540 is reserved for raw input
(SSL)

07-10-2017 16:27:02.653 -0500 INFO TcplnputConfig - IPv4 port 5540 will negotiate new-s2s
protocol

07-10-2017 16:27:02.653 -0500 INFO TcplnputConfig - IPv4 port 9997 is reserved for splunk 2
splunk

07-10-2017 16:27:02.653 -0500 INFO TcplnputConfig - IPv4 port 9997 will negotiate new-s2s
protocol

07-10-2017 16:27:02.653 -0500 INFO TcplnputProc - Creating raw Acceptor for IPv4 port 5540
with SSL

07-10-2017 16:27:02.653 -0500 INFO TcplnputProc - Creating raw Acceptor for IPv4 port 5541
with Non-SSL

07-10-2017 16:27:02.654 -0500 INFO TcplnputProc - Creating fwd data Acceptor for IPv4 port
9997 with Non-SSL

Configure the Dell Server to communicate with the Splunk server and export audit events.

Use the keytool command to add the Splunk server's root certificate (cacert.pem) to the Dell
Server operating system Java keystore. The certificate is added to the operating system Java
keystore and not to the Dell Server application Java keystore.

keytool -keystore <keystore_location> -alias <alias-name> -importcert -file
<certificate_file>

Add the Splunk server's root certificate (cacert.pem) to the Java keystore, which in Windows is
usually located at: C:\Program Files\Dell\Java Runtime\jrel.8\lib\security\cacerts

Modify the Dell Server database to change the SSL value from false to true:
In the database, navigate to the information table, SIEM-specific support configuration.

Change the "SSL":"false" value to "SSL":"true" — for example:
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{"eventsExport":{"exportToLocalFile":{"enabled":"false","fileLocation":"./logs/siem/audit-
export.log"},"exportToSyslog":{"enabled":"true","protocol":"TCP","SSL":"true","host":"yourDellSe
rver.yourdomain.com”,"port":"5540"}}}

Advanced Threat Prevention Syslog Event Types

Following are event types that are supported with the Syslog/SIEM Advanced Threats option.

Application Control

This option is visible when the Application Control feature is enabled. Application Control events represent
actions occurring when the device is in Application Control mode. Selecting this option sends a message to the
Syslog server whenever an attempt is made to modify or copy an executable file, or when an attempt is made
to execute a file from an external device or network location.

Example Message for Deny PE File Change:

CylancePROTECT: Event Type: AppControl, Event MName: pechange, Device Name: WIN-
Jentshed, IP Address: (192.168.119.128), Action: PEFileChange, Action Type: Deny,
File Path: C:\Users‘\admin‘\AppData'\Local\Temp\MyInstaller.exe, SHA256:

B4D4DCe 209567 IECADBSOFET 201044FDB3BOEICFERDT 27EQ3DBISATEOBASEDAA

Example Message for Deny Execution from External Drive:

CylancePROTECT: Ewvent Type: AppControl, Event Name: executionfromexternaldrives,
Device Name: WIN-7entShed, IP Address: (192.168.119.128), Action: PEFileChange,
Action Type: Allow, File Path: ‘\\sharedl\psexec.exe, SHA256:
FEDBABDFAB386B138C2TICEASCEAEISCAZOFF 29D9E3CTAC362521FIFBO2678D5

Devices
Select this option to send device events to the Syslog server.

e When a new device is registered, two messages for this event are received: Registration and
SystemSecurity.

Example Message for Device Registered Event:

Event Type: Device, Event Name: Registration, Device Name: WIN-5SNATVOHBUU

Event Type: Device, Event Name: SystemSecurity, Device Name: WIN-

SSNATVOHBUU, Agent Version: 1.1.1278.58, IP Address: (16.3.8.154), MAC Address:
(8@5856881877), Logged On Users: (WIN-SSNATVQHBUU\Administrator), 05: Microsoft
Windows Server 2888 R2 Standard Service Pack 1 x64 6.1.7681

e When a device is removed.

Example Message for Device Removed Event:
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Event Type: Device, Event Name: Device Removed, Device Names: (
), User: (: > -

e When a device’s policy or logging level has changed.

Example Message for Device Updated Event:

Event Type: Device, Event Name: Device Updated, Device Message:
Renamed: "WIN-SS5NATVQHBUU® to "WIN-2008R2-IRV1"; Policy Changed: "Default” to
"IRVPOlicyl";

Memory Protection

Selecting this option logs any Memory Exploit Attempts that might be considered an attack from any of
the Tenant's devices to the Syslog server.

There are four types of Memory Exploit actions:

None: Allowed because no policy has been defined for this violation.

Allowed: Allowed by policy.

Blocked: Blocked from running by policy.
e Terminated: Process has been terminated.

Example Message of Memory Protection Event:

Cyl CylancePROTECT: Event Type: ExplolitAttempt, Event Name: blocked, Device Name:
WIN-7entShe4, IP Address: (192.168.119.128), Action: Blocked, Process ID: 3884,
Process Name: C:'AttackTested.exe, User Mame: admin, Violation Type: LSASS Read

Script Control

Selecting this option logs any newly found scripts that have been blocked or have triggered an alert to
the Syslog server.

Syslog Script Control events contain the following properties:
e Alert: The script is allowed to run. A script control event is sent to the Dell Server.
e Block: The script is not allowed to run. A script control event is sent to the Dell Server.

Example Message of Script Control

CylancePROTECT - - - Event Type: ScriptControl, Event Name: Blocked, Device Name:
Fake Device, File Path: d:‘\windows‘\system32\windowspowershelllv2.i\newlyMade.vbs,
Interpreter: active, Interpreter Version: 6.1.7688.16385 (win7_rim.898713-1255)

Threats

Select this option to log any newly found threats or changes observed for any existing threat, to the Syslog
server. Changes include a threat being Removed, Quarantined, Waived, or Executed.
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There are five types of Threat Events:

e threat_found: A new threat has been found in an Unsafe status.

threat_removed: An existing threat has been Removed.
e threat_quarantined: A new threat has been found in the Quarantine status.
e threat_waived: A new threat has been found in the Waived status.

e threat_changed: The behavior of an existing threat has changed (examples: Score, Quarantine
Status, Running Status).

Example Message of Threat Event:

Event Type: Threat, Event Name: threat_found, Device Name: . -

1, IP Address: (W= - ), File Name: virusshare_8@fbcdccabd2774b58a9f71874b79bd9,
Path: c:\ruby\host_automation\test\data\test_files\, SHAZS6:
1EBF3BBAG1ATER@23AAB3BRCB24938536A1087BCEIFCCE442E137FB2A7DD518B, Status: Unsafe,
Cylance Score: 188, Found Date: 6/1/2815 18:57:42 PM, File Type: Executable, Is
Running: False, Autc Run: False, Detected By: FileWatcher

Threat Classifications

Hundreds of threats are classified each day as either Malware or Potentially Unwanted Programs (PUPS). If
this option is selected, you subscribe to be notified when these events occur.

Example Message of Threat Classification:

Event Type: Threat(Classification, Event Name: RessarchSaved, Threat
Class: Malware, Threat Subclass: Worm, SHA256:
1218493137321C1D1FE97BRC2SBEF17CDDOBESCOSBE4BADDEBS1EACEFO794F 65

Security Information and Event Management (SIEM)
Specifies the type of Syslog server or SIEM that events are to be sent to.
Protocol

This must match what is configured on your Syslog server. The choices are UDP or TCP. UDP is generally not
recommended as it does not guarantee message delivery. Dell recommends TCP (default).

TLS/SSL

Only available if the Protocol specified is TCP. TLS/SSL ensures the Syslog message is encrypted in transit
from Advanced Threat Prevention to the Syslog server. Dell encourages customers to select this option.
Ensure that the Syslog server is configured to listen for TLS/SSL messages. To use TLS/SSL, it is necessary to
configure the Syslog server and import certificates. For more information, see Export Audit Events with
TLS/SSL over TCP.

IP/Domain

Specifies the IP address or fully-qualified domain name of the Syslog server that the customer has setup.
Consult with your internal network experts to ensure firewall and domain settings are properly configured.

Port
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Specifies the port number on the devices that the Syslog server listens for messages. It must be a number
between 1 and 65535. Typical values are: 512 for UDP, 1235 or 1468 for TCP, and 6514 for Secured TCP
(example: TCP with TLS/SSL enabled).

Severity

Specifies the severity of the messages that should display in the Syslog server. This is subjective, and it may
be set to whatever level preferred. The value of severity does not change the messages that are forwarded to
Syslog.

Facility

Specifies what type of application is logging the message. The default is Internal (or Syslog). This is used to
categorize the messages when they are received by the Syslog server.

Testing the Connection

Click Test Connection to test the IP/Domain, Port and Protocol settings. If valid values are entered, after a
couple of moments, a success confirmation displays.

Advanced Threat Prevention Syslog IP Addresses
Syslog server IP addresses to allow, by region:

US (includes my.cylance.com and my-vs2.cylance.com):

52.2.154.63
52.20.244.157
52.71.59.248
52.72.144.44
54.88.241.49

AU (my-au.cylance.com):

52.63.15.218
52.65.4.232

EU (my-vs0-eucl.cylance.com and my-vsl-eucl.cylance.com):

52.28.219.170
52.29.102.181
52.29.213.11
Note: This IP Address should remain static.
For the latest IP addresses for Syslog messages, contact Dell ProSupport.

Management

Commit Policies

Uncommitted policies display in a badge icon in the top left of the Management Console. Click the
badge icon to navigate to Management > Commit.

To commit polices that have been modified and saved:
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1. Inthe left pane, click Management > Commit.

2. In Comment, enter a description of the change.

Best practice: add a comment about the changes that are committed.
3. Click Commit Policies.

A policy publication/commit occurs when an administrator clicks Commit Policies. The following
information displays:

Pending Policy Changes - The number of policy changes ready to commit.

Date Committed - Date and time the policies were committed.

Changed by - User name of the administrator who performed the policy commit.
Comment - Any comments that were added when the polices were committed.

Version - The number of policy saves since the last policy commit plus the previous Version.

Log Analyzer

Log Analyzer gives you the power to search logs by message priority level, date and time periods, and
occurrences of usernames and hosts.

To view or export logs:
1. Inthe left pane, click Management > Log Analyzer.
2. Select a Category.

The Categories are Admin Actions, Shield for Server Events, Policy, Advanced Threat Events,
System Logs, Whitelist, and Full Access List.

3. To narrow the results, select from these optional filters:

e Priority - Choose DEBUG, INFO, WARN, ERROR, or FATAL. FATAL returns fewest entries;
DEBUG returns the greatest number of entries.

e And more severe - Select this option to include all areas of greater severity than the priority level
you selected.

e Date Range - Enter a Start Date and End Date to limit results to entries that occur between these
dates. To insert dates into these fields, click the calendar icons to the right of the fields.

e Time Range - If you entered a Date Range, further narrow the entries by entering a Start Time and
End Time. To insert times into these fields, click the calendar icons to the right of the fields.

e Username and Host - Enter a either a username or host or both.
4. Click Search.
5. To sort the results in ascending order by column, click the heading of the column to sort.

6. To export the results to an Excel or CSV file, pull down the Export File list and select Excel or
Csv.

Exported files can hold up to 100,000 records.

Recovery
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Recover Data - Encryption External Media Authentication Failure

For the steps to perform a recovery on removable media when a user is no longer associated with your
organization, see Encryption External Media Recovery for User Removed from Database.

Encryption External Media encrypts data on removable media, as defined by policy. There may be
several conditions where access to encrypted data needs to be regained. In general, these scenarios
fall into two categories:

e The Encryption External Media password is lost or forgotten

e The Encryption External Media software or encryption key material has been lost or corrupted
on the device

If more than one Dell Server is part of a federation, to perform Encryption External Media Recovery
across Dell Servers in the federation, see Enable Federated Key Recovery.

Manual Authentication when Encryption External Media Password is Lost or Forgotten
If a user has lost or forgotten a password, manual authentication is necessary.

1. The user is prompted for their password. Since the password is not available, the user clicks |
forgot.

2. The user is given another opportunity to try again. If the user clicks Yes - | forgot, manual
authentication begins (or the manual authentication begins upon the set number of retries
allowed).

3. The user is instructed to contact their administrator and inform them that they need to manually
recover Encryption External Media for Windows.

4. As a Dell administrator, log in to the Management Console.
5. Inthe left pane, click Populations > Users.

6. Enter afilter to search for the user. The wild card character is *. You can enter Common Name,
Universal Principal Name, or sAMAccountName.

7. Click ~. A user or list of users displays, based on your search filter.
8. Locate the appropriate user and click the Endpoints tab.
9. Locate the appropriate Shielded Endpoint.
10. Under Actions, click the Recover link.
Tip: Numbers are red and letters are blue.

11. Ask the user for the Shield ID and verify that it is correct or enter it into Shield ID. Shield IDs do
not contain the letters B, O, Q, and S.

12. Ask the user for the 8, 16, or 32-character Endpoint Code (not case sensitive) and enter it into
the appropriate field. Endpoint Codes contain only the letters A-F.

13. Ask the user for the Key ID and enter it into the appropriate field (if your organization allows
non-domain user activation, the Key ID is required.

14. Click Generate Access Code. The Restore User Access page displays the directory user alias
associated with the Encryption client, along with an access code.

15. Confirm to your satisfaction that the request is coming from the directory user alias shown.

This is especially important if recovering media that may have been given to another user. Dell
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recommends that you set a help desk policy for how to handle requests from users other than
those who originally copied the data.
16. Do one of the following:
e To allow the user to access the endpoint, click Activate.
e Tonot allow the user to access the endpoint, click Cancel.

17. If the requester is the device authorized user, ask the user to enter the Access Code (not case
sensitive) on the endpoint and click OK. The Access Code policies of the user affect this
process (for example, how many attempts the user has to enter the code correctly).

18. When the user successfully enters the Access Code, the Encryption client changes the Current
Shield State policy to Activate, and the successfully entered Access Code is no longer valid.
Instruct the user to click OK to close the dialog.

19. In the left pane, click Management > Commit.

20. Click Commit Policies.

Once manual authentication is successful, the user is directed to reset their password. Depending on how
policies are set, one of the following three options are displayed. The user enters a new password and confirms
it, then clicks OK or Cancel.

Depending on policies set, the user may be prompted to type this password when using this removable media
in other computers.

If the policy is set to
block all access to
removable media until
authenticated/encrypted
and the user clicks
Cancel, they cannot
access any files on this
removable storage.

If a user re-uses a
password that has been
used too recently, a
dialog displays asking
them to use a different
password.

If a password does not
meet the criteria set by
policy, a dialog displays,
outlining the password
criteria.

If the policy gives read-
access to removable
storage until
authenticated/encrypted
and the user clicks
Cancel, they can
read/delete existing files
on this removable media
, but cannot edit/add files
to this removable
storage.

If a user re-uses a
password that has been
used too recently, a
dialog displays asking
them to use a different
password.

If a password does not
meet the criteria set by
policy, a dialog displays,
outlining the password
criteria.

If the policy gives full
access to removable
media until
authenticated/encrypted
and the user clicks
Cancel, they have full
access to unencrypted
files on this removable
media, but cannot access
encrypted files.

If a user re-uses a
password that has been
used too recently, a
dialog displays asking
them to use a different
password.

If a password does not
meet the criteria set by
policy, a dialog displays,
outlining the password
criteria.

The user may now use the removable media as usual.

If manual authentication is not successful, the device is disabled according to policy, as follows:

e The policy could be set to wait (cooldown) between unsuccessful manual authentication attempts.
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The policy may be set to delete the encryption key material and prevent any access to encrypted files
on this removable media . In this case, the user need to contact an administrator again for instructions

to re-enable access.

Restore Lost Encryption Key Material

If encryption keys have been deleted on the removable media (because of failed manual authentication,
accidentally deleting a necessary file, a change in policy), the encrypted data is inaccessible until an
authorized user reinitializes the encryption key material.

A dialog displays, notifying the user that key material is missing. Click Yes to use the self-healing
feature of Encryption External Media or click No.

If the policy blocks all
access to removable
media until encrypted
and the user clicks No,
they cannot access this
removable media .

If the policy gives read-
access to removable
media until encrypted
and the user clicks No,
they have read-access to
unencrypted data on this
media, but no access to

If the policy gives full
access to removable
media , whether or not
encrypted and the user
clicks No, they have full
access to unencrypted
data on this media. They

cannot access encrypted
data.

encrypted data.

Occasionally, based on policies set, encryption keys cannot be reinitialized on the computer that the
removable media is inserted in. If policy permits, the user can insert the media into any Dell-encrypted
computer where the original user is logged in, to reinitialize the encryption keys. If policy does not permit
this, it must be inserted into the originally encrypting computer, with the originally specified user name.

On rare occasions, when encryption key material is lost, the Encryption client cannot automatically
locate the necessary information. Use the following process to recover encrypted data.

1. Attach the device to a Windows computer that is not running the Encryption client.
2. Copy all folders from the device onto the Windows computer.

3. Use WSScan to determine the DCID of the encrypted data.
4

Follow the process for recovering access to encrypted data on Windows computers. Use the
DCID obtained from WSScan for the RecoveryID.

Encryption External Media Recovery for User "Removed" from Database

If a user is removed from Active Directory (such as an employee termination), when the Security
Management Server gets the update from AD, the user is marked as “removed” in the database, so that
they do not continue to get policy updates and endpoint access. However, if an Administrator needs to
recover access to data on removable storage that was encrypted by the removed user, the
Administrator does not know the user's password, and therefore cannot access the external media.

Note that the Administrator will need to repeat the following process for each piece of removable
storage encrypted by the removed user, since the recovery code is per endpoint and does not apply to
every piece of media owned by that user.

The following are SQL queries to accomplish "unmarking” the removed flag for the user in the database.

1. Follow the steps below. The user in this example is "games".
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1. select * from entity where displayname like "%(gam%'

EID CID EntityType ESubType FRemowved Hidden UID DizplayName

g8 IMRAJEEC 1 i} 1 o ENTLDCHNX - 010 g ames[gemes@ test.locsl)
2. update entity set removed = '0' where EID = '3°'

(L row(z) affected)

3. Then to verify:

zelect * from entity where EID = '3'
EID CID EntityType ESubType Removed Hidden UID DisplayName
8 AMBELJEEC 1 o o o ENTLDCHNX - 010 g ames (gemes@test.local)

The next triage resets the "removed" flag.

2. Perform a recovery through Security Management Server (meaning, lock yourself out of the
removable storage by entering an incorrect password until the recovery screen displays).

Generate an Access Code through the Security Management Server.
3. Reset the Encryption External Media password.

4. IMPORTANT - Reverse the process from step 1 to re-mark the flag as "removed" in the
database.

Enable Federated Key Recovery

If more than one Dell Server is part of a federation, to perform Encryption External Media Recovery
across Dell Servers in the federation, enable federated key recovery:

1. Navigate to <Security Server install dir>\conf\ and open the federatedservers.properties file.

2. Update the server.code property with a new a code, password or passphrase to be shared
across Dell Servers in the federation. Enclose the code, password, or passphrase within a new
CLR() tag, to replace the ENC() tag.

Example: server.code=CLR(mypassword)
3. List all Dell Servers to be federated in the server uris property, delimited by a comma.

Example:
server.uris=https://serverl.company.com:8443,https://server2.company.com:8443

4. Save and copy the federatedservers.properties file to all Dell Servers that are part of the
federation.

5. Restart all Security Servers in the federation.

The restart converts the CLR() tag to the encrypted tag, ENC(), in the
federatedservers.properties file.

Recover Data - BitLocker Manager

See the Recovery Guide for the most up-to-date recovery instructions.

Recover Endpoint

To download encryption keys of a managed or removed endpoint:
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NOTE: Select Include Removed Endpoints to display endpoints that were previously removed.
In the left pane, click Management > Recover Endpoint.
Enter the hostname and click Search.

Click Recover next to the endpoint.

A 0 poPE

Enter a password then click Download.
5. Copy the recovery file to the endpoint and run the file.
Windows Recovery

For Windows Recovery, follow the instructions in the Recovery Guide. The latest Recovery Guide is
available at these locations:

Encryption
Endpoint Security Suite Enterprise

SED Recovery
For information about SED authentication failure or SED endpoint recovery, see SED Recovery.
Encryption External Media Recovery

For information about recovering after Encryption External Media authentication failure, see Encryption
External Media Authentication Failure.

Mac Recovery

See the Encryption Enterprise for Mac Administrator Guide, available at dell.com/support for the most
up-to-date recovery instructions.

License Management

License Management

To view usage of Client Access Licenses (CALs) that you own and upload new licenses, click
Management > License Management.

Upload Client Access Licenses

You received CALs separately from the installation files, either at the initial purchase or later if you
added additional CALs.

1. Inthe left pane, click Management > License Management.
2. Under Upload Licenses, click Choose File to browse to and select the saved CAL.
View or Add License Notifications
Through Notification Management, you can set up notifications of license usage or expiration.
In the left pane, click Management > Notification Management.
Related topics:
CAL Information

Notification Management
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Client Access License (CAL) Information

Upon log in to the Management Console, if there is a problem with your CAL, an error message displays
(typically, the error states that the Dell Server has exceeded the maximum number of authorized client
licenses). The next step is to review your CALs to ensure that your enterprise has the appropriate
number of CALs to client ratio (1-to-1 ratio).

If authorized CALs exceed 5% of that specific CAL total, new client activations for that specific product
is blocked until the license key is brought into compliance. No other client or Dell Server functions is
impacted when a license key is in the over 105% state. Two separate warning messages are displayed,
the first warning message is when the CAL reaches 99% of the authorized licenses, the second when
the CAL count reaches or exceeds the 105% total.

For example:
e Authorized CAL for Dell Encryption (Windows): 5000 user licenses

e First warning message from Dell Server and an email message is sent to the administrator:
CAL count reaches 5000

e Second warning message from Dell Server and an email message is sent to the administrator:
CAL count reaches 5250

If a client has previously been activated and inventory records exist, then it is not blocked from any re-
activation. However, if the CAL authorized count is exceeded during this process, new activations are
blocked for the specific CAL that is in the over 105% state.

Licensing
1. License structure:

a. Disk Encryption (DE) — Dell Encryption (Windows and Mac), Encryption External Media
, SED Management, Full Disk Encryption, BitLocker Manager.

b. Encryption External Media (EME)
c. Dell Data Guardian (CE)

d. Threat Protection (TP) - includes Malware Protection and/or Client Firewall and/or Web
Protection features

e. Advanced Threat Prevention (ATP) - includes optional Client Firewall and/or Web
Protection features

2. Dell Digital Delivery of entitlements
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License Management

Upload Volume Licenses

‘Choose File

Client Volume Licenses Owned
Alert Type Valid From Valid To Count Status
-
OK Advanced Threat Prevention 10  None
C Data Guardian 2 ane
OK Thre. otection [Malware and e and/or Web Contre 12/3111 6:00 P 12/31/9999 5:59 250 None
OK Dell Encryption 12/31/1752 6:00 PM 12/31/9999 5:5% PM 250  Morne
OK Dell Encryption (BitLocker Manager, 12/31/1752 6:00 PM 12/31/9999 3:39 PM 230 MNone
-
On The Box Licenses Collected
Type Service Tag
Fire and/or Web Contre o
e and/or Web Contre
-
v | items per page 1-12of 12 itemn: w]
Total Volume and On the Box Seats Used
Alert Type Total Used
OK nerypti 122
OK 0
oK 6
OK or Web Contrc
OK 2

Upload Client Access Licenses

You received CALs separately from the installation files, either at the initial purchase or later if you
added additional CALs.

1. Inthe left pane of the Management Console, click Management > License Management.
2. Under Upload Licenses, click Choose File to browse to the location of the saved CAL.
Related topics:
CAL Information

License Management

Services Management

Services Management

From the left pane of the Management Console, select Management > Services Management. The
following options are available:
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Provision or Recover the Advanced Threat Prevention service - After the service is provisioned,
clients are automatically provisioned with Advanced Threat Prevention. For more information, see
Provision or Recover Advanced Threat Prevention Service.

Enroll to receive Advanced Threat Prevention agent auto updates - After enrollment, clients can
automatically download and apply updates from the Advanced Threat Prevention server. For more
information, see Enroll for Agent Auto Update.

Export audit events - Audit events can be exported to a syslog server or to a local file. For more
information, see Export Events to SIEM Server.

Provision or Recover Advanced Threat Prevention Service

The Advanced Threat Prevention service is provisioned and recovered through the Services
Management Advanced Threats tab. Only system administrator can provision and recover the service.

After provisioning is complete, the contact information of the administrator who provisioned the service
is displayed.

The guided setup prompts the system administrator to back up the Advanced Threat Prevention
certificate at this time.

Provision service
To provision the Advanced Threat Prevention service:
1. Inthe left pane of the Management Console, click Management > Services Management.
2. Select the Advanced Threats tab.
3. Click Setup Advanced Threat Prevention Service.
4. Follow the guided setup and complete the necessary fields.

Regional provisioning to support geographical data centers is available for NA (North America), EU
(EMEA), and AU (APAC).

Download and back up the Advanced Threat Prevention certificate in a safe location, separate from the
server running the Dell Server. The backed up certificate is required if a service recovery is necessary.

Clients are automatically provisioned with Advanced Threat Prevention.
After provisioning is complete, the Setup link no longer displays.
Recover service
You will need your backed up certificate to recover the Advanced Threat Prevention service.
1. Inthe left pane of the Management Console, click Management > Services Management.
2. Click Recover Advanced Threat Prevention Service.

3. Follow the guided service recovery dialogs and upload the Advanced Threat Prevention
certificate when prompted.

Enroll for Advanced Threat Prevention Agent Auto Updates

You can enroll to receive Advanced Threat Prevention agent auto updates. Enrolling to receive agent
auto updates allows clients to automatically download and apply updates from the Advanced Threat
Prevention server. Updates are released monthly.

Receive agent auto updates

127



Navigate the Dell Server

To enroll to receive agent auto updates:

1. Inthe left pane of the Management Console, click Management > Services Management.

2. Onthe Advanced Threats tab, under Agent Auto Update, click On then click Save
Preferences.

Stop receiving agent auto updates

To stop receiving agent auto updates:

1. Inthe left pane of the Management Console, click Management > Services Management.

2. Onthe Advanced Threats tab, under Agent Auto Update, click Off then click the Save
Preferences.

Events Management - Export Audit Events to a SIEM Server

To export audit events to a syslog server or to a local file:

1. In the left pane, click Management > Services Management.
2. Select the Events Management tab.
3. Select the appropriate option(s):

Export to Local File allows you to export audit events to a file. Enter the location in
which to store the file. This option also provides a backup of the audit events database.

Export to Syslog lets you specify the syslog server to which to export the file. If TCP protocol
is not selected, select it.

4, Click the Save Preferences button.

Product Notifications

You can enroll to receive notifications of product updates, recommended configuration changes, and
relevant knowledge base articles.

Receive product notifications
To enroll to receive product notifications:
1. Inthe left pane, click Management > Services Management.
2. Select the Product Notifications tab.
3. Click On then click Save Preferences.

Note: The product notification switch does not display when servers are configured in disconnected
mode.

Stop receiving product notifications
To stop receiving product notifications:

1. Inthe left pane of the Management Console, click Management > Services Management.
2. Select the Product Notifications tab.

3. Click Off then click Save Preferences.
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Enable Data Guardian Access Groups

You can allow access to selected user groups to collaborate on encrypted data by updating Access
Groups preferences. Users outside that group cannot access or view the data unless the owner of the
file grants access. See Configure_Access_Groups.

Note: Access Groups were initially named Circle of Trust. The Management Console is in the process
of updating the user interface.

To enable Access Groups:
1. Inthe left pane, navigate to Management > Services Management.
2. Select the Data Guardian tab.
3. For Access Groups, click On.
Important: Currently, if you enable Access Groups, you cannot disable it.
3. Click Save Preferences. A check box displays.

4. Optionally, if you are implementing a transitional period for an initial implementation, click the
Auto access for swept files check box. When the transitional period is complete, clear the check
box.

5. Click Save Preferences.

6. Continue with Configure Access Groups.

Notification Management

Notification Management
The Notification Management page lets you manage email notifications.
To add an email notification:
1. Inthe left pane, click Management > Notification Management.
2. Click Add and enter the following information:
Email: Enter or select your email address.

Notification Type: Select the type of alert to add.

Priority Level: Select the priority levels of notifications.
Email Frequency: Select how often alerts of this type. The default frequency is 24 hours.
3. Click Add when complete.
To edit an alert:
e Select the alert to change, click Edit, make the changes, and press Enter.
To delete an alert:
e Select the alert to delete, and click Delete.
Related topics:

License Management

Enable SMTP Server for Email Notifications
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Enable SMTP Server for Email Notifications
If using Data Guardian, these settings are automated by using the Server Configuration Tool.

Use this procedure to enable the SMTP server for email notifications for purposes outside of Data
Guardian.

When configuration changes are complete, restart the Security Server service. The Security Server
service must be restarted for the settings to be updated.

Product Notifications

You can enroll to receive notifications of product updates, recommended configuration changes, and
relevant knowledge base articles.

Receive product notifications
To enroll to receive product notifications:
1. Inthe left pane, click Management > Services Management.
2. Select the Product Notifications tab.
3. Click On then click Save Preferences.

Note: The product notification switch does not display when servers are configured in disconnected
mode.

Stop receiving product notifications
To stop receiving product notifications:
1. Inthe left pane of the Management Console, click Management > Services Management.
2. Select the Product Notifications tab.
3. Click Off then click Save Preferences.

Data Guardian Management

Registration Access
To allow or block Data Guardian access for users who are not in the organization's domain:
1. Inthe left pane, click Management > Data Guardian Management.
2. Select the Registration Access tab.
3. Click Add.
4. Select Registration Access Type:
Blacklist - Blocks registration and file access for a user or a domain.

Full Access List - Grants registration and file access for a user or domain. If the user or domain
is also on the blacklist, no access is granted.

5. Enter either a domain to set access for the entire domain, or email address to set access only
for a single user.

6. Click Add.
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External users can also be added to the blacklist from the Audit Events page, if the user is associated
with an audit event:

1.

2.

Key Request

In the left pane, click Reporting > Audit Events.

In the user column, click |-:_|= to the right of the user name to add to the blacklist.

Data Guardian external users can request a key from an internal user to access a protected Office
document. Key requests are shown on the Key Request Management page until the internal user
approves or denies the request. After 48 hours, key requests are removed from the list. At that time,
external users can request access again.

If the internal user is not available or has left the enterprise, an administrator can use this page to
approve or deny requests.

Columns include:

User - external user making the request
File Name

Request Date

Request Expiration

File Owner - internal user

Approve/Deny

To approve or deny a request:

1.
2.

4.

In the left pane, click Management > Data Guardian Management.

Select the Key Request tab.

Search for specific requests or select requests in the list.

To select multiple requests to approve or deny, press Ctrl and then select the requests.

To select multiple sequential requests, select the first request and then press Shift and select
the last request in the sequential list.

Click Approve or Deny.

To approve or deny a single request, click approve & or deny @ icon at the right end of the request.

Key Revocation

The administrator can revoke access to files, at both the user level and the file level.

To revoke access:

1.

2
3.
4
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Key Management
The administrator can manage key ownership.
The keyid is available here:

e Reporting > Audit Events > Columns > File KeyID. See Options_in_the Columns_menu.

e On the client side, a user can right-click a protected file to see the KeyID.
To find/change the owner for a key:

1. Inthe left pane, navigate to Management > Data Guardian Management.

2. Select the Key Management tab.

3. Enter the keyid and click Find Owner. The owner displays in the Current Owner field.

4. Inthe New Owner field, enter the email address of the new owner and click Change Owner.
To change ownership for all keys:

1. Inthe left pane, navigate to Management > Data Guardian Management.

2. Select the Key Management tab.

3. Select Change Ownership for ALL keys.

4. Enter the email address of the current owner.

5. Enter the email address of the new owner.

6. Click Change Owner.

If changing ownership for all keys, a table, Key Changes in Progress, displays at the bottom during the
transfer. When complete, this content is removed. The Log Analyzer displays a log of the entries in the
Transfer of keys column that have changed ownership.

Web Portal
To access the Web Portal URL:
1. Inthe left pane, click Management > Data Guardian Management.
2. Select the Web Portal tab.

Portal URL - The URL used to access the enterprise's Data Guardian web portal. After the portal URL is
entered and saved, it is displayed on the Management Console's Downloads page. Additionally, it is
displayed on the cover page of a protected file if the user does not have access to the key. This portal
URL also displays on the Activation page after a new user registers.

Change Superadmin Password

1. Inthe masthead at the top of the screen, click the gear icon and select Change superadmin
password.

2. Enter the current password.
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3. Enter the new password.

The new password must be at least 6 characters, contain at least one capital letter and one of
these characters: ~@#%$%"*()|?'{}[].

4. Confirm the new password.
5. Click Update.

After three failed login attempts, the superadmin account is locked for five minutes. To change these
settings, see Set or Change Account Lockout Settings.

Change Account Lockout Settings

After three failed login attempts, the superadmin account is locked for five minutes. To change these
settings:

1. Open <Security Server installation folder>\conf\application.properties.
2. Edit the following property to change the maximum allowed number of failed login attempts.
login.cooldown.max.failed.attempts=3

3. Edit the following property to change the length of lockout time after the maximum allowed
number of failed login attempts is reached.

login.cooldown.minutes=5
4. Save the file, and restart the Security Server.

Downloads

Endpoint Software
To download the latest version of Dell Encryption:
1. Inthe left pane, click Management > Downloads.
2. Select the Endpoint Software tab.
3. Click Navigate to Download.

The Download tab is only available if the user has been assigned a security and a system
administrator role.

To download the latest version of Dell Data Guardian:
1. Inthe left pane, click Management > Downloads.
2. Select the Endpoint Software tab.
3. Choose from the following:
e Navigate to Download (for Windows or Mac)
e Download on the App Store (for iOS)

e Get it on Google Play (for Android)

133



Navigate the Dell Server

The Download tab is only available if the user has been assigned a security and a system
administrator role.

To download the latest version of Endpoint Security Suite Enterprise (ESSE):
1. Inthe left pane, click Management > Downloads.
2. Select the Endpoint Software tab.

3. Click Dell Support to contact Dell for access to Dell Endpoint Security Suite Enterprise.
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Manage Security Policies

You can apply security policies at the Enterprise, Domain, User Group, User, Endpoint Group, and Endpoint

levels. Default policy settings allow your enterprise to get started with Dell security, but you should customize

the security and configuration settings. If you've migrated from an earlier version of Dell Server, your policy
settings have been migrated for you.

Security policies are grouped by technology. Click a technology group to view its policies and policy

descriptions.

Windows Encryption
Full Disk Encryption (FDE)
Self-Encrypting Drive (SED)
Policy-Based Encryption

BitLocker Encryption
Server Encryption

Authentication

Pre-Boot Authentication

Windows Authentication

Data Guardian
Cloud Encryption

Protected Office Documents

Classification

Mobile Client

Web Portal

Settings

Threat Prevention

Advanced Threat Prevention

Threat Protection
Web Protection
Client Firewall

Protection Settings

Removable Media
Encryption
Windows Media Encryption

Mac Media Encryption

Media Encryption Settings

Global Settings
Settings

Mac Encryption
Dell Volume Encryption

Mac Global Settings

Port Control

Windows Port Control

Windows Device Control

The following override information displays at the top of the Security Policies page:

Override count - the number of policy settings that are changed from their default settings.

Uncommitted overrides - the number of changes from default settings that are not yet committed.

NOTE: The Security Policies page for a population displays overrides to localizable policies in the browser

language only.
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Icons and their meanings:

® The master switch for policies in the subgroup is On, which means the policy group is enabled.
Policies in the group are sent to clients when policies are committed.

Policies in the subgroup are not enabled.

> At least one default setting in the policy group has been overridden.
O Group of policy settings that has no master switch.
(0 The policy change is not yet committed.

The policy value can be localized, so that policies on the endpoint computer display in a
selected language. For more information, see Localize Policies Displayed on the Endpoint
Computer and Localizable policies.

o The default setting of a localizable policy is overridden.

O X A localizable policy change is not yet committed.

To remove a policy override, hover over the red flag next to the policy name. The red flag becomes a red X.
Click the red X to revert to the default value.

. Block Unmanaged Access to Domain o
&) X Credentials

| Click to delete override kberﬂ‘t on File
ernatio

Group precedence

You can Modify Group Precedence. Group precedence creates a weight associated with the specific group it is
assigned to, and that weight is used in policy arbitration for all policy overrides.

Related topics:

View or Modify Enterprise-Level Policies

View or Modify Domain Policies and Information

View or Modify User Group Policies and Information

View or Modify User Policies and Information

View or Modify Endpoint Group Policies and Information

View or Modify Endpoint Policies and Information

Localize Policies Displayed on the Endpoint Computer

Localizable policies are indicated by:

To localize policies that are displayed on the endpoint computer, follow these steps:

1. Inthe left pane, expand Populations and select a population.
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2. Click the Security Policies tab.
3. Select the technology group, such as Windows Encryption, or policy group, such as Policy-
Based Encryption, to modify.
4. Select a language for localizable policies from the list at the top right of the screen.
{ED Show default settings
Policies localized in [EE IG——
French
German
Italian
Spanish
Japanese
Korean
v | Portuguese
Braziliam Portuguese
5. Enter text that is in the language you selected for localizable policies. Navigate the populations
and technology groups as necessary to localize all desired policies for that language.
6. Click Save.
7. To update policies in a different language, select the language from the list, enter localized text
for all desired policies, and click Save.
Save policy changes before selecting another language in the list. A different language cannot
be selected until policy changes are saved.
8. When finished, select the desired language. Any changes made to localizable policies are
made in the language that displays.
Policies localized in |English v|

NOTE: The Security Policies page for a population displays overrides to localizable policies in the

browser

language only.

Localizable Policies

Localizable policies are indicated with by

Available languages:

English Korean

French Brazilian Portuguese
German Portuguese

Italian Spanish

Japanese

For instructions about localizing policies, see Localize policies.
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The following policies can be displayed in a selected language on the endpoint computer:

Enterprise Level

Technology Group

Windows Encryption > Full Disk Encryption

Windows Encryption > Self-Encrypting Drive
(SED)

Windows Encryption > Policy-Based
Encryption

Windows Encryption > BitLocker Encryption

Authentication > Windows Authentication

Removable Media Encryption > Windows
Media Encryption

Data Guardian > Cloud Encryption

Policy

Support Information Text

Full Disk Encryption Title Text

Legal Notice Text

Self Help Questions

Support Information Text

PBA Title Text

Legal Notice Text

Self Help Questions (Pre-8.0 clients)

Common Encrypted Folders

User Encrypted Folders

OS Update Encryption Rules

Application Data Encryption List

Managed Services

Default Folder Location to Save Recovery
Password

Recovery Questions for Windows Authentication
(check box selections)

EMS Device Whitelist

EMS Access Code Required Message

EMS Access Code Failed Message

Help File Name
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Data Guardian > Protected Office
Documents

Data Guardian > Mobile Client > Cover Page

Data Guardian > Web Portal
Users Level
Technology Group

Windows Encryption > Policy-Based
Encryption

Removable Media Encryption > Windows
Media Encryption

Endpoints Level
Technology Group

Windows Encryption > Self-Encrypting Drive
(SED)
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Help File Contents
Excluded Folders

Excluded Files

Office Protected Clip Board Unauthorized Text

Office Protected Document Tamper Prompt
Offline Key Generation Escrow Reminder Text
Office Protected Files Cover Page Notice

Office Protected Files Cover Page Acceptance
Text

Office Protected Document Tamper Prompt

Office Protected Files Cover Page EULA

Policy

User Encrypted Folders

Application Data Encryption List

Managed Services

EMS Device Whitelist

EMS Access Code Required Message

EMS Access Code Failed Message

Policy

Support Information Text

PBA Title Text



Windows Encryption > Policy-Based
Encryption

Windows Encryption > BitLocker Encryption

Data Guardian > Cloud Encryption

Data Guardian > Protected Office
Documents

Windows Encryption

Windows Encryption

Manage Policies

Legal Notice Text

Self Help Questions (Pre-8.0 clients)

Common Encrypted Folders

OS Update Encryption Rules

Default Folder Location to Save Recovery
Password

Help File Name
Help File Contents
Excluded Folders

Excluded Files

Office Protected Clip Board Unauthorized Text

Office Protected Document Tamper Prompt
Offline Key Generation Escrow Reminder Text

Office Protected Files Cover Page Notice

A word about types of encryption: SDE is designed to encrypt the operating system and program files.
To accomplish this purpose, SDE must be able to open its encryption key while the operating system is
booting without intervention of a password by the user. Its intent is to prevent alteration or offline attacks
on the operating system by an attacker. SDE is not intended for user data. Common and User key
encryption are intended for sensitive user data because they require a user password to unlock

encryption keys.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.
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Full Disk Encryption (FDE)

Encryption Algorithm AES 256
Encryption Mode CBC
Enable FDE Plugin Selected

On

off

Toggle to ON to enable all full disk
encryption policies. If this policy is
toggled to OFF, no full disk
encryption takes place, regardless
of other policy values.

On means that all Full Disk
Encryption policies are enabled.
Changing the value of this policy
triggers a new sweep to
encrypt/decrypt files.

AES 256, AES 128, FIPS AES 256,
FIPS AES 128

Encryption algorithm used for Full
Disk Encryption.

CBC, XTS

Encryption mode used for Full Disk
Encryption.

The plugin must remain selected.
To deactivate the PBA and disable
full disk encryption, toggle the Full
Disk Encryption policy to OFF.

Self-Encrypting Drive (SED) Off

See advanced settings

On

off

Enable this policy to provision the
PBA. If disabled after the PBA is
provisioned, the PBA is de-
provisioned and the PBA database
is deleted. Re-enabling this policy
re-provisions the PBA and re-
creates the PBA database.

Policy-Based Encryption Off

Application Data Encryption Key Common
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On

Ooff

Toggle to ON to enable all policy-
based encryption policies. If this
policy is toggled to OFF, no policy-
based encryption takes place,
regardless of other policy values.
On means that all Policy-Based
Encryption policies are enabled.
Changing the value of this policy
triggers a new sweep to
encrypt/decrypt files.

Common, User, User Roaming
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Choose a key to indicate who can
access files encrypted by
Application Data Encryption List,
and where.
More...
Common for these files to be
accessible to all managed users on
the computer where they were
created (the same level of access
as Common Encrypted Folders),
and encrypted with the Common
encryption algorithm.
User for these files to be accessible
only to the user who created
them, only on the computer where
they were created (the same level
of access as User Encrypted
Folders), and encrypted with the
user encryption algorithm.
User Roaming for these files to be
accessible only to the user who
created them, on any encrypted
Windows computer, and
encrypted with the User
encryption algorithm.
Changes to this policy do not affect
files already encrypted because of
this policy.
If this policy is not selected, SDE
encryption is disabled, regardless
of other policy values. Selected
means that all data not encrypted
SDE Encryption Enabled Not Selected by other Intelligent Encryption
policies are encrypted per the SDE
Encryption Rules policy. Changing
the value of this policy requires a
reboot.

String
F#:\

-"%ENV:SYSTEMDRIVE%\System Volume Information
Encryption rules to be used to

encrypt/not encrypt certain drives,

NHENV:SYSTEMROOT%\;dIl.exe.sys.ocx.man.cat.manifest.policy directories. and folders. See

—"%ENV:SYSTEMROOT%\System32 Encryption Rules for information.
SDE Encryption Rules may be
-"%ENV:SYSTEMROOT%\SysWow64 changed as appropriate for your
A%ENV:SYSTEMROOTI\WInNSxS environment. However, these
SDE Encryption Rules defaults have been tested
HENV:SYSTEMROOT%\Fonts extensively. Removing these

exclusions may result in Windows
issues, particularly after applying
A3@UWENV:SYSTEMROOT%\SYSTEM32\cmd.exe;exe patch updates.
Contact ProSupport for guidance if
you are unsure about changing the

"3@WENV:SYSTEMROOT%\SYSTEM32\;exe

N3@WENV:SYSTEMROOT%\SYSTEM32\autochk.exe;exe
A3@UENV:SYSTEMROOTY%\SYSTEM32\winresume.exe:exe  values.
-"F#:\bootmgr

-"F#:\boot
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A@Y%ENV:SYSTEMDRIVEY\;vol

-"%ENV:SYSTEMDRIVEY\Program Files\PGP Corporation

-"3%ENV:SYSTEMDRIVE%\PGPWDEOO
-"3%ENV:SYSTEMDRIVE%\PGPWDEOL
-"3%ENV:SYSTEMDRIVE%\PGPWDEO02
-"3%ENV:SYSTEMDRIVE%\PGPWDEO03
-"%ENV:SYSTEMDRIVEY\Program Files\Symantec
-"%ENV:SYSTEMDRIVEY\Program Files (x86)\Symantec

-"%ENV:SYSTEMDRIVE%\Program Files\Common
Files\Symantec Shared

-"%ENV:SYSTEMDRIVE%\Program Files (x86)\Common
Files\Symantec Shared

-"%ENV:SYSTEMDRIVEY\ProgramData\Symantec
-"3%ENV:SYSTEMDRIVE%\SafeBoot.fs
3%ENV:SYSTEMDRIVE%\SafeBoot.rsv
A3%ENV:SYSTEMDRIVE%\SafeBoot.csv
-"3%ENV:SYSTEMDRIVE%\Program Files\McAfee

3%ENV:SYSTEMDRIVE%\Program Files\Common
Files\McAfee

-"3%ENV:SYSTEMDRIVE%\Program Files\McAfee

-"3%ENV:SYSTEMDRIVE%\Program Files (x86)\Common
Files\McAfee

-3%ENV:SYSTEMDRIVE%\\Program Files (x86)\Mcafee
"%HENV:SYSTEMDRIVE%\Program Files\Trend Micro\
-"3%ENV:SYSTEMDRIVE%\ProgramData\Dell\Kace
-"3%ENV:SYSTEMDRIVE%\Program Files\Dell\Kace

-"3%ENV:SYSTEMDRIVE%\Program Files (x86)\Dell\Kace

String
%ENV:SYSTEMDRIVE%\;accdb.doc.docm.docx.mdb. pdf.ppam.pps.ppsm.ppsx
.ppt.pptm.pptx.pub.puz.sldm.sldx.tif.tiff.vdx.vsd.vss.vst.vsx.vtx.xlam
xlm.xls.xlIsb.xIsm.xlsx.xsf.zip.rar
%ENV:USERPROFILE%\Desktop
%ENV:USERPROFILE%\Download
-A%ENV:SYSTEMDRIVE%\;dat.ini.xml.txt.log.db.Ink

Common Encrypted Folders
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String - maximum of 100 entries of
500 characters each (up to a
maximum of 2048 characters)

A list of folders on computer drives
to be encrypted or excluded from
encryption, which can then be
accessed by all managed users
who have access to the computer.
See Encryption Rules for
information. The text in this policy
is translatable.

Important: Overriding directory
protection can result in an
unbootable computer and/or
require reformatting drives.
More...

The available drive letters are:

#: Refers to all drives

f#: Refers to all fixed (non-
removable) drives

r#: Refers to all removable drives
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If the same folder is specified in
both this policy and the User
Encrypted Folders policy, this
policy prevails.

See advanced settings

Managed
Not Managed
Toggle to Managed to enable
BitLocker Encryption Not Managed BitLocker Manager policy settings.
Toggling to Not Managed disables
all BitLocker Manager policies,
regardless of other policy values.
Selected
Not Selected
Selected enables TPM
management with BitLocker
TPM Manager Enabled Not Selected management. Not Selected
disables all TPM management
policies, including policies in the
Operating System Volume Settings
category.

Selected

Not Selected

Selected disables sleep mode on
Disable Sleep Mode Not Selected the local computer.

Changing this policy requires a

reboot for the new value to take

effect.

Do Not Manage

Turn On Encryption

Turn Off Encryption

Do Not Manage ignores the

System Drive (typically the drive

that the operating system is
Encrypt System Drive Do Not Manage installed on). Turn On Encryption

allows BitLocker to encrypt the

System Drive only. Turn Off

Encryption disables BitLocker from

encrypting the system drive or

decrypts any BitLocker-encrypted

system drives.
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Encrypt Fixed Drives

Encrypt Removable Drives

Require Additional Authentication
at System Startup

Allow BitLocker Encryption
Without a Compatible TPM
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Do Not Manage

Do Not Manage

Not Selected

Selected

Do Not Manage

Turn On Encryption

Turn Off Encryption

This policy does not encrypt the
system drive. To also encrypt the
system drive, make sure that
Encrypt System Drive Only is also
Turn On Encryption.

Do Not Manage ignores Fixed
Drives. Turn On Encryption allows
BitLocker to encrypt Fixed Drives.
Turn Off Encryption causes
Manager to decrypt any BitLocker
encrypted fixed drives.

Do Not Manage

Turn On Encryption

Turn Off Encryption

Do Not Manage ignores
Removable Drives. Turn On
Encryption allows BitLocker to
encrypt Removable Drives. Turn
Off Encryption causes Manager to
decrypt any BitLocker encrypted
removable drives.

Selected

Not Selected

This policy allows for the
configuration of BitLocker to
require additional authentication
each time the computer starts up
[with or without a Trusted
Platform module (TPM)].

More...

This policy is the parent policy to:
Allow BitLocker Encryption
Without a Compatible TPM
Configure TPM Startup

Configure TPM Startup PIN
Configure TPM Startup Key
Configure TPM Startup Key and
PIN

Selected

Not Selected

Selected allows a computer
without a compatible TPM to use
BitLocker encryption. In this mode,
a USB drive is required for startup.
When the key is inserted, access to
the drive is authenticated and the
drive is accessible. If the USB key is
lost or unavailable, the computer
will require BitLocker recovery for
access.

To use this policy, Require
Additional Authentication at
System Startup must be set to
Selected.



Configure TPM Startup

Configure TPM Startup PIN

Configure TPM Startup Key

Configure TPM Startup Key and
PIN

Encryption Method and Cipher
Strength (OS Volumes)

Allow

Allow

Do Not Allow

Do Not Allow

XTS-AES-128

Manage Policies

Do Not Allow

Require

Allow

On computers with a compatible
TPM, three types of authentication
are supported. Only one of the
following can be required or
allowed:

Configure TPM Startup PIN
Configure TPM Startup Key
Configure TPM Startup Key and
PIN

To use this policy, Require
Additional Authentication at
System Startup must be set to
Selected.

Do Not Allow

Require

Allow

To use this policy, Require
Additional Authentication at
System Startup must be set to
Selected.

This type of authentication
involves the entry of a 4-digit

to 20-digit personal identification
number (PIN).

Do Not Allow

Require

Allow

To use this policy, Require
Additional Authentication at
System Startup must be set to
Selected.

This type of authentication
involves insertion of a USB drive
containing the startup key.

Do Not Allow

Require

Allow

To use this policy, Require
Additional Authentication at
System Startup must be set to
Selected.

This type of authentication
involves a 4-digit to 20-digit
personal identification number
(PIN) and a USB drive containing
the startup key.

AES-128

AES-256

XTS-AES-128 (for use with
Windows 10 Anniversary Edition
and later)

XTS-AES-256 (for use with
Windows 10 Anniversary Edition
and later)

Algorithm and cipher strength
used by BitLocker Drive Encryption
for OS Volumes.
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Encryption Method and Cipher

AES-128
Strength (Removable Volumes)

Encryption Method and Cipher

XTS-AES-128
Strength (Fixed Volumes)

See advanced settings

AES-128

AES-256

XTS-AES-128 (for use with
Windows 10 Anniversary Edition
and later)

XTS-AES-256 (for use with
Windows 10 Anniversary Edition
and later)

Algorithm and cipher strength
used by BitLocker Drive Encryption
for Removable Volumes.

To encrypt removable drives to
use with older versions of
Windows as well as with Windows
10 Anniversary Edition and later,
use AES-128 or AES-256.

AES-128

AES-256

XTS-AES-128 (for use with
Windows 10 Anniversary Edition
and later)

XTS-AES-256 (for use with
Windows 10 Anniversary Edition
and later)

Algorithm and cipher strength
used by BitLocker Drive Encryption
for Fixed Volumes.

Server Encryption Off
Allow Software Server Encryption Selected
Server Maintenance Schedule Not Selected
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On

Off

This policy enables or disables
System Data Encryption (SDE) and
Common Encryption on the client

server.
Changing the value of this policy
triggers a new sweep to
encrypt/decrypt files.

Selected

Not Selected

If this policy is Selected, client
servers are activated at the
Enterprise level.

This policy may be set to Not
Selected to block activations
during initial Dell Server setup and
maintenance interruptions.

This policy must be selected to use
all other Server Maintenance
policies. If this policy is Not
Selected, no Server Maintenance
policies are enforced, regardless of



Server Maintenance Schedule

Weekly
Repeats
Port Control System Disabled
SDE Encryption Enabled Selected
String

F#:\

-A%ENV:SYSTEMDRIVE%\System Volume Information
-A%ENV:SYSTEMROOT%\;dll.exe.sys.ocx.man.cat.manifest.policy
-A%ENV:SYSTEMROOT%\System32
-A%ENV:SYSTEMROOT%\SysWow64
-A%ENV:SYSTEMROOT%\WinSxS
-A%ENV:SYSTEMROOT%\Fonts
A3@%ENV:SYSTEMROOT%\SYSTEM32\;exe
-A3@%ENV:SYSTEMROOT%\SYSTEM32\cmd.exe;exe
-A3@%ENV:SYSTEMROOT%\SYSTEM32\autochk.exe;exe
-A3%ENV:SYSTEMDRIVE%\ProgramData\Dell\Kace
-A3%ENV:SYSTEMDRIVE%\Program Files\Dell\Kace
-A3%ENV:SYSTEMDRIVE%\Program Files (x86)\Dell\Kace

SDE Encryption Rules

Encryption Enabled Selected

Manage Policies

other policy values.

Selected allows a maintenance
schedule to control application of
policy that requires a reboot.
Daily, Weekly, Monthly, Quarterly,
Annually

The schedule configuration defines
when the task should run.

Daily: Runs the task every day at
the specified Server Maintenance
Schedule Start Time.

Weekly: Runs the task weekly on
the days specified in Server
Maintenance Day of the Week.
Monthly: Runs the task monthly on
the specified Server Maintenance
Day of the Month.

Quarterly: Runs the task quarterly
on the specified Server
Maintenance Day of the Month.
Annually: Runs the task annually
on the specified Server
Maintenance Day of the Month.
Enable or Disable all Port Control
System policies. If this policy is set
to Disable, no Port Control System
policies are applied, regardless of
other Port Control System policies.
All PCS policies require a reboot
before the policy takes effect.

If this policy is Not Selected, SDE
encryption is disabled, regardless
of other policy values. Selected
means that all data not encrypted
by other Intelligent Encryption
policies are encrypted per the SDE
Encryption Rules policy. Changing
the value of this policy requires a
reboot

Encryption rules to be used to
encrypt/not encrypt certain drives,
directories, and folders. See
Encryption Rules for information.
SDE Encryption Rules may be
changed as appropriate for your
environment. However, these
defaults have been tested
extensively. Removing these
exclusions may result in Windows
issues, particularly after applying
patch updates.

Contact ProSupport for guidance if
you are unsure about changing the
values.

This policy must be selected to use
all Common Encryption policies.
Not Selected means that no
Common Encryption takes place,
regardless of other policy values.
Changing the value of this policy
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triggers a new sweep to
encrypt/decrypt files.

See advanced settings

Variables

Some Windows policies support the following variables. A pathname can consist entirely of one or more
of these variables, or can include one or more of these variables at any point.

To get directory locations that these CSIDL values resolve to, go to http://msdn.microsoft.com/en-
us/library/bb762494.aspx. All names listed on the MSDN page are CSIDL_<name>.

e Includes any of the following Windows CSIDL constants:
DESKTOP
INTERNET
PROGRAMS
CONTROLS
PRINTERS
PERSONAL
FAVORITES
STARTUP
RECENT
SENDTO
STARTMENU
STARTMENU
MYDOCUMENTS
MYMUSIC
MYVIDEO
DESKTOPDIRECTORY
DRIVES
NETWORK
NETHOOD
FONTS
TEMPLATES
COMMON_STARTMENU
COMMON_PROGRAMS
COMMON_STARTUP
COMMON_DESKTOPDIRECTORY
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APPDATA
PRINTHOOD
LOCAL_APPDATA
ALTSTARTUP
COMMON_ALTSTARTUP
COMMON_FAVORITES
INTERNET_CACHE
COOKIES

HISTORY
COMMON_APPDATA
WINDOWS

SYSTEM
PROGRAM_FILES
PROGRAMFILES
MYPICTURES
PROFILE

SYSTEMX86
PROGRAM_FILESX86
PROGRAMFILESX86

PROGRAM_FILES_COMMON
PROGRAM_FILES_COMMONX86

COMMON_TEMPLATES
COMMON_DOCUMENTS
COMMON_ADMINTOOLS
ADMINTOOLS
CONNECTIONS
COMMON_MUSIC
COMMON_PICTURES
COMMON_VIDEO
RESOURCES

PROFILES

Manage Policies

e Includes a numeric or text value stored in the registry for the current user. If you specify a path

but not an item, the client uses the default value
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e Includes a numeric or text value stored in the registry for the local computer. If you specify a
path but not an item, the client uses the default value

e Includes the value of a Windows local environment variable

e Includes the % character
Windows Policies that Require Reboot

e SDE Encryption Enabled

e Encrypt Windows Paging File

e Secure Windows Credentials

e All PCS policies
Windows Policies that Require Logoff

e SDE Encryption Enabled

e User state change to Suspended

e EMS Encrypt External Media

e EMS Scan External Media

e EMS Encryption Algorithm

e EMS Exclude CD/DVD Encryption

e EMS Data Encryption Key

Advanced Windows Encryption

A word about types of encryption: SDE is designed to encrypt the operating system and program files.
To accomplish this purpose, SDE must be able to open its encryption key while the operating system is
booting without intervention of a password by the user. Its intent is to prevent alteration or offline attacks
on the operating system by an attacker. SDE is not intended for user data. Common and User key
encryption are intended for sensitive user data because they require a user password to unlock
encryption keys.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.

The plugin must remain selected. To deactivate the PBA and disable SED

Enable SED Plugin Selected . . i
Management, toggle the Self-encrypting Drive policy to OFF.

See basic settings
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Encrypt with SDE

when SED is Not Selected
detected
User Encrypted .
String
Folders
Exe List

winword.exe
excel.exe
powerpnt.exe
msaccess.exe
winproj.exe
Application Data outlook.exe
Encryption List acrobat.exe
visio.exe
mspub.exe
winzip.exe
winrar.exe
onenote.exe
onenotem.exe

When Selected, this policy applies SDE encryption to self-encrypting drives.
Use this policy when SDE encryption is preferred instead of native SED
encryption.

String - maximum of 100 entries of 500 characters each (up to a maximum
of 2048 characters)

A list of folders on the computer hard drive to be encrypted with the user
data encryption key or excluded from encryption.

If the same folder is specified in this policy for multiple users of the same
Windows computer, each file in that folder is encrypted for the first owner
of the file after the policy takes effect, and can be decrypted only by that
owner.

The text in this policy is translatable.

More...

Specify as for Common Encrypted Folders.

This policy applies to all drives classified by Windows as Hard Disk Drives
(see My Computer). You cannot use this policy to encrypt drives or
external media whose type displays as Removable Disk, use EMS Encrypt
External Media instead.

String - maximum of 100 entries of 500 characters each

Do not add explorer.exe or iexplorer.exe to the ADE list, as unexpected or
unintended results may occur.

Explorer.exe is the process used to create a new notepad file on the
desktop using the right-click menu.

Setting encryption by file extension, instead of the ADE list, provides more
comprehensive coverage.

Changes to this policy do not affect files already encrypted because of this
policy.

List process names of applications (without paths) whose new files you
want encrypted, separated by carriage returns. Do not use wildcards.

The text in this policy is translatable.

More...

You can also specify these process names (separated by commas) via the
registry value
HKLM\Software\Dell\CMGShield\ApplicationDataEncryptionList.

The Encryption client encrypts all new files (not already being encrypted by
Common Encrypted Folders and User Encrypted Folders) on the current
computer hard drives created by these application processes whenever
they are owned by a currently-logged-on managed user. This may include
files excluded from encryption by Common Encrypted Folders and/or User
Encrypted Folders.

The following folders and their subfolders are always excluded from
encryption by this policy:

C:\Windows\system32

C:\Windows\Software Distribution

C:\Windows\Security

C:\System Volume Information\Program
Files\Dell\(.dll.exe.sys.mac.ddp.wip.rty.nmd.inv)

Dell strongly recommends not listing applications or installers that write
system-critical files. Doing so could result in encryption of important
system files, which could make a Windows computer unbootable.
Common process hames:

outlook.exe
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User Encryption
Algorithm

AES256

SDE Encryption

) AES256
Algorithm

Common
Encryption AES256
Algorithm

Encrypt Outlook
Personal Folders

Not Selected

Encrypt Temporar
X s P ¥ Selected
Files
Encrypt Temporar
vP P v Selected

Internet Files

Encrypt User Profile
Documents

Not Selected

Encrypt Windows
Paging File

Selected
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winword.exe

powerpnt.exe

msaccess.exe

wordpad.exe

mspaint.exe

excel.exe

The following hard-coded system and installer process names are ignored
if specified in this policy (you can also add to this list via the registry value
HKLM\Software\Dell\CMGShield\EUWPrivilegedList):

hotfix.exe, a Windows update process

update.exe, a Windows update process

setup.exe, a third-party installer process

msiexec.exe, a third-party installer process

wuauclt.exe, a Windows update process

wmiprvse.exe, a Windows system process

migrate.exe, a Windows update process

unregmp?2.exe, a Windows update process

ikernel.exe, a third-party installer process

wssetup.exe, the Windows Encryption client installer

svchost.exe, a Windows system process

AES256, Rijndael 256, AES128, Rijndael 128, 3DES

Encryption algorithm used to encrypt data at the individual user level. You
can specify different values for different users of the same computer.
Encryption algorithms in order of speed, fastest first, are Rijndael 128, AES
128, Rijndael 256, AES 256, 3DES.

AES 256, AES 128, 3DES

Encryption algorithm used to for System Data Encryption.

Encryption algorithms in order of speed, fastest first, are AES 128, AES 256,
3DES.

AES256, Rijndael 256, AES128, Rijndael 128, 3DES

Encryption algorithm used to encrypt data at the endpoint (all users) level.
System paging files are encrypted using AES 128.

Encryption algorithms in order of speed, fastest first, are Rijndael 128, AES
128, Rijndael 256, AES 256, 3DES.

Encrypts Outlook Personal Folders (%csidl:local_appdata
%\Microsoft\Outlook) with the User data encryption key.

When this policy is selected, the paths listed in the environment variables
TEMP and TMP are encrypted. TEMP and TMP for the operating system are
encrypted with the Common encryption key.

To reduce encryption sweep time, the contents of the TEMP and TMP
folders are cleared for initial encryption, as well as updates to this policy.
However, if your organization uses a third-party application that requires
the file structure within the \temp directory to be preserved, you should
prevent this deletion.

To disable temporary file deletion, create DeleteTempFiles (REG_DWORD)
and set its value to 0 in the registry at
HKLM\SOFTWARE\Credant\CMGShield.

When this policy is selected, the path listed in the environment variable
CSIDL_INTERNET_CACHE is encrypted with the User data encryption key.
To reduce encryption sweep time, the contents of CSIDL_INTERNET_CACHE
are cleared for initial encryption, as well as updates to this policy.

This policy is applicable when using Microsoft Internet Explorer only. For
other web browsers, an administrator must create an encryption policy
that is specific to the storage location of the temporary internet files used
by each browser.

When this policy is selected, the following are encrypted:

* The users profile (C:\Users\jsmith) with the User data encryption key

e \Users\Public with the Common encryption key

When this policy is selected, the Windows paging file is encrypted. A
change to this policy requires a reboot.



Managed Services String

Secure Post- i
. No Overwrite
Encryption Cleanup

Secure Windows
R Not Selected
Credentials

Block Unmanaged
Access to Domain Not Selected
Credentials

Secure Windows
K K . Not Selected
Hibernation File

Prevent Unsecured
K K Not Selected
Hibernation

Scan Workstation
Not selected
on Logon

Workstation Scan
Priority

Manage Policies

String - maximum of 100 entries of 500 characters each (up to a maximum
of 2048 characters)

When a service is managed by this policy, the service is started only after
the user is logged in and the Encryption client is unlocked. This policy also
ensures that the service managed by this policy is stopped before the
Encryption client is locked during logoff. This policy can also prevent a user
logoff if a service is unresponsive.

More...

Syntax is one Service name per line. Spaces in the service name are
supported. Wildcards are not supported. Entries are not case-sensitive. For
example, GoogleDesktop Manager is the same as googledesktopmanager.
The service "log on as" setting has no bearing on whether or not the
Encryption client can control it. It does not matter if a user logs on with
user credentials verses the local system.

The startup type (Automatic or Manual) does not affect the ability of the
Encryption client to control it. Automatic or Manual startup is acceptable.
Managed services are not started if an unmanaged user logs on.

No Overwrite, Single-pass Overwrite, Three-pass Overwrite, Seven-pass
Overwrite

Once encryption is complete, this policy determines what happens to the
unencrypted residue of the original files:

¢ No Overwrite deletes it. This value yields the fastest encryption
processing.

e Single-pass Overwrite overwrites it with random data.

® Three-pass Overwrite overwrites it with a standard pattern of 1s and Os,
then with its complement, and then with random data.

® Seven-pass Overwrite overwrites it with a standard pattern of 1s and Os,
then with its complement, and then with random data five times. This
value makes it most difficult to recover the original files from memory, and
yields the most secure encryption processing.

When this policy is selected, the Windows Credentials are secured by
encrypting the entire registry with the exception of registry information
required for computer boot. The information required for computer boot
includes HKLM/SYSTEM and all sub-keys..

More...

A reboot is required when a change to this policy is delivered. To control
this reboot, configure the following policies: Force Reboot on Update,
Length of Each Reboot Delay, and Number of Reboot Delays Allowed.

This policy prevents unmanaged users and applications from accessing the
Windows domain credentials when a user is logged in.

When this policy is selected, the hibernation file is encrypted only when
the computer enters hibernation. The Encryption client disengages
protection when the computer comes out of hibernation, providing
protection without impacting users or applications while the computer is in
use.

When this policy is selected, the Encryption client does not allow computer
hibernation if the client is unable to encrypt the hibernation data.

When this policy is selected, all current and previously encrypted folders
on the encrypted computer's local hard drives are scanned each time a
managed user logs on, ensuring that all Common Encrypted Folders and
User Encrypted Folders policy values are properly implemented. Abides by
the Workstation Scan Priority policy.

Highest, High, Normal, Low, Lowest

Specifies the relative Windows priority of encrypted folder scanning. High
and Highest prioritize scanning speed over computer responsiveness, Low
and Lowest prioritize computer responsiveness over scanning speed and
favor other resource-intensive activities, and Normal balances the two.
The client checks for a changed Workstation Scan Priority before
processing the next file.
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The scan priority levels are used in two ways.
1.  These values correspond with the values used by the Microsoft
SDK to set thread execution priority.
2. Theclient uses these values to introduce a delay in the
encryption sweep after every single file is processed.
The values translate to the following millisecond delay ranges,
where the encryption thread will sit idle and then return full
control to the operating system:
Highest=0 ms / Lowest=100 ms

Common, User, User Roaming
Choose a key to indicate who can access files encrypted by the following
policies, and where:
e User Encrypted Folders
¢ Encrypt Outlook Personal folders
* Encrypt Temporary Files (\Users\<Username>\AppData\Local\Temp
only)
¢ Encrypt Temporary Internet Files
* Encrypt User Profile Documents (except \All Users\Shared Documents)
Select:
e Common for User Encrypted Folders to be accessible by all managed
users on the computer where they were created (the same level of access
as Common Encrypted Folders), and encrypted with the Common
encryption algorithm.
More...
The Common encryption algorithm controls the encryption algorithm for
all User Encrypted Folders and overrides any encryption algorithm
selected, including the default User encryption algorithm. For example, if
User Data User the Common encryption algorithm is set to AES 256, all Common and User
Encryption Key Encrypted Files/Folders is encrypted with the AES 256 algorithm.
All other encryption parameters can be selected to override default
settings. For example, if the Encrypt Temporary Files policy is set to Not
Selected, you can override this setting for any managed user by setting this
value to Selected.
Designated User Encrypted Folders use the Common Key, resulting in all
managed users having the key to access any encrypted files stored in these
folders as permitted by security settings on the operating system.
e User for these files to be accessible only to the user who created them,
only on the computer where they were created (the same level of access
as User Encrypted Folders), and encrypted with the User Encryption
Algorithm.
¢ User Roaming for these files to be accessible only to the user who
created them, on any encrypted Windows computer, and encrypted with
the User encryption algorithm.
When incorporating an encryption policy to encrypt entire disk partitions,
Dell recommends using the default SDE policy, rather than Common or
User. This ensures that any operating system files that are encrypted are
accessible during times when the managed user is not logged in.
String - maximum of 1500 characters
List fully qualified Policy Proxy hostnames, or IP addresses, separated by
carriage returns. Ports cannot be specified in this policy.
More...
Once a valid entry is found, the remainder of the Policy Proxies listed are
ignored.
String Entries are processed in the following order:
1. GKConnections Override (this registry entry overrides all other entries)
2. GKConnections (this registry entry is set automatically by the client,
based on the this policy)
3.GK
To override this policy and specify ports via the registry key, set
HKLM\Software\Microsoft\WindowsNT\CurrentVersion\

Policy Proxy
Connections
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Policy Proxy Polling

Interval

Allow Activations

Current Shield State

See basic settings

Enable Software
Auto Updates

On Premise Update

Staging Location

Update Check
Period

Number of Policy
Update Delays
Allowed

Force Logoff /
Reboot on Policy
Updates

Policy Viewer
Enabled

Display Local
Encryption
Processing Control

360

Selected

Activate

Not Selected

String

10080

Selected

Not Selected

Not Selected

Manage Policies

Winlogon\CMGShield\GKConnectionsOverride.

The client communicates with Policy Proxies using the GKPORT (the default
is 8000).

If necessary, change that port via the registry key
HKLM\SOFTWARE\Microsoft\WindowsNT\Current
Version\Winlogon\CMGShield\GKPort.

Inherited values for this policy accumulate.

For the client to connect to a Policy Proxy specified in this policy, it must be
in the same group as the Policy Proxy specified during client installation.
Because the client supports up to 255 users per computer, this policy is
available only at the Enterprise policy level.

1-1440 minutes

The interval that the Encryption client attempts to poll Policy Proxy for
policy updates, and send inventory information to Policy Proxy.

The Encryption client also attempts to poll Policy Proxy each time a user
logs on.

This policy is available at the Enterprise, Domain, User Group, and User
levels. This policy is used only by the Encryption client. Other applications
do not have an activation policy setting.

When this policy is selected, Encryption client activations are allowed.
When this policy is not selected, activations are blocked. Blocking
activations is useful for staggering activations, preventing activations
during the initial Dell Server setup, or preventing activations during a
maintenance interruption.

Activate, Suspend

Activate is the normal state for an encrypted user. A user must be in this
state to activate a computer.

Select Suspend to require recovery before the user can access the
computer.

When a user is suspended, encrypted data cannot be accessed. The user
can be recovered by changing this policy to Activate, and committing the
policy.

Selected

Not Selected

Selected enables the client update agent to automatically check for
updates to Encryption client software. If this policy is not selected,
Encryption client auto updates do not take place, regardless of other policy
values. If this policy is selected, the On Premise Update Staging Location
policy must have a network location in its value.

String

This policy defines the network location (UNC) where the Dell Server
stages Encryption client update packages. If a network location is not
specified in this policy, the Enable Software Auto Updates policy should
not be published.

1-43200 minutes (1 minute to 30 days)

The period in minutes between checks for software auto updates.

0-5000

If Force Logoff/Reboot on Policy Updates is Selected, a non-zero value
allows the user to delay the required logoff or reboot the specified number
of times. Set to zero to disable delays.

Selected requires either a logoff or a reboot in order for key policy updates
to take effect. Otherwise, these policy updates take effect whenever the
next logoff or reboot occurs.

When Selected, the user can view their encryption policies from the
Encryption icon in the notification area.

When Selected, the user sees a menu option in the notification area icon
that allows them to pause/resume encryption/decryption (depending on
what the client is currently doing).
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Suppress File
Contention Selected
Notification

Number of
Encryption
Processing Delays
Allowed

Length of Each
Encryption 5
Processing Delay

Length of Each

. 15
Policy Update Delay
Force Reboot on

Selected

Update
Length of Each 15
Reboot Delay
Number of Reboot 3
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Important: Allowing a user to pause encryption could allow the user to
prevent the Encryption client from fully encrypting or decrypting data per
policy.

This policy controls whether users see notification pop-ups if an
application attempts to access a file while the client is processing it.
More...

If the client is processing a large file that an application needs, and this
policy is Selected, it may appear that the application is unresponsive or
slow to open (with no message indicating what the issue is). Care should
be taken when using this policy.

0-5000

A non-zero value allows the user to delay any encryption processing
required by the encryption policies you set, the specified number of times.
Set to zero to disable delays.

5-40320 minutes

If Number of Encryption Processing Delays Allowed has a non-zero value,
use this policy to specify how often the user is prompted to continue with
encryption processing or delay again.

More...

This prompt displays for five minutes each time. If the user does not
respond to the prompt, encryption processing begins. The final delay
prompt includes a countdown and progress bar, and it displays until the
user responds, or the final delay expires and encryption processing begins.
Calculate the maximum possible delay as follows (a maximum delay would
involve the user responding to each delay prompt immediately prior to the
5-minute mark):

(Number of Encryption Processing Delays Allowed x Length of Each
Encryption Processing Delay) + (5 minutes x [Number of Encryption
Processing Delays Allowed - 1])

5-40320 minutes

If Number of Policy Update Delays Allowed has a non-zero value, use this
policy to specify how often the user is prompted to logoff/reboot or delay
again.

More...

This prompt displays for five minutes each time. If the user does not
respond to the prompt, the next delay begins. The final delay prompt
includes a countdown and progress bar, and it displays until the user
responds, or the final delay expires and the required logoff/reboot occurs.
You can change the behavior of the user prompt to begin or delay
encryption, to prevent encryption processing following no user response to
the prompt.

To do this, set the registry key SnoozeBeforeSweep |(DWORD), stored in
HKLM\Software\Microsoft\Windows
NT\CurrentVersion\Winlogon\CMGShield, to a non-zero value. Any non-
zero value will change the default behavior to snooze.

With no user interaction, encryption processing is delayed up to the
number of configurable allowed delays. When the final delay expires,
encryption processing begins.

Calculate the maximum possible delay as follows (a maximum delay would
involve the user never responding to a delay prompt, each of which
displays for 5 minutes):

(Number of Policy Update Delays Allowed x Length of Each Policy Update
Delay) + (5 minutes x [Number of Policy Update Delays Allowed - 1])

When selected, the computer immediately reboots to allow processing of
encryption or updates related to device-based policy, such as System Data
Encryption (SDE).

5-40320 minutes

The number of minutes to delay when the user chooses to delay reboot for
device-based policy.

0-5000



Delays Allowed

Allow Encryption
Processing Only
When Screen is
Locked

Hide Overlay Icons

Encrypt temporary
files

See basic settings

False

Selected

Off

Manage Policies

The number of times the user is allowed to delay reboot for device-based
policy.

True, False, User-Optional

When True, there is no encryption or decryption of data while the user is
actively working. The client will only process data when the workstation
screen is locked.

When False, encryption processing occurs any time, even while the user is
working.

User-Optional adds an option to the notification area icon allowing the
user to turn this feature on or off.

Enabling this option will significantly extend the amount of time it takes to
complete encryption or decryption.

When Selected, Encryption overlay icons is not present on encrypted files
in File Explorer for all managed users on the computer.

When

Disable BitLocker
on Self-Encrypting
Drives

See basic settings

Selected

BitLocker Encryption - Fixed Data Volume Settings

Configure the Use
of Smart Cards on
Fixed Data Drives

Deny Write Access
to Fixed Data Drives
Not Protected by
BitLocker

Allow Access to
BitLocker Protected

Allow

Disabled

Selected

Selected

Not Selected

If Selected, BitLocker Manager does not start encryption on a volume that
is already protected by a provisioned SED.

For example, if this policy is Selected and both C: and D: are on one
physical self-encrypting drive, and the PBA has been provisioned, then C:
and D: does not encrypt for BitLocker even if System and Fixed drive
encryption are turned on in the BitLocker Manager policies.

Allow

Disallow

Require

This policy specifies whether smart cards can be used to authenticate
access to BitLocker fixed data drives. These settings are enforced when
turning on BitLocker, not when unlocking a drive. BitLocker will allow
unlocking a drive with any of the protectors available on the drive.
Enabled

Disabled

Enabled for Organizations

If the drive is protected by BitLocker, it is mounted with read and write
access.

If you disable or do not configure this policy setting, all fixed data drives on
the computer is mounted with read and write access.

When Disabled, this policy element will force the option to be blocked

from being used, and will not proceed until it is met.

When Enabled, this policy element will force the option to be used, and
will not proceed unless it is met.

Selected
Not Selected
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Not Selected

Allow

Allow

Full Encryption

Not Selected

When Selected, fixed data drives with the FAT file system can be unlocked
and viewed on computers running Windows Server 2008. This policy does
not apply to drives that are formatted with the NTFS file system.

Set this policy to Selected and the Do Not Install BitLocker to Go Reader on
FAT formatted Fixed Drives policy to Not Selected to allow BitLocker to Go
Reader to be installed on the fixed drive.

Selected

Not Selected

If this policy is Not Selected, BitLocker to Go Reader is installed on the fixed
drive to enable users to unlock the drive on computers running Windows
Server 2008.

Set this policy to Not Selected and the Allow Access to BitLocker Protected
Fixed Data Drives from Earlier Versions of Windows policy to Not Selected
to allow BitLocker to Go Reader to be installed on the fixed drive.

Allow

Require

Disallow

When set to Require, a connection to a domain controller is necessary to
validate the complexity of the password. When set to Allow, a connection
to a domain controller is attempted to validate complexity, but if no
domain controller is found, the password will still be accepted. When set
to Do Not Allow, no password complexity validation is done.

To use this policy, Configure Use of Passwords for Fixed Data Drives must
be set to Allow or Require.

Do Not Allow

Require

Allow

When set to Require, a connection to a domain controller is necessary to
validate the complexity of the password. When set to Allow, a connection
to a domain controller is attempted to validate complexity, but if no
domain controller is found, the password will still be accepted. When set
to Do Not Allow, no password complexity validation is done.

To use this policy, Configure Use of Passwords for Fixed Data Drives must
be set to Allow or Require.

8 min

20 max

Passwords must be at least 8 characters. To configure a greater minimum
length for the password enter the desired number of characters.

To use this policy, Configure Use of Passwords for Fixed Data Drives must
be set to Allow or Require.

Full Encryption
Used Space Only Encryption
Select the type of encryption to use for Fixed Data Drives.

Selected

Not Selected

BitLocker drives can always be recovered with BitLocker Manager, even if
this value is Not Selected. This policy allows for the control of how
BitLocker protected fixed data drives are recovered in the absence of the
required credentials.

More...

This policy is the parent policy to:

Allow Data Recovery Agent for Protected Fixed Data Drives

Config User Storage of BitLocker 48-digit Recovery Password

Config User Storage of BitLocker 256-bit Recovery Key

Omit Recovery Options from the BitLocker Setup Wizard

Save BitLocker Recovery Info to AD DS for Fixed Data Drives

BitLocker Recovery Info to Store in AD DS



Allow Data
Recovery Agent for
Protected Fixed
Data Drives

Configure User

Storage of BitLocker

48-digit Recovery
Password

Configure User

Storage of BitLocker

256-bit Recovery
Key

Omit Recovery
Options from the
BitLocker Setup
Wizard

Save BitLocker
Recovery
Information to AD
DS for Fixed Data
Drives

BitLocker Recovery
Information to
Store in AD DS

Do Not Enable
BitLocker Until
Recovery

Information is

Selected

Allow

Allow

Not Selected

Selected

Recovery Passwords and Key Packages

Not Selected

Manage Policies

Do Not Enable BitLocker Until Recovery Info is Stored in AD DS for Fixed
Data Drives

Selected

Not Selected

When Selected, a data recovery agent is allowed for use with BitLocker
protected fixed data drives. Before the agent can be used, it must be
added from the Public Key Policies in either the Group Policy Management
Console or the Local Group Policy Editor.

When setting this policy to Selected, the Choose How BitLocker-protected
Fixed Drives Can be Recovered policy must also be set to Selected.

Allow

Require

Do Not Allow

This policy determines if a user is allowed, required, or not allowed to
generate a 48-digit password.

When setting this policy to Allow or Require, the Choose How BitLocker-
protected Fixed Drives Can be Recovered policy must also be set to
Selected.

Allow

Require

Do Not Allow

This policy determines if a user is allowed, required, or not allowed to
generate a 256-bit recovery key.

When setting this policy to Allow or Require, the Choose How BitLocker-
protected Fixed Drives Can be Recovered policy must also be set to
Selected.

Selected

Not Selected

When Selected, users are prevented from specifying recovery options
when BitLocker is enabled. Recovery options for the drive are determined
by policy settings.

When setting this policy to Not Selected, the Choose How BitLocker-
protected Fixed Drives Can be Recovered policy must also be set to
Selected.

Selected

Not Selected

Selected allows BitLocker recovery information to be stored in AD DS for
fixed data drives. BitLocker recovery information is always saved to the
Dell Server. Enabling this policy additionally saves the information to AD.
More...

The appropriate schema extensions and access control settings on the
domain must be first configured before AD DS backup can succeed.

When setting this policy to Selected, the Choose How BitLocker-protected
Fixed Drives Can be Recovered policy must also be set to Selected.

Set this policy to Selected to use the policy BitLocker Recovery Information
to Store in AD DS.

Recovery Passwords and Key Packages

Recovery Passwords Only

This policy provides the option of storing recovery passwords and key
packages, or storing the recovery password only in AD DS. The appropriate
schema extensions and access control settings on the domain must be first
configured before applying this policy.

The Choose How BitLocker-protected Fixed Drives Can be Recovered policy
must be set to Selected to use this policy.

To use this policy, Save BitLocker Recovery Information to AD DS for Fixed
Data Drives must be set to Selected.

Selected

Not Selected

Although BitLocker recovery information is automatically stored in the Dell
Server, this policy additionally requires BitLocker drive encryption recovery
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Selected

Selected

Selected

Not Selected

String

AES 128 with Diffuser

Not Selected

information to be stored in AD DS. The appropriate schema extensions and
access control settings on the domain must be configured before using this
policy.

More...

This policy is used to prevent users from enabling BitLocker unless the
computer is connected to the domain and the backup of the BitLocker
recovery information to AD DS has succeeded.

The Choose How BitLocker-protected Fixed Drives Can be Recovered policy
must be set to Selected to use this policy.

Selected

Not Selected

PARENT to the next 4 policies.

Selected enables the configuration of hardware-based encryption on fixed
data drives.

Selected

Not Selected

Selected enables hardware-based encryption for fixed data drives.

To use this policy, Configure Use of Hardware-Based Encryption for Fixed
Data Drives must be set to Selected.

Selected

Not Selected

Selected enables BitLocker software-based encryption on fixed data drives
if hardware-based encryption is not available.

To use this policy, Configure Use of Hardware-Based Encryption for Fixed
Data Drives must be set to Selected.

Selected

Not Selected

Selected allows only specific crypto algorithm and cipher suites for
BitLocker hardware encryption on fixed data drives.

To use this policy, Configure Use of Hardware-Based Encryption for Fixed
Data Drives must be set to Selected.

String -

2.16.840.1.101.3.4.1.2;

2.16.840.1.101.3.4.1.42

Set specific Crypto Algorithms and Cipher Suites on fixed data drives.

To use this policy, Configure Use of Hardware-Based Encryption for Fixed
Data Drives must be set to Selected.

Qualified path

Important: This policy is not used by BitLocker Manager, because it does
not prompt the user when saving recovery passwords.

Microsoft defines this policy as: This setting provides the default path that
is displayed when the BitLocker drive encryption setup wizard prompts the
user to enter the location of a folder to save the recovery password.

The text in this policy is translatable.

AES 128 with Diffuser

AES 256 with Diffuser

AES 128

AES 256

This policy specifies the encryption method and cipher strength used for
BitLocker drive encryption. Changing this policy has no effect if the drive is
already encrypted or encryption is in progress.

Selected

Not Selected

This policy allows for the association of unique organizational identifiers to
a new drive that is enabled with BitLocker. These identifiers are stored as



Set Organizational
Unique Identifiers

Set Allowed
Organizational
Unique Identifiers

Prevent Memory
Overwrite on Not Selected
Restart

Enable Smart Card
Certificate Identifier

Not Selected

Smart Card

e e 1.3.6.1.4.1.311.67.1.1
Certificate Identifier

See basic settings
Bitlocker Encryption - Operating System Volume Settings

Allow Enhanced
PINs for Startup

Not Selected

Number of
Characters 4
Required in PIN

Manage Policies

the identification field and allowed identification field. The allowed
identification field is used in combination with the Deny Write Access to
Removable Drives Not Protected by BitLocker policy to help control the use
of removable drives in the organization.

This policy must be set to Selected to use the policies Set Organizational
Unique Identifiers and Set Allowed Organizational Unique Identifiers.

Up to 260 characters

The identification field allows you to associate a unique organizational
identifier to BitLocker-protected drives. This identifier is automatically
added to new BitLocker-protected drives and can be updated on existing
BitLocker-protected drives using the Manage-BDE command-line tool. An
identification field is required for management of certificate-based data
recovery agents on BitLocker-protected drives and for potential updates to
the BitLocker To Go Reader. BitLocker will only manage and update data
recovery agents when the identification field on the drive matches the
value configured in the identification field. In a similar manner, BitLocker
will only update BitLocker To Go Reader when the identification field on
the drive matches the value configured for the identification field.

To use this policy, Enable Organizational Unique Identifiers must be set to
Selected.

Up to 260 characters

The allowed identification field is used in combination with the Deny Write
Access to Removable Drives Not Protected by BitLocker policy to help
control the use of removable drives in the organization. It is a comma
separated list of identification fields from your organization or other
external organizations.

To use this policy, Enable Organizational Unique Identifiers must be set to
Selected.

Selected

Not Selected

Selected prevents memory from being overwritten on restart. Preventing
memory overwrite may improve restart performance, but will increase the
risk of exposing BitLocker secrets. When Not Selected, BitLocker secrets
are removed from memory when the computer restarts.

Selected

Not Selected

This policy allows or denies an object identifier to be specified for
enhanced key usage with a certificate.

This policy must be set to Selected to use the policy Smart Card Certificate
Identifier.

1.3.6.1.4.1.311.67.1.1

This policy provides for an object identifier to be specified for enhanced
key usage with a certificate. BitLocker can identify which certificates may
be used to authenticate a user certificate to a BitLocker drive by matching
the object identifier in the certificate with the object identifier that is
defined by this policy. Use caution if changing the default value.

To use this policy, Enable Smart Card Certificate Identifier must be set to
Selected.

Selected

Not Selected

Selected allows enhanced startup PINs to be used with BitLocker.
Enhanced startup PINs permit the use of characters including uppercase
and lowercase letters, symbols, numbers, and spaces. This policy setting is
applied when you turn on BitLocker.

4-20 digits

This policy configures the minimum length for a TPM startup PIN. The
startup PIN must have a minimum length of 4 digits and can have a
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Not Selected

Selected

Not Selected

Not Selected

Not Selected

Not Selected

Selected

Allow

Allow

maximum of 20 digits.

Selected

Not Selected

This policy specifies if a user is allowed to use the Network Unlock at
Startup feature on operating system drives.

Selected

Not Selected

This policy specifies if a user is allowed to use SecureBoot on operating
system drives.

Selected

Not Selected

This policy specifies if a standard user is allowed to change their PIN on
operating system drives.

Selected

Not Selected

This policy specifies if a preboot keyboard input is enabled on Slates.
Selected

Not Selected

This policy specifies if a preboot keyboard input is enabled on Slates.
Selected

Not Selected

BitLocker drives can always be recovered with BitLocker Manager, even if
this value is Not Selected. For the GPO, a Selected value allows you to
specify how BitLocker drives are recovered.

More...

This policy is the parent policy to:

Allow Data Recovery Agent for Protected Operating System Drives
Configure User Storage of BitLocker 48-digit Recovery Password
Configure User Storage of BitLocker 256-bit Recovery Key

Omit Recovery Options from the BitLocker Setup Wizard

Save BitLocker Recovery Info to AD DS for Operating System Drives
BitLocker Recovery Information to Store in AD DS (Windows Server 2008
Only)

Do Not Enable BitLocker Until Recovery Information is Stored in AD DS for
Operating System Drives

Selected

Not Selected

The "Allow Certificate Based Data Recovery Agent" is used to specify
whether a data recovery agent can be used with BitLocker operating
system drives. Before a data recovery agent can be used, it must be added
from the Public Key policies in either the Group Policy Management
Console or the Local Group Policy Editor.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Do Not Allow

Require

Allow

This policy configures if a user is allowed, required, or not allowed to
generate a 48-digit password.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Do Not Allow

Require

Allow

This policy configures if a user is allowed, required or not allowed to
generate a 256-bit recovery key.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.
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Not Selected

Selected

Recovery Passwords and Key Packages

Not Selected

Selected

Selected

Selected

Not Selected

Manage Policies

Selected

Not Selected

When Selected, users are prevented from specifying recovery options
when BitLocker is enabled. Recovery options for the drive are determined
by policy settings.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Selected

Not Selected

Selected allows BitLocker recovery information to be stored in AD DS for
operating system drives. The appropriate schema extensions and access
control settings on the domain must be first configured before AD DS
backup can succeed.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Recovery Passwords and Key Packages

Recovery Passwords Only

This policy provides the option of storing recovery passwords and key
packages, or storing the recovery password only in AD DS. The appropriate
schema extensions and access control settings on the domain must be first
configured before applying this policy.

This policy is applicable only to computers running Windows Server 2008.
To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Selected

Not Selected

Although BitLocker recovery information is automatically stored in the Dell
Server, this policy additionally requires BitLocker drive encryption recovery
information to be stored in AD DS. The appropriate schema extensions and
access control settings on the domain must be configured before using this
policy.

This policy is used to prevent users from enabling BitLocker unless the
computer is connected to the domain and the backup of the BitLocker
recovery information to AD DS has succeeded.

To use this policy, Choose How BitLocker-protected Operating System
Drives Can be Recovered must be set to Selected.

Selected

Not Selected

PARENT to the next 4 policies.

Selected enables the configuration of hardware-based encryption on
operating system drives.

Selected

Not Selected

Selected enables hardware-based encryption on operating system drives.
To use this policy, Configure Use of Hardware-Based Encryption for
Operating System Drives must be set to Selected.

Selected

Not Selected

Selected enables BitLocker software-based encryption on operating system
drives if hardware-based encryption is not available.

To use this policy, Configure Use of Hardware-Based Encryption for
Operating System Drives must be set to Selected.

Selected

Not Selected

Selected allows only specific crypto algorithm and cipher suites for
BitLocker hardware encryption on operating system drives.

To use this policy, Configure Use of Hardware-Based Encryption for
Operating System Drives must be set to Selected.
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2.16.840.1.101.3.4.1.2;2.16.840.1.101.3.4.1.42

Full Encryption

Not Configured

Allow

Not Selected

Disabled

String

String

String -

2.16.840.1.101.3.4.1.2;

2.16.840.1.101.3.4.1.42

Specific Crypto Algorithms and Cipher Suites allowed on operating system
drives.

To use this policy, Configure Use of Hardware-Based Encryption for
Operating System Drives must be set to Selected.

Full Encryption

Used Space Only Encryption

Select the type of encryption to use for operating system drives.
Enabled

Disabled

Not Configured

Configure password requirements for Operating System Drives.

When Disabled, this policy element will force the option to be blocked

from being used, and will not proceed until it is met.

When Enabled, this policy element will force the option to be used, and
will not proceed unless it is met.

When Not Configured, this policy element will consume the default action
to do nothing.

Allow

Require

Do Not Allow

When set to Require, a connection to a domain controller is necessary to
validate the complexity of the password. When set to Allow, a connection
to a domain controller is attempted to validate complexity, but if no
domain controller is found, the password will still be accepted. When set
to Do Not Allow, no password complexity validation is done.

To use this policy, Configure Use of Passwords for Operating System Drives
must be set to Enabled.

8-256

The default value is a password length of 8 characters. 8-256 characters
are allowed.

To use this policy, Configure Use of Passwords for Operating System Drives
must be set to Enabled.

Selected

Not Selected

Require ASClI-only passwords for operating system drives to create
stronger passwords.

To use this policy, Configure Use of Passwords for Operating System Drives
must be set to Enabled.

Enabled

Disabled

Not Configured

Set this policy to Enable to allow the verification and exclusion of BCD
settings.

When Disabled, this policy element will force the option to be blocked

from being used, and will not proceed until it is met.

When Enabled, this policy element will force the option to be used, and
will not proceed unless it is met.

When Not Configured, this policy element will consume the default action
to do nothing.

String

Specify the additional Boot Configuration settings.

To use this policy, Use Enhanced Boot Configuration Data Profile must be
set to Enabled.

String
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Configure BIOS TPM
Platform Validation
Profile

Not Selected

PCRO,on
PCR1,off
PCR2,0n
PCR3,off
PCR4,0on
PCR5,0n
PCR6,0ff
PCR7,0off
PCR8,0n
PCR9,0n
PCR10,0n
PCR11,0n
PCR12,0ff
PCR13,off
PCR14,0ff
PCR15,0ff
PCR16,0ff
PCR17,0ff
PCR18,0ff
PCR19,0ff
PCR20,off
PCR21,0ff
PCR22,0ff
PCR23,off

Not Selected

Manage Policies

Exclude specific Boot Configuration settings.

To use this policy, Use Enhanced Boot Configuration Data Profile must be
set to Enabled.

Selected

Not Selected

Set to Selected to enable boot up TPM drive unlocking for Windows 7 and
Windows Server 2008 R2. Selected allows the configuration of how the
TPM security hardware secures the BitLocker encryption key. This policy
does not apply if the computer does not have a compatible TPM or if
BitLocker has already been turned on with TPM protection.

This policy must be set to Selected to use the policy Configure Specific TPM
Platform Settings.

See http://technet.microsoft.com/en-

us/library/ji679890.aspx#BKMK depopt3 for more information.

This policy allows you to configure how the computer's TPM security
hardware secures the BitLocker encryption key. This policy setting does not
apply if the computer does not have a compatible TPM or if BitLocker has
already been turned on with TPM protection. This setting determines what
values the TPM measures when it validates early boot components before

unlocking a drive on a computer running Windows 7 or Windows Server
2008 R2.

More...

If you enable this policy before turning on BitLocker, you can configure the
boot components that the TPM will validate before unlocking access to the
BitLocker-encrypted operating system drive. If any of these components
change while BitLocker protection is in effect, the TPM does not release
the encryption key to unlock the drive and the computer will instead
display the BitLocker recovery console and require that either the recovery
password or recovery key be provided to unlock the drive.

If you disable or do not configure this policy, the TPM uses the default
platform validation profile or the platform validation profile specified by
the setup script. A platform validation profile consists of a set of Platform
Configuration Register (PCR) indices ranging from 0 to 23. The default
platform validation profile secures the encryption key against changes to
the Core Root of Trust of Measurement (CRTM), BIOS, and Platform
Extensions (PCR 0), the Option ROM Code (PCR 2), the Master Boot Record
(MBR) Code (PCR 4), the NTFS Boot Sector (PCR 8), the NTFS Boot Block
(PCR 9), the Boot Manager (PCR 10), and the BitLocker Access Control (PCR
11). The descriptions of PCR settings for computers that use an Extensible
Firmware Interface (EFI) are different than the PCR settings described for
computers that use a standard BIOS. The BitLocker Drive Encryption
Deployment Guide on Microsoft TechNet contains a complete list of PCR
settings for both EFl and standard BIOS.

Caution: Changing from the default platform validation profile affects the
security and manageability of your computer. BitLocker's sensitivity to
platform modifications (malicious or authorized) is increased or decreased
depending upon inclusion or exclusion (respectively) of the PCRs.

To use this policy, Configure TPM Platform Validation Profile must be set to
True.

Selected

Not Selected

Set to Selected to enable boot up BIOS TPM drive unlocking. Selected
allows the configuration of how the BIOS TPM security hardware secures
the BitLocker encryption key. This policy does not apply if the computer
does not have a compatible TPM or if BitLocker has already been turned on
with TPM protection.

This policy must be set to Selected to use the policy Configure Specific BIOS
TPM Platform Settings.

See http://technet.microsoft.com/en-

us/library/jj679890.aspx#BKMK tpmbios for more information.
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PCRO,on
PCR1,off
PCR2,0n
PCR3,off
PCR4,0n i . i .
PCRS, off This policy setting allows you to configure how the computer's TPM
PCRS, off security hardware secures the BitLocker encryption key. This setting
PCR7 off determines what values the TPM measures when it validates early boot
PCR8’,on components before unlocking an operating system drive on a computer
PCRI,0n with BIOS configuration or with UEFI firmware that has the Compatibility
PCR10,0n Support Module (CSM) enabled.
Configure Specific PCR1L.0n If you enable this policy before turning on BitLocker, you can configure the
BIOS TPM Platform PCRlZloff boot components that the TPM will validate before unlocking access to the
Settings PCR13’off BitLocker-encrypted operating system drive. If any of these components
PCR14:off change while BitLocker protection is in effect, the TPM does not release
PCR1S off the encryption key to unlock the drive and the computer will instead
PCR16:off display the BitLocker recovery console and require that either the recovery
PCR17,off password or recovery key be provided to unlock the drive.
PCR18, off To use this policy, Configure BIOS TPM Platform Validation Profile must be
set to Selected.
PCR19,0ff
PCR20,off
PCR21,0ff
PCR22,0ff
PCR23,off
Selected
Not Selected
Set to Selected to enable boot up UEFI TPM drive unlocking. Selected
allows the configuration of how the UEFI TPM security hardware secures
Configure UEFI TPM the BitLocker encryption key. This policy does not apply if the computer
Platform Validation Not Selected does not have a compatible TPM or if BitLocker has already been turned on
Profile with TPM protection.
This policy must be set to Selected to use the policy Configure Specific UEFI
TPM Platform Settings.
See http://technet.microsoft.com/en-
us/library/ji679890.aspx#BKMK tpmvaluefi for more information.
PCRO,on
PCR1,off
PCR2,0n
PCR3,off
PCR4,0on
PCR5, off This policy setting allows you to configure how the computer's TPM
PCR6,0ff security hardware secures the BitLocker encryption key. This setting
PCR7,off determines what values the TPM measures when it validates early boot
PCRS8,off components before unlocking an operating system drive on a computer
PCR9,off with native UEFI firmware configurations.
. . PCR10,0ff If you enable this policy before turning on BitLocker, you can configure the
Configure Specific ) . )
UEFI TPM Platform PCR11,0n boot components that the TPM will validate before unlocking access to the
Settings PCR12,0ff BitLocker-encrypted operating system drive. If any of these components
PCR13,off change while BitLocker protection is in effect, the TPM does not release
PCR14,0ff the encryption key to unlock the drive and the computer will instead
PCR15,off display the BitLocker recovery console and require that either the recovery
PCR16,0ff password or recovery key be provided to unlock the drive.
PCR17,off To use this policy, Configure UEFI TPM Platform Validation Profile must be
PCR18,off set to Selected.
PCR19,0ff
PCR20,off
PCR21,0ff
PCR22,0ff
PCR23,off

See basic settings
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Bitlocker Encryption - Removable Storage Settings

Allow User to Apply
BitLocker
Protection on

Selected

Removable Drives

Allow User to
Suspend and
Decrypt BitLocker
Protection on

Selected

Removable Data
Drives

Configure Use of
Smart Cards on

Allow
Removable Data

Drives

Deny Write Access

to Removable

Drives Not Disabled
Protected by

BitLocker

Allow Access to
BitLocker Protected
Removable Data
. K Selected
Drives from Earlier
Versions of

Windows

Do Not Install

BitLocker to Go

Reader on FAT Not Selected
formatted

Removable Drives

Configure Use of
Passwords for

Allow
Removable Data

Drives

Configure Password
Complexity for
Removable Data

Allow

Drives

Minimum Password
Length for
Removable Data
Drives

Manage Policies

Selected

Not Selected

When Selected, users are permitted to run the BitLocker setup wizard on a
removable data drive.

Selected

Not Selected

When Selected, users are authorized to suspend and decrypt BitLocker
protection on removable data drives.

Allow

Disallow

Require

This policy specifies whether smart cards can be used to authenticate
access to BitLocker removable data drives. These settings are enforced
when turning on BitLocker, not when unlocking a drive. BitLocker will allow
unlocking a drive with any of the protectors available on the drive.

Enabled

Disabled

Enabled for Organization

If this policy is enabled, all removable drives that are not BitLocker
protected are mounted as read only. If this policy is disabled, all removable
drives on the computer are mounted with read and write access.

Selected

Not Selected

When Selected, removable data drives with the FAT file system can be
unlocked on computers running Windows Server 2008. This policy does not
apply to drives that are formatted with the NTFS file system.

Selected

Not Selected

If this policy is Not Selected, removable data drives formatted with the FAT
file system that are BitLocker protected cannot be unlocked on computers
running Windows Server 2008. Bitlockertogo.exe is not installed.

Allow

Require

Do No Allow

This policy specifies whether a password is required to unlock BitLocker
removable data drives. These settings allow the use of a password, require
the use of a password, or disallow the use of a password.

This policy must be set to Allow or Require to use the Configure Password
Complexity for Removable Data Drives and Minimum Password Length for
Removable Data Drives polices.

Allow

Require

Do Not Allow

When set to Require, a connection to a domain controller is necessary to
validate the complexity of the password. When set to Allow, a connection
to a domain controller is attempted to validate complexity, but if no
domain controller is found, the password will still be accepted. When set
to Do Not Allow, no password complexity validation is done.

To use this policy, Configure Use of Passwords for Removable Data Drives
must be set to Allow or Require.

8-20 characters

Passwords must be at least 8 characters in length, with a maximum of 20
characters.

To use this policy, Configure Use of Passwords for Removable Data Drives
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Encryption Type for
Removable Data Full Encryption
Drives

Choose How
BitLocker-protected

R Not Selected
Removable Drives

Can be Recovered

Allow Data

Recovery Agent for

Protected Selected
Removable Data

Drives

Configure User
Storage of BitLocker
48-digit Recovery
Password

Allow

Configure User
Storage of BitLocker
256-bit Recovery
Key

Allow

Omit Recovery

Options from the

BitLocker Setup Not Selected
Wizard for

Removable Media

Save BitLocker

Recovery

Information to AD Selected
DS for Removable

Data Drives
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must be set to Allow or Require.

Allow User to Choose

Full Encryption

Used Space Only Encryption

Select the type of encryption to use for Removable Data Drives.

Selected

Not Selected

BitLocker drives can always be recovered with BitLocker Manager, even if
this value is Not Selected. This policy allows for the control of how
BitLocker protected removable data drives are recovered in the absence of
the required credentials.

More...

This policy is the parent policy to:

Allow Data Recovery Agent for Protected Removable Data Drives
Configure User Storage of BitLocker 48-digit Recovery Password

Configure User Storage of BitLocker 256-bit Recovery Key

Omit Recovery Options from the BitLocker Setup Wizard for Removable
Media

Save BitLocker Recovery Information to AD DS for Removable Data Drives
BitLocker Recovery Info to Store in AD DS for Removable Data Drives

Do Not Enable BitLocker Until Recovery Info is Stored in AD DS for Rem
Data Drives

Selected

Not Selected

When Selected, a data recovery agent is allowed for use with BitLocker
protected removable data drives. Before the agent can be used, it must be
added from the Public Key Policies in either the Group Policy Management
Console or the Local Group Policy Editor.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Allow

Require

Do Not Allow

This policy configures if a user is allowed, required, or not allowed to
generate a 48-digit password.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Allow

Require

Do Not Allow

This policy configures if a user is allowed, required, or not allowed to
generate a 256-bit recovery key.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Selected

Not Selected

When Selected, users are prevented from specifying recovery options
when BitLocker is enabled. Recovery options for the drive are determined
by policy settings.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Selected

Not Selected

Selected allows BitLocker recovery information to be stored in AD DS for
removable data drives. The appropriate schema extensions and access
control settings on the domain must be first configured before AD DS
backup can succeed.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Set this policy to Selected to use the policy BitLocker Recovery Information



BitLocker Recovery
Information to
Store in AD DS for
Removable Data

Recovery Passwords and Key Packages

Drives

Do Not Enable
BitLocker Until
Recovery
Information is
Stored in AD DS for
Removable Data

Not Selected

Drives

Configure Use of
Hardware-Based
Encryption for

Removable Data

Selected

Drives

Use Hardware-
Based Encryption
for Removable Data

Selected
Drives

Use BitLocker
Software-Based
Encryption on
Removable Data
Drives When
Hardware

Selected

Encryption is Not
Available

Restrict Crypto
Algorithms and
Cipher Suites
Allowed for
Not Selected
Hardware-Based
Encryption on
Removable Data

Drives

Configure Specific
Crypto Algorithms
and Cipher Suites
Settings on
Removable Data

2.16.840.1.101.3.4.1.2;2.16.840.1.101.3.4.1.42

Drives

See basic settings

Manage Policies

to Store in AD DS for Removable Data Drives.

Recovery Passwords and Key Packages

Recovery Passwords Only

This policy provides the option of storing recovery passwords and key
packages, or storing the recovery password only in AD DS. The appropriate
schema extensions and access control settings on the domain must be first
configured before applying this policy.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

To use this policy, Save BitLocker Recovery Information to AD DS for
Removable Data Drives must be set to Selected.

Selected

Not Selected

Although BitLocker recovery information is automatically stored in the Dell
Server, this policy additionally requires BitLocker drive encryption recovery
information to be stored in AD DS. The appropriate schema extensions and
access control settings on the domain must be configured before using this
policy.

This policy is used to prevent users from enabling BitLocker unless the
computer is connected to the domain and the backup of the BitLocker
recovery information to AD DS has succeeded.

To use this policy, Choose How BitLocker-protected Removable Drives Can
be Recovered must be to Selected.

Selected

Not Selected

PARENT to the next 4 policies.

Selected enables the configuration of hardware-based encryption on
removable data drives.

Selected

Not Selected

Selected enables hardware-based encryption on removable data drives.
To use this policy, Configure Use of Hardware-Based Encryption for
Removable Data Drives must be set to Selected.

Selected

Not Selected

Selected enables BitLocker software-based encryption on removable data
drives if hardware-based encryption is not available.

To use this policy, Configure Use of Hardware-Based Encryption for
Removable Data Drives must be set to Selected.

Selected

Not Selected

Selected allows only specific crypto algorithm and cipher suites for
BitLocker hardware encryption.

To use this policy, Configure Use of Hardware-Based Encryption for
Removable Data Drives must be set to Selected.

String -

2.16.840.1.101.3.4.1.2;

2.16.840.1.101.3.4.1.42

Specific Crypto Algorithms and Cipher Suites allowed.

To use this policy, Configure Use of Hardware-Based Encryption for
Removable Data Drives must be set to Selected.
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Server Encryption

Allow Software
Server Encryption

Max Network Failed
Attempts

Retry Interval to
connect to Dell
Server

Retry if
Authentication Fails
Upon Network
Failure

Retry Interval Upon
Network Failure

Server Maintenance
Schedule

Server Maintenance
Schedule Repeats

Server Maintenance
Schedule Start Time

Server Maintenance
Day of the Week

Server Maintenance
Day of the Month

Infinite Suppress

Port Control System
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Off

Selected

Selected

10

Not Selected

Weekly

21:00

Saturday

Not Selected

Disabled

On

off

This policy enables or disables System Data Encryption (SDE) and Common
encryption on the client server.

Changing the value of this policy triggers a new sweep to encrypt/decrypt

files.

Selected

Not Selected

If this policy is Selected, client servers are activated at the Enterprise level.
This policy may be set to Not Selected to block activations during

initial Dell Server setup and maintenance interruptions.

1-10

Number of successive failed attempts for a client server to connect to the
Dell Server before encryption keys are locked.

1-60 minutes
Time interval for the client server to attempt to connect to the Dell Server.

Selected

Not Selected

If Selected, the client server continues to attempt to contact the Dell
Server if the first attempt fails due to a network failure.

10-60 minutes

The length of time between attempts to contact the Dell Server if the first
attempt fails due to a network failure. The Retry if Authentication Fails
Upon Network Failure policy must be set to Selected for this policy to be
enforced.

This policy must be selected to use all other Server Maintenance policies. If
this policy is Not Selected, no Server Maintenance policies are enforced,
regardless of other policy values.

Selected allows a maintenance schedule to control application of policy
that requires a reboot.

Daily, Weekly, Monthly, Quarterly, Annually

The schedule configuration defines when the task should run.

Daily: Runs the task every day at the specified Server Maintenance
Schedule Start Time.

Weekly: Runs the task weekly on the days specified in Server Maintenance
Day of the Week.

Monthly: Runs the task monthly on the specified Server Maintenance Day
of the Month.

Quarterly: Runs the task quarterly on the specified Server Maintenance
Day of the Month.

Annually: Runs the task annually on the specified Server Maintenance Day
of the Month.

Format is HH:mm. Example: 23:59

The time the task should run.

Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday

The day of the week the task should run.

1-31

The day of the month the task should run.

Example: 17.

When Selected, an automatic reboot is suppressed indefinitely.

Enable or Disable all Port Control System policies. If this policy is set to
Disable, no Port Control System policies are applied, regardless of other



Port: Express Card
Slot

Port: USB

Port: eSATA
Port: PCMCIA
Port: Firewire
(1394)

Port: SD

Port: Memory
Transfer Device
(MTD)

Class: Storage

Subclass Storage:
External Drive
Control

Subclass Storage:
Optical Drive
Control

Subclass Storage:
Floppy Drive
Control

Class: Windows
Portable Device
(WPD)

Subclass Windows
Portable Device

Enabled

Enabled

Enabled
Enabled

Enabled

Enabled

Enabled

Enabled

Full Access

UDF Only

Read Only

Enabled

Full Access

Manage Policies

Port Control System policies.
All PCS policies require a reboot before the policy takes effect.

Enable, Disable, or Bypass ports exposed through the Express Card Slot.

Enable, Disable, or Bypass port access to external USB ports.

Note: USB port-level blocking and HID class-level blocking is only honored
if we can identify the computer chassis as a laptop/notebook form-factor.
We rely on the computer's BIOS for the identification of the chassis.
Enable, Disable, or Bypass port access to external SATA ports.

Enable, Disable, or Bypass port access to PCMCIA ports.
Enable, Disable, or Bypass port access to external Firewire (1394) ports.

Enable, Disable, or Bypass port access to SD card ports.
Enable, Disable, or Bypass access to Memory Transfer Device (MTD) ports.

PARENT to the next 3 policies. Set this policy to Enabled to use the next 3
Subclass Storage polices. Setting this policy to Disabled disables all 3
Subclass Storage policies - no matter what their value.

CHILD of Class: Storage. Class: Storage must be set to Enabled to use this
policy.

This policy interacts with the EMS Access to unShielded Media policy. If
you intend to have Full Access to media, also set this policy to Full Access
to ensure that the media is not set to read only and the port is not blocked.
Full Access: External drive port does not have read/write data restrictions
applied

Read Only: Allows read capability /write data is disabled

Blocked: Port is blocked from read/write capability

This policy is endpoint-based and cannot be overridden by user policy.
CHILD of Class: Storage. Class: Storage must be set to Enabled to use this
policy.

Full Access: Optical Drive port does not have read/write data restrictions
applied

UDF Only: Blocks all data writes that are not in the UDF format (CD/DVD
burning, I1SO burning). Read data is enabled.

Read Only: Allows read capability. Write data is disabled

Blocked: Port is blocked from read/write capability

This policy is endpoint-based and cannot be overridden by user policy.
Universal Disk Format (UDF) is an implementation of the specification
known as ISO/IEC 13346 and ECMA-167 and is an open vendor-neutral file
system for computer data storage for a broad range of media.

To encrypt data written to CD/DVD media:

Set EMS Encrypt External Media = Selected, EMS Exclude CD/DVD
Encryption = Not Selected, and Storage Class: Optical Drive Control = UDF
Only.

CHILD of Class: Storage. Class: Storage must be set to Enabled to use this
policy.

Full Access: Floppy Drive port does not have read/write data restrictions
applied

Read Only: Allows read capability. Write data is disabled

Blocked: Port is blocked from read/write capability

This policy is endpoint-based and cannot be overridden by user policy.
PARENT to the next policy. Set this policy to Enabled to use the Subclass
Windows Portable Device (WPD): Storage policy. Setting this policy to
Disabled disables the Subclass Windows Portable Device (WPD): Storage
policy - no matter what its value.

Control access to all Windows Portable Devices.

CHILD of Class: Windows Portable Device (WPD) . Class: Windows Portable
Device (WPD) must be set to Enabled to use this policy.
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Enabled

Enabled

Not Selected

Not Selected

Read Only

AES256

Disabled

Not Selected

Selected

Full Access: Port does not have read/write data restrictions applied.

Read Only: Allows read capability. Write data is disabled.

Blocked: Port is blocked from read/write capability.

Control access to all Human Interface Devices (keyboards, mice).

Note: USB port-level blocking and HID class-level blocking is only honored
if we can identify the computer chassis as a laptop/notebook form-factor.
We rely on the computer's BIOS for the identification of the chassis.
Control access to all devices not covered by other Classes.

This policy must be selected to use all other removable media policies. Not
Selected means that no encryption of removable media takes place,
regardless of other removable media policy values.

Not Selected encrypts CD/DVD devices.

Block, Read Only, Full Access

Note that this policy interacts with the Storage > Subclass Storage: External
Drive Control policy. If you intend to set this policy to Full Access, ensure
that Subclass Storage: External Drive Control is not set to Read Only or
Blocked.

More...

When this policy is set to Block Access, you have no access to removable
media unless it is encrypted.

Choosing either Read-Only or Full Access allows you to decide what
removable media to encrypt.

If you choose not to encrypt removable media and this policy is set to Full
Access, you have full read/write access to removable media.

If you choose not to encrypt removable media and this policy is set to
Read-Only, you can read or delete existing files on the unencrypted media,
but files cannot be edited on, or added to, the media .

AES 256, AES 128, 3DES

Encryption algorithm used to encrypt removable media.

Encryption algorithms in order of speed, fastest first, are AES 128, AES 256,
3DES.

Disabled, Local, Roaming

Local automatic authentication allows the encrypted media to be
automatically authenticated when inserted in the originally encrypting
computer when the owner of that media is logged in. When local
automatic authentication is disabled, users must always manually
authenticate to access encrypted media.

Not selecting roaming automatic authentication helps to prevent users
from forgetting their password when they take the media home or share it
with a colleague. Not selecting roaming automatic authentication also
promotes a sense of awareness from a security perspective for users that
the data being written to that media is protected.

Selected allows removable media to be scanned every time it is inserted.
When this policy is Not Selected and the EMS Encrypt External Media
policy is Selected, only new and changed files are encrypted.

See EMS Encryption Rules if changing this policy to Selected. Do not enable
this policy without applying EMS Encryption Rules also.

More...

A scan occurs at every insertion so that any files added to the removable
media without authenticating can be caught. Files can be added to the
media if authentication is declined, but encrypted data cannot be
accessed. The files added are not encrypted in this case, so the next time
the media is authenticated (to work with encrypted data), any files that
may have been added are scanned and encrypted.

Selected allows the user to access encrypted data on removable media
whether the endpoint is encrypted or not.

More...

When this policy is Not Selected, the user can work with encrypted data



EMS Device
Whitelist

Manage Policies

when logged on to any encrypted device, regardless of the Dell Server the
user activated against. The user cannot work with encrypted data using
any unencrypted device.

String - Maximum of 150 devices with a maximum of 500 characters per
PNPDevicelD. Maximum of 2048 total characters allowed. "Space" and
"Enter" characters count in the total characters used.

This policy allows the specification of removable media devices to exclude
from encryption [using the device's Plug and Play device identifier
(PNPDevicelD)], thereby allowing users full access to the specified
removable media devices.

More...

This policy is available on an Enterprise, Domain, Group, and User level.
Note that local settings override inherited settings. If a user is in more than
one group, all EMS Device Whitelist entries, across all Groups, apply.

This policy is particularly useful when using removable media devices
which provide hardware encryption. However, this policy should be used
with caution. This policy does not check whether external media devices
on this list provide hardware encryption. Whitelisting removable storage
devices that do not have hardware encryption do not have enforced
security and are not protected.

For example, the Kingston® DataTraveler® Vault Privacy model enforces
that encryption is enabled to use the device. However, the Kingston
DataTraveler Vault model has an unsecured partition and a secured
partition. Because it is the same physical removable media device with only
one PNPDevicelD, the two partitions cannot be distinguished, meaning that
whitelisting this particular device would allow unencrypted data to leave
the endpoint.

Additionally, if a removable media device is encrypted and is subsequently
added to the EMS Device Whitelist policy, it remains encrypted and requires
a reformat of the device to remove encryption.

The following is an example of a PNPDevicelD, which contains the
manufacturer identifier, product identifier, revision, and hardware serial
number:

USBSTORDISK&YEN_KIMNGSTON
&PROD_DTYAULT_PRIVACYTR
REV_104,07005B831A0004B4&0

To whitelist a removable media device, provide a string value that matches
portions of the device’s PNPDevicelD. Multiple device PNPDevicelDs are
allowed.
For example, to whitelist all Kingston DataTraveler Vault Privacy models,
input the string:
PROD_DTYAULT PRIVALY
To whitelist both models of Kingston DataTraveler, the Vault and Vault
Privacy models, input the string:
PROD_DTYAULT_PRIVALCY;
PROD_DT_VAULT
Space characters are considered part of the substring to match to a
PNPDevicelD. Using the previous PNPDevicelD as an example, a space
before and after the semicolon would cause neither of the substrings to be
matched, because the space character is not part of the PNPDevicelD.
Instructions...
To find the PNPDevicelD for removable media:
1. Insert the removable media device into an encrypted
computer.
2. Open the EMSService.log in C:\Programdata\Dell\Dell Data
Protection\Encryption\EMS.
3. Find PNPDevicelD=

For example:
14.03.18 18:50:06.834 [I] [Volume "F:\"] PnPDevicelD =
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Selected

Selected

Selected

Not Selected

16

Apply Cooldown

USBSTOR\DISK&VEN_SEAGATE&PROD_USB&REV_0409\2HC01
5KJ&0

VEN=Vendor; Green highlighted text is for the vendor to be
excluded

PROD=Product/Model Name; Adding text highlighted blue also
excludes all of Seagate’s USB drives

REV=Firmware Revision; Adding text highlighted gray also
excludes the specific model being used

Serial number (in this example); Adding text highlighted yellow
excludes just this device
OR
To find the PNPDevicelD for removable media on Windows 7 or later:
1. Insert the removable media device.
2. Open the Control Panel and go to Administrative Tools >
Computer Management.
3. Select the Hardware tab, select the drive, and click Properties.
A new windows displays. Select the Device Instance Path in the
Property menu.
The PNPDevicelD is displayed in Value .

Available Delimeters:

Tabs

Commas

Semi colons

Hex character Ox1E (Record separator character)

Selected requires one or more letters in the password.

Selected requires at least one uppercase and one lowercase letter in the
password.

1-40 characters
Minimum number of characters required in the password.

Selected requires one or more numeric characters in the password.

1-10
Number of times the user can attempt to enter the correct password.

Selected requires one or more special characters in the password.

8, 16, 32
Number of characters access and device codes have. 32 characters is the
most secure, while 8 is the easiest to enter.

1-10

Number of times the user can attempt to enter the access code.

Apply Cooldown, Wipe Encryption Keys

Action to take following unsuccessful EMS Access Code Attempts Allowed:
¢ Apply Cooldown to allow another round of attempts following the
specified cooldown period (EMS Cooldown Time Delay and EMS Cooldown
Time Increment policies)



String
Authentication Failed. Please contact your system
administrator.

EMS Access Code
Required Message

EMS Cooldown

) 30
Time Delay
EMS Cooldown 20
Time Increment
String

EMS Access Code

) You are not authorized to use this media. Please contact
Failed Message

your system administrator.

EMS Encryption

Strin
Rules &

Manage Policies

¢ Wipe Encryption Keys to delete the encryption keys on the media,
making the encrypted data inaccessible until the owner takes the media to
an encrypted computer for which he has a login.

String - 5-512 characters - Authentication Failed: Please contact your
system administrator.

Message that displays when a user needs to contact an administrator for
an access code after authentication failure.

More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on
the client.

Optionally customize the second sentence of the message to include
specific instructions about how to contact a help desk or security
administrator for authentication failures.

0-5000 seconds

Number of seconds the user must wait before attempting to enter the
access code after failing the specified number of times.

0-5000 seconds

Incremental time to add to the cooldown time each time the user fails to
enter the correct access code in the specified number of attempts.

String - 5-512 characters - You are not authorized to use this media. Please
contact your system administrator.

Message that displays following unsuccessful Access Code Attempts
Allowed.

More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on
the client.

Optionally customize the message to include specific instructions about
how to contact the help desk or security administrator.

Encryption rules to be used to encrypt/not encrypt certain drives,
directories, and folders.

A total of 2048 characters are allowed. "Space" and "Enter" characters
used to add lines between rows count as characters used. Any rules
exceeding the 2048 limit are ignored.

See Encryption Rules for information.

More...

Storage devices which incorporate multi-interface connections, such as
Firewire, USB, eSATA, etc. may require the use of both Encryption External
Media and encryption rules to encrypt the endpoint. This is necessary due
to differences in how the Windows operating system handles storage
devices based on interface type.

To ensure encrypting an iPod via Encryption External Media does not make
the device unusable, use the following rules:

-R#t:\Calendars

-R#t:\Contacts

-R#:\iPod_Control

-R#:\Notes

-R#:\Photos

You can also force encryption of specific file types in the directories above.
Adding the following rules will ensure that ppt, pptx, doc, docx, xIs, and
xlsx files are encrypted in the directories excluded from encryption via the
previous rules:

AR#:\Calendars

;ppt.doc

Xls.pptx

.docx.xIsx

AR#:\Contacts
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;ppt

.doc.xls

.pptx.docx

Xlsx

R#:

\iPod_Control

;ppt.doc

Xls.pptx

.docx.xIsx

AR#:\Notes

;ppt.doc

Xls.pptx

.docx.xlsx

AR#:\Photos

;ppt.doc

Xls.pptx

.docx.xIsx

Replacing these five rules with the following rule will force encryption of
ppt, pptx, doc, docx, xIs, and xIsx files in any directory on the iPod,
including Calendars, Contacts, iPod_Control, Notes, and Photos:
AR#:\;ppt.doc.xls

.pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for
all removable devices - not just an iPod. Use care when defining rules to
exclude an iPod from encryption.

These rules have been tested against the following iPods:

iPod Video 30gb fifth generation

iPod Nano 2gb second generation

iPod Mini 4gb second generation

Dell does not recommend the use of the iPod Shuffle, as unexpected
results may occur.

As iPods change, this information could also change, so caution is advised
when allowing the use of iPods on Encryption External Media-enabled
computers.

Because folder names on iPods are dependent on the model of the iPod,
Dell recommends creating an exclusion encryption policy which covers all
folder names, across all iPod models.

Block access to any removable media that is less than 55 MB and thus has
insufficient storage capacity to host Encryption External Media (such as a
1.44MB floppy disk).

More...

All access is blocked if EMS Encrypt External Media and this policy are both
Selected. If EMS Encrypt External Media is Selected, but this policy is Not
Selected, data can be read from the unencryptable media, but write access
to the media is blocked.

EMS Block Access
to UnShieldable Selected
Media

If EMS Encrypt External Media is Off, then this policy has no effect and
access to unencryptable media is not impacted.
If this policy is Not Selected, SDE encryption is disabled, regardless of other
SDE Encryption selected policy values. Selected means that all data not encrypted by other
Enabled Intelligent Encryption policies are encrypted per the SDE Encryption Rules

policy. Changing the value of this policy requires a reboot.

AES 256, AES 128, 3DES
SDE Encryption AESS6 Encryption algorithm used to for System Data Encryption.
Algorithm Encryption algorithms in order of speed, fastest first, are AES 128, AES 256,

3DES.

String Encryption rules to be used to encrypt/not encrypt certain drives,
F#:\ directories, and folders. See Encryption Rules for information.

SDE Encryption . . .
-A%ENV:SYSTEMDRIVE%\System Volume Information SDE Encryption Rules may be changed as appropriate for your

Rules
-A%ENV:SYSTEMROOT%\;dll.exe.sys.ocx.man.cat environment. However, these defaults have been tested extensively.

.manifest.policy Removing these exclusions may result in Windows issues, particularly after
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Common Encrypted
Folders

Common
Encryption
Algorithm

Application Data
Encryption List

-A%ENV:SYSTEMROOT%\System32
-A%ENV:SYSTEMROOT%\SysWow64
-A%ENV:SYSTEMROOT%\WinSxS
-A%ENV:SYSTEMROOT%\Fonts
A3@%ENV:SYSTEMROOT%\SYSTEM32\;exe
-A3@%ENV:SYSTEMROOT%\SYSTEM32\cmd.exe;exe
-A3@%ENV:SYSTEMROOT%\SYSTEM32\autochk.exe;exe
-A3%ENV:SYSTEMDRIVE%\ProgramData\Dell\Kace
-A3%ENV:SYSTEMDRIVE%\Program Files\Dell\Kace
-A3%ENV:SYSTEMDRIVE%\Program Files (x86)\Dell\Kace

Selected

String
%ENV:SYSTEMDRIVE%\;accdb.doc.docm.docx.mdb. pdf.ppam
.pps.ppsM.ppsx.ppt.pptm.pptx.pub.puz.sldm.sldx.tif.tiff
vdx.vsd.vss.vst.vsx.vtx.xlam.xIm.xls.xlsb.xlsm.xlsx
xsf.zip.rar
%ENV:USERPROFILE%\Desktop
%ENV:USERPROFILE%\Download
-A%ENV:SYSTEMDRIVE%\;dat

AES256

Exe List
winword.exe

excel.exe
powerpnt.exe
msaccess.exe
winproj.exe
outlook.exe
acrobat.exe
visio.exe
mspub.exe
winzip.exe
winrar.exe
onenote.exe
onenotem.exe

Manage Policies

applying patch updates.
Contact ProSupport for guidance if you are unsure about changing the
values.

This policy must be selected to use all Common encryption policies. Not
Selected means that no Common encryption takes place, regardless of
other policy values.

Changing the value of this policy triggers a new sweep to encrypt/decrypt
files.

String - maximum of 100 entries of 500 characters each (up to a maximum
of 2048 characters)

A list of folders on computer drives to be encrypted or excluded from
encryption, which can then be accessed by all managed users who have
access to the computer. See Encryption Rules for information.

Important: Overriding directory protection can result in an unbootable
computer and/or require reformatting drives.

More...

The available drive letters are:

#: Refers to all drives

f#: Refers to all fixed (non-removable) drives

rit: Refers to all removable drives

AES 256 or AES 128

Encryption algorithm used to encrypt data at the endpoint (all users) level.
System paging files are encrypted using AES 128.

Encryption algorithms in order of speed, fastest first, are AES 128, AES 256,
3DES.

String - maximum of 100 entries of 500 characters each

Dell does not add explorer.exe or iexplorer.exe to the ADE list, as
unexpected or unintended results may occur.

Explorer.exe is the process used to create a new notepad file on the
desktop using the right-click menu.

Setting encryption by file extension, instead of the ADE list, provides more
comprehensive coverage.

Changes to this policy do not affect files already encrypted because of this
policy.

List process names of applications (without paths) whose new files you
want encrypted, separated by carriage returns. Do not use wildcards.
More...

You can also specify these process names (separated by commas) via the
registry value
HKLM\SOFTWARE\Credant\CMGShield\ApplicationDataEncryptionList.
The Encryption client encrypts all new files (not already being encrypted by
Common Encrypted Folders and User Encrypted Folders) on the current
computer hard drives created by these application processes whenever
they are owned by a currently-logged-on managed user. This may include
files excluded from encryption by Common Encrypted Folders and/or User
Encrypted Folders.

The following folders and their subfolders are always excluded from
encryption by this policy:

C:\Windows\system32

C:\Windows\Software Distribution

C:\Windows\Security

C:\System Volume Information\Program
Files\Credant\(.dll.exe.sys.mac.ddp.wip.rty.nmd.inv)
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Dell strongly recommends not listing applications or installers that write
system-critical files. Doing so could result in encryption of important
system files, which could make a Windows computer unbootable.
Common process hames:
outlook.exe
winword.exe
powerpnt.exe
msaccess.exe
wordpad.exe
mspaint.exe
excel.exe
The following hard-coded system and installer process names are ignored
if specified in this policy (you can also add to this list in the registry value
HKLM\SOFTWARE\Credant\CMGShield\EUWPrivilegedList):
hotfix.exe, a Windows update process
update.exe, a Windows update process
setup.exe, a third-party installer process
msiexec.exe, a third-party installer process
wuauclt.exe, a Windows update process
wmiprvse.exe, a Windows system process
migrate.exe, a Windows update process
unregmp?2.exe, a Windows update process
ikernel.exe, a third-party installer process
wssetup.exe, the Windows Encryption client installer
svchost.exe, a Windows system process
When this policy is selected, the paths listed in the environment variables
TEMP and TMP are encrypted. TEMP and TMP for the operating system are
encrypted with the Common encryption key.
To reduce encryption sweep time, the contents of the TEMP and TMP
folders are cleared for initial encryption, as well as updates to this policy.

Not Selected However, if your organization uses a third-party application that requires
the file structure within the \temp directory to be preserved, you should
prevent this deletion.
To disable temporary file deletion, create DeleteTempFiles (REG_DWORD)
and set its value to 0 in the registry at
HKLM\SOFTWARE\Credant\CMGShield.
When this policy is selected, the following are encrypted:

Not Selected ® The users profile (C:\Users\jsmith) with the User data encryption key
o \Users\Public with the Common encryption key

Encrypt Temporary
Files

Encrypt User Profile
Documents

Encrypt Windows Selected When this policy is selected, the Windows paging file is encrypted. A
electe
Paging File change to this policy requires a reboot.

String - maximum of 100 entries of 500 characters each (up to a maximum
of 2048 characters)

When a service is managed by this policy, the service is started only after
the user is logged in and the Encryption client is unlocked. This policy also
ensures that the Service managed by this policy is stopped before the
Encryption client is locked during logoff. This policy can also prevent a user
logoff if a service is unresponsive.

More...

Managed Services null Syntax is one service name per line. Spaces in the Service name are
supported. Wildcards are not supported. Entries are not case-sensitive. For
example, GoogleDesktop Manager is the same as googledesktopmanager.
The service "log on as" setting has no bearing on whether or not the
Encryption client can control it. It does not matter if a user logs on with
user credentials verses the local system.
The startup type (Automatic or Manual) does not affect the ability of the
Encryption client to control it. Automatic or Manual startup is acceptable.
Managed services are not started if an unmanaged user logs on.

Secure Post- No Overwrite, Single-pass Overwrite, Three-pass Overwrite, Seven-pass

A Single Pass Overwrite i
Encryption Cleanup Overwrite
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Secure Windows

R Selected
Credentials
Block Unmanaged
Access to Domain Selected

Credentials

Secure Windows
K K . Not Selected
Hibernation File

Prevent Unsecured
K K Not Selected
Hibernation

Workstation Scan
Priority

Lowest

Policy Proxy

Connections String

Manage Policies

Once encryption is complete, this policy determines what happens to the
unencrypted residue of the original files:

¢ No Overwrite deletes it. This value yields the fastest encryption
processing.

e Single-pass Overwrite overwrites it with random data.

® Three-pass Overwrite overwrites it with a standard pattern of 1s and Os,
then with its complement, and then with random data.

e Seven-pass Overwrite overwrites it with a standard pattern of 1s and Os,
then with its complement, and then with random data five times. This
value makes it most difficult to recover the original files from memory, and
yields the most secure encryption processing.

When this policy is selected, the Windows Credentials is secured by
encrypting the entire registry with the exception of registry information
required for computer boot. The information required for computer boot
includes HKLM/SYSTEM and all sub-keys.

This policy value is automatically set to Selected if SDE is enabled.

More...

A reboot is required when a change to this policy is delivered. To control
this reboot, configure the following policies: Force Reboot on Update,
Length of Each Reboot Delay, and Number of Reboot Delays Allowed.

This policy prevents unmanaged applications from accessing the Windows
domain credentials when a user is logged in.

When enabled, the hibernation file is encrypted only when the computer
enters hibernation. The Encryption client disengages protection when the
computer comes out of hibernation, providing protection without
impacting users or applications while the computer is in use.
When enabled, the Encryption client does not allow computer hibernation
if the client is unable to encrypt the hibernation data.
Highest, High, Normal, Low, Lowest
Specifies the relative Windows priority of encrypted folder scanning. High
and Highest prioritize scanning speed over computer responsiveness, Low
and Lowest prioritize computer responsiveness over scanning speed and
favor other resource-intensive activities, and Normal balances the two.
The client checks for a changed Workstation Scan Priority before
processing the next file.
The scan priority levels are used in two different ways.
1.  These values correspond with the values used by the Microsoft
SDK to set thread execution priority.
2. Theclient uses these values to introduce a delay in the
encryption sweep after every single file is processed.

The values translate to the following millisecond delay ranges,

where the encryption thread will sit idle and then return full

control to the operating system:

Highest=0 ms / Lowest=100 ms
String - maximum of 1500 characters
List fully qualified Policy Proxy hostnames, or IP addresses, separated by
carriage returns. Ports cannot be specified in this policy.
More...
Once a valid entry is found, the remainder of the Policy Proxies listed are
ignored.
Entries are processed in the following order:
1. GKConnections Override (this registry entry overrides all other entries)
2. GKConnections (this registry entry is set automatically by the client,
based on the this policy)
3.GK
To override this policy and specify ports via the registry key, set
HKLM\Software\Microsoft\WindowsNT\CurrentVersion\
Winlogon\CMGShield\GKConnectionsOverride.
The client communicates with Policy Proxies using the GKPORT (the default
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is 8000).
If necessary, change that port via the registry key
HKLM\SOFTWARE\Microsoft\WindowsNT\Current
Version\Winlogon\CMGShield\GKPort.
Inherited values for this policy accumulate.
For the client to connect to a Policy Proxy specified in this policy, it must be
in the same group as the Policy Proxy specified during client installation.
Because the client supports up to 255 users per computer, this policy is
available only at the Enterprise level.
1-1440 minutes
Policy Proxy Polling 220 The interval that the client attempts to poll Policy Proxy for policy updates,
Interval and send inventory information to Policy Proxy.
The client also attempts to poll Policy Proxy each time a user logs on.

See basic settings

Variables

Some Windows policies support the following variables. A pathname can consist entirely of one or more
of these variables, or can include one or more of these variables at any point.

To get directory locations that these CSIDL values resolve to, go to http://msdn.microsoft.com/en-
us/library/bb762494.aspx. All names listed on the MSDN page are CSIDL_<name>.

e Includes any of the following Windows CSIDL constants:
DESKTOP
INTERNET
PROGRAMS
CONTROLS
PRINTERS
PERSONAL
FAVORITES
STARTUP
RECENT
SENDTO
STARTMENU
STARTMENU
MYDOCUMENTS
MYMUSIC
MYVIDEO
DESKTOPDIRECTORY
DRIVES
NETWORK
NETHOOD
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FONTS

TEMPLATES
COMMON_STARTMENU
COMMON_PROGRAMS
COMMON_STARTUP
COMMON_DESKTOPDIRECTORY
APPDATA

PRINTHOOD
LOCAL_APPDATA
ALTSTARTUP
COMMON_ALTSTARTUP
COMMON_FAVORITES
INTERNET_CACHE
COOKIES

HISTORY
COMMON_APPDATA
WINDOWS

SYSTEM
PROGRAM_FILES
PROGRAMFILES
MYPICTURES

PROFILE

SYSTEMX86
PROGRAM_FILESX86
PROGRAMFILESX86
PROGRAM_FILES_COMMON
PROGRAM_FILES_COMMONX86
COMMON_TEMPLATES
COMMON_DOCUMENTS
COMMON_ADMINTOOLS
ADMINTOOLS
CONNECTIONS
COMMON_MUSIC
COMMON_PICTURES

Manage Policies
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COMMON_VIDEO
RESOURCES
PROFILES

e Includes a numeric or text value stored in the registry for the current user. If you specify a path
but not an item, the client uses the default value

e Includes a numeric or text value stored in the registry for the local computer. If you specify a
path but not an item, the client uses the default value

e Includes the value of a Windows local environment variable

e Includes the % character
Windows Policies that Require Reboot

e SDE Encryption Enabled

e Encrypt Windows Paging File

e Secure Windows Credentials

e All PCS policies
Windows Policies that Require Logoff

e SDE Encryption Enabled

e User state change to Suspended

e EMS Encrypt External Media

e EMS Scan External Media

e EMS Encryption Algorithm

e EMS Exclude CD/DVD Encryption

e EMS Data Encryption Key

Encryption Rules

Important: Before you begin, you must understand directory protection, as well as when and how to
override directories and file types. If you do not completely understand the information included in this
section, as well as the encryption settings that currently exist on your environment, do not attempt to
override protected directories.

Do not encrypt files with the extension tmp. Encrypting .tmp files may result in an unbootable computer
and/or require reformatting drives.

Protected Directories
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The Encryption client has several directories that are, by default, protected from encryption. The level of
protection varies from folder to folder. If a folder is protected, then the only way to encrypt data within
that directory is to use the override modifier described in Modifiers — What they are and what they do.

There are four levels (categories) of protection that directories and files can have: 0, 1, 2, and 3.
Category 3 is the most protected level.

Modifiers - What they are and what they do

The ~ character is the “Override” command. It causes the listed policy to override protected directories.
It may be followed by a “2” or a “3”, indicating the level of the override.

The @ character is the “At” command. It will cause the listed policy to be applied at the specified folder
location only (subdirectories of that folder are not subject to that policy).

The - is the “Not” command. It will cause the listed policy to be an exclusion policy instead of an
inclusion policy.

Using the Override Modifier

The Override Modifier can be used to allow for inclusion or exclusion in cases where there is a higher
level of protection. The following are the different override levels supported:

N Category 1 Override
A2 Category 2 Override
A3 Category 3 Override
Encrypting/Not Encrypting Extensions
To include or exclude file name extensions using encryption rules, use the following within your rules:
e After specifying your directory location, use a semi-colon (;) before listing your extensions.
e After specifying your directory location, you do not need to list a trailing backslash (\).

e The period is used as a delineator. It is not meant to be used as “dot-extension.” However, you
can precede the first extension with a period.

e The Override command (*) can be used with extensions.
e The At command (@)can be used with extensions.
e The Not command (-) can be used with extensions.
e You can make any combination of the modifiers with an extension inclusion or exclusion.
Examples of Extension Inclusions/Exclusion
C:\;doc.xls.ppt.docx.xlsx.pptx

What this does: On the C: drive, this encrypts all doc, docx, xls, xIsx, ppt, and pptx files that do not
exist within any protected directory.

AC:\;txt

What this does: On the C: drive, this encrypts all txt files that are not in a directory that has protection
of Category 1 or better.

-C:\;bat.exe.dll

What this does: On the C: drive, this causes all files with the extension bat, exe, and dIl to not be
encrypted.
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Encrypting/Not Encrypting Directories
To include or exclude directories using encryption rules, use the following within your rules:
e After specifying your directory location, you do not need to list a trailing backslash (\).
e If you list a directory for inclusion, every file contained within that directory is encrypted.
e The Override command (*) can be used with folders only when specifying an exclusion policy.
e The At command (@) can be used with folders.
e The Not command (-) can be used with folders.

e You can make any combination of the supported modifiers for folders. If the Override
command (") is used, the statement can only be an exclusion statement.

Examples of folder inclusion/exclusion
C:\CustomApplication\DataStore

What this does: On the C: drive, this causes every file within the directory of
\CustomApplication\DataStore to be encrypted.

-C:\Documents and Settings\All Users

What this does: On the C: drive, this applies a Category 0 level of protection to the directory of
\Documents and Settings\All Users.

-A2C:\CustomApplication\dll

What this does: On the C: drive, this applies a Category 2 level of protection to the directory of
\CustomApplication\dll.

Sub-directories and Precedence of Directives

Encryption rules may be listed in any order. If more than one rule applies to a given folder or file, then
the following general rules determine which one prevails:

1. The rule with the more specific path prevails.
2. If the rules have equal paths, specified extensions prevail.
3. If the rules both specify extensions, exclusion overrides inclusion.
Example of sub-directories
C:\
-C:\MyApplicationFolder

What this does: (1st statement is an inclusion, 2nd statement is an exclusion) On the C: drive, encrypt
all files in folders at the root level and below, except for files residing in the protected directories and
any files residing in “MyApplicationFolder”.

Example 1 of competing directives:
c:\

-C:\MyApplicationFolder
AC:\;doc.xIs.ppt.docx.xIsx.pptx

What this does: (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an
inclusion) On the C: drive, encrypt all files in folders at the root level and below, except for files residing
in the protected directories and files residing in “MyApplicationFolder”. However, override and encrypt
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files with the extension doc, docx, xlIs, xIsx, ppt, and pptx in the protected directories and in the folder
“MyApplicationFolder”.

Example 2 of competing directives:

c:\

-C:\MyApplicationFolder

AC:\;doc.xIs.ppt.docx.xIsx.pptx

-"C:\MyApplicationFolder;doc.xls.ppt.docx.xIsx.pptx

What this does: (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an
inclusion, 4th statement is an exclusion) On the drive of C:, encrypt all files in folders at the root level
and below, except for files residing in the protected directories and files residing in
“MyApplicationFolder”. However, override and encrypt files with the extension doc, docx, xls, xIsx, ppt,
and pptx in the protected directories, but not in the folder “MyApplicationFolder”.

Example 3 of competing directives:

c:\

-C:\MyApplicationFolder

AC:\;doc.xIs.ppt.docx.xIsx.pptx

-"C:\MyApplicationFolder;doc.xls.ppt.docx.xIsx.pptx

-AC:\MyApplicationFolder\Templates

What this does: (1st statement is an inclusion, 2nd statement is an exclusion, 3rd statement is an inclusion, 4th
statement is an exclusion, 5th statement is an exclusion) On the C: drive, encrypt all files in folders at the root
level and below, except for files residing in the protected directories and files residing in “MyApplicationFolder”.
However, override and encrypt files with the extension doc, docx, xls, xIsx, ppt, and pptx in the protected
directories, but not in the folder “MyApplicationFolder”. Additionally, the folder
“MyApplicationFolder\Templates” gains a category 2 protection causing no data to be encrypted there, since
the inclusion statements are less than or equal to category 2.

Environment Variables, KNOWNFOLDERID constants, and CSIDL

Using encryption rules, you can make use of environment variables, KNOWNFOLDERID constants
(Windows 7 and later), and CSIDL values (pre-Windows 7 computers) in addition to specifying your
policy folder locations as absolute paths. To use variables in your encryption rules, follow these
formatting rules:

Before and after the use of the variable, use a percent sign (%).

For environment variables, you must use “ENV:” preceding the variable name, all contained
within the percent signs.

For KNOWNFOLDERID constants, you must use "FOLDERID_" preceding the variable name.
Percent signs are not used.

For CSIDL variables, you must use “CSIDL:” preceding the variable name, all contained within
the percent signs.

Ensure that your variable contains a trailing backslash if you plan on appending another
directory after the use of the variable.

Variables can be used in both folder and extension inclusion or exclusion rules.

The following environment variables are supported:
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All locally defined environment variables
The following KNOWNFOLDERID values are supported:
RoamingAppData
Cookies

Desktop

Favorites

InternetCache
LocalAppData

Music

Pictures

Documents

Programs

Recent

SendTo

StartMenu

Startup

Templates

The following CSIDL variables are supported:
APPDATA

COOKIES
DESKTOPDIRECTORY
FAVORITES
INTERNET_CACHE
LOCAL_APPDATA
MYMUSIC
MYPICTURES
PERSONAL
PROGRAMS

RECENT

SENDTO

STARTMENU
STARTUP
TEMPLATES

Some examples of variables used in folder and extension policy:
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%ENV:SYSTEMDRIVE%\CustomApplication

What this does: This lists the folder \CustomApplication\ for encryption on the default drive where
Windows is installed.

-%ENV:USERPROFILE%\Desktop

What this does: This lists the user who is logged in to have their desktop obtain a category 0
protection.

Application Data Encryption (ADE)

ADE encrypts any file written by a protected application, using a category 2 override. This means that
any directory that has a category 2 protection or better, or any location that has specific extensions
protected with category 2 or better, will cause ADE to not encrypt those files.

For example, ADE does not encrypt any files written into /Windows/System32 folder, because this
directory has a default protection of category 2.

Example Policies for Common/User Key Encryption

The following set of encryption rules encrypts most of the drive, including standard Microsoft Office-type
documents in the Documents and Settings folders. This policy set should only be used for Common
encryption (not User encryption, removable media, or SDE). This is considered a strong policy set, and
will typically require some adjustments for local conditions and requirements.

%ENV:SYSTEMDRIVE%\

N%BENV:USERPROFILE%\;<insert standard office extensions here >
FOLDERID_Documents or %CSIDL:PERSONAL% (pre-Windows 7)
%ENV:USERPROFILE%\Desktop\
N%ENV:USERPROFILE%\;mp3.mp4.mpeg.avi.wmv.wav
-“"%ENV:USERPROFILE%\Desktop\;<system file extensions to exclude>
-%ENV:SYSTEMDRIVE%\;<system file extensions to exclude>
-%ENV:SYSTEMDRIVE%\config.msi

What this does:

Encrypts all of C:\, except for protected directories

Encrypts standard Microsoft Office documents across the drive, except for protected directories,
although it will encrypt them in the USERPROFILE directory.

Encrypts all of My Documents

Encrypts all of the Desktop, except for any selected excluded extensions

Excludes common system files from encryption

Excludes all encryption from C:\config.msi directory, due to MSI upgrade migration issues
All paths are dynamic based on environment variables

%ENV:USERPROFILE% (inclusion or exclusion) variable should never be used with SDE
Encryption.

System Data Encryption (SDE)

SDE is an intelligent file-based encryption method where the encryption key is auto-authenticated during
the volume mount process. A unique SDE key is generated for each volume that is targeted for
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encryption by SDE. This allows the SDE key to be used to encrypt data that would not otherwise be
possible with the Common or User keys due to time-based availability of the keys.

Due to the difference in how the SDE key can be used, there are several caveats to be aware of when
considering use of this feature.

e The built-in exclusions covered in protected directories do not apply to SDE. By design, SDE
excludes portions of the operating system that are necessary for booting and updating.

o If afile is targeted for encryption by any key other than SDE in addition to SDE, then SDE does
not encrypt the file.

e All encryption rules apply when writing SDE policies.
Encryption Rules for SDE Encryption

The following is the default SDE policy. Any changes to this policy should be considered carefully.

The protection of the SystemRoot directory is specified so that only the root itself is protected, meaning
that the sub-directories of the SystemRoot do not inherit this protection. This would be the equivalent of
using the following policy:

-@C:\
Encryption Rules for Encryption External Media

Removable Media Encryption policies operate off their own set of encryption rules, independent of
Common encryption, User encryption, or SDE uses. User/Common encryption policies are only applied
to fixed disks. If an endpoint is determined to be removable media, then Removable Media Encryption
policies are applied.

What Happens When Policies Tie

e When an exclusion and inclusion statement both apply to a given directory or file, the exclusion
policy prevails.

e If you apply a Common encryption policy and User encryption policy specifically to the same file
or location, the file or location is Common key encrypted.

e If you apply a Common encryption policy and an SDE encryption policy specifically to the same
file or location, the file or location is Common key encrypted.

e If you apply a User encryption policy and an SDE encryption policy specifically to the same file
or location, the file or location is User key encrypted.

See Sub-directories and Precedence of Directives for more information.

Encryption Rules for Generic Drive Statements

Instead of having to specify each drive in an inclusion or exclusion rule by its drive letter assignment,
you may use a generic rule to target either All Fixed Drives or all Removable Drives.

Fixed Drive Usage: Replace the drive letter with F#.
Example: F#:\ instead of C:\ or D:\

The Fixed Drive rule can only be used within a Common Encrypted Folder policy, User Encrypted
Folder policy, and/or SDE policy.

Removable Drive Usage: Replace the drive letter with R#.

Example: R#:\ instead of F:\ or H:\
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The Removable Drive rule can only be used within an Encryption External Media Encryption Rules
policy.

Remove System Data Encryption (SDE)
To completely decrypt SDE encrypted files, apply the following policies:
SDE Encryption Enabled = Not Selected
Encrypt Windows Paging File = Not Selected
Secure Windows Credentials = Not Selected

Authentication

Authentication
Authentication policies allow you to configure user experience and Windows authentication.

Policy descriptions also display in tooltips in the Management Console.

Password
Authentication Method Password Smart Card
Select the type of authentication to use when logging in to the PBA.

String 0-512 characters
Text to display on the PBA support information screen. Customize the
message to include specific instructions about how to contact the help
. desk or Security administrator. Not entering text in this field results in
Support Information Text String . no support contact information being available for the user.
Please contact your system administrator. :
Text wrapping occurs at the word level, not the character level. If a
single word is more than approximately 50 characters in length, it does
not wrap and no scroll bar is present, therefore the text is truncated.
The text in this policy is translatable.
0-17 characters
The text to display on the top of the PBA screen. Not entering text in
PBA Title Text 0-17 characters this field results in no title being displayed. Text does not wrap, so
entering more than 17 characters results in the text being truncated.
The text in this policy is translatable.

Select this option to sync all users of this computer with the PBA

Sync Users at PBA Activation Not Selected . L.
database during PBA activation.

See advanced settings

Logon Authentication Policy for Windows Password and None The possible VALUES are:
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Administrators Windows Password
None
Fingerprints
Contactless Card
The possible VALUES are:
Windows Password
None
Fingerprints
Contactless Card

Logon Authentication Policy for Users Windows Password and None

One-Time Password

See advanced settings

On

off

Toggle to On to enable Microsoft Passport. If this policy is toggled to
Off, no Microsoft Passport policies are enabled.

Microsoft Passport is supported only on computers running Windows

Microsoft Passport Off

10.
. i 1-10 attempts
Maximum Windows Passport X i
L 3 Number of chances the user has to authenticate with correct
Authentication Attempts i
credentials.
Logon Authentication Method PIN Currently, logon authentication method is supported only with PIN.

4-127 numeric characters

PIN Length 8
g Minimum number of characters required in the PIN.

Advanced Authentication

Authentication policies allow you to configure user experience and Windows authentication.

Policy descriptions also display in tooltips in the Management Console.

Password

Smart Card

Select the type of authentication to use when
logging in to the PBA.

Authentication Method Password
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Support Information Text

PBA Title Text

Sync Users at PBA Activation

Legal Notice Text

Self Help Questions (Pre-8.0 clients)

String

Please contact your system administrator.

0-17 characters

Not Selected

String 0-512 characters

At least 3 selectable questions

Manage Policies

String 0-512 characters

Text to display on the PBA support information
screen. Customize the message to include specific
instructions about how to contact the help desk or
Security administrator. Not entering text in this
field results in no support contact information
being available for the user.

Text wrapping occurs at the word level, not the
character level. If a single word is more than
approximately 50 characters in length, it does not
wrap and no scroll bar is present, therefore the
text is truncated.

The text in this policy is translatable.

0-17 characters

The text to display on the top of the PBA screen.
Not entering text in this field results in no title
being displayed. Text does not wrap, so entering
more than 17 characters results in the text being
truncated.

The text in this policy is translatable.

Select this option to sync all users of this
computer with the PBA database during PBA
activation.

String 0-512 characters

Text to display before being allowed to log on to
the computer. For example: By clicking OK, you
agree to abide by the acceptable computer use
policy.

Not entering text in this field results in no text,
OK, or Cancel buttons being displayed.

Text wrapping occurs at the word level, not the
character level. If a single word is more than
approximately 50 characters in length, it does not
wrap and no scroll bar is present, therefore the
text is truncated.

The text in this policy is translatable.

Specify the questions to present to Windows
users during recovery questions setup. Separate
each question by a carriage return. These
questions are used if the Windows password is
forgotten. At least 3 questions must be specified.
What is the name of your first pet?

Who was your first employer?

What was the first concert you attended?

What was the make of the first car you owned?
What was the last name of your third grade
teacher?

In what city or town did your mother and father
meet?

In what city or town was your first job?
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Initial Access Code

Encryption Administrator Password

Non-Cached User Login Attempts Allowed

Cached User Login Attempts Allowed

Self Help Question/Answer Attempts Allowed

Enable One Step Logon

Number of Shutdown/Restart Delays Allowed

Length of Each Shutdown/Restart Delay
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String 1-100 characters

String

50

10

Selected

300 seconds

String 1-100 characters

This policy is used to log on to a computer when
network access to Dell Server and Active Directory
(AD) are both unavailable. The Initial Access Code
policy should only be used if absolutely necessary,
it is not the recommended method to log in. Using
the Initial Access Code policy does not provide the
same level of security as the usual authentication
method of logging in using user name, domain,
and password.

The Initial Access Code can only be used one time,
immediately after activation. The first domain
login that occurs after the Initial Access Code is
entered is cached and the Initial Access Code
entry field does not displayed again.

9-32 characters with at least 1 number and 1
letter

Computer-generated password used by the Dell
Server and client for recovery and other internal
processes. No user or administrator interaction is
required. All values are automatically maintained
in the Dell Server and can never be deleted.
Entering a value for this policy does not affect the
Override Count.

Any number

This policy does not come into play when
connected to the network (there is a connection
to AD), because authentication with AD is
attempted.

This policy only comes into play when the
computer is not connected to the network and an
unknown user attempts to log in (meaning, a user
that has not logged in to the computer before --
no credentials have been cached).

1-20 times

Number of times that a cached user can attempt
to log in.

1-10 times

Number of times the user can attempt to enter
the correct answer.

This policy simplifies the logon process when
multi-factor authentication is enabled at both
preboot and Windows logon. If selected (or not
configured), authentication is required at preboot
only, and users are automatically logged on to
Windows. If not selected, authentication may be
required multiple times.

1-25 times

Number of times that a user is allowed to
snooze/delay a shutdown/restart before being
forced to shutdown/restart.

TPM requires a reboot.

SED requires a shutdown.

300-30000 seconds

Number of seconds between each time the user is
asked to shutdown/reboot.

TPM requires a reboot.

SED requires a shutdown.



Length of Forced Shutdown/Restart Notice

Allow PBA to Remember User Name

Crypto Erase Password

Enable Client Check for PBA Commands

See basic settings

60 seconds

Selected

String 0-100 characters

Not Selected

Manage Policies

60-1800 seconds

When user has reached the maximum number of
authorized shutdown/restart snoozes/delays, this
policy sets the number of seconds allowed before
forcing a shutdown/restart.

TPM requires a reboot.

SED requires a shutdown.

Selected

Not Selected

Enables or disables the ability for users to select
Remember Me on the PBA login screen.

String 0-512 characters

A word or code of up to 100 characters used as a
fail-safe security mechanism. Entering this word
or code in the user name or password field during
PBA authentication initiates a crypto erase, which
removes the keys from secure storage. Once this
process is invoked, the drive is unrecoverable.
Leave this field blank if you do not want a crypto
erase password available in case of emergency.

Allows the client to automatically check for PBA
Device Control commands that are pushed from
the Dell Server. When enabled, the PBA
environment checks for new commands from the
Dell Server every five minutes.

Logon Authentication Policy for Administrators

Logon Authentication Policy for Users

In-session Authentication Policy for
Administrators

Windows Password and None

Windows Password and None

Windows Password and None

The possible VALUES are:
Windows Password
None

Fingerprints

Contactless Card

The possible VALUES are:
Windows Password
None

Fingerprints

Contactless Card

The possible VALUES are:
Windows Password
None

Fingerprints

Contactless Card
One-Time Password
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In-session Authentication Policy for Users

Recovery Questions for Windows Authentication

Allow Recovery Questions
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Windows Password and None

At least 3 selectable questions

Not Selected

The possible VALUES are:
Windows Password
None

Fingerprints

Contactless Card
One-Time Password

Specify the questions to present to Windows
users during recovery questions setup. Separate
each question by a carriage return. These
questions are used if the Windows password is
forgotten. At least 3 questions must be specified.
What is your mother's maiden name?

What was the name of the first school you
attended?

What is the name of your first pet?

What is your father's middle name?

What is your mother's middle name?

Who was your first employer?

Who was your first teacher?

What city were you born in?

What city was your mother born in?

What city was your father born in?

What was the first concert you attended?

Who is your favorite TV show character?

What was the name of your first stuffed animal?
What was the make of the first car you owned?
Where did you spend your honeymoon?

Where did you meet your spouse?

What is your oldest cousin's name?

What is your oldest niece's name?

What is your oldest nephew's name?

What is your youngest child's nickname?

What is your oldest child's nickname?

What was the last name of your third grade
teacher?

In what city or town did your mother and father
meet?

In what city or town was your first job?

Selected

Not Selected

Set to Selected to allow users to use recovery
questions/answers to log on to Windows.



Log Events Level

False Accept Rate of Fingerprint

Minimum Number of Fingerprints to Enroll

Maximum Number of Fingerprints to Enroll

Minimum Length of PIN

Allow Users to Enroll Credentials

Allow Users to Modify Credentials

Audit

Medium High - 1 in 100,000

10

Selected

Selected

Manage Policies

Errors

Audit

Details

Level of detail in Windows Event logs.
Determines whether events such as fingerprint
registration and authentication attempts are
logged in the Windows Event log.

Each higher level includes all previous levels.
Events are logged on the computer where they
occur. Normally, the auditing level provides
sufficient detail, covering all logon,
authentication, fingerprint management, and user
management events. The details levels can fill the
log file very quickly. Status events provide
information about the state of several important
systems on the computer. They are logged on
configurable intervals and generally used when
events are remotely collected.

The False Accept Rate is the probability of
receiving a false acceptance decision when
comparing fingerprints scanned from different
fingers.

You can select one of the following FAR values:

* Medium (1 in 10,000)

* Medium High (1 in 100,000)

* High (1 in 1,000,000)

For example: if you select Medium High, on
average, one false acceptance will occur when a
fingerprint is compared against one hundred
thousand fingerprints scanned from different
fingers.

The higher the setting, the lower the chance of
receiving a false acceptance. However, at the High
setting, the system may reject legitimate
fingerprints.

NOTE: The FAR is set on a per verification basis.
When matching a fingerprint against fingerprints
of multiple users (identification), the internally
used FAR is automatically adjusted to maintain
the same effective FAR as was selected for a single
match.

The minimum number of fingerprints required to
be enrolled.

The maximum number of fingerprints required to
be enrolled.

The minimum number of characters required in
the PIN.

Set to Selected to allow users to enroll their own
credentials without administrator involvement.
Set to Selected to allow users to modify their own
credentials that have been previously set up or
enrolled.
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Reminder to Enroll Credentials (Admin) In one day

Reminder to Enroll Credentials Expiration Date

Now
(Admin)
Reminder to Enroll Credentials (User) In one day
Reminder to Enroll Credentials Expiration Date N
ow
(User)
Action Upon Smart Card Removal Lock Workstation

Threat Prevention

Threat Prevention

Values for reminders:
Disable Reminder

At Next Logon

In One Day

In One Week

Every Two Hours

The date (time is always 12 am) when
authentication policy is going into full effect.
Meaning, the client stops asking the local
administrator to enroll credentials and forces
them to enroll before they can logon. The default
is “now”.

Values for reminders:
Disable Reminder

At Next Logon

In One Day

In One Week

Every Two Hours

The date (time is always 12 am) when
authentication policy is going into full effect.
Meaning, the client stops asking the user to enroll
credentials and forces them to enroll before they
can logon. The default is “now”.

No Action

Lock Workstation

Force Logoff

Disconnect if on a Remote Desktop session
The action that occurs when a smart card is
removed from the computer.

Threat Prevention policies are available at the Enterprise, Endpoint Group, and Endpoint levels.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are

in bold font.

Advanced Threat Prevention Off
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On

off

Toggle ON to enable Advanced Threat Prevention. If this
policy is toggled to OFF, Advanced Threat Prevention is
disabled, regardless of other policies.



File Actions

Unsafe Executable Auto Quarantine with

Selected
Executable Control Enabled
Abnormal Executable Auto Quarantine with

Selected
Executable Control Enabled
Memory Actions
Memory Protection Enabled Not Selected

See advanced settings

Manage Policies

Selected

Not Selected

If selected, Unsafe executable files are automatically
quarantined or blocked to prevent their execution.

Note: If you Auto Quarantine, it is highly recommended
that before deployment, you test Auto Quarantine only on
devices using a test policy to observe the behavior and
ensure that no business-critical applications are blocked at
execution.

Selected

Not Selected

If selected, Abnormal executable files are automatically
quarantined or blocked to prevent their execution.

Note: If you Auto Quarantine, it is highly recommended
that before deployment, you test Auto Quarantine only on
devices using a test policy to observe the behavior and
ensure that no business-critical applications are blocked at
execution.

Selected

Not Selected

This policy must be selected to use all other Memory
policies. If this policy is Not Selected, no Memory Action
policies are enforced, regardless of other policy values.
NOTE: Before enabling Memory Protection, enable
Compatibility Mode, to ensure applications function
properly on the client computer. For instructions on how
to enable Compatibility Mode, see

Enable_Compatibility Mode for Memory Protection.htm.
Compatibility Mode does not apply to Mac clients.

Threat Protection Off

Exploit Protection Selected

Action on Malicious Activity for Files and

Block and Report
Folders P

On

off

Toggle to ON to enable Threat Protection. If toggled to
OFF, no Threat Protection policies are applied.

Threat Protection includes Malware Protection, Web
Protection, and Client Firewall.

Selected

Not Selected

This policy is the "master policy" for all other Exploit
Protection policies. If this policy is Not Selected, no Exploit
Protection policies are enforced, regardless of other policy
values.

A Selected value means that Exploit Protection is enabled.
Exploit Protection monitors for application vulnerabilities
and keeps buffer overflow exploits from executing
arbitrary code on the computer.

This policy must be set to Selected to enable Exploit
Protection. If this policy is Not Selected, no Exploit
Prevention policies are applied.

Block Only

Report Only
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Action on Malicious Activity for Registry

On-Access Protection

See advanced settings

Block and Report

Selected

Block and Report

Prevents users from modifying or deleting Threat
Protection system files and folders and sets the action to
take upon attempt.

Block Only: Blocks activity but does not report to the
server.

Report Only: Reports activity to the server but does not
block activity.

Block and Report (default): Blocks and reports activity to
the server.

Block Only

Report Only

Block and Report

Prevents users from modifying or deleting Threat
Protection registry keys and values and sets the action to
take upon attempt.

Block Only: Blocks activity but does not report to the
Server.

Report Only: Reports activity to the Server but does not
block activity.

Block and Report (default): Blocks and reports activity to
the Server.

Selected

Not Selected

This policy is the "master policy" for all other On-Access
Protection policies. If this policy is Not Selected, no On-
Access Protection policies are enforced, regardless of other
policy values.

A Selected value means that On-Access Protection is
enabled.

This policy must be set to Selected to enable On-Access
Protection. If this policy is Not Selected, no On-Access
Protection policies are applied.

Web Protection

Enforcement - Action to Apply to Sites Not
Verified

Enforcement - Enable File Scanning for File
Downloads
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Off

Allow

Selected

On

off

Toggle to ON to enable Web Protection. If toggled to OFF,
no Web Protection policies are applied.

Block

Allow

Warn

Specifies the default action to apply to sites that have not
been verified.

Block: Prevents users from accessing the site and displays a
message that the site is blocked.

Allow: Permits users to access the site.

Warn: Displays a warning to notify users of potential
dangers associated with the site. Users must dismiss the
warning before continuing.

Selected

Not Selected



Manage Policies

A Selected value scans all files (including .zip files) before
downloading. This option prevents users from accessing a
downloaded file until Threat Protection marks the file as
clean.
Downloaded files are sent to Threat Protection for
scanning. Threat Protection performs a Reputation Service
lookup on the file. If a downloaded file is detected as a
threat, Threat Protection takes action on the file and alerts
the user.
Selected
Not Selected

Enable Secure Search Not Selected A Selected value enables Secure Search, automatically
blocking malicious sites in search results based on safety
rating.
Selected
Not Selected

Block Links to Risky Sites in Search Results Not Selected A Selected value prevents users from clicking links to risky

sites in search results.

See advanced settings

On
off
Client Firewall Off Toggle to ON to enable Client Firewall. If toggled to OFF, no
Client Firewall Settings or Rules are applied.
Client firewall is a stateful firewall.

See advanced settings

Selected
Not Selected
If Selected, popup notifications of Advanced Threat

Suppress Popup Notifications Not Selected

Prevention events are disabled on the computer.

High

Medium

Low

Severity level of events that result in popup notifications

that display on the computer.

High allows only notifications of critical events to display.

Low displays all on-screen notifications for all events.
Minimum Popup Notification Level High Listed below are examples of events:

High

1) Protection status has changed. (Protected means that

the Advanced Threat Prevention service is running and

protecting the computer and needs no user or

administrator interaction.)

2) A threat is detected and policy is not set to

automatically address the threat.
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Medium

1) Execution Control blocked a process from starting
because it was detected as a threat.

2) A threat is detected that has an associated mitigation
(for example, the threat was manually quarantined), so the
process has been terminated.

3) A process was blocked or terminated due to a memory
violation.

4) A memory violation was detected and no automatic
mitigation policy is in effect for that violation type.

Low

1) A file that was identified as a threat has been added to
the Global Safe List or deleted from the file system.

2) A threat has been detected and automatically
quarantined.

3) A file has been identified as a threat, but waived on the
computer.

4) The status of a current threat has changed (for example,
Threat > Quarantined, Quarantined > Waived, or Waived >
Quarantined).

String - File path

Specifies the location for the log files.

The default location is
<SYSTEM_DRIVE>:\ProgramData\DDP\Suite\Logs.
Selected

Not Selected

This policy is the "master policy" for all other Threat
Protection logging policies. If this policy is Not Selected, no
Threat Protection logging takes place, regardless of other
policy values.

A Selected value enables Threat Protection logging.

Log Files Location <SYSTEM_DRIVE>:\ProgramData\DDP\Suite\Logs

Enable Activity Logging Selected

Selected
Not Selected
A Selected value enables verbose logging of Web
Protection activity.
Selected
Debug Logging for Client Firewall Not Selected
Not Selected . .
A Selected value enables verbose logging of Firewall
activity.

Debug Logging for Web Protection Not Selected

Advanced Threat Prevention

Threat Prevention policies are available at the Enterprise, Endpoint Group, and Endpoint levels.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.
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Advanced Threat
Prevention

File Actions

Unsafe Executable
Auto Quarantine
With Executable
Control Enabled

Unsafe Executable
Auto Upload
Enabled

Abnormal
Executable Auto
Quarantine With
Executable Control
Enabled

Abnormal
Executable Auto
Upload Enabled

Allow Execution of
Files in Exclude
Folders

Auto Delete

Days until Deleted

Memory Actions

Memory Protection
Enabled

Enable Exclude
executable files

Off

Selected

Selected

Selected

Selected

Not Selected

Not Selected

14

Not Selected

Selected

Manage Policies

On

off

Toggle ON to enable Advanced Threat Prevention. If this policy is toggled to
OFF, Advanced Threat Prevention is disabled, and policies are set to defaults
for activated devices. This results in Execution Control blocking threats, but
Auto Quarantine, Memory Protection, and Script Control will be disabled.

Selected
Not Selected

If selected, Unsafe executable files are automatically quarantined or
blocked to prevent their execution.

Note: If you Auto Quarantine, it is highly recommended that before
deployment, you test Auto Quarantine only on devices using a test
policy to observe the behavior and ensure that no business-critical
applications are blocked at execution.

Selected

Not Selected

If selected, any detected Unsafe file is automatically uploaded for a deeper
analysis and additional details about the file.

Selected

Not Selected

If selected, Abnormal executable files are automatically quarantined
or blocked to prevent their execution.

Note: If you Auto Quarantine, it is highly recommended that before
deployment, you test Auto Quarantine only on devices using a test
policy to observe the behavior and ensure that no business-critical
applications are blocked at execution.

Selected

Not Selected

If selected, any detected Abnormal file is automatically uploaded for a deeper
analysis and additional details about the file.

Selected

Not Selected

If selected, executable files are allowed to run, even if they are in folders
excluded in the Exclude Specific Folders policy.

Selected

Not Selected

If selected, after the time period specified in the Days until Deleted policy, files
that are quarantined on an endpoint are automatically deleted.

14-365 days

Number of days until files that are quarantined on an endpoint are
automatically deleted.

Selected

Not Selected

This policy must be selected to use all other Memory policies. If this policy is
Not Selected, no Memory Action policies are enforced, regardless of other
policy values.

NOTE: Before enabling Memory Protection, enable Compatibility Mode, to
ensure applications function properly on the client computer. For instructions
on how to enable Compatibility Mode, see Enable Compatibility Mode for
Memory Protection.

Compatibility Mode does not apply to Mac clients.

Selected

Not Selected

Allow specific process files to be excluded from Memory Protection. This policy
must be selected to use the Exclude executable files policy.
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String
String Exclude specific process files from Memory Protection. This allows the
\Windows\System32\CmgShieldService.exe specified files to run or be installed on any device on which this policy is
enforced.

\Windows\System32\EMSService.exe
\Program Files\Dell\Dell Data Protection\Threat
Protection\DellAVAgent.exe

All exclusions added must be specified using the relative path of that
executable file (exclude the drive letter from the path).

Correct (Windows): \Application\SubFolder\application.exe

Correct (Mac): /Users/application.app/executable

Incorrect: \Application\SubFolder\

Incorrect: C:\Application\SubFolder\application.exe

\Program Files\McAfee\Agent\cmdagent.exe
\Program Files\McAfee\Agent\FrmInst.exe
\Program Files\McAfee\Agent\macmnsvc.exe
\Program Files\McAfee\Agent\macompatsvc.exe
\Program Files\McAfee\Agent\maconfig.exe
\Program Files\McAfee\Agent\masvc.exe
\Program Files\McAfee\Agent\x86\Frminst.exe
\Program Files\McAfee\Agent\x86\macompatsvc.exe
\Program Files\McAfee\Agent\x86\marepomirror.exe
\Program Files\McAfee\Agent\x86\McScanCheck.exe
\Program Files\McAfee\Agent\x86\McScript_InUse.exe
\Program Files\McAfee\Agent\x86\mctray_back.exe
\Program Files\McAfee\Agent\x86\Mue.exe
\Program Files\McAfee\Agent\x86\policyupgrade.exe
\Program Files\McAfee\Agent\x86\UpdaterUl.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\ESConfigTool.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\MFEConsole.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\mfeesp.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\mfeProvisionModeUtility.exe
Exclude executable \Program Files\McAfee\Endpoint Security\Endpoint
files Security Platform\PwdUninstall.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\RepairCache\CCUninst.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\RepairCache\McAfee_Common_x64.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\RepairCache\McAfee_Common_x64.msi
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\RepairCache\McAfee_Common_x86.msi
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\RepairCache\setupCC.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\aacinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\cacheinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\Release\fwinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\mfecanary.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\mfefire.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
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Platform\VSCore_ENS_10.1\Release\mfehidin.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\mfemms.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\mfevtps.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\mmsinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security
Platform\VSCore_ENS_10.1\Release\vtpinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\aacinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\cacheinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\fwinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mfecanary.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mfefire.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mfehidin.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mfemms.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mfevtps.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\mmsinfo.exe
\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\VSCore_ENS_10.1\x64\vtpinfo.exe
\Program Files\McAfee\Endpoint
Security\Firewall\FWInstCheck.exe

\Program Files\McAfee\Endpoint
Security\Firewall\FwWindowsFirewallHandler.exe
\Program Files\McAfee\Endpoint
Security\Firewall\mfefw.exe

\Program Files\McAfee\Endpoint
Security\Firewall\RepairCache\McAfee_Firewall_x64.msi
\Program Files\McAfee\Endpoint
Security\Firewall\RepairCache\McAfee_Firewall_x86.msi
\Program Files\McAfee\Endpoint
Security\Firewall\RepairCache\setupFW.exe
\Program Files\McAfee\Endpoint Security\Web
Control\McChHost.exe

\Program Files\McAfee\Endpoint Security\Web
Control\mfewc.exe

\Program Files\McAfee\Endpoint Security\Web
Control\mfewch.exe

\Program Files\McAfee\Endpoint Security\Web
Control\mfewcui.exe

\Program Files\McAfee\Endpoint Security\Web
Control\RepairCache\McAfee_Web_Control_x86.msi
\Program Files\McAfee\Endpoint Security\Web
Control\RepairCache\setupWC.exe

\Program Files\McAfee\marepomirror.exe

\Program Files\McAfee\McScanCheck.exe

\Program Files\McAfee\McScript_InUse.exe

\Program Files\McAfee\mctray_back.exe

Manage Policies
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\Program Files\McAfee\Mue.exe

\Program Files\McAfee\policyupgrade.exe
\Program Files\McAfee\UpdaterUl.exe

\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security Platform\MaComServer.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security Platform\MFEConsole.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\mfeProvisionModeUtility.exe

\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\RepairCache\CCUninst.exe

\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\aacinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\cacheinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\fwinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mfecanary.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mfefire.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mfehidin.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mfemms.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mfevtps.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\mmsinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\Release\vtpinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\aacinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\cacheinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\fwinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mfecanary.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mfefire.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mfehidin.exe
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Pivot

\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mfemms.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mfevtps.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\mmsinfo.exe
\Program Files (x86)\McAfee\Endpoint
Security\Endpoint Security
Platform\VSCore_ENS_10.1\x64\vtpinfo.exe
\Program Files (x86)\McAfee\Endpoint Security\Web
Control\McChHost.exe

\Program Files (x86)\McAfee\Endpoint Security\Web
Control\mfewc.exe

\Program Files (x86)\McAfee\Endpoint Security\Web
Control\mfewch.exe

\Program Files (x86)\McAfee\Endpoint Security\Web
Control\mfewcui.exe

\Program Files (x86)\McAfee\Endpoint Security\Web
Control\RepairCache\McAfee_Web_Control_x64.msi
\Program Files (x86)\McAfee\Endpoint Security\Web
Control\RepairCache\setupWC.exe

\Program Files (x86)\McAfee\Endpoint Security\Web
Control\x64\mfewch.exe
\Windows\System32\mfevtps.exe

\Program Files\McAfee\Endpoint Security\Endpoint
Security Platform\LogDebugSetter.exe

\Program Files\McAfee\Endpoint
Security\MfeUpgradeTool.exe

Alert

Manage Policies

Ignore

Alert

Block

Terminate

Specify the action to take when a stack pivot threat is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Stack Pivot - The stack for a thread has been replaced with a different stack.
Generally the system will only allocate a single stack for a thread. An attacker
would use a different stack to control execution in a way that is not blocked by
Data Execution Prevention (DEP).

The Stack Pivot exploitation affects Windows and macOS operating systems.
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Ignore

Alert

Block

Terminate

Specify the action to take when a stack protect threat is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
Exploitation: Stack Alert violation process. The application that made the call is allowed to continue to
Protect run.

Terminate - Block the process call if an application attempts to call a memory

violation process and terminate the application that made the call.

Stack Protect - The memory protection of a thread's stack has been modified

to enable execution permission. Stack memory should not be executable, so

usually this means that an attacker is preparing to run malicious code stored in

stack memory as part of an exploit, an attempt which would otherwise be

blocked by Data Execution Prevention (DEP).

The Stack Protect exploitation affects Windows and macOS operating systems.

Ignore

Alert

Block

Terminate

Specify the action to take when an overwrite code threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.
Block - Block the process call if an application attempts to call a memory

Exploitation:
P Alert violation process. The application that made the call is allowed to continue to

Overwrite Code
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Overwrite Code - Code residing in a process's memory has been modified using
a technique that may indicate an attempt to bypass Data Execution Prevention
(DEP).

The Overwrite Code exploitation affects Windows operating systems. This
policy does not apply to Mac clients.

Ignore

Alert

Block

Terminate

Specify the action to take when a scanner memory search threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Exploitation: Block - Block the process call if an application attempts to call a memory
Scanner Memory Alert violation process. The application that made the call is allowed to continue to
Search run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Scanner Memory Search, or RAM Scraping - A process is trying to read valid
magnetic stripe track data from another process. Typically related to point-of-
sale systems (POS).

The Scanner Memory Search exploitation affects Windows operating systems.
This policy does not apply to Mac clients.
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Exploitation:
Malicious Payload

Process Injection:
Remote Allocation
of Memory

Process Injection:
Remote Mapping of
Memory

Alert

Alert

Alert

Manage Policies

Ignore

Alert

Block

Terminate

Specify the action to take when a malicious payload is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Malicious Payload - A generic shellcode and payload detection associated with
exploitation has been detected.

The Malicious Payload exploitation affects Windows operating systems. This
policy does not apply to Mac clients.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote memory allocation threat is
detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Allocation of Memory - A process has allocated memory in another
process. Most allocations will only occur within the same process. This
generally indicates an attempt to inject code or data into another process,
which may be a first step in reinforcing a malicious presence on a system.
The Remote Allocation of Memory process injection affects Windows and
macOS operating systems.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote attempt to map memory threat is
detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Mapping of Memory - A process has introduced code and/or data into
another process. This may indicate an attempt to begin executing code in
another process and thereby reinforce a malicious presence.

The Remote Mapping of Memory process injection affects Windows and
macOS operating systems.

208



Security Management Server v10.2.6 AdminHelp

Ignore

Alert

Block

Terminate

Specify the action to take when a remote attempt to write to memory threat is
detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Process Injection: Block - Block the process call if an application attempts to call a memory
Remote Write to Alert violation process. The application that made the call is allowed to continue to
Memory run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Write to Memory - A process has modified memory in another
process. This is usually an attempt to store code or data in previously allocated
memory but it is possible that an attacker is trying to overwrite existing
memory to divert execution for a malicious purpose.

The Remote Write to Memory process injection affects Windows and macOS
operating systems.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote attempt to write a portable
executable to memory threat is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Process Injection:
Remote Write PE to Alert
Memory

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Write PE to Memory - A process has modified memory in another
process to contain an executable image. Generally this indicates that an
attacker is attempting to execute code without first writing that code to disk.
The Remote Write PE to Memory process injection affects Windows operating
systems. This policy does not apply to Mac clients.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote overwrite code threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Process Injection:
Remote Overwrite Alert

Code
Terminate - Block the process call if an application attempts to call a memory

violation process and terminate the application that made the call.

Remote Overwrite Code - A process has modified executable memory in
another process. Under normal conditions executable memory is not modified,
especially by another process. This usually indicates an attempt to divert
execution in another process.

The Remote Overwrite Code process injection affects Windows operating
systems. This policy does not apply to Mac clients.
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Process Injection:
Remote Unmap of
Memory

Process Injection:
Remote Thread
Creation

Process Injection:
Remote APC
Scheduled

Alert

Alert

Alert

Manage Policies

Ignore

Alert

Block

Terminate

Specify the action to take when a remote memory unmapping threat is
detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Unmap of Memory - A process has removed a Windows executable
from the memory of another process. This may indicate an intent to replace
the executable image with a modified copy for the purpose of diverting
execution.

The Remote Unmap of Memory process injection affects Windows operating
systems. This policy does not apply to Mac clients.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote thread creation threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote Thread Creation - A process has created a new thread in another
process. A process's threads are usually only created by that same process.
This is generally used by an attacker to activate a malicious presence that has
been injected into another process.

The Remote Thread Creation process injection affects Windows and macOS
operating systems.

Ignore

Alert

Block

Terminate

Specify the action to take when a remote APC scheduled threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
violation process. The application that made the call is allowed to continue to
run.

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Remote APC Scheduled - A process has diverted the execution of another
process's thread. This is generally used by an attacker to activate a malicious
presence that has been injected into another process.

The Remote APC Scheduled process injection affects Windows operating
systems. This policy does not apply to Mac clients.
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Ignore

Alert

Block

Terminate

Specify the action to take when a remote DYLD injection threat is detected.
Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Process Injection: Block - Block the process call if an application attempts to call a memory
Remote DYLD Alert violation process. The application that made the call is allowed to continue to
Injection (Mac OS X run.

only) Terminate - Block the process call if an application attempts to call a memory

violation process and terminate the application that made the call.

DYLD Injection - An environment variable has been set to cause a shared

library to be injected into a launched process. Attacks can modify the plist of

applications like Safari or replace applications with bash scripts, that cause

their modules to be loaded automatically when an application starts.

The DYLD Injection process injection affects macOS operating systems. This

policy does not apply to Windows clients.

Ignore

Alert

Block

Terminate

Specify the action to take when an LSASS read threat is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
Alert violation process. The application that made the call is allowed to continue to

run.

Escalation: LSASS
Read

Terminate - Block the process call if an application attempts to call a memory

violation process and terminate the application that made the call.

LSASS Read - Memory belonging to the Windows Local Security Authority

process has been accessed in a manner that indicates an attempt to obtain

users' passwords.

The LSASS Read escalation affects Windows operating systems. This policy

does not apply to Mac clients.

Ignore

Alert

Block

Terminate

Specify the action to take when a zero byte allocation threat is detected.

Ignore - No action is taken against identified memory violations.

Alert - Record the violation and report the incident to the Dell Server.

Block - Block the process call if an application attempts to call a memory
Alert violation process. The application that made the call is allowed to continue to

run.

Escalation: Zero
Allocate

Terminate - Block the process call if an application attempts to call a memory
violation process and terminate the application that made the call.

Zero Allocate - A null page has been allocated. The memory region is typically
reserved, but in certain circumstances it can be allocated. Attacks can use this
to setup privilege escalation by taking advantage of some known null de-
reference exploit, typically in the kernel.

The Zero Allocate escalation affects Windows and macOS operating systems.

Execution Control

. Selected
Prevent Service
Not Selected
Shutdown from Not Selected . . X
Device If selected, the Advanced Threat Prevention service is protected from being

shut down either manually or by another process.
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Kill Unsafe Running
Processes and Sub-
Processes

Background Threat
Detection

Watch for New
Files

Set Maximum
Archive File Size to
Scan

Protection Settings

Enable Exclude
Specific Folders
(includes
subfolders)

Exclude Specific
Folders (includes
subfolders)

Application Control

Not Selected

Run Once

Selected

150 MB

Selected

String

Manage Policies

Selected

Not Selected

If selected, processes and sub-processes are quarantined and terminated
regardless of their state when a threat is detected (exe or dll). Although a
process or sub-process is terminated, the command prompt window remains
open.

If a file has been determined to be Safe and allowed to run and then a threat
model update occurs that results in the file being identified as unsafe, the
process is automatically terminated. Dell recommends that you review threat
model updates before Selecting this policy. For more information, see Threat
Model Updates.

Disabled

Run Recurring

Run Once

If set to Run Recurring or Run Once, a full-disk scan is run to detect and analyze
any dormant threats on the disk.

An update to the Threat Model triggers a full-disk scan.

Selected

Not Selected

If selected, any new or modified files are detected and analyzed for dormant
threats.

Dell recommends enabling this policy. However, If Auto Quarantine is enabled
for all Unsafe or Abnormal files, all malicious files are blocked at execution.
Therefore, it is not necessary to enable this policy with Auto Quarantine mode
unless you prefer to quarantine a file as it is added to a disk but before
execution.

The default setting is 150 MB.

Specify the maximum size of archive (compressed) files, including .jar files to
be scanned. Because scanning compressed files can negatively affect computer
performance, Dell recommends Quick-Scan - Scan Archives and Full-Scan - Scan
Archives to run during off-work hours.

Selected

Not Selected

Allow specific folders to be excluded from Auto Quarantine and Auto Upload.
This policy must be Selected to use the Exclude Specific Folders policy.

String

Folders specified in this policy are excluded from actions performed based on
Background Threat Detection and Watch for New Files, when these policies are
enabled. This exclusion extends to subfolders of folders that are specified in
this policy.

All exclusions must be specified using the Absolute path of that executable file.
Windows requires an absolute path (requires a drive letter)

Mac requires an absolute path (macOS does not use a drive letter)

Correct (Windows): C:\Program Files\Dell

Correct (Mac): /Mac\ HD/Users/Application\ Support/Dell

Incorrect: C:\Program Files\Dell\Executable.exe

Incorrect: \Program Files\Dell\

Spaces only must be escaped on Mac-based exclusions.
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Application Control

Application Control
Allowed Folders

Enable Change
Window

Script Control

Script Control

Script Control
Mode

Active Script
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Not Selected

String

Not Selected

Not Selected

Alert

Alert

Selected

Not Selected

If Selected, specified devices are locked down, restricting any changes. Only
applications that exist on a device before the lock-down are allowed to
execute on that device. Any new applications, as well as changes to the
executables of existing applications, are denied. The Advanced Threat
Prevention agent updater is also disabled.

Additionally, certain File Action, Memory Action, and Execution Control
policies are automatically set. These policies may be changed after they are
automatically set, without disabling Application Control. See Policies Set by
Application Control for a list of policies that are automatically set when the
Application Control policy is Selected.

To exclude specific folders from lockdown, specify the folders in the
Application Control Allowed Folders policy.

IMPORTANT: Specify the following folder in the Application Control Allowed
Folders policy when running Data Guardian Protected Office mode with this
policy Selected: C:\Users\<Username>\AppData\Local\assembly\tmp

This policy does not apply to Mac clients.

String

Specify folders to be excluded from Application Control lockdown.
IMPORTANT: Specify the following folder in this policy when running Data
Guardian Protected Office mode with the Application Control policy Selected:
C:\Users\<Username>\AppData\Local\assembly\tmp

Selected

Not Selected

If selected, Application Control is temporarily disabled to allow, edit, and run
new applications or perform updates. This includes updating the Advanced
Threat Prevention agent. After performing the necessary changes, deselect
Enable Change Window.

Note: Enable Change Window retains changes made to Application Control.
Deselecting Application Control and resetting back to Selected resets
Application Control to default values.

This policy does not apply to Mac clients.

Selected

Not Selected

If Selected, Script Control protects devices by blocking malicious scripts from
running.

Note: Script Control is currently only available for PowerShell and Active
Scripts.

This policy does not apply to Mac clients.

Alert

Block

Alert monitors scripts running in the environment. Recommended for initial
deployment.

Block allows scripts to run only from specific folders. This should be used only
after testing in Alert mode.

This policy does not apply to Mac clients.

Alert

Block

Alert monitors Active Scripts running in the environment. Recommended for
initial deployment.

Block allows Active Scripts to run only from specific folders. This should be
used only after testing in Alert mode.

This policy does not apply to Mac clients.



Macros

PowerShell

PowerShell Console

Enable Approve
Scripts in Folders
(and Subfolders)

Approve Scripts in
Folders (and
Subfolders)

Quarantine

Waive

Global Allow

Alert

Alert

Allow

Not Selected

String

String

String

String

Manage Policies

Alert

Block

Alert monitors Office macros running in the environment. Recommended for
initial deployment.

Block allows Office macros to run only from specific folders. This should be
used only after testing in Alert mode.

Note: Starting with Office 2013, macros are disabled by default. Most of the
time, users should not be required to enable macros to view the content of an
Office document. Dell recommends enabling macros only for documents from
trusted users. Otherwise, macros should always be disabled.

This policy does not apply to Mac clients.

Alert

Block

Alert (default) - Monitors PowerShell scripts running in the environment.
Recommended for initial deployment.

Block - Allow PowerShell scripts to run only from specific folders. This should
be used only after testing in Alert mode.

This policy does not apply to Mac clients.

Allow

Block

Allow (default) - Allows the PowerShell v3 console to be launched.

Block - Blocks the PowerShell v3 console from being launched. Provides
additional security by protecting against the use of PowerShell one-liners.
Note: If this policy is set to Block and you use a script that launches the
PowerShell console, the script will fail. It is recommended that users change
their scripts to invoke the PowerShell scripts, not the PowerShell console.
This policy applies only to PowerShell v3 and does not apply to Mac clients.
Selected

Not Selected

Allows scripts stored in specific folders to be automatically approved to run.
This policy must be selected to use the Script Control Approve Scripts in
Folders (and Subfolders policy).

This policy does not apply to Mac clients.

String

Folders specified in this policy are excluded from actions performed based on
the Script Control policy. This exclusion extends to subfolders of folders that
are specified with this policy.

A folder must be specified using its relative path. A path may not include the

drive letter. Example: \Cases\ScriptsAllowed
A specified path may represent any of the following:

- local drive path

- mapped network drive path

- universal naming convention (UNC) path
This policy does not apply to Mac clients.
String
The value of this policy includes a collection of hashes for portable executable
that need to be automatically quarantined within the Endpoint Group or on
the specific Endpoint. This policy will force quarantine files based on a SHA256
hash of the specific portable executable.

String

The value of this policy includes a collection of hashes for portable executable
that need to be allowed to run within the Endpoint Group or on the specific
Endpoint. This policy will force allow files based on a SHA256 hash of the
specific portable executable.

String

This policy defines a change to the local math model to prevent problematic
portable executable to properly run on the machine. This is used in situations
where normal exclusions may not properly apply to the files that are needing
to be waived. The value of this policy will consist of an XML blob that can be
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Global Quarantine
List

Global Safe List

Agent Settings

Suppress Popup
Notifications

Minimum Popup
Notification Level

Enable BIOS
Assurance
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String

String

Not Selected

High

Selected

provided by support if it is required.

The value of this policy must include the entire contents of the policy.xml file.
Copy and paste the contents of policy.xml into the policy editor as shown in
this example.

String

The value of this policy includes a collection of hashes for portable executable
that need to be automatically quarantined within the enterprise. This policy
will force quarantine files based on a SHA256 hash of the specific portable
executable.

String

The value of this policy includes a collection of hashes for portable executable
that need to be allowed to run within the enterprise. This policy will force
allow files based on a SHA256 hash of the specific portable executable.

Selected

Not Selected

If Selected, popup notifications for Advanced Threat Prevention events do not
display on the client computer.

High

Medium

Low

Severity level of events that result in popup notifications that display on the
client computer.

A setting of High allows only notifications of critical events to display. A setting
of Low displays all on-screen notifications for all events. Listed below are
examples of events that fall into the severity levels:

High

1) Protection status has changed. (Protected means that the Advanced Threat
Prevention service is running and protecting the computer and needs no user
or administrator interaction.)

2) A threat is detected and policy is not set to automatically address the threat.
Medium

1) Execution Control blocked a process from starting because it was detected
as a threat.

2) A threat is detected that has an associated mitigation (for example, the
threat was manually quarantined), so the process has been terminated.

3) A process was blocked or terminated due to a memory violation.

4) A memory violation was detected and no automatic mitigation policy is in
effect for that violation type.

Low

1) A file that was identified as a threat has been added to the Global Safe List
or deleted from the file system.

2) A threat has been detected and automatically quarantined.

3) Afile has been identified as a threat but waived on the computer.

4) The status of a current threat has changed (for example, Threat to
Quarantined, Quarantined to Waived, or Waived to Quarantined).

Selected

Not Selected

If selected, BIOS integrity checks are performed on endpoints computers to
validate that the BIOS has not been modified from the Dell factory version. A
custom factory image cannot be used with this feature, as the BIOS has been
modified. This feature is available only on Dell platforms.

Platforms available with this feature include the newest release of select XPS,
Latitude, Optiplex, Precision Workstations, and Venues. Speak to your Sales
Associates for details or contact Dell ProSupport.

This policy does not apply to Mac clients.



Enable Auto-upload
of Log Files

Enable Standard Ul

See basic settings

Not Selected

Not Selected

Manage Policies

Selected

Not Selected

If selected, log files are automatically uploaded at 12:00 am or when their size
reaches 100 MB. If this policy is Not Selected, logs can still be manually
uploaded.

Selected

Not Selected

If Selected, the User Interface that will show individual details for threat events
that have occurred on the local client is enabled.

Threat Protection

Action on Malicious
Activity for Files
and Folders

Action on Malicious
Activity for Registry

Action on Malicious
Activity for
Processes

Exclude Processes

Client Update

Off

Block and Report

Block and Report

Block and Report

String

On

Off

Toggle to ON to enable Threat Protection. If toggled to OFF, no Threat
Protection policies are applied.

Threat Protection includes Malware Protection, Web Protection, and Client
Firewall.

Block Only

Report Only

Block and Report

Prevents users from modifying or deleting Threat Protection system files and
folders and sets the action to take upon attempt.

Block Only: Blocks activity but does not report to the Dell Server.

Report Only: Reports activity to the Dell Server but does not block activity.
Block and Report (default): Blocks and reports activity to the Dell Server.

Block Only

Report Only

Block and Report

Prevents users from modifying or deleting Threat Protection registry keys and
values and sets the action to take upon attempt.

Block Only: Blocks activity but does not report to the Dell Server.

Report Only: Reports activity to the Dell Server but does not block activity.
Block and Report (default): Blocks and reports activity to the Dell Server.

Block Only

Report Only

Block and Report

Prevents users from stopping Threat Protection processes and sets the action
to take upon attempt.

Block Only: Blocks activity but does not report to the Dell Server.

Report Only: Reports activity to the Dell Server but does not block activity.
Block and Report (default): Blocks and reports activity to the Dell Server.

String - Example: avtask.exe
Excludes specific process files from Threat Protection scans.
Enter the exact resource name of a process to exclude.
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Schedule Selected
Schedule Repeats Daily
Schedule Start Time String
Day of the Week Wednesday
Day of the Month 1

Debug Logging for
Malware and Not Selected

Exploit Protection

Exploit Protection Off
On-Access

) Off
Protection
Max Seconds for

45

Scan
On-Access Scan
Scan Boot Sectors Selected
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Selected

Not Selected

This policy is the "master policy" for all other Client Scheduling policies. If this
policy is Not Selected, no Client Scheduling takes place, regardless of other
policy values.

A Selected value enables the Client Scheduling options.

Daily

Weekly

Monthly

The schedule configuration defines when the task should run. Schedule types
are Daily, Weekly, and Monthly.

Daily: Runs the task every day at the specified Schedule Start Time.

Weekly: Runs the task weekly on the days specified in Day of the Week.
Monthly: Runs the task monthly on the specified Day of the Month.

String - format is [HH:mm tt]. Example: 11:59 PM
The time the task should run.

Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
The day of the week the task should run.

1-31
The day of the month the task should run.
Example: 17.

Selected

Not Selected

A Selected value enables debug logging of Malware and Exploit Protection
activity.

On

Off

Toggle to ON to enable Exploit Protection. If toggled to OFF, no Exploit
Protection policies are applied.

Exploit Protection protects the critical operating system resources from
changes made by malware or other unauthorized processes.

On

Ooff

Toggle to ON to enable On-Access Protection. If toggled to OFF, no On-Access
Protection policies are applied.

On-Access Protection protects the critical operating system resources from
changes made by malware or other unauthorized processes at the time a
resource is accessed.

10 to 9999

Specifies the maximum number of seconds for each file scan. Limits each file
scan to the specified number of seconds. If a scan exceeds the time limit, the
scan stops and logs a message.

Selected

Not Selected

Examines the disk boot sector. Consider disabling this policy if a disk contains a
unique or abnormal boot sector that cannot be scanned.



Scan Processes on
Enable

Scan Trusted
Installers

Scan When Copying
Between Local
Folders

Reputation Service
Sensitivity

Not Selected

Not Selected

Not Selected

Medium

Manage Policies

Selected

Not Selected

Rescans all processes that are currently in memory each time:

- On-Access Scan is disabled and re-enabled.

- The computer starts.

When the on-access scanner is enabled, it always scans all processes when
they are executed.

Because some programs or executables start automatically when the
computer starts, enabling this option can slow the computer and increase
computer startup time.

Selected

Not Selected

Scans MSiI files or Windows Trusted Installer service files. Disable this option to
improve the performance of large Microsoft application installers.

Selected

Not Selected

Scans files whenever the user copies from one local folder to another. If
disabled, only items in the destination folder are scanned. If enabled, items in
both source and destination folders are scanned.

Disable

Very Low

Low

Medium

High

Very High

When enabled, samples are submitted to the lab to determine if they are
malware. Sensitivity level configures the sensitivity level to use when
determining if a detected sample is malware.

The higher the sensitivity level, the higher the number of malware detections.
However, allowing more detections might result in more false positive results.
Risk levels:

Very low - The detections and risk of false positives are the same as with
regular content files. A detection is made available to Threat Protection when
the lab publishes it instead of waiting for the next file update. Use this setting
for desktops and servers with restricted user rights and a strong security
footprint. This setting results in an average of 10-15 queries per day, per
computer.

Low - This setting is the minimum recommendation for laptops or desktops
and servers with a strong security footprint. This setting results in an average
of 10-15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is
greater than the risk of a false positive. The proprietary, heuristic checks result
in detections that are likely to be malware. However, some detections might
result in a false positive. With this setting, the lab checks that popular
applications and operating system files do not result in a false positive. This
setting is the minimum recommendation for laptops or desktops and servers.
This setting results in an average of 20-25 queries per day, per computer.
High - Use this setting for deployment to systems or areas which are regularly
infected. This setting results in an average of 20-25 queries per day, per
computer.

Very high - Dell recommends using this level only for scanning volumes and
directories that do not support executing programs or operating systems.
Detections found with this level are presumed malicious, but have not been
fully tested to determine if they are false positives. Use this setting for on-
demand scans on non-operating system volumes. This setting results in an
average of 20-25 queries per day, per computer.
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Selected

Not Selected

This policy is the "master policy" for all other On-Demand Protection: Full Scan
policies. If this policy is Not Selected, no On-Demand Protection: Full Scan
policies are enforced, regardless of other policy values.

A Selected value means that On-Demand Protection: Full Scan is enabled.

This policy must be set to Selected to enable On-Demand Protection: Full Scan

On-Demand settings. If this policy is Not Selected, no On-Demand Protection: Full Scan

Protection - Full Selected policies are applied.

Scan By default, every time Full Scan runs, it scans the following locations for
threats:

- the computer memory for installed rootkits, hidden processes, and other
behavior that suggests malware is attempting to hide itself. This scan occurs
before all other scans.

- the memory of all running processes.

- all drives and their subfolders on the computer.

By default, the scanner scans all file types, regardless of extension.

Full Scan

Selected

Not Selected

Examines the disk boot sector. Consider disabling this policy if a disk contains a
unique or abnormal boot sector that cannot be scanned.

Boot Sectors Selected

Selected

Unwanted Not Selected

Programs Selected Enables the scanner to detect potentially unwanted programs. The scanner
uses configured information to detect potentially unwanted programs.
Selected
Not Selected
Detects, decodes, and scans Multipurpose Internet Mail Extensions (MIME)
encoded files.

Decode MIME Files Not Selected

Selected

Not Selected

Examines the contents of archive (compressed) files, including .jar files.
Because scanning compressed files can negatively affect computer
performance, Dell recommends using this option in scans during off-work
hours.

Scan Archives Selected

Selected
Not Selected

Not Selected Scans files that remote storage manages. When the scanner encounters a file
with migrated content, it restores the file to the local computer before

Files Migrated to
Storage

scanning.
Selected
h | d Not Selected
Program Threats Selecte Detects executable files that have code that resembles malware.
Selected
Not Selected
Detects unknown macro viruses.

Macro Threats Selected

Selected
Not Selected

Scan Subfolders Selected . .
Examines all subfolders of the specified folder.
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Disable

Very Low

Low

Medium

High

Very High

When enabled, samples are submitted to the lab to determine if they are
malware. Sensitivity level configures the sensitivity level to use when
determining if a detected sample is malware.

The higher the sensitivity level, the higher the number of malware detections.
However, allowing more detections might result in more false positive results.
Risk levels:

Very low - The detections and risk of false positives are the same as with
regular content files. A detection is made available to Threat Protection when
the lab publishes it instead of waiting for the next content file update. Use this
setting for desktops and servers with restricted user rights and a strong
security footprint. This setting results in an average of 10-15 queries per day,
per computer.

Low - This setting is the minimum recommendation for laptops or desktops
and servers with a strong security footprint. This setting results in an average
of 10-15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is
greater than the risk of a false positive. The proprietary, heuristic checks result
in detections that are likely to be malware. However, some detections might
result in a false positive. With this setting, the lab checks that popular
applications and operating system files do not result in a false positive. This
setting is the minimum recommendation for laptops or desktops and servers.
This setting results in an average of 20-25 queries per day, per computer.
High - Use this setting for deployment to systems or areas which are regularly
infected. This setting results in an average of 20-25 queries per day, per
computer.

Very high - Dell recommends using this level only for scanning volumes and
directories that do not support executing programs or operating systems.
Detections found with this level are presumed malicious, but have not been
fully tested to determine if they are false positives. Use this setting for on-
demand scans on non-operating system volumes. This setting results in an
average of 20-25 queries per day, per computer.

String - Comma-separated list of parameters

Specify files, folders, and drives to exclude from scanning.

Comma separated list of parameters:
<ExclusionType>,<ExclusionData>,<ExcludeSubfolders

(only applies to FileOrFolder type)>

Possible values: <FileOrFolder | FileType | ModifiedAge |

AccessedAge | CreatedAge>,<PathToFileOrFolder|

FileType|Age>,<true|false>

Examples:

FileOrFolder,C:\Users,false

FileType,xml,false

FileType,mp?,false

ModifiedAge,120,true

AccessedAge,150,false

CreatedAge,300,true
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Threat
First
Response

Clean file

Threat
First
Response
Fails

Delete file

Exploit
First
Response

Clean file

Exploit
First
Response
Fails

Delete file

Use Scan

Cache Selected

Below Normal

System Utilization

Scan on Battery
Power

Not Selected
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Clean file

Delete file

Continue scanning

Specifies the first action for the scanner to take when a threat is detected.
Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the action for the scanner to take when a threat is detected if the
first action fails.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the first action for the scanner to take when a potentially unwanted
program is detected.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the action for the scanner to take when an unwanted program is
detected if the first action fails.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Selected

Not Selected

A Selected value enables the scanner to use the existing clean scan results. A
Selected value reduces duplicate scanning and improves performance.

Low Priority

Below Normal

Normal

Enables the operating system to specify the amount of CPU time that the
scanner receives during the scan. Each task runs independently, unaware of
the limits for other tasks.

Low Priority - Provides improved performance for other running applications.
Select this option for computers with end user activity.

Below Normal - Sets the computer utilization for the scan to the default.
Normal - Enables the scan to complete faster. Select this option for computers
that have large volumes and low user activity.

Selected

Not Selected

A Selected value allows the scan when the computer is using battery power.
Not Selected postpones the scan until the computer is no longer using battery
power.



Schedule Repeats

Schedule Start Time

Day of the Week

Day of the Month

Quick Scan

On-Demand
Protection - Quick
Scan

Boot Sectors

Unwanted
Programs

Decode MIME Files

Scan Archives

Daily

String

Wednesday

Selected

Selected

Selected

Not Selected

Selected

Manage Policies

Daily

Weekly

Monthly

The schedule configuration defines when the task should run. Schedule types
are Daily, Weekly, and Monthly.

Daily: Runs the task every day at the specified Full-Scan Schedule Start Time.
Weekly: Runs the task weekly on the days specified in Full-Scan Schedule Day
of the Week.

Monthly: Runs the task monthly on the specified Full-Scan Schedule Day of the
Month.

String - format is [HH:mm tt]. Example: 11:59 PM

The time the task should run.

Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
The day of the week the task should run.

1-31
The day of the month the task should run.
Example: 17.

Selected

Not Selected

This policy is the "master policy" for all other On-Demand Protection: Quick
Scan policies. If this policy is Not Selected, no On-Demand Protection: Quick
Scan policies are enforced, regardless of other policy values.

A Selected value means that On-Demand Protection: Quick Scan is enabled.
This policy must be set to Selected to enable On-Demand Protection: Quick
Scan settings. If this policy is Not Selected, no On-Demand Protection: Quick
Scan policies are applied.

By default, every time Quick Scan runs, it scans the following locations for
threats:

- the memory of all running processes

- the files that the Windows Registry references

- the contents of the Windows folder

- the contents of the Temp folder

By default, the scanner scans all file types, regardless of extension.

Selected

Not Selected

Examines the disk boot sector. Consider disabling this policy if a disk contains a
unique or abnormal boot sector that cannot be scanned.

Selected

Not Selected

Enables the scanner to detect potentially unwanted programs. The scanner
uses configured information to detect potentially unwanted programs.
Selected

Not Selected

Detects, decodes, and scans Multipurpose Internet Mail Extensions (MIME)
encoded files.

Selected

Not Selected

Examines the contents of archive (compressed) files, including .jar files.
Because scanning compressed files can negatively affect computer
performance, Dell recommends using this option in scans during off-work
hours.
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Selected
Not Selected

Not Selected Scans files that remote storage manages. When the scanner encounters a file
with migrated content, it restores the file to the local computer before
scanning.

Files Migrated to
Storage

Selected
Program Threats Selected Not Selected
Detects executable files that have code that resembles malware.
Selected
Not Selected
Detects unknown macro viruses.

Macro Threats Selected

Selected
Not Selected

Scan Subfolders Selected . .
Examines all subfolders of the specified folder.
Disable
Very Low
Low
Medium
High
Very High
When enabled, samples are submitted to the lab to determine if they are
malware. Sensitivity level configures the sensitivity level to use when
determining if a detected sample is malware.
The higher the sensitivity level, the higher the number of malware detections.
However, allowing more detections might result in more false positive results.
Risk levels:
Very low - The detections and risk of false positives are the same as with
regular content files. A detection is made available to Threat Protection when
the lab publishes it instead of waiting for the next content file update. Use this
setting for desktops and servers with restricted user rights and a strong
security footprint. This setting results in an average of 10-15 queries per day,
per computer.

Medium Low - This setting is the minimum recommendation for laptops or desktops
and servers with a strong security footprint. This setting results in an average
of 10-15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is
greater than the risk of a false positive. The proprietary, heuristic checks result
in detections that are likely to be malware. However, some detections might
result in a false positive. With this setting, the lab checks that popular
applications and operating system files do not result in a false positive. This
setting is the minimum recommendation for laptops or desktops and servers.
This setting results in an average of 20-25 queries per day, per computer.
High - Use this setting for deployment to systems or areas which are regularly
infected. This setting results in an average of 20-25 queries per day, per
computer.

Very high - Dell recommends using this level only for scanning volumes and
directories that do not support executing programs or operating systems.
Detections found with this level are presumed malicious, but have not been
fully tested to determine if they are false positives. Use this setting for on-
demand scans on non-operating system volumes. This setting results in an
average of 20-25 queries per day, per computer.

Reputation Service
Sensitivity
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Threat First
Response Fails

Exploit
First
Response

Exploit
First
Response
Fails

String

Clean file

Delete file

Clean file

Delete file
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String - Comma-separated list of parameters
Specify files, folders, and drives to exclude from scanning.

Comma separated list of parameters:

<ExclusionType>,<ExclusionData>,<ExcludeSubfolders
(only applies to FileOrFolder type)>

Possible values: <FileOrFolder|FileType|ModifiedAge|
AccessedAge|CreatedAge>,<PathToFileOrFolder|
FileType|Age>,<true|false>

Examples:
FileOrFolder,C:\Users,false
FileType,xml,false
FileType,mp?,false
ModifiedAge,120,true
AccessedAge,150,false
CreatedAge,300,true

Clean file

Delete file

Continue scanning

Specifies the first action for the scanner to take when a threat is detected.
Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the action for the scanner to take when a threat is detected if the
first action fails.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the first action for the scanner to take when a potential exploit is
detected.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.

Clean file

Delete file

Continue scanning

Specifies the action for the scanner to take when an exploit is detected if the
first action fails.

Clean files - Removes the threat from the detected file, if possible.

Delete files - Deletes files with potential threats.

Continue scanning - Continues scanning files when a threat is detected. The
scanner does not move items to the quarantine.
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Selected
Use Scan Not Selected
Cache Selected A Selected value enables the scanner to use the existing clean scan results. A
Selected value reduces duplicate scanning and improves performance.
Low Priority
Below Normal
Normal
Enables the operating system to specify the amount of CPU time that the
scanner receives during the scan. Each task runs independently, unaware of
System Utilization Below Normal the limits for other tasks.
Low Priority - Provides improved performance for other running applications.
Select this option for computers with user activity.
Below Normal - Sets the computer utilization for the scan to the default.
Normal - Enables the scan to complete faster. Select this option for computers
that have large volumes and low user activity.
Selected
Not Selected
Scan on Battery Not Selected A Selected value allows the scan when the computer is using battery power.
Power Not Selected postpones the scan until the computer is no longer using battery
power.
Daily
Weekly
Monthly
The schedule configuration defines when the task should run. Schedule types
) are Daily, Weekly, and Monthly.
Schedule Repeats Daily . " . .
Daily: Runs the task every day at the specified Quick-Scan Schedule Start Time.
Weekly: Runs the task weekly on the days specified in Quick-Scan Schedule
Day of the Week.
Monthly: Runs the task monthly on the specified Quick-Scan Schedule Day of
the Month.
String - format is [HH:mm tt]. Example: 11:59 PM
Schedule Start Time String The time the task should run.
Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
Day of the Week Wednesday The day of the week the task should run.
1-31
The day of the month the task should run.
Day of the Month 1 Example: 17.
Selected
Not Selected
. Access Protection prevents other computers from making a connection and
Access Protection Selected Rk i X )
creating or altering autorun (autorun.inf) files from CDs. The rule prevents
spyware and adware distributed on CDs from being executed and will
automatically block and report the issue.
Selected
Not Selected
. This policy enables scanning JavaScript and VBScript scripts to prevent
Script Scan K .
Protection Selected unwanted scripts from executing.
Note: If Script Scan Protection is disabled when Internet Explorer is launched,
and then is enabled, it doesn't detect malicious scripts in that instance of
Internet Explorer.
To modify the source sites your clients access for Malware Protection signature
updates, click the Source Sites for Updates link. To modify the priority level or
Source Sites for Hyperlink availability of an external source site, click either NAIHttp or NAIFtp, edit the
Update necessary fields, and click OK.

To designate an internal signature update server, see Designate a Threat
Protection Signature Update Server. Designating a signature update server
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within your network allows client computers to obtain signature updates
without accessing the Internet.

Web Protection

Enforcement -
Action to Apply to
Sites Not Verified

Enforcement -
Enable File
Scanning for File
Downloads

Enforcement -
Enable HTML
iFrames Support

Enforcement -
Block Sites by
Default if
Reputation Service
Server is not
Reachable

Enforcement -
Block Phishing
Pages for All Sites

off

Allow

Selected

Selected

Not Selected

Selected

On

Off

Toggle to ON to enable Web Protection. If toggled to OFF, no Web Protection
policies are applied.

Block

Allow

Warn

Specifies the default action to apply to sites that have not been verified.
Block: Prevents users from accessing the site and displays a message that the
site is blocked.

Allow: Permits users to access the site.

Warn: Displays a warning to notify users of potential dangers associated with
the site. Users must dismiss the warning before continuing.

Selected

Not Selected

A Selected value scans all files (including .zip files) before downloading. This
option prevents users from accessing a downloaded file until Threat Protection
marks the file as clean.

Downloaded files are sent to Threat Protection for scanning. Threat Protection
performs a Reputation Service lookup on the file. If a downloaded file is
detected as a threat, Threat Protection takes action on the file and alerts the
user.

NOTE: This policy does not apply when Web Protection is installed as an
optional feature with Advanced Threat Prevention.

Selected

Not Selected

A Selected value blocks access to malicious (Red) and warn (Yellow) sites that
display in an HTML iframe.

Selected

Not Selected

A Selected value blocks access to websites if Web Control cannot reach the
Reputation Service server.

Selected
Not Selected
A Selected value blocks all phishing pages, overriding content rating actions.
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Enforcement -
Specify Reputation
P ] v 'p Very High
Service Risk Level
to Block
IP Exclusions for X
String

Web Protection

Enable Secure
Not Selected
Search

Set Default Search

. Google
Engine

Block Links to Risky
Sites in Search Not Selected

Results

Rating Action for
Red Sites

Block

Rating Action for
Yellow Sites

Warn
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Disable

Very Low

Low

Medium

High

Very High

Specifies the Reputation Service risk level to block when the Threat Protection
on-demand scan feature is not installed and enabled. Web Protection uses the
risk level to calculate the score when retrieving the checksum reputation from
the Reputation Service.

String - IP or IP Range

Configures Web Protection not to rate or act on the specified private IP
address range. The format is the IP address or IP address range.

Selected

Not Selected

A Selected value enables Secure Search, automatically blocking malicious sites
in search results based on safety rating.

Google

Yahoo

Bing

Ask

Specifies the default search engine to use for supported browsers: Google,
Yahoo, Bing, Ask.

Selected

Not Selected

A Selected value prevents users from clicking links to risky sites in search
results.

Block

Allow

Warn

Specifies the action to apply to sites that are rated Red.

Block: Prevents users from accessing the site and displays a message that the
site is blocked. Block is the default for Red sites.

Allow: Permits users to access the site.

Warn: Displays a warning to notify users of potential dangers associated with
the site. Users must dismiss the warning before canceling or proceeding to the
site.

Green-rated sites and downloads are automatically allowed.

Block

Allow

Warn

Specifies the action to apply to sites that are rated Yellow.

Block: Prevents users from accessing the site and displays a message that the
site is blocked.

Allow: Permits users to access the site.

Warn: Displays a warning to notify users of potential dangers associated with
the site. Users must dismiss the warning before canceling or proceeding to the
site. Warn is the default for Yellow sites.

Green-rated sites and downloads are automatically allowed.



Rating Action for
Unrated Sites

Rating Action for
Red Downloads

Rating Action for
Yellow Downloads

Rating Action for
Unrated
Downloads

Web Event Logging

Log Web Control
iFrame Events

Log Web Categories
Green Rated Sites

Enable Web
Category Blocking

Allow

Block

Warn

Allow

Not Selected

Not Selected

Not Selected
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Block

Allow

Warn

Specifies the action to apply to sites that are Unrated.

Block: Prevents users from accessing the site and displays a message that the
site is blocked.

Allow: Permits users to access the site. Allow is the default for Unrated sites.
Warn: Displays a warning to notify users of potential dangers associated with
the site. Users must dismiss the warning before canceling or proceeding to the
site.

Green-rated sites and downloads are automatically allowed.

Block

Allow

Warn

Specifies the action to apply to file downloads that are rated Red.

Block: Prevents users from downloading the file and displays a message that
the download is blocked. Block is the default for Red downloads.

Allow: Permits users to proceed with the download.

Warn: Displays a warning to notify users of potential dangers associated with
the download file. Users must dismiss the warning before ending or
proceeding with the download.

Block

Allow

Warn

Specifies the action to apply to file downloads that are rated Yellow.

Block: Prevents users from downloading the file and displays a message that
the download is blocked.

Allow: Permits users to proceed with the download.

Warn: Displays a warning to notify users of potential dangers associated with
the download file. Users must dismiss the warning before ending or
proceeding with the download. Warn is the default for Yellow sites.

Block

Allow

Warn

Specifies the action to apply to file downloads that are Unrated.

Block: Prevents users from downloading the file and displays a message that
the download is blocked.

Allow: Permits users to proceed with the download. Allow is the default for
Unrated downloads.

Warn: Displays a warning to notify users of potential dangers associated with
the download file. Users must dismiss the warning before ending or
proceeding with the download.

Selected

Not Selected

When this policy is selected, blocked Red (malicious) and Yellow (warn) sites
that display in an HTML iFrame are logged.

Selected

Not Selected

When this policy is selected, content categories are logged for all green-rated
sites. Selecting this policy may affect Server performance.

Selected

Not Selected

When this policy is selected, web sites can be blocked based on category.
Web Categories that can be blocked

When this policy is selected, the following categories can be blocked. Select
the check box next to a category to block that category. Categories indicated
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with * are selected and blocked by default when this policy is selected.
Art/Culture/Heritage
Alcohol

Anonymizers
Anonymizing Utilities
Business

Chat

Public Information
Potential Criminal Activities
Drugs
Education/Reference
Entertainment

Extreme
Finance/Banking
Gambling

Games
Government/Military
Potential Hacking/Computer Crime*
Health

Humor/Comics
Discrimination

Instant Messaging

Stock Trading

Internet Radio/TV

Job Search

Information Security
Dating/Social Networking
Mobile Phone

Media Downloads
Malicious Sites*

Usenet News

Nudity
Non-Profit/Advocacy/NGO
General News

Online Shopping
Provocative Attire
P2P/File Sharing
Politics/Opinion

Personal Pages

Portal Sites

Remote Access
Religion/Ideology
Resource Sharing

Search Engines

Sports

Streaming Media
Shareware/Freeware
Pornography*
Spyware/Adware/Keyloggers*
Tobacco

Travel

Violence

Web Ads

Weapons

Web Mail

Web Phone
Auctions/Classifieds
Forum/Bulletin Boards
Profanity

School Cheating Information
Sexual Materials
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Gruesome Content
Visual Search Engine
Technical/Business Forums
Gambling Related
Messaging
Game/Cartoon Violence
Phishing*

Personal Network Storage
Spam URLs

Interactive Web
Fashion/Beauty
Software/Hardware
Potential Illegal Software
Content Server

Internet Services

Media Sharing

Incidental Nudity
Marketing/Merchandising
Parked Domain
Pharmacy

Restaurants

Real Estate
Recreation/Hobbies
Blogs/Wiki

Digital Postcards
Historical Revisionism
Technical Information
Dating/Personals

Motor Vehicles
Professional Networking
Social Networking

Text Translators

Web Meetings

For Kids

History

Moderated

Text/Spoken Only
Controversial Opinions
Residential IP Addresses
Browser Exploits*
Consumer Protection
Illegal UK

Major Global Religions
Malicious Downloads*
Potentially Unwanted Programs

See basic settings

On
off
Client Firewall off Toggle to ON to enable Client Firewall. If toggled to OFF, no Client Firewall
Settings or Rules are applied.
Client firewall is a stateful firewall.

230



Security Management Server v10.2.6 AdminHelp

Settings and Rules See Client Firewall Settings and Rules.

See basic settings

Client Firewall Settings and Rules
In the Client Firewall policy, Settings and Rules, click View/Edit.

In the Settings window, you can set Client Firewall Options and Client Firewall Rules.

Return to Client Firewall Policies

Client Firewall Options

Allows all traffic that uses unsupported protocols.
Allow traffic for unsupported protocols Check box When disabled, all traffic using unsupported
protocols is blocked.

Allows outgoing traffic but no incoming traffic

i i i until the Firewall service starts.
Allow only outgoing traffic until Check box

firewall services have started If this option disabled, Firewall allows all traffic

before services are started.
Allows traffic with a local MAC address.
The MAC address is an address in the list of VMs

Allow bridged traffic Check box that Firewall supports, not the local system's MAC
address. Use this option to allow traffic through a
bridged environment with virtual machines.
Blocks network traffic from non-local host IP

Enable IP spoof protection Check box addresses or from local processes that attempt to
spoof their IP address.
Displays alerts automatically when Firewall
Enable firewall intrusion alerts Check box

detects a potential attack.

Creates rules automatically to allow traffic.
Enable Adaptive mode Check box NOTE: Enable this option temporarily while

tuning a deployment.

Enabled by default

Logs all blocked traffic to the Firewall event log

(FirewallEventMonitor.log) on the Endpoint

Security Client.

Disabled by default

Logs all allowed traffic to the Firewall event log

(FirewallEventMonitor.log) on the Endpoint

Security Client.

NOTE: Enabling this option might negatively

impact performance.

Log all blocked traffic to client activity log Check box

Log all allowed traffic to client activity log Check box
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Incoming network - reputation threshold Drop-down menu

Outgoing network - reputation threshold Drop-down menu

High Risk

Unverified

Do not block

Medium Risk

Specifies the rating threshold for blocking

incoming or outgoing traffic from a network
connection.

High Risk - This source/destination sends or hosts
potentially malicious content/traffic that is
considered risky.

Unverified - This site appears to be a legitimate
source or destination of content/traffic, but also
displays properties suggesting that further
inspection is necessary.

Do not block - This site is a legitimate source or
destination of content/traffic.

Medium Risk - This source/destination shows
behavior that is considered suspicious. Any
content/traffic from the site requires special
scrutiny.

High Risk

Unverified

Do not block

Medium Risk

Specifies the rating threshold for blocking
incoming or outgoing traffic from a network
connection.

High Risk - This source/destination sends or hosts
potentially malicious content/traffic that is
considered risky.

Unverified - This site appears to be a legitimate
source or destination of content/traffic, but also
displays properties suggesting that further
inspection is necessary.

Do not block - This site is a legitimate source or
destination of content/traffic.

Medium Risk - This source/destination shows
behavior that is considered suspicious. Any
content/traffic from the site requires special
scrutiny.

Number of seconds (1-240) before TCP

. . Up/down number selector
connections time out

Specifies the time, in seconds, that an
unestablished TCP connection remains active if no

more packets matching the connection are sent
or received. The default number is 60; the valid
range is 1-240.
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Specifies the time, in seconds, that a UDP or ICMP
Echo virtual connection remains active if no more
packets matching the connection are sent or
Up/down number selector received. This option resets to its configured value
every time a packet that matches the virtual
connection is sent or received. The default

Number of seconds (1-300) before UDP and ICMP
echo virtual connections time out

number is 60; the valid range is 1-300.

Defines domain names to block.

When applied, this setting adds a rule near the
top of the firewall rules that blocks connections to
the IP addresses resolving to the domain names.
Add - To add a domain name to block, click Add,
then enter a domain name. You can use the * and

Domain name Button/text input field ? wildcards. For example, *domain.com. Separate
multiple domains with a comma (,) or a carriage
return.

Duplicate entries are automatically removed.
Delete - To remove a domain name from the
blocked list, select the domain name and click
Delete.

Return to top

Client Firewall Rules
Client Firewall applies the rule at the top of the firewall rules list.

1. Client Firewall applies the rule at the top of the firewall rules list. If the traffic meets this rule’s
conditions, Client Firewall allows or blocks the traffic. It doesn't try to apply any other rules in
the list.

2. If the traffic doesn't meet the first rule’s conditions, Client Firewall continues to the next rule in
the list until it finds a rule that the traffic matches.

3. If no rule matches, the firewall automatically blocks the traffic.

To modify Core Networking or Default Rules, expand either Core Networking Rules or Default Rules,
select the rule to modify, and edit the desired settings, and click OK. The settings are described in the
table below.

Alternatively, click one of the following buttons to perform the desired action:
Add Rule - Adds a firewall rule.
Duplicate - Creates a copy of the selected item.

Delete - Removes a selected firewall item.

Name Text input field Specifies the descriptive name of the item.

233



Radio button/Check box

Drop-down menu

Manage Policies

Select Enable rule to make the rule active.

Allow

Block

Treat match as intrusion

Log matching traffic

Allow - Allows traffic through the firewall if the
item is matched.

Block - Stops traffic from passing through the
firewall if the item is matched.

Treat match as intrusion - Treats traffic that
matches the rule as an attack and generates an
event that is sent to the Reputation Service. The
Block action for the rule must be selected for an
event to be generated.

Log matching traffic - Preserves a record of
matching traffic in the Firewall activity log on the
Endpoint Security Client.

In

Out

Either

In - Monitors incoming traffic.

Out - Monitors outgoing traffic.

Either - Monitors both incoming and outgoing
traffic.

Provides more information about the rule.

Radio button/Check box
Network protocol

Connection types

Specify Networks Button/Drop-down menu/text input field

Any protocol

IP protocol

Non-IP protocol

Any protocol - Allows both IP and non-IP
protocols.

IP protocol - Excludes non-IP protocols. IPv4
protocol or IPv6 protocol. If neither check box is
selected, any IP protocol applies.

Both IPv4 and IPv6 are selectable.

Non-IP protocol - Includes non-IP protocols only.
Wired

Wireless

Virtual

Indicates if one or all connection types apply.

A Virtual connection type is an adapter presented
by a VPN or a virtual machine application, such as
VMware, rather than a physical adapter.

To add a network, click Add, then specify the
following:

Name - Specifies the network address name
(required).

Type - Select either Local Network or Remote
Network.

Click Add, then specify the following:

Network type - Specifies the origin or destination
of traffic. Select from the network types Single IP,
Subnet, Local subnet, Range, or Fully qualified
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domain name
IP address - Specifies the IP address to add to the
network. Wildcards are valid.

Select the transport protocol from the menu.

Transport protocol Drop-down menu

The name that you use for the executable to add
or edit.

Name String

The file path to the executable.
File path String

Description of the executable.
File description String
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Enable digital signature check

Return to top

Return to Client Firewall Policies

Policies Set by Application Control

String

Check box

Manage Policies

The MD5 hash of the process.

Enables or disables the digital signature check
that guarantees code has not been altered or
corrupted since it was signed with a cryptographic
hash.

If enabled, specify:

Allow any signature — Allows files signed by any
process signer.

Signed by — Allows only files signed by the
specified process signer.

The following policies are set when Advanced Threat Prevention > Application Control is selected.

Unsafe Executable Auto Quarantine With Executable Control Enabled

Abnormal Executable Auto Quarantine With Executable Control Enabled

Memory Protection Enabled

Exploitation: Stack Pivot

Exploitation: Stack Protect

Exploitation: Overwrite Code

Exploitation: Scanner Memory Search
Exploitation: Malicious Payload

Process Injection: Remote Allocation of Memory
Process Injection: Remote Mapping of Memory
Process Injection: Remote Write to Memory
Process Injection: Remote Write PE to Memory
Process Injection: Remote Overwrite Code
Process Injection: Remote Unmap of Memory
Process Injection: Remote Thread Creation

Process Injection: Remote APC Scheduled

Selected

Selected

Selected
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate
Terminate

Terminate
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Process Injection: Remote DYLD Injection (Mac OS X only) Terminate
Escalation: LSASS Read Terminate
Escalation: Zero Allocate Terminate
Watch for New Files Selected

Advanced Threat Events tab fields and filters

The Advanced Threat Events tab displays information about events for the entire enterprise based on
information available in the Dell Server.

The tab displays if the Advanced Threat Prevention service is provisioned and licenses are available.
To access the Enterprise Advanced Threats tab, follow these steps:

1. Inthe left pane, click Populations > Enterprise.

2. Select the Advanced Threat Events tab.
Use the following filters to select content to display on the Advanced Threat Events tab:

Type - Threat Found, Threat Blocked, Threat Terminated, Memory Violation Blocked, Memory Violation
Terminated, Memory Violation (Detected), Threat Removed, Threat Quarantined, Threat Waived, Threat
Changed, Protection Status Changed.

Severity - Severity level of the event: Critical, Major, Minor, Caution, or Informational.
Timeframe (in days) - 1, 7, 14, 30, 60, 90
Columns - Allows you to select the following additional columns to display:
Hostname - The fully qualified name of the computer
Data - Details about the event
Created - Date and time that the event was captured
Machine Name - Name of the computer on which the threat event was detected
Path - Path to the file in which the threat was detected

Sha256 - The file's 256-character Secure Hash Algorithm can be compared with an expected result to
indicate whether the file has been tampered with.

Score - The threat file's score, indicating the confidence level that the file is malware. The higher the
number, the greater the confidence.

Manage Enterprise Advanced Threats - Protection
The Protection tab provides information about files and scripts that are potentially harmful.
Threats

The table lists all events found across the organization. An event may also be a threat but is not
necessarily so.

View additional information about a specific threat either by clicking on the threat name link to view
details displayed on a new page or by clicking anywhere in the row of the threat to view details at the
bottom of the page.
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To view additional threat information in the table, click the drop-down arrow on a column header to
select and add columns. Columns display metadata about the file, such as Classifications, Cylance
Score (confidence level), AV Industry conviction (links to VirusTotal.com for comparison with other
vendors), Date first found, Data last found, SHA256, MD5, File information (author, description, version),
and Signature details.

Filter Events Table Data

Click the Threat Filters list at the upper right side of the table to view data about events by Priority,
Status: Last 24 Hours, and Status: Total.

The number of events occurring in each subcategory are shown in parentheses.

Priority: Unsafe - Select a priority to view only events that match the selected priority. High, Medium, or
Low.

Status: Last 24 Hours - Select a status to view only events that have had changes to this status in the
last 24 hours.

Status: Total - Select a status to only events with that status.

The predictive threat model used to protect devices receives periodic updates to improve detection
rates. To understand differences in how a new threat model affects information about files in your
organization, see Threat Model Updates.

Commands

Select a threat to act on it. On this page, you can do the following to the selected threat data:

Export - Export threat data to a CSV file.

Select the rows to export, and then click Export.

Open the file with Microsoft Excel or similar application, which allows you to sort and organize the data.

Global Quarantine - Add a file to the global quarantine list. The threat is permanently quarantined from
all devices.

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the
organization. Adding a file to Quarantine removes it from lists of Unsafe files.

1. Select a threat.

2. Click Global Quarantine.

3. Enter a reason that this file should be global quarantined and click Yes.

Safe - Add a file to the safe list. The file is permanently treated as safe across all devices.

1. Select the file to list as safe.
2. Click Safe.
3. Select the category that fits the file.
4

Enter a reason why the file should be listed as safe, and click Yes.

Note: Occasionally, a “good” file may be reported as unsafe (this could happen if the
features of that file strongly resemble those of malicious files). Waiving or safelisting
the file can be useful in these instances.

Edit Global List - Add or remove files from the global quarantine list.
1. Click Edit Global List.

2. Select the items to change.
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3. Select Safe to add the selected items to the safelist, or select Remove from list to
remove the selected files from the Global Quarantine list.
Manually Add File to the Global Quarantine list
1. Click Edit Global List.
Click Add File.
Enter the file's SHA256 hash number (required).

2
3
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.

6. Enter the reason the file should be quarantined.
7. Click Submit.

View Threat Details - Click a threat name to display details of the threat details on a new page. Click
anywhere in the threat’s row to display the same threat details on the left side of this page, under the
table.

File Details
Details: [file name]

At the bottom of the page, this section displays details about the file that triggered an event. To display
this information, select the row that displays the file name in the Advanced Events table.

Click the file name next to Details: to display the same information about the event on a new page.
Overview

The overview contains summary information about the file.

Threat Indicators

Threat Indicators are observations about a file that has been analyzed.

These indicators help administrators understand the reason for a file’s classification and provide insight
into its attributes and behavior. Threat Indicators are grouped into categories.

Devices

In the Devices pane, the administrator can view a list of devices that have unsafe or abnormal files and
quarantine or waive them.

The device list can be filtered by file state: Unsafe, Quarantined, Waived, or Abnormal.
Waiving a file will allow that file to run on the device.
Detailed Threat Data

If the file has been uploaded for analysis, the Detailed Threat Data pane may display a comprehensive
summary of the static and dynamic characteristics of the file including additional file metadata, file
structure details, and dynamic behaviors such as files dropped, registry keys created or modified, and
URLSs with which it attempted to communicate.

Note: If no results display in the Detailed Threat Data pane, the file has not yet been uploaded for
analysis. Debug logging may provide information about why the file was not uploaded.

Script Control Table

The table lists details about Active and PowerShell scripts that have been blocked or have triggered an
alert and the affected devices.
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Columns display the file name, interpreter (PowerShell or ActiveScript), last found, drive type (such as

internal hard drive), SHA256, Number of devices on which the script is found, and Number of
occurrences that were blocked or triggered alerts.

To filter column data, click the filter icon on a column header and select values to include or exclude.

Manage Enterprise Advanced Threats - Agents

After an Advanced Threat Prevention client is installed on an endpoint computer, it is recognized by the Dell
Server as an agent.

Agents Table Data, Explained

Name - The name of the agent on the endpoint computer.

State - State of the agent, online or offline. A computer is in the offline state after three failed
attempts in a 15-minute period to contact the Cylance server.

Offline Date - If applicable, the date on which the agent went offline.
Files Analyzed - Number of files analyzed on the endpoint computer.

Unsafe - Number of files deemed Unsafe on the device. An unsafe file has characteristics that
greatly resemble malware.

Quarantined - Number of files Quarantined on the device.

Waived - Number of Waived files on the device.

Abnormal - Number of Quarantined files on the device.

Exploit Attempts - Number of exploit attempts on the device.
Commands

To export details about an agent or remove an agent from the list:

Export - Creates and downloads a CSV file that contains device information (Name, State, Policy, etc.).

Remove - Removes selected agents from the Agent Table. This does not uninstall the agent from the
device.

Manage Enterprise Advanced Threats - Certificate

The Certificate tab allows you to upload a certificate for the purpose of safelisting it.

Certificates must be in .cer or .crt format.

To upload a certificate, follow these steps:

1.

2
3
4.
5

Navigate to Populations > Enterprise > Advanced Threats tab > Certificate tab.
Click Browse.

Select a certificate and click Open.

Click Upload Certificate.

Click OK once the upload is successful.

For instructions about how to safelist a certificate, see Manage Enterprise Advanced Threats - Global List.
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Manage Enterprise Advanced Threats - Cylance Score and Threat Model Updates

A Cylance score is assigned to each file that is deemed Abnormal or Unsafe. The score represents the
confidence level that the file is malware. The higher the number, the greater the confidence.

Threat Model Updates

o o &~ 0 dpoE

The predictive threat model used to protect devices receives periodic updates to improve detection
rates.

Two columns on the Protection page in the Management Console show how a new threat model affects
your organization. Display and compare the Production Status and New Status columns to see which
files on devices might be impacted by a model change.

To view the Production Status and New Status columns:

In the left pane, click Populations > Enterprise.

Select the Advanced Threats tab.

Click the Protection tab.

Click the down-arrow on a column header in the table.

Hover over Columns.

Select the Production Status and New Status columns.
Production Status - Current model status (Safe, Abnormal or Unsafe) for the file.
New Status - Model status for the file in the new model.

For example, a file that was considered Safe in the current model might change to Unsafe in the new
model. If your organization needs that file, you can add it to the Safe list. A file that has never been seen
or score by the current model might be considered Unsafe by the new model. If your organization needs
that file, you can add it to the Safe list.

Only files found on device in your organization and that have a change in its Cylance Score are
displayed. Some files might have a score change but still remain within its current Status. For example,
if the score for a file goes from 10 to 20, the file status may remain Abnormal and the file appears in the
updated model list (if this file exists on devices in your organization).

The information for the model comparison comes from the database, not your devices. So no re-
analysis is done for the model comparison. However, when a new model is available and the proper
Agent is installed, a re-analysis is done on your organization and any model changes are applied.

Compare Current Model with New Model
You can now review differences between the current model and the new model.
The two scenarios you should be aware of are:

Production Status = Safe, New Status = Abnormal or Unsafe

Your Organization considers the file as Safe
Your Organization has Abnormal and/or Unsafe set to Auto-Quarantine

Production Status = Null (not seen or scored), New Status = Abnormal or Unsafe

Your Organization considers the file as Safe
Your Organization has Abnormal and/or Unsafe set to Auto-Quarantine

In the above scenarios, the recommendation is to Safelist the files to allow in your organization.
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Identify Classifications

To identify classifications that could impact your organization, Dell recommends the following approach:
1. Apply a filter to the New Status column to display all Unsafe, Abnormal, and Quarantined files.
2. Apply afilter to the Production Status column to display all Safe files.

3. Apply afilter to the Classification column to only show Trusted - Local threats.
Trusted - Local files have been analyzed by Cylance and found to be safe. Safelist these items after
review. If you have a lot of files in the filtered list, you may need to prioritize using more attributes. For
example, add a filter to the Detected By column to review threats found by Execution Control. These
were convicted when a user attempted to execute an application and need more urgent attention than
dormant files convicted by Background Threat Detection or File Watcher.

Manage Enterprise Advanced Threats - Global List

The Global Quarantine, Safe, and Unassigned tables provide a view of files in list as well as options to
perform actions on these files.

Global Quarantine
Global Quarantine lists files that are permanently quarantined from all devices.

Add a file to the global quarantine list

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the
organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1. Select Global Quarantine (n).
2. Select a threat.
3. Click Add File.
4. Enter areason that this file should be global quarantined and click Yes.
Manually Add File to the Global Quarantine list
1. Select Global Quarantine (n).
Click Add File.
Enter the file's SHA256 hash number. (required)

2
3
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.

6. Enter the reason the file should be quarantined.
7. Click Submit.

Remove a file from the global quarantine list

Remove the selected file from the Global Quarantine list to allow it to run on any device in the
organization.

1. Select Global Quarantine (n).
2. Select afile.
3. Click Remove from List.

Safelist a file from the global quarantine list
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Safeli;t the selected file from the Global Quarantine list to allow it to run on any device in the
organization.
1. Select Global Quarantine (n).
2. Select afile.
3. Click Safe.
Safe

Safelisted files and certificates are permanently treated as safe across all devices. Any certificate that is
safelisted is a known safe certificate for the Advanced Threat Prevention tenant.

Add a file to the safe list

Safelisting a file allows that file to run on any device across the entire organization.

Note: Occasionally, a “good” file may be reported as unsafe (this could happen if the features of that file
strongly resemble those of malicious files). Waiving or safelisting the file can be useful in these
instances.

1. Select Safe (n).

2. Click Add File.

3. Enter the file's SHA256 hash number. (required)
4. Enter the file's MD5 number, if available.

5. Enter the file name, if available.

6. Enter the reason the file should be safelisted.

7. Click Submit.

Remove a file from the safe list

1. Select Safe (n).

2. Select Files (n).

3. Select the file to remove from the safe list.
4. Click Remove from List.

Add a certificate to the safe list

Safelisting a certificate allows access to that certificate, as needed, across the entire organization.
1. Select Safe (n).
2. Select Certificates (n).
3. Select the certificate to list as safe.
4. Click Add Certificate.
5. Select the category that fits the certificate.
6. Enter a reason why the certificate should be listed as safe, and click Submit.

Note: You must upload a certificate for it to be available to safelist. For more information, see Manage
Enterprise Advanced Threats - Certificate.

Remove a certificate from the safe list
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Select Safe (n).
Select Certificates (n).
Select the certificate to remove from the safe list.

Click Remove from List.

Unassigned files can be added to the global quarantine or safe list.

Add an unassigned file to the global quarantine list

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the
organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1.

2.

3.

4.

Select Unassigned (n).
Select a file.
Click Global Quarantine.

Enter a reason that this file should be global quarantined and click Yes.

Manually Add File to the Global Quarantine list

1.

2.
3
4.
5
6
7.

Select Unassigned (n).

Click Add File.

Enter the file's SHA256 hash number. (required)
Enter the file's MD5 number, if available.

Enter the file name, if available.

Enter the reason the file should be quarantined.

Click Submit.

Add an unassigned file to the safe list

Safelisting a file allows that file to run on any device across the entire organization.

1.

2
3
4.
5

Select Unassigned (n).

Select afile.

Click Safe.

Select the category that fits the file.

Enter a reason why the file should be listed as safe, and click Yes.

Note: Occasionally, a “good” file may be reported as unsafe (this could happen if the features
of that file strongly resemble those of malicious files). Waiving or safelisting the file can be
useful in these instances.

Manually Add File to the Safe list

1.
2.
3.

Select Unassigned (n).
Click Add File.
Enter the file's SHA256 hash number. (required)
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4. Enter the file's MD5 number, if available.

5. Enter the file name, if available.

6. Enter the reason the file should be safelisted.
7. Click Submit.

Add the selected file to the Global Quarantine list to prevent it from being run on any device in the
organization. Adding a file to Quarantine removes it from lists of Unsafe or Unassigned files.

1. Select Global Quarantine (n).
2. Select a threat.
3. Click Add File
4. Enter areason that this file should be global quarantined and click Yes.
Manually Add File to the Global Quarantine list
1. Select Global Quarantine (n).
Click Add File.
Enter the file's SHA256 hash number. (required)

2
3
4. Enter the file's MD5 number, if available.
5. Enter the file name, if available.

6. Enter the reason the file should be quarantined.
7

Click Submit.

Manage Enterprise Advanced Threats - Options

The Options tab allows you to integrate with Security Information Event Management (SIEM) software using
the Syslog feature as well as export Advanced Threat data. SIEM software allows administrators to run
customized analytics on threat data within their environments. Software options include Splunk, available to
Splunkbase users at https://splunkbase.splunk.com/app/3233.

Syslog events are persisted at the same time Agent events are persisted to the Cylance server. For more
information about supported event types, see Syslog Event Types.

To integrate with SIEM, select Syslog/SIEM on the Options tab, and complete the form that displays. For a list
of syslog server IP addresses to allow, see Syslog IP Addresses.

With SIEM integration, to export data about threats, select Threat Data Report on the Options tab. For
instructions and a description of exportable data, see Threat Data Report.

Threat Data Report
Select Threat Data Report on the Options tab to enable threat data export to .csv files.
The following types of data are available for export:

Threats - Lists all threats discovered in your organization. This information includes file name and File Status
(unsafe, abnormal, waived, and quarantined).

Devices - Lists all devices in your organization that have an Agent installed. This information includes device
name, operating system version, agent version, and policy applied.
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Events - Lists all events related to the Threat Events graph on the dashboard for the last 30 days. This
information includes file hash, device name, file path, and the date the event occurred.
Indicators - Lists each threat and the associated threat characteristics.

Cleared - Lists all files that have been cleared in your organization. This information includes files that were
waived, added to the safe list, or deleted from the quarantine folder on a device.

Export Data

To access the exported data:
1. Select Generate token.
2. Copy the URL of the desired data and paste it into a web browser address field.
3. Inthe URL, replace [Token] with the generated token displayed in Token.

To disable access to the exported data, select Delete or regenerate to invalidate the current token. After
regenerating a token, provide it to persons who should have continued access to the exported data.

Advanced Threat Prevention Classifications

The Advanced Threat Prevention Classifications pane shows a heat map of threats. The color indicates
the priority classification of the threat. The size of the box indicates the relative number of endpoints that
have a particular threat. This classification helps administrators determine which threats and devices to

address first. Click a threat to view threat and device details.

Threat classifications include the following:

Malware

Trojan
Downloader

Potentially Unwanted Programs (PUP)

Adware
Hacking Tool
Portable Application

Enable Compatibility Mode for Memory Protection

Compatibility Mode allows applications to run on the client computer while Memory Protection or
Memory Protection and Script Control policies are enabled. Compatibility Mode is enabled through a
registry setting or a command on the client computer. Compatibility Mode does not apply to Mac clients.

To enable Compatibility Mode with a registry setting:

1. Inthe Remote Management Console, disable the Memory Protection Enabled policy. If the

Script Control policy is enabled, disable it.
2. Save the policy changes, and Commit_Policies.

3. Using the Registry Editor on the client computer, go to
HKEY_LOCAL_MACHINE\SOFTWARE\Cylance\Desktop.
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4.

5.

Right-click Desktop, click Permissions, then take ownership and grant yourself Full Control.
Right-click Desktop, then select New > Binary Value.

For the name, type CompatibilityMode.

Open the registry setting and change the value to 01.

Click OK, then close Registry Editor.

In the Management Console, enable the Memory Protection Enabled policy. If the Script

Control policy was enabled, enable it.

10. Save the policy changes, and Commit_Policies.

To add the registry setting with a command:

1.

In the Management Console, disable the Memory Protection Enabled policy. If the Script

Control policy is enabled, disable it.
Save the policy changes, and Commit_Policies.

Select one command line option to run on the client computer:

(For one computer) Psexec:
psexec -s reg add HKEY_LOCAL_MACHINE\SOFTWARE\Cylance\Desktop /v
CompatibilityMode /t REG_BINARY /d 01

(For multiple computers) Invoke-Command cmdlet:

$servers = "testComp1”,"testComp2","textComp3"

$credential = Get-Credential -Credential {UserNamePadministrator

Invoke-Command -ComputerName $servers -Credential $credential -ScriptBlock {New-Item -
Path HKCU:\Software\Cylance\Desktop -Name CompatibilityMode -Type REG_BINARY -Value
01}

In the Management Console, enable the Memory Protection Enabled policy. If the Script

Control policy was enabled, enable it.

Save the policy changes, and Commit_Policies.

Disconnected Mode Policy Examples

Examples for Global Allow, Quarantine List, and Safe List policies are shown below.

Global Allow policy example

<?xml version="1.0" encoding="utf-8"?>

<disconnected_policy>
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<policy_name>Default</policy_name>
<policy_company>Acme</policy_company>
<policy_company_id>uxSYabWoP2nMbGLzuqJhvT9Y</policy_company_id>
<policy_utctimestamp>Date(-62135596800000+0000)</policy_utctimestamp>

<filetype_actions>
<suspicious_files file_type="executable" actions="7" />
<threat_files file_type="executable" actions="7" />

</filetype_actions>

<memoryviolation_actions>
<memory_violation violation_type="stackpivot" action="Alert" />
<memory_violation violation_type="stackprotect™ action="Block™ />
<memory_violation violation_type="stackpivot"” action="Terminate" />
<memory_violation violation_type="overwritecode" action="None" />

<memory_violation violation_type="outofprocessallocation”™ action="Scuba
/>

<memory_violation violation_type="outofprocessmap" action="Alert" />
<memory_violation violation_type="outofprocesswrite" action="Block" />

<memory_violation violation_type="outofprocesswritepe"
action="Terminate" />

<memory_violation violation_type="outofprocessoverwritecode"
action="None" />

<memory_violation violation_type="outofprocessunmapmemory"
action="Alert" />

<memory_violation violation_type="outofprocesscreatethread"
action="Alert" />

<memory_violation violation_type="outofprocessapc”™ action="Alert" />
<memory_violation violation_type="Isassread” action="Alert" />
<memory_exclusion_list>
<path>temp\fTiles\exel.exe</path>
<path>stuff\folder\exe2._exe</path>
</memory_exclusion_list>

</memoryviolation_actions>

<appcontrol>
<changewindow_enabled>0</changewindow_enabled>

<lockdown lockdown_type="executionfromexternaldrives”™ action="deny" />
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<lockdown lockdown_type="pechange' action="deny" />

</appcontrol>

<policy>
<option name="auto_blocking"” value="0" />
<option name="auto_uploading” value="1" />
<option name="threat_report_limit" value="500" />
<option name="low_confidence_threshold"” value="-600" />
<option name="full_disc_scan" value="0" />
<option name="watch_for_new_files" value="0" />
<option name="memory_exploit_detection" value="0" />
<option name="trust_files_in_scan_exception_list" value="0" />
<scan_exception_list>
<path>C:\temp</path>
<path>C:\stuff</path>
</scan_exception_list>

</policy>

<exclusion_list>
<checksum>3fdc391ef0e200af3e4c206e785eldeO0</checksum>
<error_rate>1E-05</error_rate>
<size>509</size>

<exclusionlisthash>XjxtEUkQVOFIXTZof+f6Jb149fhxFbOHUzc3S/5Hi f6zqeiZrv0aMOQvG
ruMlun/uiOGeMwiNB31LCBD9PtwbgaYUpiz8Ne88wOmKhnerXo5TJRy+4HzPWDotDXSz+d5AHP74
zbbHFH7mM47KGObFAsPa4KNhFLQSOD3g/A17ZCWLL/ 10FyWcFMTLLKkeLRycDlyZpzf8QDskQVsAt8
Ub1h2UGY4BGgKwCQTYz9J/yIWUF1XGy9A7rMAHzYdghOB5s4Y2iB2j rd IHUGSxtNPu9gTuMIdfxE
BgcXq7XUWxuJUTbol1lFv2jsCHYpd/hgld+3SkNb19qykHmK9gnCH2r7 IHPIK5zvR9Y1eVxTsh16Jo
XQMDD+MOVKrL3tHqlSImJi9N1979dd8Gi1 YnAqtkFsMg+FhOT2PkVkBSzLgkCF+rHWoeDdo+MVX79
X9XJIqT1kRwSM2p301P14g+NH6X/YPs6Fz7wb95 jMx61LX/L7pHGOdMOFSeSFwO/X10yk5Fhog0J
qY86SkJs437CS7+pW+nz82 I XuFgqNP4pZaG2xf2iepTDo89dAMQIGWEOCNIR1zOIP18782TLLRM50
Ky tCrhUMut+P28K8LuUPOTdTgSCnf2uVrcecQTz/BZ0yqX5B6vy7g1P2HOHMEV1uVFfhWMjABROSK+
al5VXd5qNRaY4zFnOw5Z6L01 1 YDtvESgkLuwObzHrsF5ADKEKwv9 1g09DxhDYzLdJ1Zp/DNMsnJG
tvntZ/cezXbGtzJuGSFq71em5L00cavDQ3vRo3G I FettwN2CT9Z2MssLIhweTS8utTabMBFF1sM8
dx3sdN26 1Asx9rDyR7fLn4BJI2WnNMXvBFROTZJI30XX0QFUSCM1RNhw7ottTaLEi PF7Rd4 jdxbsErB
nK1CYfyYAePaD6yclelh6bYMyWxUUD2ZqyVBiu3La/4MKalml9V21zEsYObxp9RRXKY3HcTzPHkS
e8Zp+YbPQAr88RNpC277sCRiBWY 1b000OH/hx5yc6lrae/pzrGjusBT53KaiGémILpvRY rgDQ7fWo
cpFa2eClczQ+o8LN/gNVT7FtFhKgd8pnQWOOC1dxeSULTzRk6TS9rLCgXBDtRyK1FRrkkOCrHZU/
YvC2BXaWVAx60g i DsKxBUYQsgXQbaGwPG279Chdwn jW 1 VMWCqdvOoGEBMDAp j bkggkwgHIpkCJIF
4z0TChpVTM17PFKw/uycxogMzpdb+A0OQnTX+MzRmOBKTNIT9aFh+CRIeDgc/XxhP59RBUUT3GAP+r
k3789EQXdUVpOtC7hmXT j jg85JWSEe6 1 cGES5RY7NQXdXZGJIScLmy 1UVq+01Zj03xkAUZ5eq0lUJo
5KYaneGeYQFe7VzSmyzPMao6YPTpnRxXOuLVMANIhKF9qOzL1 I1PgJfVTwU9AHOLCUE2ztor3bdrRn
Z3+e5HqZKEpHtMGruMj i P4ZLmA7tJINh j 63KSpEEKJFCSkXGw74+cepc6I5ThPIWNA331ZmgcwgE2
7/5Xxsb5xzYFgFBUZmr12KnU7IMbg95bZTatxN8Pt1QS2NTdny XK/ 7§71 74FQZXNksONgfyEel F
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DOTIqgl 17SLKw1uffUEK2QGVv54bUQANLhbAVLbLR1b6V352rw3ANgECAQbgXcvKE/ jYKUZHSW3qql
PcPnrguYVoJuydKNiJVmoagqPLJ3LC6m7+PdGBuqEdVo+MK/PMJIdTVb47zW1RSYX0t9SJ/4xXWEByb
UMsHXRZTux6nlca5qCxHDiHb501677Bi+Y0YLddza7 i1A7z4mPTRMQEX6 JE05ZorZ4kcTIbNHJ77p
4kzouYDg3s+0+9Kvoxc 10iw8MAOtKrRVZTN24 j jSUAETJI66rb3JdzcflIeb7w4QVOUckL2kFyaS4
ASp80Fzp0OxJI3hSLw2bnR2nOWukMh j 3kWvY+GeXDBFGzHFDGeLVOpF/+hQTPR/XWuOSsnH1wUeJE
XS3al61yhcRCS7XbVPt+85NYGuk2ntf6zmST/v6a3E2exxerUDAmHTCK/0VQKrglYeclhkH1SbvC
Q==</exclusionlisthash>

<exclusionlisthash_secondary>rT7UrQI1tYORFpDEVEDwWSXdiGg3FUgEJ90pQMEUEacRRy10F
AS2W51m9f3hbzr0A7 IvoiKZLy9/h0koV2d5vy 1 j+xC275ucwOvghKpKPQH8mMFcD3vT498DuteVOi
1Tmzg/WFLIhdgK75CF8ys17UVZZabbExD2s9W49gUft5W9UozOWS5KImMCOV5E79YCF83s0wrabqrZ
gENT198WNpDOUbyN1UQN72g5mQligT8ViuoEMagB6JQaT I18CgCLe6NK8DFVUykGOYVELTFKCEMCqgtO
eglImOoFxLiVrouovcCdNpFzWOXFIQSEVEbVeqFfPXEUTrHRWZBzFXOYLrT86tSsH8 1 I+XC3uFjN7
ul/HB8daE3saFPmIAZUC9sq3rMU8BRoy9+iRw31ebLOP51RTSHXCOMz8xr85gt3m4MyqSO8mNNBXI
zwxeUCishz8A17VB5ai/R5Hy17zMTwIXU2x5Pcnpd2UqyeLQbXWpnkeRp 1 7FOrdwBMOFDCpZgEXn
FYQswvOb8kPnruC0/i 1gx/zNSFeuF 1T8dSbCZNvgh070hh4s10v9U9 I r7nBe9ZreDgdZMdZ1wCTq
XBk/yxJB74+95uRYasNznVAG2yD11 IwtWNvygHrmw5sZgk097K2quTOHjDpO0thnhaSGAOK5pF2TF
Em8zegjewP65pR5JdyslIvKquzbx3NZ3LtROXyV IMBzcFINDLP8v4UkwaKg9EL7302yPjqgDVwit9
AhX1h4VdSEv5M+JRTo+EguQB91/DleTbWUGAEMMN1cADZ j9yYOTB/SEsDVAWiILbiP/PYcUXz6g4C
v2uF9jk2Tn7KEbvuFWFI1 Ing2+z/gUNUHOUj 44 jggswv6G/q5VFbW5dMOMETGmZd5 j EBPNYy3R/uyg
m4ZoTvnOUu93FI1C8dpmVj Isyi i 9XhM8XN/YX90m5wXAJ9CuTgRWbuUK4 IvVWIORO I EOKQRFU76Y80T
Evx6kpCEFgAVZIhbfeOfmGo+CD1wl+dg0tze2BN7jk/ 1tXgiPKp/+/fLoH3HR8MZSWX8bWSuURpBg
qo3xg57tpP9JIxcyPQetG9fungtlBjzAd53Frro8XYXbz0d71honuEsFYv4T030jUBw7a9EBbI7Sv
RFDDi27mT/YmZNr3Y39FRIT7qQ44Ng5cjgp9etwV 1egolxpFBXECF2PX0uA/S7u06QakK+Ngkl+b
Fw5MBbG/NLHALbkV+jbLENKmUMWHYO4ruPzSoUYE84F9VOWFBZpWMxnx/ j /ZZZMwv8+p8kF3dAR9
SJjK38coPVCnLCJI8uDJIPoLDXS79u+pTQbsqgdPL+dwDeQAl IhHZzjpNIpM5UeHYGUiwHFbOr8GTdg2
GSEactW510uvldNe lklwo2a2z 1 cBMHOV57¥3/aVi0ZDtDKL5N1TO81xSPa6/hck4RGj IRINnr6320
mMh/dtx+40q7c8269KQSnXvpaVS8kyF2GvLMHCWurEg+NyCBON5+UonnC+0i9Kial FIByLBUPCNQ
ppdsOmkjhbCmJgPtCxgLadVYop2qddzsry9PFWO7tDEJcUi I rQc7aSNTFWExXc4a8LLpT+dEXNXEvV
ZAg2VSsTfawczZ894um6Gw55 I1BRmLHeyso0Y3zBWOGq5G3KA31FFyk90ATFxgdwl kHAG jBINSRzi/e
a7HSRUHNRTp26Bc0/c4K/dDDA23NdTOT14A1uU+3d822EH91/McuValFAK1gzPwcOrL8IT3x9vrR
JwUOCWOEamqgAzQNrE3tIbPsVuOhevtZhjm+NDzRZcxuk4Tu38To jo5H2xCucaEWdYxz0CKzCch/
VH8F 1 proJ9s1Jbl10Acim+FrnuUZ ImePkSXdmvkX4SpD4hoCyOL1F4eVGMniFFjCIhQyBwphCoqG
KolwP7WOQA/9fDZc7z0vka2u6Uz3Sy/ekJHZ0y 1 70zP4nAzTq7bnBQR2KCXgLaUP2mqOV jyFS9zP
msx1o0HU8T js2kDP4 jH2e+qXSAIJwQ0112Y+9mEvdktSkAJq24c5HS04F80p1Ae8YhpuAECKXqCC+P
OYiksNToTGA==</exclusionlisthash_secondary>

</exclusion_list>

</disconnected_policy>

Quarantine List and Safe List policy examples
Quarantine List
The Global Quarantine List contains hashes of files to be quarantined as shown in this example:
OA5F695900F1FC75070BB8B7C7A55B5BCFAADGFE
525E7A55B5BCB6B16F25B5DD6CE11DFC6DDOB4EG
Safe List
The Global Safe List contains hashes of files to be quarantined as shown in this example:
0OA5F695900F1FC75070BB8B7C7A55B5BCFAADGFE
525E7A55B5BCB6B16F25B5DD6CE11DFC6DDOB4EG
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Threat Protection Policy Overview
Threat Protection policies are divided into the following categories:
e Threat Protection
e Client Firewall
e Web Protection
When you set the Threat Protection policy to Selected, you can then set policies for these client options:
e Actions to take when malicious activity is identified (Block, Report, Block and Report)

Policies allow you to set the action to take when users attempt to modify or delete Threat
Protection system files, registry keys, and processes. The default setting for these policies is
Block and Report: Action on Malicious Activity for Files and Folders, Action on Malicious Activity
for Registry, and Action on Malicious Activity for Processes.

e Exclusion of specified processes from Threat Protection scans
e Logging locations and debug/verbose logging of certain activities

Activity logging is enabled by default. Debug logging is disabled by default.
e Client update scheduling

Client updates ensure that client computers are always protected from the latest threats through
content files that include definitions of threats such as viruses and spyware, that are used to
detect threats. The Client Update Schedule policy is selected (Enabled) by default. The Client
Update Schedule Repeats policy, which determines the frequency of client updates, is set to
Daily by default.

The following policies represent the different types of scans included in Threat Protection:

On-Access Protection — When a user accesses files, folders, and programs, the on-access scanner
intercepts the operation and scans the item. Default: Selected (Enabled).

On-Demand Protection - Full Scan — Based on a schedule set in policy, the on-demand scanner runs a
thorough check of all areas of the computer. Default: Selected (Enabled).

By default, every time Full Scan runs, it scans the following for threats:

e Computer memory for installed rootkits, hidden processes, and other behavior that suggests
malware is attempting to hide itself. This scan occurs before all other scans.

e  Memory of all running processes.
e All drives on the computer and their subfolders.
By default, the scanner scans all file types, regardless of extension.

On-Demand Protection - Quick Scan — Based on a schedule set in policy, the on-demand scanner runs
a quick check of areas of the computer that are most susceptible to threats. Default: Selected (Enabled).

By default, every time Quick Scan runs, it scans the following for threats:
e  Memory of all running processes.
e Files that the Windows Registry references.

e Contents of the Windows folder.
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e Contents of the Temp folder.
By default, the scanner scans all file types, regardless of extension.

Access Protection — Prevents other computers from making a connection and creating or altering
autorun (autorun.inf) files from CDs. The rule prevents spyware and adware distributed on CDs from
being executed and automatically blocks and reports such issues. Default: Selected (Enabled).

Exploit Protection — Monitors for application vulnerabilities and keeps buffer overflow exploits from
executing arbitrary code on the computer. Default: Selected (Enabled).

Script Scan Protection — Enables scanning JavaScript and VBScript scripts to prevent unwanted scripts
from executing. Default: Selected (Enabled).

Actions taken if a threat, unwanted program, or exploit is detected are controlled by policy and include
the following:

Full-Scan Threat First Response - Specifies the first action for the scanner to take when a threat is
detected. Default: Clean file.

Full-Scan Threat First Response Fails - Specifies the action for the scanner to take when a threat is
detected if the first action fails. Default: Delete file.

Full-Scan Unwanted Program First Response - Specifies the first action for the scanner to take when a
potentially unwanted program is detected. Default: Clean file.

Full-Scan Unwanted Program First Response Fails - Specifies the action for the scanner to take when
an unwanted program is detected if the first action fails. Default: Delete file.

Quick-Scan Threat First Response - Specifies the first action for the scanner to take when a threat is
detected. Default: Clean file.

Quick-Scan Threat First Response Fails - Specifies the action for the scanner to take when a threat is
detected if the first action fails. Default: Delete file.

Quick-Scan Exploit First Response - Specifies the first action for the scanner to take when a potential
exploit is detected. Default: Clean file.

Quick-Scan Exploit First Response Fails - Specifies the action for the scanner to take when an exploit is
detected if the first action fails. Default: Delete file.

When the Full-Scan Reputation Service Sensitivity or Quick-Scan Reputation Service Sensitivity policies
are enabled, samples are submitted to the Reputation Service lab to determine if they are malware. The
sensitivity level is used when determining if a detected sample is malware. The higher the sensitivity
level, the higher the number of malware detections. However, allowing more detections might result in
more false positive results.

The following values can be set:
Disable - Samples are not submitted to the Reputation Service lab.

Very Low - A detection is made available to Threat Protection when the Reputation Service lab
publishes it instead of waiting for the next file update. Average of 10-15 queries per day, per computer.

Low - This setting is the minimum recommendation for laptops or desktops and servers with a strong
security footprint. This setting results in an average of 10-15 queries per day, per computer.

Medium - Use this level when the regular risk of exposure to malware is greater than the risk of a false
positive. This setting is the minimum recommendation for laptops or desktops and servers. Average of
20-25 queries per day, per computer.
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High - Use this setting for deployment to systems or areas which are regularly infected. This setting
results in an average of 20-25 queries per day, per computer.

Very High - Dell recommends using this level only for scanning volumes and directories that do not
support executing programs or operating systems. Detections found with this level are presumed
malicious, but have not been fully tested to determine if they are false positives. Use this setting for on-
demand scans on non-operating system volumes. This setting results in an average of 20-25 queries
per day, per computer.

For more detail about Threat Protection policies, see Windows Threat Protection.

Client Firewall Policies

The Client Firewall is a stateful firewall that checks all incoming and outgoing traffic against its list of
rules. If the traffic matches all criteria in a rule, the Client Firewall acts according to the rule, blocking or
allowing traffic through the firewall.

Configurable options and rules define how the Client Firewall works. When the master policy, Client
Firewall, is set to On, you can select View/Edit in the Settings and Rules policy to view or configure an
extensive set of Client Firewall options and rules.

Options include which subsets of traffic to block or allow and logging settings, as well as timeout
parameters for TCP, UDP, and ICMP connections.

Client firewall rules define specific handling of network traffic. Each rule provides a set of conditions that
traffic must meet and an action to allow or block that traffic. When Client Firewall finds traffic that
matches a rule’s conditions, it performs the associated action.

Client Firewall uses precedence to apply rules and applies the rule at the top of the firewall rules list.

1. If the traffic meets the conditions of the rule at the top of the list, Client Firewall allows or blocks
the traffic. It does not try to apply any other rules in the list.

2. If the traffic does not meet the first rule’s conditions, Client Firewall continues to the next rule in
the list until it finds a rule that the traffic matches.

3. If no rule matches, the firewall automatically blocks the traffic.

For a list of Client Firewall rules and their descriptions, see Client Firewall Settings and Rules.

Web Protection Policies

Web Protection monitors web browsing and downloads to identify threats and enforce action set by
policy when a threat is detected, based on ratings for websites. When you set the master policy, Web
Protection, to On, you can set other policies for Web Protection.

The Reputation Service analyzes each website and assigns a color-coded safety rating based on test
results. The color indicates the level of safety for the site:

Red — Malicious
Yellow — Potentially malicious
Green - Safe

Through the following policies, you can assign actions to implement when a user accesses a website or
attempts a download, based on website ratings:

Rating Action for Red Sites - Specifies the action to apply to sites that are rated Red. Default: Block.
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Rating Action for Yellow Sites - Specifies the action to apply to sites that are rated Yellow. Default:
Warn.
Rating Action for Unrated Sites - Specifies the action to apply to sites that are Unrated. Default: Allow.

Rating Action for Red Downloads - Specifies the action to apply to file downloads that are rated Red.
Default: Block.

Rating Action for Yellow Downloads - Specifies the action to apply to file downloads that are rated
Yellow. Default: Warn.

Rating Action for Unrated Downloads - Specifies the action to apply to file downloads that are Unrated.
Default: Allow.

Configurable actions for website access or download attempts include the following:

Block — Prevents users from accessing the site or downloading a file from the site. A message is
displayed.

Allow — Permits users to access the site or proceed with the download.

Warn — Displays a warning to notify users of potential dangers associated with the site or download file.
Users must dismiss the warning before ending the web session or proceeding with the download.

To exclude a private IP address or range of addresses from Web Protection content rating actions,
specify the IP address or IP address range in the IP Exclusions for Web Protection policy.

To block all phishing pages, without regard to policy values that control content rating actions, select the
Enforcement - Block Phishing Pages for All Sites policy.

Designate a Threat Protection Signature Update Server

w

N oo o &

Both an HTTP and FTP signature update server are pre-configured with your Dell Server installation.
You can also, optionally, designate an internal signature update server or servers within your network.

Designating a signature update server within your network allows client computers to obtain signature
updates without accessing the Internet. Rather than individual clients contacting an external update
server, they contact your internal update server, which maintains current signatures through contact with
the external signature update server.

To designate a signature update server, follow these steps:

As an administrator on the server to be the internal update server, run the appropriate command:

VSSETUP_86.EXE /SetRelayServerEnable=1
or
VSSETUP_64.EXE /SetRelayServerEnable=1

Restart the internal update server.

In the Management Console, navigate to Populations > Enterprise and select Malware Protection
on the Security Policies tab.

In Malware Protection advanced settings, click Source Sites for Updates.
Click Add.
Enter a Name for the internal update server.

To enable connections to the internal update server, select Enabled. To enable later, clear the
Enabled check box.
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In Order, set the sequence in which clients will contact the internal update server in relation to
other update servers. Dell recommends that you set the Order for internal update servers to
precede the Order for external update servers.

Select the type of repository or path to the update server: HTTP repository, FTP repository, UNC
path, or Local path.

Enter the URL or path to the internal update server.

Complete the remaining fields in the form, and click OK.

Repeat these steps to designate additional internal update servers.

To revert an internal update server to non-update server status, enter the appropriate command:

VSSETUP_86.EXE /SetRelayServerEnable=0
or
VSSETUP_64.EXE /SetRelayServerEnable=0

Data Guardian

Data G

uardian
Data Guardian provides the following:

e Data on the device and data-in-motion is encrypted. To decrypt and view the content, users
must have Data Guardian installed on the client. Users can access protected files on Windows,
Mac, mobile devices, and a web portal.

e An audit trail of file activity allows you to monitor security. See Data Guardian and Audit Events.

e Protection against data leakage for protected Office documents - policies allow you to control
copy/paste or to add a watermark with the user's name, domain, and computer ID

Data Guardian basic policies are available for these populations:

e Cloud Encryption (Mac; v2.3 and earlier for Windows) - Enterprise, Endpoint Groups, and
Endpoints

e Protected Office Documents - Enterprise (master switch)

e Classification - Enterprise (master switch)

e Mobile Client - Enterprise, Domain, User Groups, and User

e Web Portal - Enterprise, Domain, User Groups, and User
e Node level policies are only available at the Enterprise level and require a node restart.
e Lock Account is only available at the User level.

Determine which Data Guardian policy groups you want to enable for Mac or for v2.3 and earlier
Windows:

Protected Office Documents is On Office documents are protected based on policies.
Cloud Encryption is Off For more information, see Set Security Policies to
Protect Office Documents in Windows. N/A

No DDG VDisk virtual drive is created. Non-Office
documents are not impacted.
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If Force Protected Files Only is selected, an

Unprotected folder is added to the root of the

user's Documents folder.
Cloud Encryption is On Office and non-Office documents are protected as Office and non-Office documents are protected as
Protected Office Documents is Off .xen files based on policies set. .xen files based on policies set.

A DDG VDisk virtual drive displays in the client's

Windows Explorer.

Both are On Non-Office documents are protected as .xen files if Non-Office documents are protected as .xen files.
in the DDG VDisk virtual drive. Office documents are protected based on
A DDG VDisk virtual drive displays in the client's  Protected Office policies.
Windows Explorer. For more information, see Set Security Policies to

Office documents have different levels of security Protect Office Documents in Mac.
based on policy. If protected, the Office document

retains its extension in the cloud but unauthorized

users cannot access it.

Additional policies impact Office documents. For
more information, see Set Security Policies to
Protect Office Documents in Windows.

Neither is On Files are not protected. If opened, content displays Files are not protected. If opened, content
in cleartext. displays in cleartext.

The Dell Server automatically updates profiles of cloud storage providers. For more information, see
Cloud Profile Update.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.

Cloud Encryption Off On
(Mac; 2.3 and earlier for Ooff
Windows) Toggle On to enable Cloud Encryption policies. If this policy is Off, no Cloud

protection takes place, regardless of other policies.

Enable Access to Restricted Not Selected Selected
File Not Selected
(Windows - v2.3 and earlier) Applies only to Google Drive. Selected disables any Google Drive-created shortcuts

to the web that Data Guardian cannot encrypt.

Enable In-App Feedback Not Selected Selected

(Cloud) Not Selected

(Mac; v2.3 and earlier for When selected, an end user can submit feedback and satisfaction ratings to Dell via
Windows) a link within the client application to a web form.
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Cloud Storage Protection String

Providers Protect,Dropbox_V1
(Mac; v2.3 and earlier for Protect,Box.net_V1
Windows) Protect,Chrome_V1*

Protect,Firefox_V1*
Protect,IE_V1*
Protect,SkyDrive_V1
Allow,BoxInstaller_V1
Allow,SkyDrivelnstaller_V1
Protect,Flash_V1*
Protect,Java_V1*
Allow, TrendMicroProxy_V1
Allow,DropboxInstaller_V1
Protect,OneDrive_For_Business_V1
Protect,Google_Drive_V1

String

Profiles that Allow, Block, Protect, or Bypass these providers/connections. Protect:
Allow the provider/connection, encrypt the files, and send audit events about
file/folder activity. Block: Block all access to the provider/connection. Allow: Allow
the provider/connection to pass through without encrypting, but audit file/folder
activity. Bypass: Bypass the protection of the provider/connection without
encrypting or auditing.

The format is: ProtectionLevel,ProfileName.

ProtectionLevel options: Allow, Protect, Block, Bypass

The Dell Server automatically checks for updated profiles of Cloud storage providers
supported with Data Guardian. When available, updated profiles are sent to Data
Guardian clients after the administrator commits policy changes. When the Pending
Policy Changes value in the Management Console is automatically incremented
although an administrator has not modified policy values, at least one updated
profile is available.

Allow,0OneDriveForBusinessinstaller_V1The polling interval for Cloud storage provider profile updates is daily at 12:30 a.m.

Allow,GoogleDrivelnstaller_V1

*For these profiles, ProtectionLevel
settings must match.
Dropbox Encrypt Personal Selected
Folders
(Windows- v2.3 and earlier)

Dropbox Encrypt Personal String
Folders Message You have added files to your Dropbox

(Windows- v2.3 and earlier) | (Personal) folder. Do not add business
files to your Dropbox (Personal) folder.
The names of all files that you add to
your Dropbox (Personal) folder are
being logged and sent back to the Dell
Server.
Help File Visible Selected
(Windows- v2.3 and earlier)

See advanced settings

Selected
Not Selected
Selected encrypts personal cloud storage provider folders.

String
Message to display when Dropbox Encrypt Personal Folders is set to Not Selected.
This message is customizable by the Administrator.

Selected

Not Selected

Selected allows the registration help file to be visible in the provider folder.
More...

Not Selected hides the help file, therefore, potential file sharers
does not be redirected to the registration URL located at
https://<yoursecurityserver>.<domain>.com:8443/cloudweb/register.

Protected Office Documents Off
(Windows and Mac)

Basic File Protection Not Selected
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On

off

Toggle On to provide users with a menu option for protecting Office documents
(.docx, .xlsx, .pptx, .docm, .xIsm, .pptm, and .pdf). On also allows you to enable
other Protected Office policies. If this policy is Off, no Office-protected formatting
takes place, regardless of other policies.

This policy is available at the Enterprise level.

Selected

Not Selected

When selected, the Basic File Protection Feature is enabled. This feature allows for



Basic File Protection String
Configuration

Block Print Screen Selected
(Windows- 2.7 and earlier)

File Icon Overlay Selected
(Windows)

See advanced settings

Manage Policies

the key-per-file encryption of line of business files that are not covered within
Microsoft Office.

String

Specifies which process and which extensions are included in Basic File Protection.
For Windows, specifies which process and which extensions are included in Basic
File Protection. For Mac and mobile devices, these encrypted files are read-only.
These encrypted files can be uploaded to the web portal. The following are
examples to follow for specific format inclusions:

Notepad.exe:txt.csv

Wordpad.exe:txt.rtf

Word.exe:txt.rtf

Note: Basic File Protection Configuration is supported in Data Guardian v1.6 and
later.

See Configure Basic File Protection Policies.

Selected disables the user's ability to take screen captures via the Windows Print
Screen capability while a protected office document is open.

Note: To block this option, Data Guardian must be installed and run on the
operating system, not a VM or Remote Desktop.

An overlay icon for Windows that indicates a file is protected by Data Guardian.

Classification Off
Data Classification Rules test (default)
Public
Internal Use
Restricted

On

off

Toggle On to provide users with a menu option for protecting files based on
classification level.

If this policy is Off, files are not automatically protected based on classification
level.

See Column options for Data Classification only.

Selected

Not Selected

When selected, the selected classification rule applies for encrypting files.

Data Guardian Off
Dropbox Allow and Audit
Box Allow and Audit

off

Cloud Protection

Office Protected Documents

Both

Select one option or Both to use Data Guardian with mobile clients. If this policy is
Off, Data Guardian is not enabled for mobile clients, regardless of other policies.
Allow and Audit

Allow and Protect

Disallow

Sets the status for Dropbox usage and protection.

Allow and Audit
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Google Drive Allow and Audit
OneDrive Allow and Audit
OneDrive for Business Allow and Audit
Apply Encryption to Root Selected

Data-Store Location

Basic File Protection Not Selected

Basic File Protection String
Configuration

Geo-Fencing
Enable Geo-Fencing Not Selected
Geo-Fencing Location US and Canada

See advanced settings

Allow and Protect

Disallow

Sets the status for Box usage and protection.

Allow and Audit

Allow and Protect

Disallow

Sets the status for Google Drive usage and protection.

Allow and Audit

Allow and Protect

Disallow

Sets the status for OneDrive usage and protection.

Allow and Audit

Allow and Protect

Disallow

Sets the status for OneDrive for Business usage and protection.

Selected

Not Selected

Selected encrypts personal cloud storage provider folders.

Selected

Not Selected

When selected, the Basic File Protection Feature is enabled.

String

Specifies which process and which extensions are included in Basic File Protection.
For mobile, copy and paste the processes and extensions from the Windows Basic
File Protection policy. For Mac and mobile devices,these encrypted files are read-
only.

See Basic File Configuration for Mobile.

Selected

Not Selected

Selected allows only users in the region selected in the Geo-Fencing Location policy
to access files.

us

Canada

US and Canada

Sets the location in which users can access files.

The Enable Geo-Fencing policy must be Selected.

Edit Permission Selected
External User Edit Not Selected
Permission

Main Title Image Choose File button

(Enterprise only)

Masthead Choose File button
(Enterprise only)
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Selected
Not Selected
Selected allows users to edit files within the web client.

Selected

Not Selected

Selected allows external users to edit files within the web client.

Image or logo to display on the login page.

The image must be a .jpg of square dimensions with a maximum file size of 25 KB. If
the image height and width dimensions are not equal, the displayed image is
stretched.

Image to display as the masthead on the login page. The image must be a .png file,
26x26 pixels.
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Access Agreement String Agreement text to be displayed for users to accept before they are allowed to log
(Enterprise only) in.

See advanced settings

Allow Mac Data Guardian Not Selected Selected
Activation Not Selected
Not Selected prevents Mac Data Guardian clients from being activated.
Allow Mobile Data Guardian Selected Selected
Activation Not Selected

Not Selected prevents Mobile Data Guardian clients from being activated.

Advanced Data Guardian
Advanced Data Guardian policies are available for these populations:

e Cloud Encryption (Mac; v2.3 and earlier for Windows) - Enterprise, Endpoint Groups, and
Endpoints

e Protected Office Documents - Enterprise, Endpoint Groups, and Endpoints (The Protected
Office Documents master policy, Enable Callback Beacon, and Callback Beacon URL policies
are available at the Enterprise level only.)

e Mobile Client - Enterprise, Domain, User Groups, and User

e Web Portal:
e Node level policies are only available at the Enterprise level and require a node restart.
e Lock Account is only available at the User level.

See Data Guardian policy groups to determine which policies to enable.

The Dell Server automatically updates profiles of cloud storage providers. For more information, see
Cloud Profile Update.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.

Cloud Encryption Off On

(Mac; v2.3 and earlier for Windows) Ooff
Toggle On to enable Cloud Encryption policies. If
this policy is Off, no Cloud Encryption protection
takes place, regardless of other policies.
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iOS Document Handling Disallow

(Windows)

Help File Name 1. How to access secure files.html

(Windows)

Help File Contents
(Windows)

HTML
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE html
PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml|1/DTD/xhtml1-
strict.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml"
xml:lang="en" lang="en">
<head>
<title>How to Access Secure Files</title>
<style type="text/css">P { text-align: center
}</style>
</head>
<body>
<h3>%PRODUCTNAME%</h3>
<hr />
<p>
<br /><br /> <br /><br /><br />
The files in this folder have been secured using
%PRODUCTNAME%.<br /><br />
To view the files in the folder, you need to
register with the owner of the files.<br /><br />

<a href="%ACTIVATIONURL%web/register">Click

Here To Register</a>
</p>
</body>
</html>
Excluded Folders
(Windows)

String

%windir%
%SystemDrive%\Srecycle.bin
%ProgramFiles%
%SystemDrive%\users\*\appdata
%ProgramFiles(x86)%
%ProgramData%\WebEx
String
C3901A99-1A1B-55B4-AE11-891207B1D341.xen
desktop.ini
thumbs.db
creddb.cef
~$*

~k

Excluded Files
(Windows)

~*tmp
.DDPCE.attr
*.Ink

Server Polling Interval 360 minutes

(Windows and Mac)

Software Update Server URL
(Windows)
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Allow

Disallow

Use this policy to allow or disallow iOS clients to
open documents with external applications.

String
Name of the registration help file. The file name
format is helpfilename.html.

HTML for the registration help file. HTML
validation is not performed.

The files in this folder have been secured

using Data Guardian. To view files in this folder
you need to register with the owner of the files.
%PRODUCTNAME% and %ACTIVATIONURL% are
both replaced by the Windows client based on the
activation URL dynamically.

The html can be modified to suit your
environment.

String

Folders excluded from encryption, separated by
carriage returns. A"!"
to exclude exactly that directory. Folders without
the "!1" are partial matches, so everything that
starts with the path is excluded.

before the variable means

String
Files excluded from encryption, separated by
carriage returns.

1-1440 minutes

How often, in minutes, the client checks in with
the Dell Server for updates. Default is 360
minutes (6 hours).

String

Use this policy if software updates for users is
located at an alternate Server URL.



Obfuscate Filenames
(Mac; v2.3 and earlier for Windows)

Folder Management Enabled
(Windows- v2.3 and earlier)

See basic settings

Extension only

Manage Policies

Extension only
Select Extension only to display the actual
filename with the ".xen" extension.

Not available for v2.8 and higher.

Protected Office Documents
(Basic - Windows and Mac)

Folder Exclusions for Basic File Protection
(Windows and Mac)

Protected Office Document Process Protection
(Windows)

off

String

String

On

Ooff

Toggle On to provide users with a menu option
for protecting Office documents (.docx, .xlsx,
.pptx, .docm, .xIsm, .pptm, and .pdf). On also
allows you to enable other Protected Office
policies. If this policy is Off, no Office-protected
formatting takes place, regardless of other
policies.

This policy is available at the Enterprise level.

String

Listing of folder paths that are excluded from
Basic File Protection.

See Configure policy to exclude folders.

String

Specifies which process and which extensions to
block while a Protected Office Document is open.
The following are examples to follow for specific
format inclusions:

SnippingTool.exe

mspaint.exe
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Force Protected Files Only
(Windows)

Enable Time To Live and Embargo Control
(Windows)

Print Control
(Mac; Windows- v2.7 and earlier)

Export Control
(Windows - v2.7 and earlier)
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Not Selected

Not Selected

Allowed

Allowed

Selected

Not Selected

Selected forces users to save Office files as
protected documents. It also enables a sweep on
the clients' internal fixed drives to locate new
Office files and change them to Protected mode.
It disables the Share option.

If Not Selected, users have some options in
determining whether to save a file as protected or
unprotected.

Selected

Not Selected

Selected allows users to specify dates for when
protected Office files are accessible to external
users.

Allowed
Watermark
Disabled
Controls the Print function of protected Office
documents (.docx, .xlsx, .pptx, .docm, .xlsm,
.pptm, and .pdf):

° Allowed - Print option is enabled for

protected Office documents.

° Watermark - Print option is enabled
for protected Office documents but a
watermark with the user's name,
domain name, and computer ID
displays on each page. Unprotected
documents print without the
watermark.

° Disabled - Print option is enabled.

However, if the user clicks Print for a
protected Office document or when a
protected Office document is open in
Acrobat Reader DC, a toaster states
that Print is not allowed. In addition,
the attempt to print is an audit event.
Users can always print unprotected
Office documents.

If Force Protected Files Only is Not Selected, the

Print option is available for all unprotected Office

documents.

Allowed

Watermark

Disabled

For Office 2013 and higher, controls the Export

function of protected Office documents (.docx,

Xlsx, .pptx, .docm, .xIsm, .pptm, and .pdf):

° Allowed - This varies based on
whether Force Protected Files Only is
Selected. For detailed information, see
Set Security Policies to Protect Office
Documents.

° Watermark - Export is disabled. See
Protected Export.

L] Disabled - Export is disabled for
protected Office documents. Users



Protected Office Clip Board Unauthorized Text
(Windows)

Protected Office Document Tamper Prompt
(Windows)

Offline Key Generation Escrow Reminder Delay
(Windows)

Offline Key Generation Escrow Reminder Text
(Windows)

Protected Office Documents Cover Page Notice
(Windows and Mac)

Protected Office Documents Cover Page
Corporate Logo
(Windows and Mac)

Protected Office Documents Cover Page Dell
Server URL
(Windows and Mac)

Enable Callback Beacon

Pasting of protected data is not allowed on this
computer. Please contact your administrator for
assistance.

The file has been tampered with. Contact the
author or your administrator.

3 days

Data Guardian has not been able to contact the Dell

Manage Policies

can export unprotected Office
documents.
String to display when a user attempts to paste
secure data from a protected document into an
unprotected location.
String to display if a user encounters an Office-
protected document that is identified as having
been tampered with.
1-14 days. 3 days default.
Specifies the number of days the client will wait
while not being able to escrow key material prior
to warning the end user.

Server for several days. Please ensure that you are String to display when the end user is warned that
connected to the network. If you are connected to |¢he client cannot escrow key material.

the network, contact your Administrator.

String

Browse button and Save Logo File button

String

Not Selected

Enterprise-defined text to be displayed on Office-
protected cover pages. Maximum number of
character is 4096. See Set Cover Page Policies.

If line breaks are entered as part of the text, they
are automatically converted to spaces to ensure
the text displays correctly in all Office
applications.

F

Image to be displayed on the document cover
page. See Set Cover Page Policies.

The logo image must be a .jpg of square
dimensions with a maximum file size of 25 KB. If
the image height and width dimensions are not
equal, the displayed image is stretched.

Dell Server URL that is displayed on the cover
page.

Selected inserts a callback beacon into every
protected Office file.

To use the callback beacon, the following
requirements must be met:

L] The beacon server must be installed
as part of Front End Server/Proxy
Mode installation. Port 8446 must be
open. For more information, see the
Security Management Server
Installation and Migration Guide or
Security Management Server Virtual
Quick Start Guide and Installation
Guide.

L] An administrator must have enrolled
to receive Product Notifications.

° The Callback Beacon URL policy is set.
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Callback Beacon URL

Hidden Audit Trail within Protected Office
Document
(Windows and Mac)

On Screen Watermark

(Windows - 2.7 and earlier)

Enable 2FA mode via RSA

Flag all User Created Pods for Two Factor
Authentication

Encrypt based on Titus Classification

Titus Classification Encryption Mapping
(Windows)

Allow File Exclusions
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String

Selected

Not Selected

Not Selected

Not Selected

Not Selected

String

Not Selected

Specifies the URL to be used when the callback
beacon is inserted into Office-protected files.
The URL, for example
http://server.domain.com:8446, must be
externally available, hosted on an HTTP server
that is installed as part of Front End Server/Proxy
Mode installation. Port 8446 must be open. For
more information, see the Security Management
Server Installation and Migration Guide or
Security Management Server Virtual Quick Start
Guide and Installation Guide.

The Enable callback beacon policy must be
Selected.

Enables a hidden watermark audit trail within a
Protected Office Document. For information on
decrypting protected documents to view audit
data, see Data Guardian in the Recovery Guide.
See also web_client and Mobile.

Selected

Not Selected

Selected displays a watermark on the client
computer screen when any protected Office file is
open.

Selected

Not Selected

Selected requires a Two Factor authentication on
selected Protected Office Documents..

Selected

Not Selected

Selected flags Protected Office Documents that
require a Two Factor authentication.

Selected

Not Selected

Selected causes the supported files to be
converted into Protected Office Documents if a
Titus classification is specified.

Requires "Encrypted based on Titus Classification"
to be enabled.

This policies specifies which classifications, when
selected, will have files classified as such
automatically converted to Protected Office
Documents. Each Classification is separated by a
carriage return, semi-colon, or comma.

Example:

Restricted

Classified

This policy is supported as of Data Guardian v1.6
and later.

See Set TITUS classification.

Selected

Not Selected

Selected allows internal users to place files within
an Unprotected Documents folder where no data
is protected. This applies only when Force
Protected Files Only is selected.



Email Encryption via Outlook

See basic settings

Selected

Manage Policies

Selected

Not Selected

Selected allows users to send emails as Protected
by Data Guardian.

Enable Callback Beacon

Callback Beacon URL

Hidden Audit Trail within Protected Office
Document

On Screen Watermark

Server Polling Interval

Workspace Access

Not Selected

String

Selected

Not Selected

360 minutes

Selected inserts a callback beacon into every
protected Office file.

To use the callback beacon, the following
requirements must be met:

. The beacon server must be installed
as part of Front End Server/Proxy
Mode installation. Port 8446 must be
open. For more information, see the
Security Management Server
Installation and Migration Guide or
Security Management Server Virtual
Quick Start Guide and Installation
Guide.

. An administrator must have enrolled
to receive Product Notifications.

. The Callback Beacon URL policy is set.
Specifies the URL to be used when the callback
beacon is inserted into Office-protected files.
The URL, for example
http://server.domain.com:8446, must be
externally available, hosted on an HTTP server
that is installed as part of Front End Server/Proxy
Mode installation. Port 8446 must be open. For
more information, see the Security Management
Server Installation and Migration Guide or
Security Management Server Virtual Quick Start
Guide and Installation Guide.

The Enable callback beacon policy must be
Selected.

Enables a hidden watermark audit trail within a
Protected Office Document. For information on
decrypting protected documents to view audit
data, see Data Guardian in the Recovery Guide.
See also Windows and Mac and web client.
Selected

Not Selected

Selected displays a watermark on the mobile

client screen when any protected Office file is
open.

1-1440 minutes

How often, in minutes, the client checks in with
the Data Guardian for updates. Default is 360
minutes (6 hours).
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Application pass code (PIN)

Set maximum failed login attempts

Set action on maximum failed login attempts

Set inactivity lock duration

Set copy/paste capabilities

Allow Non-Genuine device OS

Cover Page

Protected Office Documents Cover Page Notice

Protected Office Documents Cover Page
Corporate Logo

Protected Office Documents Cover Page Dell
Server URL

Protected Office Document Tamper Prompt

Web Browser
Set a default homepage

Pre-configure bookmarks

See basic settings

Timeout for 1 minute

Not Selected

Not Selected

String

Browse button and Save Logo File button

String

The file being opened appears to have been

tampered with and can no longer be validated.

Please contact the original author or your
administrator.

http://www.dell.com

4or6
Required number of characters for Workspace
PIN.

4-16

Define the number of PIN login failures. Then set
the policy for action to take on the Workspace
after the failed attempts.

Timeout for 1 minute

Timeout for 5 minutes

Lock Workspace

Wipe Workspace Data

The action to take after the maximum failed login
attempts are reached.

2, 5,20, 30, or 60 minutes
Configure the amount of inactivity time that can
elapse before the end user must re-enter a PIN.

Selected

Not Selected

Selected allows users to copy and paste outside of
the workspace.

Selected

Not Selected

Selected allows a jailbroken iOS device or a rooted
Android device.

Enterprise-defined text to be displayed on Office-
protected cover pages. See Set Cover Page
Policies.

Image to be displayed on the document cover
page. See Set Cover Page Policies.

The logo image must be a .jpg of square
dimensions with a maximum file size of 25 KB. If
the image height and width dimensions are not
equal, the displayed image is stretched.

Dell Server URL that is displayed on the cover
page.

Note: With mobile, for the URL to work with all
file types, it must have http or https prepended.

Text to be displayed if a user encounters an Office
Protected Document that has been determined
was tampered with.

Homepage default for the Workspace browser.

Pre-configure bookmarks.
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Protected Office Documents Cover Page Notice String

Protected Office Documents Cover Page

Choose File button
Corporate Logo

Protected Office Documents Cover Page Dell

String
Server URL
Enable Callback Beacon Not Selected
Callback Beacon URL String
Hidden Audit Trail within Protected Office

Selected

Document
On Screen Watermark Not Selected

Manage Policies

Text to be displayed on Protected Office
Documents Cover Page.
The text in this policy is translatable.

Corporate logo to display on the document cover
page.

The image must be a .jpg of square dimensions
with a maximum file size of 25 KB. If the image
height and width dimensions are not equal, the
displayed image is stretched.

Dell Server URL that is displayed on the Cover
Page.

Selected inserts a callback beacon into every
protected Office file.

To use the callback beacon, the following
requirements must be met:

L] The beacon server must be installed
as part of Front End Server/Proxy
Mode installation. Port 8446 must be
open. For more information, see the
Security Management Server
Installation and Migration Guide or
Security Management Server Virtual
Quick Start Guide and Installation
Guide.

L] An administrator must have enrolled
to receive Product Notifications.

. The Callback Beacon URL policy is set.
Specifies the URL to be used when the callback
beacon is inserted into Office-protected files.
The URL, for example
http://server.domain.com:8446, must be
externally available, hosted on an HTTP server
that is installed as part of Front End Server/Proxy
Mode installation. Port 8446 must be open. For
more information, see the Security Management
Server Installation and Migration Guide or
Security Management Server Virtual Quick Start
Guide and Installation Guide.

The Enable callback beacon policy must be
Selected.

Enables a hidden watermark audit trail within a
Protected Office Document. For information on
decrypting protected documents to view audit
data, see the Data Guardian in the Recovery
Guide. See also Windows and Mac and Mobile.

Selected

Not Selected

Selected displays a watermark on the mobile
client screen when any protected Office file is
open.
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Selected
Not Selected

Lo . When selected, the Basic File Protection Feature

Basic File Protection Not Selected R K .
is enabled. This feature allows for the key-per-file
encryption of line of business files that are not
covered within Microsoft Office.
String
Specifies which process and which extensions are
included in Basic File Protection.
For Windows, specifies which process and which
extensions are included in Basic File Protection.
For Mac and mobile devices, these encrypted files
are read-only. These encrypted files can be
Basic File Protection Configuration String uploaded to the web portal. The following are

examples to follow for specific format inclusions:
Notepad.exe:txt.csv
Wordpad.exe:txt.rtf
Word.exe:txt.rtf
Note: Basic File Protection Configuration is
supported in Data Guardian v1.6 and later.
See Configure Basic File Protection Policies.

See basic settings

Set Cover Page Policies

For Windows, Mac, mobile, and web portal, you can set policies to customize a cover page for protected
Office documents.

e Internal users for all platforms and external users for mobile and web portal - The cover page
displays for the following:

e Protected Office Documents policies have been enabled, but the user has not yet
installed or activated Data Guardian.

e User opens a protected Office document or .pdf from the cloud.

e User downloads a protected Office document or .pdf to a device that does not have
Data Guardian installed.

e Unauthorized users - The cover page displays, and the person cannot access the content.

To customize the cover page for protected Office documents, you can use these Advanced Data
Guardian policies:

e Protected Office Documents Cover Page Notice
e Protected Office Documents Cover Page Corporate Logo

e Protected Office Documents Cover Page Dell Server URL

See also, Data Guardian Management > Web Portal to add a URL to access the web portal.

Cloud Profile Update

The Security Management Server can automatically check for updated profiles of cloud storage
providers supported with Data Guardian.

Note: For Windows, this applies to Data Guardian v2.3 and previous.
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To configure Dell Server to automatically check for updated profiles, follow these steps:
1. Navigate to <Security Server install dir>\conf\ and open the application.properties file.
2. Locate cloud.profile.updater.enabled and set the value to true.

When update is enabled and updated profiles are available, the profiles are sent to Data Guardian
clients after the administrator commits policy changes. When the Pending Policy Changes value in the
Management Console is automatically incremented although an administrator has not modified policy
values, at least one updated profile is available.

The polling interval for cloud storage provider profile updates is daily at 12:30 a.m.

Set Policies to Protect Documents in Windows

For enhanced security on Office documents (.docx, .pptx, .xIsx, .docm, .pptm, .xIlsm, or .pdf), you can
implement Data Guardian's Protected Office mode for internal users.

Users can open a protected .pdf file with:
e Adobe Acrobat Reader DC
e Microsoft Word - from a local drive or from the network
You cannot map a network drive to a local drive to open a .pdf.
The Basic File Protection policies allow you to configure additional file extensions to be encrypted.

If an unauthorized user tries to access a protected file, the file remains encrypted, for example when the
file is:

e Attached in an email
e Moved in a browser - if the user selects Move in a cloud sync client
e Moved in File Explorer

e Stored on removable media

You can:

e Set Policies for Protected Office Documents

e Determine Impact on Windows Users for Opt-in_or Force Protected Modes

e File_menu options for Data Guardian v2.7 and earlier

e Enable Both Cloud Encryption and Protected Office Documents Windows 2.3 and earli
er

Set Policies for Protected Office Documents

To set Protected-mode policies on Office documents for internal users:
1. Logintothe Management Console.

2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected
Office Documents policy group.

3. Determine the level of security for Office documents:

e Opt-in mode (allows users the option to choose which Office documents to protect):
Toggle the Protected Office Documents policy to On.
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e Force-Protected mode (ensures protection of all Office documents):
e At the Enterprise level, toggle the Protected Office Documents policy to On.

e Atthe Enterprise, Endpoint Groups, or Endpoints level, click Show advanced
settings and select the Force Protected Files Only check box.

For Endpoint Groups or Endpoints, click an option to access the Detail page’s Security Policies
tab.

4. Set additional Protected Office Documents policies based on security requirements for Office
documents, for example, Print, Export, and Embargo.

5. To view protected Office documents in mobile devices, see Set Policies to Protect Office
Documents in Mobile Devices.

Return to list

Determine Impact on Windows Users for Opt-in or Force Protected Modes

When you set Protected Office Documents policies and the client is activated, the File menu for Office
documents displays additional options and enables/disables some options.

Dell recommends that you test policy updates on a test group of endpoints before applying them on a
large scale.

This table provides an overview of the security impact on the Office File menu options for internal users
based on which policies you activate:

e Protected Office Documents (Opt-in mode - user has the option to choose which Office
documents to protect. Both Save As and Protected Save As are enabled). For Opt-in mode, a
Secure Documents folder is added to the root of the user's Documents folder. Documents in
that folder are encrypted.

e Protected Office Documents and Force Protected files only (Force-Protected mode - higher
security) - The Force Protected policy enables a sweep on the clients' internal fixed drives to
locate unprotected Office files and change them to Protected mode. It disables Save As and the
Share option. It enables Protected Save As. For Force-Protected mode, an Unprotected
Documents folder is added to the root of the user's Documents folder. Documents in that folder
are not encrypted.

For Data Guardian to sweep the Office documents, the user must log in and be connected to the
network. The sweep acquires keys from the Dell Server for ten unprotected Office files at a time. If fewer
than ten unprotected Office files require keys, the sweep waits 30 seconds for more files but then
requests the keys.

Sweep ignores network file share, optical, and removable drives.

For Office-protected documents, users cannot run macros in macro-enabled documents.

‘Protected Office documents ‘ Unprotected Office documents ‘AII Office documents

|Fi|es open as usual. |Fi|es open as usual. |Unprotected documents open in read-
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only mode. See Save and Protected
Save As.

User clicks Save: the file

is protected.

If the file is in read-only mode, the
Save As window opens. The only
option in the Save as type field is

User clicks Save: the file is saved
but not in protected mode.
Save as type field - If this is the
first time to save the file, the
Save As window opens and this

User clicks Save: the file is protected.

If the file is in read-only mode, the Save

As window opens. The only option in
the Save as type field is Protected
(Documents, Presentation, or

unprotected

unprotected

Save Protected (Documents, field has the standard list of Workbook).
Presentation, or Workbook). options. User opens and saves a .xen file - the
User opens and saves a .xen file - only option in the Save as type field is
the only option in the Save as type Protected. The .xen file is removed from
field is Protected. The .xen file is the cloud.
removed from the cloud.

Save As Enabled for user - saves as Enabled for user- saves as Disabled for user - the only option is

Protected Save As.

Protected Save As

Enabled for user
Save as type field - the only option
is Protected (Documents,

Presentation, or Workbook).

Enabled for user
Save as type field - the only
option is Protected (Documents,

Presentation, or Workbook).

Enabled for user
Save as type field - the only option
is Protected (Documents, Presentation,

or Workbook).

Return to list

File menu options for Data Guardian v2.7 and earlier

For Data Guardian v2.7 and earlier, this table provides an overview of additional Protected Office policy

settings and what displays in the Office File menu. These do not apply to Data Guardian v2.8 and

higher.

Protected Office documents

Unprotected Office documents

user is forced to save any Office
document as Protected.

With Force Protected enabled, the

° Allowed: Enabled for
user

o Watermark: Export is

disabled. See Protected

Export.

o Disabled: Disabled for
user

Print Enabled for user Enabled for user Enabled for user
For Office-protected documents, For Office-protected documents, the
the Print _Control policy Print Control policy determines how
determines how this function this function behaves.
behaves.
Export Office 2013/2016 and Export Enabled for user Office 2013/2016 and Export Control
(Office 2013 and higher) |Control policy: policy:

o Allowed: Export option is
enabled for user. However,
with Force Protected
enabled and a higher level
of security, Dell
recommends setting this
policy to Watermark or
Disabled. With Allowed,
users can save as another
file type, which could leave
a document unprotected.

o Watermark: Export is
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disabled. See Protected
Export.

o Disabled: Disabled for user

Protected Export (Office
2013 and higher)

This option displays in
the File menu only if the
Export Control policy is
set to Watermark.

Office 2013/2016 and Export
Control policy:

° Watermark: The user

can export only to a
PDF, but a watermark
with their name,
domain name, and
computer ID displays
on each page.

Note: Export is disabled

for user.

N/A

Office 2013/2016 and Export Control
policy:

° Watermark: The user can
export only to a PDF, but a
watermark with their
name, domain name, and
computer ID displays on
each page.

Note: Export is disabled for
the user.

Share
(Office 2013 and higher )

Disabled for protected Office
documents

Enabled for unprotected
documents

Enabled for user

Disabled for user

For Data Guardian v2.7 and earlier, this table provides an overview of Protected Office policy settings
and other menu options. These do not apply to Data Guardian v2.8 and higher.

Protected Office documents

Unprotected Office documents

With Force Protected enabled, the
user is forced to save any Office
document as Protected.

Copy/Paste
(Office Protected Clip
Board policy)

Copy/Paste only to a protected
Office document or protected .pdf.
However, no unprotected PDFs can
be open in Adobe Acrobat Reader
DC.

Copy/Paste unprotected content
as usual.

Copy/Paste only to a protected Office
document or protected .pdf. However,
no unprotected PDFs can be open in
Adobe Acrobat Reader DC.

Screen Sketch
(previously Snipping
Tool)

Windows 10 RS5 and higher - In
the Protected Office Document
Process Protected policy enter this
.exe to block this app since users
could capture images of protected
documents or content.

Note: This policy cannot block the
Action Center tile that directly
launches the screen-clipping
Windows feature.

Snipping Tool

Windows 10 RS4 and earlier - In
the Protected Office Document
Process Protected policy enter
SnippingTool.exe to block it.
Windows 10 RS5 and higher -

With Force Protected enabled, if you
block the PrtScr button, this may also
block the ability for users to print

screens with touch screen or tablets.

Return to list

Enable Both Cloud Encryption and Protected Office Documents (Windows 2.3 and earlier)
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If you enable both policy groups, Protected Office documents differ from non-Office documents in some
areas:

e |f the Cloud Storage Protection Providers policy is set to Allow and does not encrypt non-Office
files, protected Office documents still maintain any protection status.

e |f the Excluded Folders policy excludes a particular folder from encryption, protected Office
documents still maintain any protection status if copied to those folders.

Return to Data Guardian policies.

Return to list

Set Policies to Protect Office Documents in Mac

For enhanced security on Office documents (.docx, .pptx, .xIsx, .docm, .pptm, .xIsm, or .pdf), you can
implement Data Guardian's Protected Office mode. Protected Office documents are uploaded to the
cloud, not as .xen files, but with their file extensions (.docx, .pptx, .xIsx, .docm, .pptm, .xIsm, or .pdf).
However, the Office documents are encrypted. If opened or downloaded to a device that does not have
Data Guardian installed, only a cover page displays with instructions on how to obtain validated access.
An authorized user can obtain installation or activation information from the enterprise. An unauthorized
user cannot access the protected data.

The cloud storage provider is optional. Protected Office documents and .xen files can be opened from
local storage.

The Basic File Protection policies allow you to configure additional file extensions to be encrypted. For
Mac, this requires Force-Protected mode.

Set Protected Office Document Policies
To set Protected-mode policies on Office documents for internal users:
1. Logintothe Management Console.

2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected
Office Documents policy group.

3. Determine the level of security for Office documents:

e Opt-in mode (allows users the option to choose which Office documents to protect):
Toggle the Protected Office Documents policy to On.

e Force-Protected mode (ensures protection of all Office documents):
e At the Enterprise level, toggle the Protected Office Documents policy to On.

e At the Enterprise, Endpoint Groups, or Endpoints level, click Show advanced
settings and select the Force Protected Files Only check box.

4. Inthe Data Guardian technology group, click Settings.
5. Ensure the Allow Mac Data Guardian Activation check box is selected.
6. Set additional Protected Office policies at the Enterprise, Endpoint Groups, or Endpoints levels.

For endpoint groups or endpoints, click an option to access the Detail page’s Security Policies
tab.

7. To view protected Office documents in mobile devices, see Set Policies to Protect Office
Documents in Mobile Devices.

Determine Impact on Mac Users for Opt-in or Force Protected Modes
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When you set Protected Office Documents policies and the client is activated, the File menu for Office
documents displays additional options and enables/disables some options.

Dell recommends that you test policy updates on a test group of endpoints before applying them on a
large scale.

This table provides an overview of the security impact on the Office File menu options for internal users
based on which policies you activate:

e Protected Office Documents (Opt-in mode - user has the option to choose which Office
documents to protect. Both Save As and Protected Save As are enabled). For Opt-in mode, a
Secure Documents folder is added to the root of the user's Documents folder. Documents in
that folder are encrypted.

e Protected Office Documents and Force Protected files only (Force-Protected mode - higher
security) - The Force Protected policy enables a sweep on the clients' internal fixed drives to
locate unprotected Office files and change them to Protected mode. It disables Save As and the
Share option (Office 2013 and 2016). It enables Protected Save As. For Force-Protected mode,
an Unprotected Documents folder is added to the root of the user's Documents folder. Mac
protects files in \Users. Documents in that folder are not encrypted.

Set Policies to Protect Documents in Mobile Devices

For enhanced security on Office documents (.docx, .pptx, .xIsx, .docm, .pptm, .xIsm, or .pdf), you can
implement Data Guardian's Protected Office mode. Protected Office documents are uploaded to the

cloud, not as .xen files, but with their file extensions (for example, .docx or .pdf). However, the Office
documents are encrypted.

Basic File Protection policies allow you to configure additional file extensions to be encrypted. Copy the
extensions from the Windows policy to the mobile's Basic File Protection Configuration policy. Users can
open, edit, and save encrypted files.

Set Protected Office Document Policies
To set Protected-mode policies on Office documents:
1. Logintothe Management Console.

2. In Populations > Enterprise, in the Data Guardian technology group, click the Protected
Office Documents policy group.

3. Toggle the Protected Office Documents policy to On.
The Force Protected files only policy is not available for mobile.

4. Inthe Data Guardian technology group, click Settings.

o

Ensure the Allow Mobile Data Guardian Activation check box is selected.

6. Set additional Protected Office policies at the Enterprise, Domains, User Groups, or
Users levels.

For domains, user groups, or users, click an option to access the Detail page’s Security Policies
tab.

Set Policies to Protect Documents on the Web Portal

For enhanced security on Office documents (.docx, .pptx, .xIsx, .docm, .pptm, .xIsm, or .pdf), you can
implement Data Guardian's Protected Office mode for internal users.
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Users can open a protected .pdf file with Adobe Acrobat Reader DC or Microsoft Word.

If additional file extensions are set through the Basic File Protection Configuration policy on a Windows
client, users can upload those encrypted files on the web portal. If an editing policy is enabled, users
can edit them.

With OneDrive for Business, users can connect to the cloud storage provider to download files directly
from the cloud to the web portal.

Set Protected Office Document Policies

To set Protected-mode policies on Office documents:

1.
2.

Log in to the Management Console.

In Populations > Enterprise, in the Data Guardian technology group, click the Protected
Office Documents policy group.

Toggle the Protected Office Documents policy to On.

In the Web_Portal policy group or Global Settings, set additional policies at the Enterprise,
Domains, User Groups, or Users levels. Some polices are set at the Enterprise (node level)
only.

For domains, user groups, or users, click an option to access the Detail page’s Security Policies

tab.

Configure Basic File Protection Policies

With Data Guardian v1.6 and higher, you can configure applications and file types in addition to Office
documents. This policy applies at the Enterprise level. A sweep of users’ computers encrypts those
configured file types.

This topic includes:

Supported applications_and file types

Additional applications_and file types

Configure policy for Basic File Protection

Configure policy to_exclude_folders (Windows and Mac)

Unsupported_applications_and_file_types

Use the Recovery Tool

Supported applications and file types

This table lists applications and file types that Dell has certified.

Dell has certified these applications: .bmp In the policy configuration field, enter the
° Notepad .CsV application, followed by applicable file extensions.
.gif As a best practice, only add the essential file
o Wordpad . . .
Jfif extensions to prevent performance issues.
L4 Visio Jpe
®  MSPaint jpg .tmp extension
Add these applications if you want them to open -jpeg Be aware that if you add a .tmp extension, all
the supported file extensions. For an example, see -PnNg Temp files are encrypted. Use only if necessary.
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NoRename. .tmp
®  Word (winword) rtf
N Excel tif
xee iff
° PowerPoint txt
.vsdx
These applications are partially supported: .bmp See .bmp file.
o Microsoft.Photos.exe (Windows 10)
This file extension is partially supported: Currently, when opened with Wordpad, a
.odt protected .odt file may not save new content.
Add these applications if required by another Add applicable extensions from above. Here are examples:
application: RuntimeBroker.exe:png.rtf.txt.omp
®  Sihost CodeWriter.exe:rtf.txt

° Code Writer

° Runtime Broker
Additional applications and file types

Many applications and file types should work. However, Dell has not certified all. In addition, enterprise-
created applications and file types may work.

You can add other applications and file types, but as a best practice, configure them in a test
environment before deploying to your enterprise.

If you test frequently used or essential applications and would like Dell to confirm that and add them to
the Supported list or if issues arise, contact Dell support.

Configure policy for Basic File Protection
To configure additional file types to be encrypted:

1. Inthe left pane, click Populations > Enterprise, enable the Protected Office Documents
policy.

2. In the Data Guardian > Windows technology group, enable the Basic File Protection policy.

Note: This policy applies to the Enterprise population only. Also, if you enable Allow File
Exclusions, users must remove files from the Unprotected Documents folder for these file types
to be swept and encrypted.

3. In Windows technology group’s Basic File Protection Configuration policy field, enter an
application that you want to be encrypted, followed by a colon, for example:

notepad.exe:

4. After the colon, add the file extensions that is encrypted and any processes needed to support
that application. Here are some sample configuration strings that Dell has certified. Only add
essential extensions to prevent performance issues.

wordpad.exe:rtf.odt.txt.png.jpg.csv.bmp
notepad.exe:txt.csv
visio.exe:vsdx.png.jpg.jpeg.jpe.jfif.gif.tif.tiff. bmp
mspaint.exe:png.jpg.jpeg.jpe.ffif.gif tif.tiff. bmp
sihost.exe:png.jpg.jpeg.jpe.jfif.gif tif.tiff.rtf.txt.bmp
microsoft.photos.exe:png.jpg.jpeg.jpe.jfif.gif.tif.tiff. bmp
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For Mobile, copy the extensions from the Windows policy to the Enterprise > Mobile Client >
Basic File Protection Configuration policy. The file extensions in the Mobile policy must
match Windows.

Basic File Protection policy and operating systems

Windows, Mac, and mobile: When the policy is enabled, these files are swept and Data
Guardian encrypts all local files with those extensions. Files encrypted with Basic File
Protection can only be viewed and edited using the application associated with the file
extension. Mac requires Force-Protected mode.

Web Portal: If the Edit Permission policy is enabled for web portal, users can edit them.

Some folders are excluded from Windows’ Basic File Protection sweep and files are not encrypted:

AppData
Some System folders

Folders that relate to protected Office documents, such as the Secure Documents folder

If applicable, add these workflows to the policy lists:

NoRename - add this for Office applications to ensure that if users open them, they can only
save them as an Office file, not as a Basic File Protection file. Here are some examples:

winword.exe:NoRename.odt.txt.png.jpg.csv.rtf.jpeg.jpe.jfif.gif.tif.tiff. bmp

excel.exe:NoRename.png.jpg.csv.jpeg.jpe.jfif.gif.tif.tiff. bomp
powerpnt.exe:NoRename.png.jpg.jpeg.jpe.jfif.gif.tif.tiff. bomp
Note: Do not add Office file extensions to this policy configuration.

NoNetwork — if users io to a network and files hang when users close them, add this to the
application to prevent network save.

Before deploying Basic File Protection to the enterprise, be sure to test applications and file
extensions in a test environment to ensure that the intended file types remain encrypted. Also,
you can download procmon (process monitor) to determine file types that might create an issue
for that application.

Inform users:
e Which applications and file types your enterprise encrypts
e Which operating systems can be used and whether files are read only or can be edited

e Files sent to external users or to devices that do not have Data Guardian installed

Configure policy to exclude folders for Basic File Protection (Windows and Mac)

After you enter file types, like .txt or .png, in the Basic File Protection Configuration policy field, a sweep
will encrypt those files on the client computers.

You may want to exclude some of those file types, for example:

To prevent files needed by the system from being encrypted

To create a folder where users can place files of that type that do not require encrypting

In the Folder Exclusions for Basic File Protection policy, enter the path for a folder on client computers
to exclude files from a Basic File Protection sweep.

Note: You cannot exclude the Secure Documents folder.
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Windows example

Enter the string in one of these formats based on type:
e C:\Program Files, System, or a subfolder in those paths - for files needed by the system
e Variables with a %VALUE% format

o KNOWNFOLDERID - for Windows-specified known-folder ID mappings. For example, enter a
string for a uniquely named folder like My Excluded Basic File Types and then tell users to
create that folder in their User Profile. Here are examples of supported formats for Known
Folder ID mappings:

e GUID with dashes:
D0384E7D-BAC3-4797-8F14-CBA229B392B5

e  GUID without dashes:
D0384E7DBAC347978F14CBA229B392B5

e  GUID with dashes and curly brackets:
{D0384E7D-BAC3-4797-8F14-CBA229B392B5}

If the computer has more than one user, only the current logged-in user can place files in that folder and
have them excluded from the sweep. Any files that another user has placed in that folder will be swept
and encrypted.

Mac example
Enter the string in this format:
e Variable with a $VALUE format, for example, $SHOME/Documents or SHOME/Hidden
Note: For Force-protected mode, a sweep occurs in the /Users folder.
Inform users of the impact or usability

If you define a unique folder name in the Folder Exclusions for Basic File Protection policy so that users
can store files of a specific type that should not be encrypted, the policy does not create that folder on
the client computers. You must inform users of the folder name and the need to create it.

Users can add subfolders and create names. The content of subfolders is also excluded.

Note: If that folder already has files that are encrypted with Basic File Protection, those files are not
decrypted.

Unsupported applications and file types

e Do not add these Office file extensions to the Basic File Configuration policy: .docx, .pptX, .XIsX,
.docm, .pptm, .xIsm, .pdf. Basic File Protection does not scan these during a sweep.

e PhotosApp.exe (Windows 8.1)
Remove a file type

If you modify the Folder Exclusions for Basic File Protection policy to remove a file type, those
encrypted files on the client computer are decrypted.

However, if the computer has more than one user, only the current logged-in user has files decrypted. If
the logged in user logs out and a second user logs in, the sweep starts again but decrypts only the files
of the second logged-in user.

Use the Recovery Tool
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You can modify Data Guardian to encrypt additional file types. However, to ensure protection, be aware

of the following factors.

Cloud Encryption enabled (Windows 2.7 and In the Basic File Protection Configuration policy, if Options to avoid Edge decrypting files on upload:

earlier) you add any UWP application and the processes °
Windows 8.1 - 10 and higher that support the app, all UWP applications are
Universal Windows Platform (UWP) application enabled to read these encrypted file types.
added to Basic File Protection Configuration policy Edge is a UWP application. File extensions added

or

.
(See below for steps to add a UWP application.)  to the policy, such as .txt or .png, are encrypted.
However, if users use Edge to upload these
encrypted files to a cloud storage provider, the file
°

is decrypted.

Do not add UWP apps to the
configuration field.

If you add a UWP application, block
Edge through GPO or ensure that it is
not installed on computers.

Consider which UWP applications you
want users to have encrypted.
However, test all UWP applications
before deploying Basic File Protection
to the enterprise to ensure that the
intended file types remain encrypted.

These applications are supported and can open a .bmp files require additional configuration in the Here is an example:
.bmp file: Basic File Protection Configuration policy. microsoft.photos.exe:bmp

®  Microsoft.Photos.exe (Windows 10) DllHost.exe:bmp
sihost.exe:bmp

o Windows Photo Viewer (Windows 8.1)
This UWP application, is not supported and will
not open a .bmp file:

. PhotosApp.exe (Windows 8.1)

To add a Universal Windows Platform (UWP) application

RuntimeBroker.exe:bmp

1. Inthe Basic File Protection Configuration policy, enter the UWP application name.

2. Also enter the following process names:
e RuntimeBroker.exe

e sjhost.exe

Note: For Windows 8, if you want to add Photo Previewer as a UWP application to the Basic
File Protection Configuration policy, you must also add the DLLHost.exe process.

3. To add the file extensions that each .exe will encrypt, follow the examples in the policy.

Set TITUS classification (Opt-in mode)

For Data Guardian 1.6 and later, you can use the Titus Classification Encryption Mapping policy to set
one or more TITUS classifications to encrypt unprotected Office documents (.docx, .pptx, .xIsx, .docm,

.pptm, .xIsm, or .pdf) for Windows.

TITUS classification in a Data Guardian environment with Opt-in mode provides another way for users
to protect Office documents. When a user right-clicks and selects a TITUS classification that you have

configured, Data Guardian converts it to a protected Office document.

Currently, TITUS classification applies only to Office documents and PDFs, not additional file extensions

set in the Basic File Protection policy.
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In the policy, you can also add keywords.

Configure TITUS to encrypt files

TITUS server

The TITUS server administrator must set the TITUS Classification levels on the TITUS server.

Here are some examples.

Public
Internal
Confidential

Restricted

t_class_1
t_class_2
t_class_3

t_class_4

For more information, see the TITUS Administration Guide.

Management Console

Configure the policy on the Management Console:

1.
2.

From the TITUS server administrator, obtain the format for each TITUS classification level.
In the Management Console > Protected Office Documents policy group, enable these policies:
e Protected Office Documents

e Advanced: Encrypt based on Titus Classification
Do not select the Force Protected Files Only policy.

In the Titus Classification Encryption Mapping policy field, enter the formatting. For example, for
Data Guardian to encrypt a Restricted TITUS classification, enter Set classification to
t _class_4.

Separate each classification by a carriage return, semi-colon, or comma, for example,
t class_1,t class_2.

Optionally, obtain keywords for sensitive data from the TITUS administrator. For example,
TITUS can scan a document for sensitive data, like Social Security Numbers. If you enter a
keyword for that in this policy field and TITUS detects it, that document is protected as
Restricted regardless of which TITUS option the user selects. For more information, see
Actions in the TITUS Administration Guide.

Configure TITUS to encrypt macro-enabled documents

To use TITUS classification with Data Guardian and macro-enabled documents (.docm, .pptm, .xlsm)
requires additional configuration.
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In the TITUS Administration Console, select the Configurations tab.
Select the current enabled configuration from the list and click Edit.
In the left pane, click Adapters.

In the Adapter column, click OPC Document Properties.

Click Edit.

In the OPC Document Properties view > Additional File Extensions field, add .docm, .pptm,
Xlsm.
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7. Click Save.

Configure Data Classification for Data Guardian's Opt-in mode

In Windows for Office documents and PDFs, use the Data Classification Rules policy to set rules that
enforce encryption on sensitive data.

Note: Users also have the option to right-click a file that has been analyzed by Data Classification and
select Protect File.

You can set Classification rules at the Enterprise, Endpoint Groups, or Endpoints populations. Dell
recommends that IT best practices are followed during the deployment. This includes, but is not limited
to, controlled test environments for initial tests and staggered deployments to users. Initially, do not
select the Encrypt check box for any classifications. View the audit event reports to see the amount of
data returned and the number of endpoints affected. Then modify your rules. To store a large amount of
data, see Export Dell Data Guardian Audit Events to SIEM a Server.

To configure the Data Classification Rules policy:
1. Inthe Data Guardian technology group, set these policies to on:
e Protected Office Documents
e Classification

2. Click Edit Rules. Edit and delete icons display for each classification. An Elements button
displays at the bottom.

3. Configure the classifications, rules, elements, and actions:

e Modify a Classification

e Add an Enterprise-Specific_Classification or Tag Element

e View Audit Event Reports

4. Each time you add or modify a classification or add a rule, you must click Save beneath the
Data Classification Rules policy.

Note: If you navigate away from this page without clicking Save at the bottom, your changes are
not saved.

5. When finished, click Save in the upper-right and commit the policy.

The sweep for Data Classification does not include folders for your cloud storage provider. Also, if a file
is already encrypted, the sweep does not rescan it to classify it.

Modify a Classification
The Data Classification Rules policy allows you to modify:

e Classification Name and Priority - The policy lists sample classification names with default
priorities that you can modify:

0 Restricted - priority 3, the highest
0 Internal Use - priority 2

0 Public - priority 1, the lowest. The lowest priority displays (default) after the
classification name, and no rules or actions apply.

Important: Optionally, you can delete these classifications but the policy requires a
minimum number. See Delete.
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e Actions:

Encrypt - If you select the Encrypt check box for a non-default classification, the
system encrypts the files. In addition, Reports can list which files were encrypted
based on classification rules. If you select Encrypt and the system sweeps an endpoint
and encrypts, the files remain encrypted.

Audit - By default when the Classification policy is enabled, the Audit action applies
to all files. You can view these in Audit Events and Reports. The report displays the
first 2000 audit events. Before deploying, you can configure the classifications and
rules without selecting the Encrypt option and then generate an audit report to
determine the impact on endpoints and then further modify the rules.

e Rules - For configured rules, the system will sweep and detect them when a user saves the file.
If the Encrypt check box is selected, the system encrypts the files.

e Elements - Options for configuring a rule, such as Credit Card number, US Name, Social
Security Number, or Tags.

Classification Name and Priority

To modify:

See Configuration _overview.

P 0 p PR

Select a non-default classification name, and click the Edit icon.
Optionally, modify the classification name.

Modify the priority:

The Priority label lists the range of numbers based on your number of classifications.
The largest number is the highest priority.

By default, Public is set to 1, the lowest priority. Whichever classification is set to
priority 1 is listed with the (default) label and has no Encrypt option and no rules to
modify. If you configure rules for a higher classification but then change the priority to
1, those rules are ignored.

5. Toremove a classification, select one and click the Delete icon (X). The range of priorities will
also decrease.

Important: The policy requires a minimum number of classifications

For files to be encrypted, this policy requires a minimum of two classifications and one
Encrypt check box selected.

For the policy to function and create audit events, this policy requires a minimum of one
classification.

6. In Edit Classification, click Save.

7. Below the Data Classification Rules policy, click Save.

Return to top

Actions

To modify:

1. See Configuration overview.

2. Click the icon to expand a non-default classification.
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3. Select the Encrypt check box if you want the audit report to display files that have met the
criteria for encryption.
4. Below the Data Classification Rules policy, click Save.
Return to top
To modify:
1. See Configuration_overview.
2. Click the icon to expand a non-default classification.
3. Click + to add a rule.
3. Inthe Rule field that displays, select one or more check boxes for that rule and modify the
number if needed. Incremented numbers mean that a file must contain that element, such as
U.S. Address or Social Security Number, the specified number of times or higher in order to
encrypt the file. For example, if your file lists a sample U.S. Address, you may not want the file
to be encrypted. Therefore, you could set this number to 2 for an encryption.
4. Click + to add and configure more rules for that classification. Rules are or'd together.
5. Below the Data Classification Rules policy, click Save.

Return to top

To view Elements:

See Configuration _overview.

Select a non-default classification.

Click the Elements button at the bottom.

On the Elements window, select an element.

Do not modify the Content Identifier or Content Type.
See the table below.

When finished with the Elements window, click Save.

Below the Data Classification Rules policy, click Save.

For elements that you can modify, if you use them in multiple classifications be aware that future
changes impact all classifications that use that element.

Predefined Elements:

Do not modify these elements, except for US Name.

Credit Card For US Name, use these fields: First Names, Last Names, Common Words.

Email (IPv4 and IPv6 IP addresses are

You cannot delete these elements.

recognized.)

IP Address

Social Security Number

US Address

US Date
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o US Name

. US Phone Number
Keywords elements In the Keywords field, type any key words that you want the system to recognize when encrypting
files for that classification. The format is [object Object].Click Save.
Click X to delete.
See Add an Enterprise-Specific Classification or Tag Element.

Tags elements Select the tag element that corresponds to the classification, for example, with the Restricted
Public, Internal Use, Confidential, Restricted classification, select Restricted Tag.
In the Tag field, a default tag displays. The system recognizes that tag when encrypting that
classification
For Tag elements, do not enter content in the Regex field.
Click X to delete.
Note: If end users want to use the Tag option in Office documents to trigger a classification, inform
them of the content in the Tag field. End users must match the case.
See Add an Enterprise-Specific Classification or Tag Element.

Custom Regex element The best practice is not to modify the Regex for predefined elements or Tag elements. Use the
Custom Regex element or create a new Regex element. See Add an Enterprise-
Specific Classification or Tag Element.

9. When finished with the Elements window, click Save.

10. Below the Data Classification Rules policy, click Save.

Return to top

Add an Enterprise-Specific Classification or Tag Element

Create a Classification
You can create an additional classification or modify the names of existing ones.
To create a new classification:

1. See Configuration overview.

2. Inthe Data Classification Rules policy, click the add icon (+) next to Classifications.
3. Inthe Add Classification window, enter a name for the classification.
4

Enter a priority. A number displays to indicate the range of classifications in your list. See
Classification Name and Priority.

5. Click Add.
6. Below the Data Classification Rules policy, click Save.
Create an Element
To create an element:

1. See Configuration overview.

2. In the Elements window, click the add icon (+) next to Elements.
3. Inthe Content Identifier field, enter a unique identifier.
4. Select a Content Type.

Note: Select the KeywordContent for any Keywords elements; the FileTagMetadataContent for
any Tag elements, and the CustomRegexContent for any Regex elements.

5. Click Add.
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6. Below the Data Classification Rules policy, click Save.
7. Modify the Element when it displays in the Element window.
After you create an element, you can add it as a new rule.

For Regex, the best practice is to create a new element with a Content Identifier such as MyEnterprise
Custom Regex or Custom Regex for Internal Use. Any Custom Regex would use the Content Type
Custom Regex. However, do not use Custom Regex for predefined or Tags elements.

Note: Data Classification uses the .NET regex engine.

Return to top
View Audit Event Reports
Any documents that are impacted by Data Classification rules can display in Audit Events and Reports.

If you select the Encrypt check box in policy, the report can also display which files were encrypted
based on these rules.

You can set filters on the columns to view the essential data in the report.

Return to top

Configure Access Groups (On-prem)

Data Guardian's Access Groups (formerly Circle of Trust) enhances security by creating user groups
that can collaborate on encrypted data. Users outside a group cannot access or view the data unless
the owner of the file grants access. Access Groups can include internal and external users. You can use
Access Groups with Windows, Mac, mobile, and web portal.

Data Guardian encrypted files:
e Internal users within an access group have access to encrypted data.

e Internal users outside an access group or external users do not have access but can request
access.

Important: Currently, if you enable Access Groups in the Management Console, you cannot disable it.
To configure access groups, complete the following:

e Set up Access Groups

e Determine whether the enterprise already has Data Guardian installed. Implementation will be
easier if you have a brief transition period where you allow users with shared files to prepare a
plan for shared files. Do one of these:

0 Enterprise does not yet have Data Guardian - Transition time differs based on
Force-Protected or Opt-in mode. Instruct users to process shared files.

0 Enterprise has Data Guardian_Installed - Instruct users to process shared, encrypted
files.

e Configure Access Groups

e Disable Auto access for swept files

Set up Access Groups
Analyze which users to include within each access group based on which users need to share or

collaborate on documents. You can create groups before or after enabling Access Groups in the
Management Console.
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To set up groups, see Add a User Group.

For Access Groups, you can configure the following:
e Import existing AD groups, for example, an accounting or legal group that shares files.

e Select ADMIN-DEFINED User Groups for cross-functional teams of managed users and any
external users that share or collaborate on files.

Note: When defining new groups, be sure to use descriptive names. On the client side, users will
be selecting some of these groups.

e After you add the user group, you can select that group, select the Details and Action tab, and
enable Access Groups for a single group or a combination of groups.

Also consider the following:

e Develop a plan for adding and removing users from a group if internal users join or leave the
enterprise.

e As a best practice, stagger deployment of Access Groups to user groups.
Note: Access groups should be specific groups within the enterprise, not the entire enterprise.
Return to top
Enterprise does not yet have Data Guardian

If you do not yet have Data Guardian installed, develop a plan for implementing access groups and
creating a smooth transition for users who have shared files.

Determine a transitional time range for deployment

Initially, enable Access Groups and Auto access for swept files for a transitional period. This should be a
brief time but long enough for user files to be swept. In the transitional period, allow enough time for the
following:

e Determine or estimate the quantity of documents that users have. Allow enough time for Data
Guardian to sweep unprotected files. A sweep occurs with the following:

e If you enable Force-Protected mode (Office documents and PDFs) or Basic File
Protection (additional file types), all those unprotected files are swept.

e Opt-in mode - A sweep only occurs for Data Classification (Windows only), TITUS
Classification (Windows only), or Basic File Protection (additional file types).

e Users must log in to their computers while Access Groups and Auto access for swept files are
enabled. Be sure to allow for users who are out of the office or on vacation.

Instruct users to process shared files

Inform internal users who will be in their access group and allow them to process shared files to ensure
a smooth transition. Inform them that this effort will minimize their having to request access to shared
files later.

e After Access Groups is enabled, a sweep occurs for Windows and Mac files. See
Disable_Auto_access_for_swept files. If files are shared by multiple users, the first computer to
be swept gives ownership of any shared files to the owner of that computer, not the original
author.

e Allinternal users within the same access group will have access to the file.
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o If the original author of the file is not in the access group with the user whose computer
was first swept, the author must request access or request that the administrator
change ownership of the file.

e External users' unprotected shared files are not swept.

e If Auto access will be temporarily enabled, instruct users that any internal user outside their
access group who has a copy of the file has permanent access to the key. In some cases, the
key cannot be revoked later. See Disable Auto_access for_swept files.

Note: After Auto access is disabled, for those outside an access group, the internal user can
grant access or users outside the access group can request access if they receive an encrypted
file. You can revoke the key access in the Management Console if needed.

Return to top
Enterprise has Data Guardian Installed

If you have Data Guardian installed, develop a plan for implementing access groups and creating a
smooth transition for users who have shared files.

Determine a transitional time range for deployment

Initially, enable Access Groups and Auto access for swept files for a transitional period. This should be a
brief time but owners of a protected, shared file should plan for any impact to that file.

Instruct users to process shared files

Inform internal users who will be in their access group and allow them to process shared files to ensure
a smooth transition.

e During the Auto-access transitional period, all internal users within the same access group have
access to the shared, protected files.

e If Auto access will be temporarily enabled, instruct users that any internal user outside their
access group who has a copy of the file and opens it has permanent access to the key. In some
cases, the key cannot be revoked later. See Disable Auto_access_for_swept files.

e If a user does not open a file and auto access is disabled, they lose access.

e If aninternal user already granted access to an external user, the external user will not lose
access.

e When afile is created after Access Groups is enabled, all users within that access group have
access to the file.

e If auseris removed from the access group, the user no longer has access to the files.

e |f the owner of the file is removed from the access group, others who shared access
still have access.

For detailed information on the impact, see Disable Auto_access for_swept files.

Return to top

Configure Access Groups

IT best practices should be followed during deployment. This includes, but is not limited to, controlled
test environments for initial tests, and staggered deployments to users.

1. Enable Data Guardian Access Groups and, optionally, Auto access for swept files.

Important: Currently, if you enable Access Groups, you cannot disable it.
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If you have not yet created user groups for this feature, see Add a User Group.

2
3. In User Groups, select a group.

4. On User Group Detail, select the Details and Action tab.
5. Click the check box for Access Group Enabled.

Note: You can also modify the group members, remove the group, or clear the Access Group
check box.

With Access Groups enabled, the Protected File Access screen allows internal users to select one or
more access groups or add an individual when sharing a protected file. External users who own a
document can share it with individual users but not access groups. This is available on Windows, Mac,
mobile, and web portal. For more information, see the Data Guardian User Guide.

Return to top
Disable Auto access for swept files (Windows and Mac)
If you have a transitional period, when it is complete, clear the Auto access for swept files check box.

Be aware of the following for an enterprise that already had Data Guardian installed on Windows or
Mac.

Internal users in access groups

Force-protected mode - files that Data Guardian swept Internal users within the access group do not have automatic |Internal users within the access group ha
®  Force-Protected sweep (Office documents, PDFs)  2CC€SS- protected files.
®  Basic File Protection sweep (additional file types) ®  Owner of the file can grant protected access. ®  If someone is removed from

L] Users with a protected file can request access. access.

(] If the owner of a file leaves tl
In the Management Console, if needed, you can revoke key still have access.
access that has been granted.
Note: During the transitional period when Auto access for
swept files was enabled, if a user within the access group
opened the file, that user has permanent access, and you
cannot revoke key access.

Opt-in mode - files that Data Guardian swept Same as above. Same as above.

o Secure documents folder sweep
o Basic File Protection sweep (additional file types)
o TITUS classification (Windows)

o Data classification (Windows)

Opt-in mode files protected through: Internal users within the access group do not have automatic Same as above.
L4 Protected Save As access.
L Right-click protect ®  Owner of the file can grant protected access.
®  Basic File Protection - direct save ®  Users with a protected file can request access.

(] Protected messages .
g In the Management Console, if needed, you can revoke key

access that has been granted.

Internal users not in the access group and external users
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Force-protected mode - files that Data Guardian swept
o Force-Protected sweep (Office documents, PDFs)

o Basic File Protection sweep (additional file types)

Note: Sweeping only applies to internal users. External users
computers are not swept.

Opt-in mode - files that Data Guardian swept
L] Secure documents folder sweep
L] Basic File Protection sweep (additional file types)
o TITUS classification (Windows)

o Data classification (Windows)
Note: Sweeping only applies to internal users. External users
computers are not swept.

Opt-in mode files protected through:
(] Protected Save As
L] Right-click protect
(] Basic File Protection - direct save

° Protected messages

Change the owner of afile

Internal users outside the access group and external users do

not have automatic access.
o Owner of the file can grant protected access.

o Users with a protected file can request access.

In the Management Console, if needed, you can revoke key
access that has been granted.

Note: During the transitional period when Auto access for
swept files was enabled, if a user within the access group
opened the file, that user has permanent access, and you
cannot revoke key access.

Internal users outside the access group and external users:
Same as above.

Internal users outside the access group and external users:
Same as above.

Internal users outside the access group a
not have automatic access.

o Owner of the file can grant p

o Users with a new protected f

In the Management Console, if needed, \
access that has been granted.

Note: During the transitional period whe
swept files was enabled, if a user within 1
opened the file, that user has permanent
cannot revoke key access.

Internal users outside the access group
Same as above.

Internal users outside the access group a
Same as above.

However, if the owner of the new file is 1
new user group, other members still hav
New members of the group, or users wh
Guardian after the group was created, m
or request access of the file.

After enabling Access Groups, if another user was designated as the owner of a shared, encrypted
document, you can change the owner. See Key Management.

Return to top
Removable Media Encryption

Removable Media Encryption

A note about Removable Media policies: Mac Media Encryption policies are device-based policies. This
is different behavior than Windows Media Encryption, which are user-based.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are

in bold font.
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Windows Media Encryption Off
EMS Scan External Media Not Selected
EMS Access to unShielded Media Read Only
EMS Block Access to UnShieldable Media Selected

See advanced settings

This policy must be selected to use all other
removable media policies. Not Selected means
that no encryption of removable media takes
place, regardless of other policy values.

Selected allows removable media to be scanned
every time it is inserted.

When this policy is Not Selected and the Windows
Media Encryption policy is Selected, only new and
changed files are encrypted.

More...

A scan occurs at every insertion so that any files
added to the removable media without
authenticating can be caught. Files can be added
to the media if authentication is declined, but
encrypted data cannot be accessed. The files
added are not encrypted in this case, so the next
time the media is authenticated (to work with
encrypted data), any files that may have been
added are scanned and encrypted.

Block, Read Only, Full Access

This policy interacts with the Port Control System
- Class: Storage > Subclass Storage: External Drive
Control policy. If you intend to set this policy to
Full Access, ensure that Subclass Storage: External
Drive Control is not set to Read Only or Blocked.
More...

When this policy is set to Block Access, you have
no access to media unless it is encrypted.
Choosing either Read-Only or Full Access allows
you to decide what media to encrypt.

If you choose not to encrypt removable media
and this policy is set to Full Access, you have full
read/write access to media.

If you choose not to encrypt media and this policy
is set to Read-Only, you can read or delete
existing files on the unencrypted removable
storage, but files cannot be edited on, or added
to, the media .

Block access to any removable media that is less
than 55 MB and thus has insufficient storage
capacity to host Encryption External Media (such
as a 1.44MB floppy disk).

More...

All access is blocked if Windows Media Encryption
and this policy are both Selected. If Windows
Media Encryption is Selected, but this policy is
Not Selected, data can be read from the
unencryptable media, but write access to the
media is blocked.

If Windows Media Encryption is Off, then this
policy has no effect and access to unencryptable
media is not impacted.
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Mac Media Encryption

EMS Scan External Media

EMS Access to unShielded Media

EMS Block Access to UnShieldable Media

Toggle On to enable Mac Removable Media
Encryption policies. If this policy is toggled to OFF,
no Mac Removable Media Encryption takes place,
regardless of other policies.

HFS Plus is supported and must be enabled. For
instructions to enable HFS Plus, see the
Encryption Enterprise for Mac Administrator
Guide.

Media containing Time Machine backups are not
supported. However, media recognized by
computers as Time Machine backup destinations
are automatically whitelisted, to allow backups to
continue. All other removable media with Time
Machine backups are handled based on EMS
Access to unShielded Media and EMS Block Access
to UnShieldable Media policies.

Selected allows removable media to be scanned
every time it is inserted.

When this policy is Not Selected and the Windows
Media Encryption policy is Selected, only new and
changed files are encrypted.

More...

A scan occurs at every insertion so
that any files added to the removable
media without authenticating can be
caught. Files can be added to the
media if authentication is declined,
but encrypted data cannot be
accessed. The files added are not
encrypted in this case, so the next
time the media is authenticated (to
work with encrypted data), any files
that may have been added are
scanned and encrypted.

Block, Read Only, Full Access

When this policy is set to Block Access, you have
no access to removable media unless it is
encrypted.

Choosing either Read-Only or Full Access allows
you to decide what media to encrypt.

If you choose not to encrypt removable storage
and this policy is set to Full Access, you have full
read/write access to removable media.

If you choose not to encrypt removable media
and this policy is set to Read-Only, you cannot
read or delete existing files on the unencrypted
media, but no files can be edited on, or added to,
the media unless it is encrypted.

Block access to any removable media that is less
than 55 MB and thus has insufficient storage
capacity to host Encryption External Media (such
as a 1.44MB floppy disk).

All access is blocked if EMS Encrypt External
Media and this policy are both selected. If EMS
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Encrypt External Media is True, but this policy is
False, data can be read from the unencryptable

media, but write access to the media is blocked.
If EMS Encrypt External Media is False, then this
policy has no effect and access to unencryptable
media is not impacted.

See advanced settings

"security", "fail", "30"

"security", "success", "30"

"application", "error", "30"

"application", "warn", "15"

"application", "info", "5"

"application", "debug", "5"

Defines the amount of time (in days) that
Encryption External Media, and PCS event types
are maintained in the event log.

Each event type is defined by category and level.
You may set different retention times for each
event level in each category.

The Security category represents events related
to user authentication, authorization, or
encryption. This includes events for Dell-
encrypting devices, updating security policies, or
failed authentication attempts. Security events
are further differentiated by a fail or success
indicating the outcome of the event.

The Application category (application type event,
rather than a security type event) represents
events related to general application actions.
These events are further differentiated by a set of
severity levels - error, warn, info, and debug. You
should use longer retention times for more severe
levels.

Event Retention

Removable Media Policies that Require Logoff
e Windows Media Encryption
e EMS Scan External Media
e EMS Encryption Algorithm
e EMS Exclude CD/DVD Encryption

e EMS Data Encryption Key

Advanced Removable Media Encryption

A note about Removable Media Encryption policies: Mac Media Encryption policies are device-based
policies. This is different behavior than Windows Media Encryption, which are user-based.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.
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Windows Media Encryption

EMS Exclude CD/DVD Encryption

EMS Allow Read-access to
unShielded Media (5.4.x Only)

EMS Encryption Algorithm

EMS Data Encryption Key

EMS Automatic Authentication

EMS Access Encrypted Data on
unShielded Device

EMS Device Whitelist

Off

Not Selected

Selected

AES256

User Roaming

Disabled

Selected

This policy must be selected to use all other removable media policies. Not
Selected means that no encryption of removable media takes place, regardless of
other policy values.

False encrypts CD/DVD devices.

This policy applies to 5.4.x Windows Encryption clients only.

More...

If a user chooses not to encrypt media and this policy is set to True, they are able
to read or delete existing files on the media that are not encrypted, but the client
does not allow any files to be edited on or added to the media unless it is Dell-
encrypted.

AES 256, AES 128, 3DES

Encryption algorithm used to encrypt removable media.

Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.
Common, User, User Roaming

Choose a key to be used by the Encryption client to encrypt all data encrypted by
the Encryption External Media.

More...

You cannot save a policy where this policy has the same value as either User Data
Encryption Key policy or Application Data Encryption Key policy, the error message
Policy Constraint Violation: The value for EMS Data Encryption Key conflicts with
User Data Encryption Key and/or Application Data Encryption Key will display.
Disabled, Local, Roaming

Local automatic authentication allows the encrypted media to be automatically
authenticated when inserted in the originally encrypting computer when the
owner of that media is logged in. When automatic authentication is Disabled,
users must always manually authenticate to access encrypted media.

Not Selecting Roaming automatic authentication helps to prevent users from
forgetting their password when they take the media home or share it with a
colleague. Not selecting Roaming automatic authentication also promotes a sense
of awareness from a security perspective for users that the data being written to
that media is protected.

Selected allows the user to access encrypted data on removable media whether
the endpoint is Dell-encrypted or not.

More...

When this policy is False, the user can work with encrypted data when logged on
to any Dell-encrypted endpoint . The user cannot work with encrypted data using
any device that is not Dell-encrypted.

String - Maximum of 150 devices with a maximum of 500 characters per
PNPDevicelD. Maximum of 2048 total characters allowed. "Space" and "Enter"
characters count in the total characters used.

This policy allows the specification of removable media devices to exclude from
encryption [using the device's Plug and Play device identifier (PNPDevicelD)],
thereby allowing users full access to the specified removable media devices.
More...

This policy is available on an Enterprise, Domain, Group, and User level. Local
settings override inherited settings. If a user is in more than one group, all EMS
Device Whitelist entries, across all Groups, apply.

This policy is particularly useful when using removable media devices which
provide hardware encryption. However, this policy should be used with caution.
This policy does not check whether external media devices on this list provide
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hardware encryption. Whitelisting removable storage devices that do not have
hardware encryption do not have enforced security and are not protected.

For example, the Kingston® DataTraveler® Vault Privacy model enforces that
encryption is enabled to use the device. However, the Kingston DataTraveler Vault
model has an unsecured partition and a secured partition. Because it is the same
physical removable media device with only one PNPDevicelD, the two partitions
cannot be distinguished, meaning that whitelisting this particular device would
allow unencrypted data to leave the endpoint.

Additionally, if a removable media device is encrypted and is subsequently added
to the EMS Device Whitelist policy, it remains encrypted and requires a reformat of
the device to remove encryption.

The following is an example of a PNPDevicelD, which contains the manufacturer
identifier, product identifier, revision, and hardware serial number:

USBSTOR\DISK&VEN_KIMGSTON
&EPROD_DTYAULT_PRIVACTE
RE¥_104%07005B831A0004B 480

To whitelist a removable media device, provide a string value that matches
portions of the device’s PNPDevicelD. Multiple device PNPDevicelDs are allowed.
For example, to whitelist all Kingston DataTraveler Vault Privacy models, input the
string:
PROD_DTYAULT_PRIVACY
To whitelist both models of Kingston DataTraveler, the Vault and Vault Privacy
models, input the string:
PROD_DTYAULT_PRIVALCY;
PROD_DT_VAULT
Space characters are considered part of the substring to match to a PNPDevicelD.
Using the previous PNPDevicelD as an example, a space before and after the
semicolon would cause neither of the substrings to be matched, because the
space character is not part of the PNPDevicelD.
Instructions...
To find the PNPDevicelD for removable media:
1. Insert the removable media device into an encrypted computer.
2. Open the EMSService.log in C:\Programdata\Dell\Dell Data
Protection\Encryption\EMS.
3. Find PNPDevicelD=

For example:

14.03.18 18:50:06.834 [1] [Volume "F:\"] PnPDevicelD =
USBSTOR\DISK&VEN_SEAGATE&PROD_USB&REV_0409\2HC015KJ&0
VEN=Vendor; Green highlighted text is for the vendor to be excluded

PROD=Product/Model Name; Adding text highlighted blue also
excludes all of Seagate’s USB drives

REV=Firmware Revision; Adding text highlighted gray also excludes the
specific model being used

Serial number (in this example); Adding text highlighted yellow excludes
just this device
OR
To find the PNPDevicelD for removable media on Windows 7 or later:
1. Insert the removable media device.
2. Open the Control Panel and go to Administrative Tools > Computer
Management.
3. Select the Hardware tab, select the drive, and click Properties.
A new windows displays. Select the Device Instance Path in the
Property menu.
The PNPDevicelD is displayed in Value .

Available Delimeters:
Tabs



EMS Alpha Characters Required in

Selected
Password
EMS Mixed Case Required in

Selected
Password
EMS Number of Characters 8
Required in Password
EMS Numeric Characters

X R Selected

Required in Password
EMS Password Attempts Allowed 3

EMS Special Characters Required

i Not Selected
in Password

EMS Access and Device Code

16
Length

EMS Access Code Attempts
Allowed

EMS Access Code Failure Action Apply Cooldown

EMS Access Code Required String

Authentication Failed. Please contact

Message L

your system administrator.
EMS Cooldown Time Delay 30
EMS Cooldown Time Increment 20

String
. You are not authorized to use this
EMS Access Code Failed Message .
media. Please contact your system

administrator.

EMS Encryption Rules

Manage Policies

Commas
Semi colons
Hex character Ox1E (Record separator character)

Selected requires one or more letters in the password.

Selected requires at least one uppercase and one lowercase letter in the
password.

1-40 characters

Minimum number of characters required in the password.

Selected requires one or more numeric characters in the password.

1-10
Number of times the user can attempt to enter the correct password.

Selected requires one or more special characters in the password.

8, 16, 32

Number of characters access and device codes have. 32 characters is the most
secure, while 8 is the easiest to enter.

1-10

Number of times the user can attempt to enter the access code.

Apply Cooldown, Wipe Encryption Keys

Action to take following unsuccessful EMS Access Code Attempts Allowed:

¢ Apply Cooldown to allow another round of attempts following the specified
cooldown period (EMS Cooldown Time Delay and EMS Cooldown Time Increment
policies)

¢ Wipe Encryption Keys to delete the encryption keys on the removable storage,
making the encrypted data inaccessible until the owner takes the media to an
encrypted computer for which he has a login.

String - 5-512 characters - Authentication Failed: Please contact your system
administrator.

Message that displays when a user needs to contact you for an access code (after
authentication failure).

More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on the client.
Optionally customize the second sentence of the message to include specific
instructions about how to contact a help desk or security administrator for
authentication failures.

0-5000 seconds

Number of seconds the user must wait before attempting to enter the access code
after failing the specified number of times.

0-5000 seconds

Incremental time to add to the cooldown time each time the user fails to enter the
correct access code in the specified number of attempts.

String - 5-512 characters - You are not authorized to use this media. Please contact
your system administrator.

Message that displays following unsuccessful Access Code Attempts Allowed.
More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on the client.
Optionally customize the message to include specific instructions about how to
contact the help desk or security administrator.

Encryption rules to be used to encrypt/not encrypt certain drives, directories, and
folders.

A total of 2048 characters are allowed. "Space" and "Enter" characters used to add
lines between rows count as characters used. Any rules exceeding the 2048 limit
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See basic settings
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are ignored.

See Encryption Rules for information.

More...

Storage devices which incorporate multi-interface connections, such as Firewire,
USB, eSATA, etc. may require the use of both EMS and encryption rules to encrypt
the endpoint. This is necessary due to differences in how the Windows operating
system handles storage devices based on interface type.

To ensure encrypting an iPod via EMS does not make the device unusable, use the
following rules:

-R#:\Calendars

-R#:\Contacts

-R#:\iPod_Control

-R#:\Notes

-R#:\Photos

You can also force encryption of specific file types in the directories above. Adding
the following rules will ensure that ppt, pptx, doc, docx, xIs, and xIsx files are
encrypted in the directories excluded from encryption via the previous rules:
AR#:\Calendars

;ppt.doc

Xls.pptx

.docx.xlsx

AR#:\Contacts

;ppt

.doc.xls

.pptx.docx

Xlsx

AR#:

\iPod_Control

;ppt.doc

Xls.pptx

.docx.xlsx

AR#:\Notes

;ppt.doc

Xls.pptx

.docx.xIsx

AR#:\Photos

;ppt.doc

Xls.pptx

.docx.xlsx

Replacing these five rules with the following rule will force encryption of ppt, pptx,
doc, docx, xls, and xIsx files in any directory on the iPod, including Calendars,
Contacts, iPod_Control, Notes, and Photos:

AR#:\;ppt.doc.xls

.pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for all
removable devices - not just an iPod. Use care when defining rules to exclude an
iPod from encryption.

These rules have been tested against the following iPods:

iPod Video 30gb fifth generation

iPod Nano 2gb second generation

iPod Mini 4gb second generation

Dell does not recommend the use of the iPod Shuffle, as unexpected results may
occur.

As iPods change, this information could also change, so caution is advised when
allowing the use of iPods on EMS-enabled computers.

Because folder names on iPods are dependent on the model of the iPod, Dell
recommends creating an exclusion encryption policy which covers all folder
names, across all iPod models.



Mac Media Encryption

EMS Encryption Algorithm

EMS Data Encryption Key

EMS Alpha Characters Required in
EMS Mixed Case Required in

EMS Number of Characters.
Required in Password

EMS Numeric Characters
Required in Password

EMS Password Attempts Allowed

EMS Special Characters Required

EMS Access and Device Code

EMS Access Code Attempts

EMS Access Code Failure Action

EMS Access Code Required

EMS Cooldown Time Delay

EMS Cooldown Time Increment

EMS Access Code Failed Message

off

AES256

User Roaming

Selected

Selected

Selected

Not Selected

16

Apply Cooldown

String

Authentication Failed. Please
contact your system administrator.

30

20

String

Manage Policies

Toggle On to enable Mac Removable Media Encryption policies. If this policy is
toggled to OFF, no Mac Removable Media Encryption takes place, regardless of
other policies.

AES 256, AES 128, 3DES

Encryption algorithm used to encrypt removable storage.

Encryption algorithms in order of speed, fastest first, are AES 128, AES 256, 3DES.

Common, User, User Roaming

Although Common is available, it is not implemented in this release.

Choose a key to be used by the Encryption client to encrypt all data encrypted by
the Encryption External Media.

Selected requires one or more letters in the password.

Selected requires at least one uppercase and one lowercase letter in the
password.

1-40 characters

Minimum number of characters required in the password.

Selected requires one or more numeric characters in the password.

1-10
Number of times the user can attempt to enter the correct password.

Selected requires one or more special characters in the password.

8, 16, 32

Number of characters access and device codes have. 32 characters is the most
secure, while 8 is the easiest to enter.

1-10

Number of times the user can attempt to enter the access code.

Apply Cooldown, Wipe Encryption Keys

Action to take following unsuccessful Access Code Attempts Allowed:

¢ Apply Cooldown to allow another round of attempts following the specified
cooldown period (Cooldown Time Delay and Cooldown Time Increment policies)
¢ Wipe Encryption Keys to have the Encryption client delete the encryption keys
on the removable storage, making the encrypted data inaccessible until the owner
takes the media to a Dell-encrypted computer for which he has a login.

String - 5-512 characters - Authentication Failed: Please contact your system
administrator.

Message that displays when a user needs to contact you for an access code (after
authentication failure).

More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on the client.
Optionally customize the second sentence of the message to include specific
instructions about how to contact a help desk or security administrator for
authentication failures.

0-5000 seconds

Number of seconds the user must wait between the first and second rounds of
access code entry attempts.

0-5000 seconds

Incremental time to add to the previous cooldown time after each unsuccessful
round of access code entry attempts.

String - 5-512 characters - You are not authorized to use this media. Please contact
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You are not authorized to use this your system administrator.

media. Please contact your system |Message that displays following unsuccessful Access Code Attempts Allowed.

administrator.

More...

Message policies must have non-blank values.

"Space" and "Enter" characters used to add lines between rows count as
characters used. Messages over the 512 character limit are truncated on the client.
Optionally customize the message to include specific instructions about how to
contact the help desk or security administrator.

Encryption rules to be used to encrypt/not encrypt certain drives, directories, and
folders.

A total of 2048 characters are allowed. "Space" and "Enter" characters used to add
lines between rows count as characters used. Any rules exceeding the 2048 limit
are ignored.

See Encryption Rules for information.

More...

Storage devices which incorporate multi-interface connections, such as Firewire,
USB, eSATA, etc. may require the use of both EMS and encryption rules to encrypt
the endpoint. This is necessary due to differences in how the Windows operating
system handles storage devices based on interface type.

To ensure encrypting an iPod via EMS does not make the device unusable, use the
following rules:

-R#:\Calendars

-R#:\Contacts

-R#:\iPod_Control

-R#:\Notes

-R#:\Photos

You can also force encryption of specific file types in the directories above. Adding
the following rules will ensure that ppt, pptx, doc, docx, xIs, and xIsx files are
encrypted in the directories excluded from encryption via the previous rules:
AR#:\Calendars

;ppt.doc

Xls.pptx

.docx.xlsx

AR#:\Contacts

;ppt

.doc.xls

.pptx.docx

Xlsx

AR#:

\iPod_Control

;ppt.doc

Xls.pptx

.docx.xIsx

AR#:\Notes

;ppt.doc

Xls.pptx

.docx.xlsx

AR#:\Photos

;ppt.doc

Xls.pptx

.docx.xIsx

Replacing these five rules with the following rule will force encryption of ppt, pptx,
doc, docx, xIs, and xIsx files in any directory on the iPod, including Calendars,
Contacts, iPod_Control, Notes, and Photos:

AR#:\;ppt.doc.xls

.pptx.docx.xlsx

These rules disable or enable encryption for these folders and file types for all
removable devices - not just an iPod. Use care when defining rules to exclude an
iPod from encryption.

These rules have been tested against the following iPods:

iPod Video 30gb fifth generation



EMS Automatic Authentication

EMS Access Encrypted Data on
unShielded Device

EMS Device Whitelist

Local

Selected

Manage Policies

iPod Nano 2gb second generation

iPod Mini 4gb second generation

Dell does not recommend the use of the iPod Shuffle, as unexpected results may
occur.

As iPods change, this information could also change, so caution is advised when
allowing the use of iPods on EMS-enabled computers.

Because folder names on iPods are dependent on the model of the iPod, Dell
recommends creating an exclusion encryption policy which covers all folder
names, across all iPod models.

Disabled, Enable Local, Enable Roaming

Local automatic authentication allows the Dell-encrypted media to be
automatically authenticated when inserted in the originally encrypting computer
when the owner of that media is logged in. When the User Roaming key is applied
to Encryption External Media, Roaming Automatic Authentication allows Dell-
encrypted media to be automatically authenticated when it is inserted in any Dell-
encrypted computer the media owner is logged into. When automatic
authentication is disabled, users must always manually authenticate to access
Dell-encrypted media.

Disabling Roaming Authentication helps to prevent users from forgetting their
password when they take the media home or share it with a colleague. Disabling
Roaming Authentication also promotes a sense of awareness from a security
perspective for users that the data being written to that media is protected.

Selected allows the user to access encrypted data on removable storage whether
the endpoint is encrypted or not.

When this policy is Not Selected, the user can work with encrypted data when
logged on to any encrypted endpoint. The user cannot work with encrypted data
using any unencrypted device.

String - Maximum of 150 devices with a maximum of 500 characters per
PNPDevicelD. Maximum of 2048 total characters allowed. "Space" and "Enter"
characters count in the total characters used.

This policy allows the specification of removable media devices to exclude from
encryption [using the device's Plug and Play device identifier (PNPDevicelD)],
thereby allowing users full access to the specified removable media devices.
More...

This policy is available on an Enterprise, Domain, Group, and User level. Local
settings override inherited settings. If a user is in more than one group, all EMS
Device Whitelist entries, across all Groups, apply.

This policy is particularly useful when using removable media devices which
provide hardware encryption. However, this policy should be used with caution.
This policy does not check whether external media devices on this list provide
hardware encryption. Whitelisting removable storage devices that do not have
hardware encryption do not have enforced security and are not protected.

For example, the Kingston® DataTraveler® Vault Privacy model enforces that
encryption is enabled to use the device. However, the Kingston DataTraveler Vault
model has an unsecured partition and a secured partition. Because it is the same
physical removable media device with only one PNPDevicelD, the two partitions
cannot be distinguished, meaning that whitelisting this particular device would
allow unencrypted data to leave the endpoint.

Ad(ditionally, if a removable media device is encrypted and is subsequently added
to the EMS Device Whitelist policy, it remains encrypted and requires a reformat of
the device to remove encryption.

The following is an example of a PNPDevicelD, which contains the manufacturer
identifier, product identifier, revision, and hardware serial number:

USBSTOR\DISK&VEN_KIMGSTON
&EPROD_DTYAULT_PRIVACTE
REV_10407005B831A00048 480

To whitelist a removable media device, provide a string value that matches
portions of the device’s PNPDevicelD. Multiple device PNPDevicelDs are allowed.
For example, to whitelist all Kingston DataTraveler Vault Privacy models, input the
string:
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EMS Trust for Unsupported File

Ignore
Systems
Restricted user list for access to e
) Dictionary
unencrypted media
Restrict Access to Unencrypted Full
u

Media

See basic settings

Removable Media Policies that Require Logoff
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PROD_DTYAULT_PRIVALCY
To whitelist both models of Kingston DataTraveler, the Vault and Vault Privacy
models, input the string:
PROD_DTYAULT_PRIVALCY;
PROD_DT _VAULT
Space characters are considered part of the substring to match to a PNPDevicelD.
Using the previous PNPDevicelD as an example, a space before and after the
semicolon would cause neither of the substrings to be matched, because the
space character is not part of the PNPDevicelD.
Instructions...
1. Insert removable media.
2. Open System Profiler.
3. Under Hardware, select the device and find the Product ID and Vendor
ID, as follows:
Capacity:2.06 GB (2,055,019,008 bytes)
Removable Media:Yes
Detachable Drive:Yes
BSD Name:disk2
Product ID:0x5406
Vendor 1D:0x0781 (SanDisk Corporation)
Version: 0.10
Serial Number:0000188C36725BC8
Speed:Up to 480 Mb/sec
Manufacturer:SanDisk
Location 1D:0x24100000
Current Available (mA):500
Current Required (mA):200
Partition Map Type:MBR (Master Boot Record)
S.M.A.R.T. status:Not Supported
4.  The following whitelist rules can be used:
USBVendorName=abc
USBVendorNum=0x02
USBVendorNum=2,USBProductNum=3
USBVendorNum=2,USBProdName=abc
For this example, add the following key/pair string to the EMS Device Whitelist
policy, as shown below:
"USBVendorNum=0x0781,USBProductNum=0x05406"
(including quotes)
5. When satisfied with the EMS Device Whitelist rules, save and commit
the policy.
Ignore, Provisioning Rejected, Unshieldable
Specifies how media are handled when formatted by file systems that are not
supported with Encryption External Media.
Users matching this dictionary are restricted from unencrypted media use.
Example:
<key>AccessUnencryptedMediaRestrictionUsers</key>
<dict>
<key>dsAttrTypeStandard:AuthenticationAuthority</key>
<array>
<string>;Kerberosv5;;usernamel@domainName.com;domainName.com*</string>
<string>;Kerberosv5;;@domainName.org;domainName.org</string>
</array>
</dict>
Full, Read Only, Block
Specify how media encrypted with Encryption External Media is handled for users
matching unencrypted media restriction.



e Windows Media Encryption

e EMS Scan External Media

e EMS Encryption Algorithm

e EMS Exclude CD/DVD Encryption
e EMS Data Encryption Key

Mac Encryption

Mac Encryption

Manage Policies

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are

in bold font.

Dell Volume Encryption On
Encrypt Using FileVault for Mac Not Selected
Workstation Scan Priority Normal

See advanced settings

On

off

Toggle ON to enable Dell Volume Encryption
policies. If this policy is toggled to OFF, no Dell
Volume Encryption takes place, regardless of
other policies.

If selected, FileVault is enabled to encrypt all
volumes including System Volumes and Fusion
Drives.

Highest, High, Normal, Low, Lowest

Specifies the relative priority of encrypted folder
scanning. High and Highest prioritize scanning
speed over computer responsiveness, Low and
Lowest prioritize computer responsiveness over
scanning speed and favor other resource-intensive
activities, and Normal balances the two.

The Encryption client checks for a changed
Workstation Scan Priority before processing the
next file.

This policy applies to Dell Encryption, not FileVault
encryption.

Volumes Targeted for Encryption All Fixed Volumes

Policy Proxy Connections

System Volume Only

All Fixed Volumes

The System Volume Only setting secures only the
currently running system volume.

String - maximum of 1500 characters
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Policy Proxy Polling Interval

Force Restart on Policy Updates

Length of Each Restart Delay

303

360

Selected

15

List fully qualified Policy Proxy hostnames, or IP
addresses, separated by carriage returns.
More...

Once the Encryption client finds a valid entry, the
remainder of the entries are ignored.

Entries are processed in the following order:

1. GKConnections

Override (this registry entry overrides all other
entries)

2. GKConnections (this registry entry is set
automatically by the Encryption client, based on
the this policy)

3.GK

This policy works in conjunction with the Policy
Proxy Polling Interval policy.

You cannot specify ports in this policy.

The Encryption client communicates with Policy
Proxies using the GKPORT

specified during client installation (the default is
8000).

Inherited values for this policy accumulate.

For the Encryption client to connect to a Policy
Proxy specified in this policy, it must be in the
same group as the Policy Proxy specified during
client installation.

Because the Shield supports up to 255 users per
endpoint, this policy is available only at the
Enterprise level.

1-1440 minutes

The interval that the Encryption client attempts to
poll Policy Proxy for policy updates, and send
inventory information to Policy Proxy.

Setting the Policy Proxy Polling Interval below 60
minutes is not recommended, due to potential
degradation of performance.

The Encryption client also attempts to poll Policy
Proxy each time a user logs on.

If this policy is set to Selected, the Encryption
client will force a computer restart after the
specified delay upon receiving a policy update
requiring a restart. The delay is specified by the
Length of Each Restart Delay and Number of
Restart Delays Allowed policies.

If this policy is set to Not Selected, the Encryption
client will neither force nor prompt for a restart.
The policy requiring the restart will take effect the
next time the user restarts their computer.

If Force Restart on Policy Updates is set to
Selected, this value is the number of minutes the
user can delay the restart before another restart
prompt is displayed.

If Force Restart on Policy Updates is set to Not
Selected, this policy is ignored.

More...

The Encryption client displays the restart prompt
for five minutes each time. If the user does not
respond to the prompt, the prompt is dismissed
and next delay begins. If the five-minute timer
expires and no restart delays remain, the
computer restarts immediately.



Manage Policies

Tip: Calculate the maximum possible delay as
follows (a maximum delay would involve the user
responding to each delay prompt immediately
prior to the 5-minute mark):

(Number of Reboot Delays Allowed x Length of
Each Reboot Delay) + (5 minutes x [Number of
Reboot Delays Allowed + 1]).

If Force Restart on Policy Update is set to Selected,
this value is the number of times the user can
delay the restart. If this policy is set to "0", the
Encryption client prompts the user to restart
immediately and forces the restart if the user does
not acknowledge the prompt within five minutes.
If Force Restart on Policy Updates is set to Not
Selected, this policy is ignored.

Number of Restart Delays Allowed 3

Advanced Mac Encryption

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are
in bold font.

On
Ooff

Dell Volume Encryption On Toggle ON to enable Dell Volume Encryption policies. If
this policy is toggled to OFF, no Dell Volume Encryption
takes place, regardless of other policies.

Highest, High, Normal, Low, Lowest
Specifies the relative Mac priority of encrypted folder
scanning. High and Highest prioritize scanning speed over
computer responsiveness, Low and Lowest prioritize
Workstation Scan Priority Normal computer responsiveness over scanning speed and favor
other resource-intensive activities, and Normal balances
the two.
The Encryption client checks for a changed Workstation
Scan Priority before processing the next file.
AES-256, AES-128
Encryption algorithm used to encrypt data at the
endpoint (all users) level.
Encryption Algorithm AES256 Encryption algorithms in order of speed, fastest first, are
AES 128, AES 256.
NOTE: This policy applies to Dell Encryption, not FileVault
encryption.
Required, Optional
Firmware Password Mode Required Specify if the firmware password in older hardware is
optional or required for Dell Volume Encryption.
Ignore, Report, Convert
Specify behavior when volume is Dell encrypted and
policy is for FV2 encryption.
Ignore — Default behavior, Dell encrypted volumes are
reported as protected if the policy requires FV2
encryption.

FileVault 2 Policy Conflict Behavior Ignore
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See basic settings

Report — Conflicted volumes are reported as unprotected.
Convert — Dell encrypted volumes are converted to FV2
volumes and reported as unprotected while converting.

Max Password Delay 300
Delay Authentication Not Selected
No Auth User List Dictionary
FileVault 2 PBA User List Dictionary

Port Control

Port Control

0-32400 seconds

Limits the maximum delay in seconds that can be set in
the system preferences “max password delay after screen
saver or sleep” of the Security panel.

If Selected, users are not prompted to activate or
authenticate to the Dell Server until required, such as to
use media encrypted with Encryption External Media.
Users matching this dictionary are not required to
activate or authenticate to the Dell Server.

Example:

<key>NoAuthenticateUsers</key>

<dict>
<key>dsAttrTypeStandard:AuthenticationAuthority</key>
<string>;Kerberosv5;; @students.school.edu;
students.school.edu</string>

</dict>

Users matching this dictionary are allowed to add
themselves to FileVault Preboot Authentication.
Example:

<key>FV2PBAUsers</key>

<dict>
<key>dsAttrTypeStandard:AuthenticationAuthority</key>
<string>;Kerberosv5;;* @students.school.edu;
students.school.edu*</string>

</dict>

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are

in bold font.

Windows Port Control Disabled

Port: Express Card Slot Enabled

305

Enable or Disable all Port Control System policies.

If this policy is set to Disable, no Port Control
System policies are applied, regardless of other
Port Control System policies.

All PCS policies require a reboot before the policy
takes effect.

Enable, Disable, or Bypass ports exposed through
the Express Card Slot.



Port: USB

Port: eSATA

Class: Storage

See advanced settings

Enabled

Enabled

Enabled

Manage Policies

Enable, Disable, or Bypass port access to external
USB ports.

USB port-level blocking and HID class-level
blocking is only honored if we can identify the
computer chassis as a laptop/notebook form-
factor. We rely on the computer's BIOS for the
identification of the chassis.

Enable, Disable, or Bypass port access to external
SATA ports.

PARENT to the next 3 policies. Set this policy to
Enabled to use the next 3 Subclass Storage
polices. Setting this policy to Disabled disables all
3 Subclass Storage policies - no matter what their
value.

Class: Windows Portable Device (WPD)

Subclass Windows Portable Device (WPD): Storage

Class: Human Interface Device (HID)

See advanced settings

Advanced Port Control

Enabled

Full Access

Enabled

PARENT to the next policy. Set this policy to
Enabled to use the Subclass Windows Portable

Device (WPD): Storage policy. Setting this policy to
Disabled disables the Subclass Windows Portable
Device (WPD): Storage policy - no matter what its
value.

Control access to all Windows Portable Devices.
CHILD of Class: Windows Portable Device (WPD) .
Class: Windows Portable Device (WPD) must be
set to Enabled to use this policy.

Full Access: Port does not have read/write data
restrictions applied.

Read Only: Allows read capability. Write data is
disabled.

Blocked: Port is blocked from read/write
capability.

Control access to all Human Interface Devices
(keyboards, mice).

USB port-level blocking and HID class-level
blocking is only honored if we can identify the
computer chassis as a laptop/notebook form-
factor. We rely on the computer's BIOS for the
identification of the chassis.

Policy descriptions also display in tooltips in the Management Console. In this table, master policies are

in bold font.

Subclass Storage: External Drive Control

Full Access

CHILD of Class: Storage. Class: Storage must be set
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Subclass Storage: Optical Drive Control

Subclass Storage: Floppy Drive Control

Port: PCMCIA

Port: Firewire (1394)

Port: SD

Port: Memory Transfer Device (MTD)

See basic settings

UDF Only

Read Only

Enabled

Enabled

Enabled

Enabled

to Enabled to use this policy.

This policy interacts with EMS Access to
unShielded Media policy. If you intend to have Full
Access to media, also set this policy to Full Access
to ensure that the media is not set to read only
and the port is not blocked.

Full Access: External Drive port does not have
read/write data restrictions applied

Read Only: Allows read capability. Write data is
disabled

Blocked: Port is blocked from read/write
capability

This policy is endpoint-based and cannot be
overridden by user policy.

CHILD of Class: Storage. Class: Storage must be set
to Enabled to use this policy.

Full Access: Optical Drive port does not have
read/write data restrictions applied

UDF Only: Blocks all data writes that are not in the
UDF format (CD/DVD burning, I1SO burning). Read
data is enabled.

Read Only: Allows read capability. Write data is
disabled

Blocked: Port is blocked from read/write
capability

This policy is endpoint-based and cannot be
overridden by user policy.

Universal Disk Format (UDF) is an implementation
of the specification known as ISO/IEC 13346 and
ECMA-167 and is an open vendor-neutral file
system for computer data storage for a broad
range of media.

To encrypt data written to CD/DVD media:

Set EMS Encrypt External Media = True, EMS
Exclude CD/DVD Encryption = False, and Storage
Class: Optical Drive Control = UDF Only.

CHILD of Class: Storage. Class: Storage must be set
to Enabled to use this policy.

Full Access: Floppy Drive port does not have
read/write data restrictions applied

Read Only: Allows read capability. Write data is
disabled

Blocked: Port is blocked from read/write
capability

This policy is endpoint-based and cannot be
overridden by user policy.

Enable, Disable, or Bypass port access to PCMCIA
ports.

Enable, Disable, or Bypass port access to external
Firewire (1394) ports.

Enable, Disable, or Bypass port access to SD card
ports.

Enable, Disable, or Bypass access to Memory
Transfer Device (MTD) ports.
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Class: Other

See basic settings

Global Settings

Enabled

Manage Policies

Control access to all devices not covered by other
Classes.

Global Settings policies are available at the Enterprise, Endpoint Groups, and Endpoints levels. All
Global Settings policies are endpoint-based, meaning the policies follow the endpoint, not the user.

Audit Control policies are available at the Enterprise, Endpoint Groups, Endpoints, User Groups, and

Users levels.

Policy descriptions also display in tooltips in the Management Console.

Device Lease Period

Enable In-App Feedback

Server Polling Interval

Custom Support Dialog

Dell Data Security Auto Updates

30

Not selected

360 minutes

String

Defines the period of inactivity (in days) before
any activated entity (a user, endpoint, or policy
proxy) is automatically removed from
management.

The inactivity period is based on the number of
days since the Dell Server last received inventory
information from the activated entity. Once
removed, the entity is no longer included in
reports, statistics, and other administrative views.
If the activated entity communicates with the Dell
Server after the inactivity period has expired, it
returns to being in a managed state.

The Dell Server always keeps encryption keys in
escrow, even for removed endpoints. This ensures
recoverability of data through various workflows,
such as re-activation and forensic analysis.

When selected, a user can submit feedback and
satisfaction ratings to Dell via a link within the
application to a web form.

1-1440 minutes
How often in minutes the SED client attempts to
contact the Dell Server for updates.

Customizable text that provides information for
users to contact IT support for the organization.
This allows a maximum of 10,000 characters,
which can be four lines with a maximum of 2500
characters each. The text cannot contain line
feeds, Enters, or similar characters unless they are
escaped. If an administrator enters an invalid
character (non-JSON format), this may cause Data
Guardian clients to stop activating. For user
experience on Windows devices, a maximum of
2000 characters is recommended; for Mobile
devices and Mac, a maximum of 1000 characters
is recommended.
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Enable Software Auto Updates

Update Staging Location

See advanced settings

Audit Control Policies

Data Guardian Audit Data Enabled

Data Guardian Geo Location Audit Data

Client Retention Period

Client Retention Storage

Web Portal Audit Control Policies

Data Guardian Audit Data Enabled

Data Guardian Geo Location Audit Data

Mobile Audit Control

Data Guardian Audit Data Enabled

See advanced settings
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Not Selected

String

Selected

Selected

30 days

512

Selected

Selected

Selected

Selected

Not Selected

Selected enables the client update agent to
automatically check for updates to Dell security
software. If this policy is not selected, no Dell Auto
Updates take place, regardless of other policies. If
this policy is set, the Update Staging Location
must have a network location in its value.

String

Network location (UNC) where Dell Server stages
Dell update packages. If a network location is not
specified in this policy, the Enable Software Auto
Updates policy should not be published.

Selected

Not Selected

Selected enables Audit Control policies. If this
policy is not selected, no Audit Control takes
place, regardless of other policies. It also enables
the collection of audit data from Data Guardian
clients.

Selected

Not Selected

Selected includes geo tracking location data in
audit data.

For Windows, this policy is supported on v8.1 and
higher.

1-365 days. 30 days default.

Specifies the number of days that the client will
hold on to audit data without transmission.
Megabytes of storage space

Specifies the maximum storage space used by the
client for audit data without transmission.

Selected

Not Selected

Selected enables Web Portal Audit policies. If this
policy is not selected, no Audit Control takes
place, regardless of other policies. It also enables
the collection of audit data from Data Guardian
clients.

Selected

Not Selected

Selected includes geo tracking location data in
audit data.

For Windows, this policy is supported on v8.1 and
higher.

Selected

Not Selected

Selected enables Audit Control policies. If this
policy is not selected, no Audit Control takes
place, regardless of other policies. It also enables
the collection of audit data from Data Guardian
clients.



Advanced Global Settings

Manage Policies

Global Settings policies are available at the Enterprise, Endpoint Groups, and Endpoints levels. All
Global Settings policies are endpoint-based, meaning the policies follow the endpoint, not the user.

Audit Control policies are available at the Enterprise, Endpoint Groups, Endpoints, User Groups, and

Users levels.

Policy descriptions also display in tooltips in the Management Console.

DDP Auto Updates

Update Check Period

See basic settings
Mobile Audit Control

Data Guardian Geo Location Audit Data

See basic settings

10080

Selected

1-43200 minutes (30 days)
The period in minutes between checks for
updates.

Selected

Not Selected

Selected includes geo tracking location data in
audit data.
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